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1 Introduction

1.1 Introduction

The gvSIG project was born in 2004 within a project that consisted in a full 
migration of  the information technology systems of the Regional  Ministry of 
Infrastructure  and  Transport  of  Valencia  (Spain),  henceforth  CIT,  to  free 
software. Initially,  It  was born with some objectives according to CIT needs. 
These objectives were expanded rapidly because of two reasons principally: on 
the one hand, the nature of free software, which greatly enables the expansion 
of technology, knowledge, and lays down the bases on which to establish a 
community,  and,  on  the  other  hand,  a  project  vision  embodied  in  some 
guidelines and a plan appropriate to implement it.

The “Association for the promotion of FOSS4G and the development of gvSIG", 
gvSIG Association, aims currently the sustainability of gvSIG project. The gvSIG 
Association  is  a  non-profit  organization  that  includes  the  main  entities  who 
promote the gvSIG project. Around democratic values and values of solidarity 
of the open source software the gvSIG Association promotes the development 
of a new business model based on cooperation and shared knowledge, where 
part  of  the benefits  from these bussines activities  will  back into  the gvSIG 
project.

1.2 What is gvSIG?

gvSIG is a programme which manages geographic information. It has a user-
friendly interface and fast access to most standard raster and vector formats. 
gvSIG can also integrate local and remote data in the same view through WMS, 
WFS, WCS and JDBC sources.

It  is  aimed  at  end  users  of  geographic  information  in  business  and  public 
administration  (city  councils,  regional  councils  and  regional  and  national 
ministries).

It  is  also  highly  suited  to  the  university  environment  thanks  to  its  R&D&I 
element.

It is a free, open code application with a GPL licence. From the outset, special 
emphasis  has  been  given  to  the  expansion  of  the  gvSIG  project  so  that 
developers can add functions to the application easily and develop completely 
new applications from the libraries used in gvSIG (as long as they comply with 
the GPL licence).

1.3 What can we do with gvSIG?

1.3.1 Introduction

gvSIG is a sophisticated Geographic Information System for managing spatial 
data and performing complex analyses on it.

1.3.2 The gvSIG interface

The gvSIG interface has the necessary features required to communicate with 

http://www.gvsig.com/
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the programme. The graphical  interface is  intuitive and user-friendly  and is 
suitable for any user who is familiar with Geographic Information Systems.

The gvSIG interface is  made up of  a main window with  different  tools  and 
secondary  windows  for  the  documents  created  using  the  programme,  as 
described in the following sections.

Before describing the different documents and tools, we must take a look at 
the  gvSIG  interface.  The  more  familiar  you  become  with  the  interface  the 
easier it will be to go through the following chapters.

Main window

1. Title  bar:  Located  at  the  top  of  the  gvSIG  window.  It  contains  the 
programme name, i.e. “gvSIG” in this case.
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2. Buttons to maximize or minimize the programme’s active window or to 
completely close it.

3. Main  window:  Work  area  in  which  the  different  “Project  Manager” 
windows and the different gvSIG documents are located.

4. Menu bar:  Some of the gvSIG functions are grouped into menus and 
sub-menus in the menu bar.

5. Toolbar: The toolbar contains the icons for the standard commands and 
is the easiest way to access them. By clicking and dragging the toolbars 
we can move them to different positions.

It is not necessary to memorize the meaning of every single icon. When 
you place the mouse pointer over them a message with a description of 
their function immediately appears.

6. Status  bar:  The  status  bar  provides  information  about  coordinates, 
distances, etc.

2 gvSIG Projects

2.1 Introduction

In gvSIG all the activities are located in one project. This project is made up of 
different  documents.  There  are  three  types  of  documents  in  gvSIG:  views, 
tables and maps.

Views: Views are the documents in which we work with graphic data.

Tables: Tables are the documents in which we work with alphanumeric data.

Maps:  A  map  generator  which  allows  the  different  cartographic  elements 
included in a map (view, legend, scale…) to be inserted.

Projects are files with a “.gvp” extension. These files do not include spatial data 
and associated attributes in the shape of tables. Instead they save references 
to the places the data sources are stored (the path to be followed in the disk in 
order to find the files). If the data changes the updates will be shown in all the 
projects they are used in. The menu which allows you to access the project 
management options is located in the “File” menu
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And in the following toolbar buttons (“New project”, “Open project” and “Save 
project”).

2.2 Saving a project 

1. Click on “File” in the menu bar and then on “Save project”. Alternatively, 
press the “Alt+G” key combination, or the “Save” button in the toolbar. 

2. When the file manager window is opened you can name the project and 
choose where to save it. 
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3. The project is saved in a file with a “.gvp” extension. 

2.3 New project

1. Click on “File” in the menu bar and then on “New project”. Alternatively, 
press the “Alt+N” key combination or the “New” button in the toolbar. 

2. If you are already working on a project, the following message will appear 
when the button is pressed. 

If  you press “Yes”, a window will  open so you can save your current gvSIG 
project.  When the previous project has been saved a new blank project will 
appear on the screen.

2.4 Open a project

2.4.1 Opening an existing project

1. If you wish to open an existing project to see or modify it, go to the “File” 
menu and click on “Open project”. Alternatively, press the “Alt+A” key 
combination or the “Open project” button in the toolbar. 

2. When the project manager window is open, look for the “.gvp” file which 
contains the project you wish to open. 
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2.4.2 Layers where the path has changed

Once a new project has been created in gvSIG, the layers that we are going to 
work with are added to the project.

Take  the  following  project  as  an  example,  which  contains  layers  for  the 
provinces of South Africa.
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View showing layers in an existing project.

As you can see, three layers have been added to the View, namely Provinces, 
Roads and Cities. Close the project, remembering to save any changes. Now 
change the path to one or more of the layers in the project either by renaming 
the directory or by moving the layer(s) to another directory.

Reopen the gvSIG project and you will see the following window displayed:

Existing Project window.

When the project is opened, gvSIG will  prompt the user to locate layers for 
which the path has changed and to provide a new path. Once the new path has 
been provided gvSIG can load the layer and you can resume working on the 
project.
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2.5 Saving and Closing a project 

When you decide to finish a session in gvSIG, a window such as the one shown 
below appears:

The text box shows both the name of the project currently in use as well as the 
layers and tables which were being edited before the decision to close the 
project was made. The “Select all” and “Clear selection” buttons allow you to 
enable or disable the check boxes in the text box which correspond to the 
project or to the layers being edited.

If you click on “Ok”, the changes made to the enabled elements in the text box 
will be saved.

If you click on “Discard changes”, none of the changes made in the project will 
be saved irrespective of whether they have been enabled or not.

The “Cancel” button allows you to exit the window.
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2.6 Copying and pasting documents in gvSIG 

2.6.1 Introduction

If you copy and paste a document, you should remember that if this document 
has any other documents associated with it these will also be copied (example: 
if a map is copied the views it includes will also be copied).

N.B. You can select several documents to be copied at the same time.

N.B. Remember that if you press “No” or “Cancel” in any of the dialogue boxes 
which appear during the process, none of the changes you have made in the 
process will be saved.

2.6.2 Copying/Pasting Views

Select the view you wish to copy from the “gvSIG Project manager”, right click 
and select “Copy” from the contextual menu.

If you wish to copy the view to another gvSIG project, select “Paste” from the 
contextual menu. If a project already has a view with this name a message will 
appear to indicate that you must change the name of the view you are trying 
to paste.
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N.B. The message “No table will be pasted” means that the tables which are 
active in the source view will  not appear in the target view unless they are 
activated in this view. If you wish to cancel the operation, press “No”. If you 
press “Yes” a new dialogue box will appear so the view can be given a new 
name.

Write  the  new view name and press  “OK”.  This  view will  be  added to  the 
project. If you press “Cancel” the process will be terminated.

2.6.3 Copying/Pasting Tables

The procedure for copying/pasting tables is similar to the procedure described 
above. However, in this case tables with the same name can exist in a project.
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2.6.4 Copying/Pasting Maps

The procedure for  copying and pasting maps is  similar to the previous two 
cases. Select the map you wish to copy from the “Project Manager”, right click 
and select “Copy” from the contextual menu. If you wish to paste the map to a 
project which already has a map with the same name, the following message 
will appear.

If you press “No”, the operation will be cancelled. If you press “Yes”, a new 
dialogue box will appear. Write the new name for the map in the box and press 
“OK”.

If  you  press  “Cancel”  the  process  will  be  terminated.  If  any  of  the  views 
associated  with  the  map  already  exist  in  the  current  project  the  following 
message will appear.

If you press “Yes”, a new map document will be created. If you press “No” the 
operation will be cancelled. N.B. The message “The conflicting views will not be 
pasted”  indicates  that  the  views  the  maps  are  associated  with  will  not  be 
added. Instead, the views which already exist in the current project with these 
names will be used (example: You have copied a map with an “A” view and a 
“B” view. When you try to paste the map into the project, you find that an “A” 
view already exists. The operation will add the “B” view and will leave the “A” 
view intact so that the map will use the pre-existing “A” view).
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2.6.5 'Cutting' documents in gvSIG

Use the “Project manager” to select the document you wish to cut. Right click 
and select the “Cut” option from the contextual menu. The following window 
will appear.

If you press “Yes” the selected document will be “cut” from your project.

3 Documents

3.1 2D views

3.1.1 Vector tools

3.1.1.1 Introduction

Views  are  the  gvSIG  documents  used  as  the  working  area  of  cartographic 
information.

A view can contain different  layers of  geographic information (hydrography, 
transport infrastructures, administrative regions, contour lines, etc.).
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When one  of  the  views  that  make  up  a  project  is  opened,  a  new window 
appears divided into the following parts:

Table of contents (ToC):  The ToC is  located on the left-hand side of  the 
window. The Table of Contents lists all the layers it contains and the symbols 
used to represent the elements which make up the layer.

Display window: The display window is located on the right-hand side of the 
screen. The project’s cartographic data are shown in this display window.

Locator:  The locator is situated in the bottom left-hand corner. The locator 
allows the current frame to be situated in the work area as a whole.

When a view is opened, the main window increases the number of menus and 
buttons, thus adding the tools required to work with the elements which make 
up the view.

The size of the ToC can be enlarged to show a full description of all the themes 
by simply dragging its edge to the right or downwards.

3.1.1.2 Layer properties

3.1.1.2.1 Introduction

You can access the active layer's properties from its contextual menu (right 
click on the layer).

3.1.1.2.2 General properties

Right click on the selected layer in the ToC to access the properties window.
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When you click on the “Properties” option, a new dialogue box opens. This can 
be used to edit some properties.
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The layer name can be changed by writing the new name in the text field in the 
“General” tab.

3.1.1.2.3 Renaming

If you wish to rename the selected layer, right click on the layer and go to the 
"Rename" option.

A new window appears:

Write the new name in the text field and click on “Ok”.

N.B.: When you do this, the layer name changes in the ToC, but the file name is 
not changed.

3.1.1.2.4 Using the spatial index

If you mark the “Use spatial index” check box, a spatial index will be created 
which makes the layer loaded in the view appear more quickly. This is because 
the view is loaded using this index.

If there are write permissions, a .qix file is created with the same name as the 
layer it is associated with in the layer’s original directory. If there are no write 
permissions, the file will be created in the user’s temporary file directory.

3.1.1.2.5 Scale range

A viewing scale range (maximum and minimum) can be set in the properties 
window.

3.1.1.2.6 File extension and path

The file extension and path are shown in the actual properties section.
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3.1.2 Raster tools

3.1.2.1 Introduction

You can access the active layer's properties from its contextual menu (right 
click on the layer).

3.1.2.2 Layer properties

3.1.2.2.1 Layer information

You  can find  information  about  the current  raster  layer  through  the option 
"Raster  Properties",  which  shows  a  dialog  with  multiple  tabs  containing 
information about the raster layer. To get information about the layer, click the 
tab "Information".

The "Raster Properties" dialog can be accessed in two ways: by right-clicking 
on the raster layer in the Table of Contents or through the raster properties 
icon in the toolbar:

Raster Properties icon

Here, set the left button to Raster Layer and select the option Raster Properties 
from the pull-down button on the right. Make sure that the name of the raster 
layer for which you want to see information is displayed as current layer in the 
text box.

The Information tab of the Raster Properties window shows general information 
about the raster layer. Since a layer can consist of multiple files with the same 
geographic  extension,  you  can  choose  the  file  for  which  you  want  to  see 
information from the pull-down tool  on the bottom of  the "Information" tab 
window.  The information is  divided in  thematic  blocs with a header in bold 
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letters indicating the bloc theme.

The bloc Dataset information shows the name of the file, disk size, width and 
height in pixels, data format (file extension), whether it is georeferenced, the 
number of bands and the data type.

The bloc Geographic coordinates shows the georeferencing information of the 
layer as well as the pixel size.

The bloc Origin will show an entry for each band in the file. For every band you 
can see the data type, the colour interpretation and the value that is assigned 
to  NoData  pixels.  The  colour  interpretation  of  a  band  is  important  for  the 
display on screen. If a band has an interpretation such as Red, this means that 
gvSIG  will  interpret  this  band  to  be  displayed  as  the  red  band  in  RGB 
visualization.  This  colour  interpretation  will  be  used  as  default  for  the 
displaying  of  the  image.  A  band  may  have  the  following  types  of 
representations:  Red,  Green,  Blue,  Gray,  Undefined  or  Alpha.  The  NoData 
information  associated  with  the  band  will  not  be  taken  into  account  when 
processing the image, and the NoData values can be shown as transparent if 
needed (see the section "NoData values").

The  bloc  Projection will  show  the  projection  information  of  the  layer,  if 
available. The representation format is WKT.

The bloc  Metadata will show metadata information from the image header if 
available.



gvSIG Desktop

Raster Properties. Metadata

3.1.2.2.2 Raster properties

Right  click on a raster  layer and select the "Raster  properties"  option.  This 
opens a menu in which we can carry out various operations on the raster layer.

This menu is divided into five tabs:
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Information: Provides general information about the raster layer, the file path, 
the number of bands, the pixel dimensions, the file format, the data type and 
the geographic coordinates of the corners.

Bands: Provides tools to change the mode in which each image band is viewed. 
Transparency: Provides tools  to change the transparency levels that can be 
applied to a raster layer.

Enhance: Provides a tool to enhance the raster layer. Pansharpening: Provides 
a tool to increase the satellite image resolution if the panchromatic band for 
these images is available.

In the “Bands” tab you can make compositions using the different bands in a 
raster image. You can also add more bands from other files. This is useful when 
working  with  Landsat-type  images,  in  which  each  band  is  delivered  in  a 
different file.
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In addition to the “Transparency” option in gvSIg version 0.3,  which is now 
called “opacity”, and which indicates the "occlusion” percentage of this layer 
over the previous ones, there is now a transparency option which allows the 
indicated colour groups (RGB) to be completely transparent. This is very useful 
to  eliminate  visual  artefacts  as  a  result  of  missing  data  in  orthophotos  or 
satellite images and to remove borders in an image mosaic.

To access the options, click on the corresponding “Activate” check boxes.
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The “Enhance” tab can be used to modify the image brightness, contrast and 
enhancement. This last option is essential to be able to view 16-bits per band 
images correctly.

The “Pansharpening” tab can be used to increase the resolution of  satellite 
images if  the panchromatic  band for  these images is  available.  N.B.:  If  the 
image bands are in different files, they must be added to the layer using the 
“Bands” tab.

Use the “Bands” tab to find the best band combination for the view. In this 
section, you can load the image which corresponds to the panchromatic band 



gvSIG Desktop

but you must not select it to be visualised.

When the bands have been loaded, you can carry out the pansharpening. Go to 
the  “Pansharpening”  tab  and  activate  it  by  clicking  on  the  “Activate 
Pansharpening”  check  box.  Select  the  panchromatic  band  with  which  the 
pansharpening  is  to  be  carried  out  from  the  band  list.  Finally,  select  an 
algorithm to be applied. There are two methods available, “Brovey” and “HSL”. 
Both of them have a slide bar control to carry out adjustments.

In  “Brovey”  the  general  brightness  of  the  resulting  image  is  increased  or 
decreased.

In  “HSL”  the  coefficient  which  is  added  to  the  brightness  taken  from  the 
pansharpening  band  varies  before  it  is  replaced  in  the  output  image.  This 
coefficient can vary between 0.15 and 0.5. When modified, the obtained result 
also  influences  the  output  image’s  general  brightness.  If  you  click  on  the 
"Apply" or “Ok" buttons, the pansharpening will be applied on the image in the 
view, thus increasing the image resolution.
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3.1.2.2.3 Setting a visible scale range for a layer

To set the layer visibility according to scale range, you can specify the scale 
ranges in the "General" tab of the Raster Properties window.

The "Raster Properties" dialog can be accessed in two ways: by right-clicking 
on the raster layer in the Table of Contents, or through the Raster Properties 
icon in the toolbar:

Raster Properties icon

In the "General" tab, the scale ranges can be set as shown in the picture below:
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Raster Properties. Configure Scale ranges

There are two ways to hide the image according to its scale:

1. Hide when the scale is bigger than 1:xxx, where xxx is a numeric value to 
be entered. This corresponds to the minimum scale. 

2. Hide when the scale is smaller than 1:xxx, where xxx is a numeric value 
to be entered. This corresponds to the maximum scale. 

3.1.2.2.4 Enhancement (Raster properties)

The Raster Properties dialog contains options for the enhancement of raster 
layers. The "Raster Properties" dialog can be accessed in two ways: by right-
clicking  on the  raster  layer  in  the  Table  of  Contents  or  through  the  raster 
properties icon in the toolbar:
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Raster Properties icon

Here, set the left button to Raster Layer and select the option Raster Properties 
from the pull-down button on the right. Make sure that the name of the raster 
layer for which you want to see information is displayed as current layer in the 
text box.

In the Raster Properties dialog, select the "Enhancement" tab.

Raster Properties. Enhancement

Every modification in this Enhancement dialog will  be applied to the current 
view for visual interpretation purposes and can not be saved as a new layer. If 
you want to save the enhancements, you will need to use the Filter dialog or 
the  Radiometric  Enhancement dialog,  depending  on  whether  you  want  to 
modify the brightness and contrast or apply a linear enhancement.

On the left side of the dialog, the controls for modifying brightness and contrast 
are shown. By default, these controls are disabled but if you want to change 
the values, you can activate them by ticking the "Activate" check box. Then, 
use  the  slide  bar  to  alter  the  slide  bar  or  type  the  value  directly  in  the 
corresponding text box.

The  right  side  of  the  dialog  is  used  for  linear  enhancement.  This  is  a 
simplification  of  linear  radiometric  enhancement  to  control  the  display  of 
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images of data types other than Byte. For Byte images, this control is disabled 
by default. For other data types, these values are automatically set when the 
raster layer is loaded. It is recommended to use this control only to modify 
automatically  assigned  values.  For  more  enhancement  options  it  is  more 
appropriate to use the Radiometric Enhancement function.

The enhancement stretches the data over a range from 0 to 255 to improve 
visual interpretation. The option "Remove edges" will ignore the minimum and 
maximum values that appear in the image. The option "Clipping tail (%)" will 
sort the values from low to high, and cut off the values that are lower or higher 
than a specified percentage of the total number of values. The effect is a shift 
in the maximum and minimum values.

3.1.2.2.5 Image statistics

gvSIG can generate basic statistics over raster layers, which you can access 
through  the  option  "Raster  properties"  that  opens  a  dialog  window  with 
multiple tabs containing information about the selected raster layer. Select the 
"General" tab to see the layer statistics.

The dialog window "Raster properties" can be accessed in two ways: by right-
clicking the raster layer in the table of contents, or from the raster properties 
icon in the toolbar:

Raster Properties icon

In this tab, you can see the layer statistics grouped by band. For each band the 
following information is shown:

• Minimum: Minimum value in the band. 
• Maximum: Maximum value in the band. 
• RGB Minimum: Minimum RGB value in the band. 
• RGB Maximum: Maximum RGB value in the band. 
• Mean: The average of all the values in the band. 
• Variance: The amount of variation within the values in the band. 
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Raster properties window with image statistics

In case that the statistics are incomplete or erroneous, you can use the option 
"recalculate statistics" to regenerate the statistics.

3.1.2.2.6 Bands and files selector

You can find  information  about  the  current  raster  layer  through  the  option 
"raster properties", which opens a dialog with several tabs. To access the list of 
image bands and corresponding files, go to the tab "Bands".

The "Raster Properties" dialog can be accessed in two ways: by right-clicking 
on  the  raster  layer  in  the  TOC,  or  through  the  raster  toolbar  by  selecting 
"Raster  layer"  on the left  drop-down button and "Raster properties"  on the 
drop-down button on the right. Make sure that the name of the raster layer for 
which you want to see information is displayed as current layer in the text box.

Raster properties icon

The "Bands" tab of the "Raster properties" dialog provides options to select 
band combinations for image display. The upper part of the dialog shows a list 
of files of which the image consists. You can add more files, but they must 
correspond to the same geographic area. This is useful when you need to load 
several files of the same sensor, each file representing a band.
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In the lower part of the dialog you can select the display order of the bands. By 
default, the display order is assigned by the colour interpretation of the bands, 
if that information is available. With the option buttons, you can change the 
display order by marking the bands that should be displayed in red (R), green 
(G),  blue  (B)  or  alpha  (A).  When clicking  on  the  "Save"  button,  the  colour 
interpretation information will be saved and set as default for the image. This 
means that the next time that the image is loaded in gvSIG, the display order 
of the bands will according to the settings that you have saved.

Raster properties. Band selection
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3.1.2.2.7 Transparency per pixel

You can find  information  about  the  current  raster  layer  through  the  option 
"Raster properties", which opens a dialog with several tabs. To access the pixel 
transparency and opacity options, go to the tab "Transparency".

The "Raster Properties" dialog can be accessed in two ways: by right-clicking 
on  the  raster  layer  in  the  TOC,  or  through  the  raster  toolbar  by  selecting 
"Raster  layer"  on the left  drop-down button and "Raster properties"  on the 
drop-down button on the right. Make sure that the name of the raster layer for 
which you want to see information is displayed as current layer in the text box.

Raster properties icon

The transparency options that are set here will only be applied to the current 
view (i.e. they will not be applied permanently to the image). The transparency 
will  be calculated and applied each time when you zoom on the view. The 
transparency  settings  can  be  saved  in  the  current  project,  and  when  the 
project  is  opened  again,  the  transparency  will  be  applied  on  the  layer. 
However, if the same image is opened in another project, it will be displayed 
normally without the transparency settings.

The upper  part  of  the  "Transparency"  tab of  the  "Raster  properties"  dialog 
shows a sliding bar labelled "Opacity". After activating the sliding bar by ticking 
the check box, you can modify the opacity of the whole layer by moving the 
slider. (Opacity is the opposite of transparency: if you set the opacity to 0%, 
the layer will be 100% transparent.)
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Set the transparency using the Opacity slider

The  pixel  transparency  controls  are  located  in  the  lower  part  of  the 
"Transparency" tab. With these controls, you can apply transparency to pixels 
or a range of pixels depending on their RGB value. After activating the controls 
(by ticking the "Activate" check box) you can add specific RGB values to the list 
of elements through the "Add" button. Three values separated by the "&" or "|" 
symbol will be added as one item in the list; the three values correspond to the 
RGB value that will be set transparent. The values that are added are those 
that appear in the text boxes, the alpha value is optional. The information in 
these text boxes can be modified in three ways: typing the value directly by 
using the keyboard, moving the colour sliders on the left of the text boxes, or 
by clicking on the image in the view to select a specific colour value. This last 
option  is  activated with the button with the tooltip  "Select  RGB clicking on 
view". This will activate a crosshair cursor in the gvSIG view so that you can 
click on the image pixels and select the values for which you want to set the 
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transparency.

If the line "255 & 0 & 0" is added to the list, this means that all pixels with the 
RGB values of 255 for red, 0 for green and 0 for blue (i.e. all pixels that are 
pure red) will be set transparent. The "&" symbol can be changed by the "And" 
and "Or" options. If "Or" is activated, the entries in the list will appear with the 
pipe symbol "|". The line "255 | 0 | 0" means that all pixels that have RGB 
values of 255 for red, or 0 for green, or 0 for blue will be set transparent. In this 
case many more pixels will be set transparent.

Set the transparency for specific pixel values

3.1.2.3 General components

3.1.2.3.1 Accessing raster functions from the toolbar

With the increase of  image processing functions  in  the menu of  gvSIG,  the 
toolbar had to incorporate these Raster functions by grouping them as pull-
down buttons.

As can be seen in the image below, when a view is selected, a control  will 
appear at the right side of the toolbar.
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Drop-down buttons for raster functions in the toolbar

The control has two drop-down buttons and a search combobox with the name 
of the current layer.

The buttons work as follows (see image below):
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Raster drop-down button, with two zones (1 and 2)

1. Clicking in this area will change the visible order of the button. 
2. Clicking  the  area  with  the  pointing  down  arrow  shows  the  menu  of 

options. 

Groups of raster functions

With the first drop down button you can access a set of grouped functions. For 
each  group  of  functions,  the  individual  functions  within  that  group  will  be 
shown in the second button. Therefore, the functions that are available in the 
second button depend on the group of functions that is chosen with the first 
button.

Individual raster functions shown in the second drop-down button

In the image above, the individual functions from the second drop-down are 
shown while in the first drop-down button the function group "Raster layer" is 
selected.
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Combobox with the name of the current raster layer

The search combobox is used to select one of the layers in the TOC. When 
clicking on the arrow on the right, all the possible layers are shown.

Search Combo to select a raster layer

You can write text in the combobox to filter the list of images (i.e. write "1x5" 
to show only layers that have these characters in their name).

3.1.2.3.2 Display of processing statistics when a new layer has 
been created

When processes that display a progress bar have ended, a statistics window 
with details of the process is usually shown.

Examples of such processes that launch statistics windows are Filters, Crop, 
Save As, etc.

Statistics component
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The statistics window shows the following information:

• File: Complete file path where the image has been stored. 
• Time: The time that it took to complete the process. 
• Size: File size on disk. 
• Compression: Whether or not the image file has been compressed. 

If you have generated more than one layer in the same process (as is the case 
when cropping images with multiple bands) the statistics window will display 
the information of each layer in a different tab.

The window can be closed by pressing the OK button.

3.1.2.3.3 Progress bar

When  running  processes  that  may  take  a  considerable  amount  of  time,  a 
progress bar is shown.

The progress bar indicates that a process is running in the background and 
informs the user on the status of the process at any given moment and on how 
much time has elapsed since the process started.

In the image below, you can see a screenshot of the progress bar during a 
running process.

Progress bar component

The progress bar consists of several parts. The title indicates which process is 
running. Below the title, the current task that is being processed is indicated as 
well as the percentage of the process that has been completed.

The progress bar contains two buttons. To see more details, you can click the 
left button, after which the dialog is enlarged to display additional information 
as in the screenshot below.
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Progress bar with details

The additional information includes a list of tasks that have been performed 
and an indication of how much time has elapsed since the process was started.

Confirmation message: are you sure you want to cancel this process?

If you want to cancel a process, you can click on the "Cancel" button on the 
right.  A  message  will  appear  to  prompt  for  confirmation.  Clicking  on  the 
"Cancel"  button  does  not  always  guarantee  that  the  process  is  stopped 
immediately.  Depending  on  the  process,  certain  tasks  might  be  needed to 
reverse the process and return to the previous state.
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3.1.2.3.4 Table control

The table control  component is  used to represent data in tabular form and 
allows you to edit the data.

The possibilities are:

Table control components (1 and 2)

1. Selection of rows in the table. 
2. Reordering the rows. Click on the arrow buttons to move a selected row 

up or down. 

Table control components (3 and 4)

3. Choose a unique property for every row. In the example above, a band is 
allocated for each layer.

4. Typical  table  controls,  as shown in the example at the bottom of  the 
table. From left to right:

• Select the first row. 
• Select the previous row. 
• Drop down to select a particular row. 
• Select the next row. 
• Select the last row. 
• Create a new row. 
• Delete the selected row. 
• Delete all rows from the table. 
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Table control components (5)

5. In  the  table  control,  besides  being  able  to  edit  anything  if  editing  is 
enabled, you can also change the color by clicking on it. 

3.1.2.3.5 Output selector

The output selection control is used to create new layers.

In this example the output selection control is shown in the lower right corner 
of the dialog (1):
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Output file selection

The selector consists of two components:

1. For the output image, you can choose whether to apply the filters over 
the image in the current view (only for display) or save the output as a 
new layer. 

• The option "Only on visualization" does not change the original layer, but 
will apply the list of filters when drawing and re-drawing the view. This 
option  is  faster  when the image is  very  large (as  the filters  are  only 
applied to the current view, not to the whole image), but it slows down 
the drawing and re-drawing of the view. 

• The option "New Layer" will apply all the filters to the image and save the 
output to a new layer. This is faster when the image size is medium or 
small and the applied changes are considerable. The generation of the 
new layer will  take some time, but then the displaying is as fast as it 
would be without the filters. 

Both options have advantages and disadvantages, and it is up to the user to 
decide which option to choose.

2. When  selecting  the  option  "New  Layer",  a  second  option  control  is 
enabled  in  which  you  can  choose  whether  to  save  the  layer  to  disk 
(Create file) with a file name specified in the text box (2), or to create a 
temporary gvSIG layer (Open in memory). 

The new layer will be added to the view, and the TOC will show the layer name 
as specified in the text box.

**  Note: The temporary working space of gvSIG is cleaned automatically, so 
any temporary layers will be deleted when exiting the application.
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3.1.2.3.6 Previewing the output

A preview is usually shown for functions that require extensive processing. It is 
usually located in the upper right corner of the dialog as shown in the following 
example:

Component 'Preview'

The preview gives only an indication of how the final output will look like. Since 
only  a minimum amount of  data is  used to generate the preview, the final 
result may be different.

The following options are available for preview windows:

• Move the image with the left mouse button. 
• Center the image in the preview by pressing the C key. 
• Zoom out to see the whole image with the space bar or 0 
• Predefined zooms with keys 1 to 5. 1 gives a 1/1 zoom. 
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• Zoom with the mouse wheel or arrow keys + and -. 
• Show a grid on the background to view images with transparency by 

pressing the B key. 
• Access the help function by pressing the H key or clicking on the question 

mark in the upper right corner of the preview window. 

The access to these preview functions through the shortcut keys only works 
when the focus is on the preview window, after clicking on it with the mouse.

For different types of functionality, the preview may appear with a different 
default  zoom level.  For  example,  the  preview of  colour  tables  is  shown as 
completely  zoomed  out  so  that  the  effects  on  the  whole  image  can  be 
previewed.

3.1.3 Table of contents (ToC)

3.1.3.1 Table of contents

The “Table of Contents” is the area used to list the different layers which make 
up the cartographic information.

A check box next to each layer indicates whether it is "visible” or not.

Remember that an active layer is not the same as a "visible" layer. When a 
layer is “active” it is highlighted compared to the other layers included in the 
“Table  of  contents”.  When  a  layer  is  activated,  gvSIG  is  notified  that  the 
elements of this layer can be worked with.

The order of appearance of the layers in the “View” is important because it ties 
in with the display order. Layers made up of text elements, points and lines are 
placed at the top whilst the polygonal layers and images which make up the 
background of the view are placed at the bottom.

To move the layers in the ToC, place the cursor over them, left click on the 
mouse and drag the layer to the required position.

The layers in the ToC can also be selected by using the Control and CAPS keys.

3.1.3.2 Grouping and ungrouping layers

From version 0.4 onwards, gvSIG allows several layers to be grouped together. 
This is useful because it means a large number of layers can be kept in the ToC 
without  taking  up  a  lot  of  space.  This  option  also  allows  operations  to  be 
carried out on all the layers that make up a group at the same time. To group a 
set of layers together, select the layers, click and hold down the CAPS key and 
right click on the mouse on any of the layers and select the “Group layers” 
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option.

The following dialogue window appears and a name for the new grouping can 
be input.

When the name of the new grouping has been input, it appears in the ToC as 
shown below.
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To undo a grouping, right click on the grouping so that the contextual menu 
appears. Select the "Ungroup layers" option.

3.1.3.3 Select raster layer

Raster layers can be selected through the raster toolbar by selecting the option 
"Raster layer" on the left drop-down button and "Select raster layers" on the 
drop-down button on the right.

Select raster layer icon

When multiple raster layers have been loaded into the view, you can select one 
of those as current layer. By clicking on one of the layers in the TOC, the layer 
will be selected and its name will appear as current layer in the drop-down text 
box of the toolbar.

3.1.4 Properties of a view in gvSIG

To access the properties window of a view, go to the “View” menu and select 
“Properties”.

The properties you wish your view to have can be configured via the following 
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window.

If you click on the “Current projection” button, a new window will  appear in 
which the view’s datum, projection and time zone can be selected.
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If you click on the pull-down menus, the different options available for each 
element in the reference system are shown. If you make any changes, click on 
“Apply” and then “Ok”.

When you have configured the view’s properties, click on “Ok”.

3.2 Maps

3.2.1 Introduction 

“Map” type documents allow you to design and combine all the elements you 
wish to have on a printed map.

3.2.2 Accessing maps

You can access “Map” type documents via gvSIG's "Project manager".

Click on “New” to create a new map. When you have created the document (it 
will  appear by default as “Untitled– 0”), you will  be able to insert elements, 
rename the map, delete it or access its properties and modify them. When the 
map is open, it will appear in gvSIG as shown below:



gvSIG Desktop

3.2.3 Map properties

You can access the map properties  window from the “Project  manager” by 
clicking on the “Properties” button or from the view by going to the “Map” 
menu and then to “Properties”.
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You can use the properties window to rename the map, change its creation 
date, add an owner and comments. You can select some default characteristics 
by activating the corresponding check boxes:

• Active grid: Activating the grid means that any element inserted in the 
map will be adjusted to the grid. Remember the following two points if 
you enable “Active grid”:

1. The  horizontal  and  vertical  grid  spacing  defines  the  distance 
between the different points which make up the grid. This can be 
modified by inserting new values in the text boxes. 

2. Output size of the chosen document (A2, A3, A4,...). The zoom tools 
may need to be used to be able to view the grid when you open the 
document. 

• Visualise grid: If this box is disabled, the grid will not be viewed when 
you open the newly created document. 

• Enable ruler: By enabling this check box a ruler appears which can be 
used as a drawing aid. 

• Editable: If you do not enable this option, the objects that make up the 
map will be blocked, thus preventing modifications. 

3.3 Copying layers in gvSIG

You can also use gvSIG to copy documents and create copies of the layers you 
are working with in your view. Firstly, select the layer in the ToC and right click 
on it. A new menu appears. Select the “Copy” option.
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You can paste the layer you wish to copy in the same view as the one you are 
working with or in a different view, either in the same project or in a different 
one.

N.B.: Remember that currently if you modify the layer, these changes will be 
reflected in all the copies.

If you wish to “Paste” the layer, right click on the point you wish to paste the 
new copy and select the “Paste” option.

N.B.: You can use this method when working with layer groups.

If you create a layer group, place the mouse pointer over the group name and 
go to the “Copy” option, you can “Paste” the whole layer group in the same 
way as you would with an individual layer.
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3.4 Deleting layers

To permanently remove the active layers from the view, right click on the layer 
in the ToC and select the “Delete layer” option.

A confirmation dialogue appears.
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3.5 Exporting to image

This option allows you to convert the active view into an image or raster file.

Select the “View” menu then go to “Export/Image”.

When you have selected the tool, a new window appears which you can use to 
edit the name of the image to be saved and the type of file (jpg, png...) you 
wish to save it in.
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When you have saved the image, you can recover it from gvSIG by going to the 
“Add layer” tool and searching for a “gvSIG Image Driver” file type.

Use the ToC to check that the exported image is a raster layer by accessing its 
properties  (right  click  on  the  layer  in  the  ToC  and  then  go  to  “Raster 
properties”).
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4 Viewing and accessing data

4.1 Layer data source

Different types of cartographic information can be added to a view. Vector and 
raster files can be loaded. Each of these groups can contain a wide range of 
formats.

GIS data: The standard GIS format is the shape, which stores both spatial data 
and their attributes. A shape (also called “Shape file”) is actually three or more 
files with the same name and different extensions (even though in gvSIG it is 
handled as one file):

dbf: Table of attributes.

shp: Spatial data.

shx: Spatial data index.

From version 0.5 onwards, gvSIG also has the capacity to access the MySQL 
Spatial and PostGIS spatial data bases via a new driver which uses JDBC.

CAD data: These  are  vector  drawing  files  which  support  the  dxf  and  dgn 
formats. The CAD files may contain information on points, lines, polygons and 
texts. From version 0.4 onwards, gvSIG also allows access to the information 
contained in Autodesk’s 2000 dwg files.

WMS data (Web Mapping Service): gvSIG can be used to  consult  WMS 
data, i.e. data available on the web. WFS data (Web Feature Service): From 
version 0.5 onwards, gvSIG can be used to download WFS vector layers from 
servers that comply with the Open Geospatial Consortium (OGC) Standard.

WCS data (Web Coverage Service): From version 0.4 onwards, gvSIG allows 
access to remote information based on the OGC’s WCS protocol.

GML (Geography  Markup  Language): From  version  1.0  onwards,  gvSIG 
allows  GML  documents  to  be  displayed  and  exported.  Geography  Markup 
Language  (GML)  is  an  XML  format  to  transport  and  store  geographic 
information  whose  design  is  based  on  specifications  produced  by  the  OGC 
group.

Images: gvSIG can display different raster images (tiff, jpg, ecw, mrsid, etc.). 
From version 0.4 onwards, gvSIG can save images which have been modified in 
these formats.

From version 0.5 onwards, “colour palette” (GIFs, 8-bit PNGs, etc.) raster files 
can be opened and raster files without  georeferencing can also be opened. 
Moreover, this new version supports GIF, BMP y JPEG2000 formats.
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4.2 Consulting tools

4.2.1 Information tool

You can access the information tool via the following button in the tool bar

or by going to the “View” menu bar, to “Query” and then to “Information”.

The “Information Tool” is used to obtain information about the map elements.

When  you  click  on  an  element  using  this  tool,  gvSIG  shows  the  selected 
element’s attributes in a dialogue window. However, the layer of the element 
you wish to identify must previously be activated.

4.2.2 Quick info tool

In gvSIG, this tool is used to quickly display available information when working 
with a view containing visible vector layers (including WFS layers, which are 
vector layers).

 Quick Info is enabled if vector layers are visible in the current view.

 Quick Info is disabled if no vector layers are visible in the current view.

With this tool  you can select fields from vector layers visible in the current 
view. Information from these fields is displayed as you move the mouse cursor 
over the view. The tool works in combination with any other tools selected for 
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the view.

You can access the Quick Info tool in two ways:

1. Via the menu: View → Query → Quick Info 
2. Via the icon on the toolbar. 

When the tool is selected a progress bar is displayed which shows the layers 
being loaded:

Progress bar for loading information

If there were no problems loading the information the Quick info field selection 
dialog is shown:
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Dialog for the selection of fields

1. Drop-down list for selecting vector layers. Lists the layers in the order 
that they appear in the TOC of the active view. The following information 
is shown: 

Level of the Layer in the TOC: displays icons and grouping nodes  containing 
the layer. The last icon always represents the vector layer.

Name of the layer.

Type of geometry of  the layer:  five types of geometry layer are supported: 
point, line, polygon, multipoint, and multi (the latter may contain any of the 
above).

2. List of Fields. Contains three columns:
• Selection box (checkbox): indicates whether or not to display the 

field information. 
• Field Type + Field Name: the field type is represented by an icon as 

shown in the following table:
•  The field type is simple. 
• The field type is complex. 
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• Type of field: according to the SQL types. 
3. Calculated fields. List of checkboxes to select which geometry fields to 

calculate. These vary depending on the geometry of the layer:
• Point layer: point coordinates. 
• Line layer: length of the line. 
• Polygon layer: perimeter and area of the polygon. 
• Multipoint layer: number of points. 
• Multi-geometry layer: any of the above; the information will  vary 

according to the selection and the nature of the geometry. 

 The units of length and area are displayed using the measurement units 
of the View.

4. Selecting / de-selecting all the fields in the layer. Select or de-select all 
the fields in the layer. 

5. Sort fields. Sort fields alphabetically in ascending or descending order, or 
according to the internal order of the layer (default). 

After selecting the fields, click Ok to enable the tool in the current view. The 
Quick info tool works in combination with Quick info tools for other Views. Thus, 
when enabled, it combines with each active View to display information. The 
tool settings can be changed for each View and are linked to that View.

As the cursor  is  moved over  the  geometry  of  a  layer,  the information  box 
showing the information is displayed and/or updated. This box disappears when 
the cursor no longer "points" to any geometry of the layer.
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Example showing the display from the Quick info tool

If  there is  more than one geometry  adjacent  to  the point  indicated by the 
cursor then information is displayed about all of them, as distinguished by the 
unique internal identifier of the geometry.

Thus, the information is provided in the following order:

• Name of the layer. 
• Information on the geometry (for each one): 

• ID: unique identifier of the geometry in the data source layer (optional, 
only visible if you have information on more than one geometry).

• Selected fields: those fields selected to display layer information.

• Optional fields: those calculated fields selected from the geometries of 
the layer.

 It should be noted that currently gvSIG adds the area and 
perimeter of islands to the geometry containing them.

4.2.3 Measuring areas

You can access this tool via the following button  or by going to the “View” 
menu and then to “Query” and “Measure area”.

This tool works in much the same way as “Measure distances”. Click on the 
point  that  represents  the  first  polygon  vertex  that  defines  the  area  to  be 
measured. Move the mouse and click on each new vertex until you reach the 
last one, then double click so that the application knows there are no more.

The calculation for the measured area appears at the bottom right of the view 
window.
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4.2.4 Measuring distances

This tool provides information about the distance between two points. You can 
also access the tool  by going to the “View” menu,  to “Query” and then to 
“Measure distances”.

Firstly,  make  sure  you  have  correctly  defined  the  units  of  measurement 
(metres by default).

Remember that the units can be defined in the “Project manager” in the view 
properties or from the “View” menu and the “Properties” when working in a 
view.

You can use the measure distance tool by clicking on the mouse at the source 
point and dragging it to the destination point.

You can take as many measurements as you like. Double click on the last one 
to finish.

The calculation for the measured distance appears at the bottom of the view 
window. Both the distance of the last measured segment and the total distance 
are shown.

4.2.5 Catalogue. Searching for geodata

4.2.5.1 Introduction

The catalogue service allows you to search for geographic information on the 
Internet. gvSIG offers a user-friendly interface which allows you to find geodata 
and load it in the view, as long as the nature of the data allows this.

4.2.5.2 Connecting to a server

Before you can carry out a search, you will  need to connect to a catalogue 
server. To access the wizard, you will first need to open a view and then click 
on the following button:
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The first  window of  the  catalogue opens.  Input  the required  parameters  to 
connect to a server. These include:

• The server address. 
• The server protocol, which in the case of the catalogue can be:

• Z39.50: General information retrieval protocol. 
• SRU/SRW: Variant of Z39.50. 
• CSW:  Catalogue  protocol  defined  by  the  OGC in  the  “Catalogue 

Interface 2.0” specification. 
• Data base name: You only need to indicate the data base you wish to 

connect to in the case of z39.50. If no value is input you will connect to 
the default data base. 

Then click on the “Connect” button. If the connection is made and the server 
supports the specified protocol, a new window will appear to start the search.

4.2.5.3 Searching

To carry out a search, you need to fill in the fields that appear in the following 
form.

Click on the button and the window will drop down to show more fields which 
will allow you to carry out an advanced search. The fields you can search in are 
set by the server. This means that some of the search fields in this form may 
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have no effect in some servers.

If you change the view zoom, the new coordinates will be reflected in this form. 
If  you wish to restrict  the search area enable the corresponding check box. 
Then click on “Search” and wait for the search to be carried out.

4.2.5.4 Viewing the results

If the search has been successful, a new window containing the search results 
will open.

Use the “Previous” and “Next” buttons to see each of the results obtained.
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The  left-hand  side  of  the  window  shows  information  about  the  metadata 
obtained.  If  you  wish  to  see  all  the  information,  click  on  the  "Description" 
button.

You  will  also  be  able  to  see  a  miniature  image  at  all  times,  metadata 
permitting.

If the metadata has any geodata associated to it, the “Add layer” button will be 
enabled.

gvSIG can currently recognise different types of associated resources, such as 
WMS, WCS, Postgis tables and web pages.

If you click on this button, a new window will be opened and will show all the 
resources the application has been able to find.

If  you  click  on  a  WMS,  WCS  or  Postgis  type  resource,  the  new  layer  will 
automatically be loaded in gvSIG. If the resource is a web page, for example, 
the operating system’s default browser.
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4.2.6 Gazetteer

4.2.6.1 Introduction

A gazetteer is a data set in which a link is established between a toponym and 
its geographic coordinates.

gvSIG has a  catalogue client  which allows you to search by toponyms and 
centre the view on a specific point.

4.2.6.2 Connecting to a server

Create a view first and open it. The following button will appear automatically 
in the gvSIG tool bar.

Click on the button.  A wizard opens to help you to carry out a search. The 
parameters to be input are:

• The server address. 
• The server protocol, which in the case of the gazetteer can be:

• WFS-G: Toponym search protocol defined by the OGC. 
• WFS: Although this protocol was created with a different purpose 

in mind, it can be used for a toponym search, as long as it has a 
text attribute in one of the tables. This protocol also allows you to 
carry out a “Feature” search in any other field, but not necessarily 
a text attribute. 

• ADL: Protocol specified by the Alexandria Digital Library. 
• IDEC/SOAP: Protocol  that  uses  the  Catalonian  Cartographic 

Institute (ICC) gazetteer web service. 

July 2011 Page 72 of 655



When you have input all the parameters, click on the "Connect" button and 
wait  until  the  server  is  found  and  accepts  the  specified  protocol.  If  it  is 
accepted,  a  new  window  will  appear  to  start  the  search.  If  not,  an  error 
message will appear.

4.2.6.3 Searching

To carry out a search, you will  need to fill  in the criteria that appear in the 
following  form.  You  can  see  the  simplified  form or  carry  out  an  advanced 
search by clicking on the button in the top right hand corner. This drops down 
the window.
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If you change the view zoom, the new coordinates will be reflected in this form. 
If you wish to restrict the search area activate the corresponding check box. 
There are also three options in the “Aspect set up” box which you can use to 
set up the search view:

Zoom to search: This puts the toponym found in the centre of the gvSIG view.

Delete old searches: This deletes all the texts found in the previous searches 
from the view.

Draw result: This draws a point and a text label in the place the resulting 
toponym has been found.

When you have filled in all the fields in the form, click on “Search” and wait for 
the search to be carried out.
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4.2.6.4 Viewing the results 

A new window containing the search results will open. Use the “Previous” and 
“Next” buttons to move through the different pages of results.

Finally, select the toponym required and click on “Localise”. The gvSIG view 
will centre on the point the toponym is located in.

4.2.7 Advanced hyperlink

The Advanced Hyperlink tool in this version of gvSIG significantly extends the 
functionality of the hyperlink tool found in version 1.1.

The  tool  is  accessible  either  from  the  Layer  menu  (Layer  >  Advanced 
Hyperlink) or by clicking the icon on the toolbar.

Accessing the Hyperlink tool

Hyperlinks are configured at the layer level,  which means that they can be 
enabled or disabled per layer. To set the hyperlink for a layer, double-click on 
the  layer  name  in  the  TOC  to  open  the  Layer  Properties  and  select  the 
Hyperlink tab.

The hyperlink configuration screen looks like this:
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Hyperlink Configuration

Remember that the layer's attribute table must be correctly prepared for the 
hyperlinks to work. To do this, edit the relevant record and insert the path to 
the hyperlinked file, leaving out the extension.

After  the  hyperlinks  have  been  setup  and  enabled,  select  the  Advanced 
Hyperlink tool and find the item in the View that corresponds to the record 
associated with the link. Click on the item and a window will open displaying 
the linked file.

Actions

The Advanced Hyperlink tool provides the following actions:

1. Link to text and HTML files: the tool will open a window in gvSIG and load 
the linked text or HTML document into it. 

2. Link to image files: the tool will  open a window in gvSIG and load the 
linked image into it. 

3. Link to PDF files: the tool will open a window in gvSIG and load the linked 
PDF document into it. 

4. Load raster layer: the tool loads the raster layer into the active View. 
5. Load vector layer: the tool loads the vector layer into the active View. 
6. Link to SVG files: the tool will open a window in gvSIG and load the linked 

SVG file into it. 
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NOTE 1: When editing  the hyperlink  fields  in  the attribute  table,  if  a  path 
longer than the maximum field length is entered, the path will be truncated 
(without warning) to the maximum field length. By default, fields are created 
with a maximum length of 50 characters. Fields should be defined to handle 
long paths when necessary, otherwise only very short paths can be stored.

For example: if we enter

C:/Documents and Settings/My documents/images/villafafila.jpg

and the maximum field length is 50 characters, the path will be truncated to:

C:/Documents and Settings/My documents/images/vill

which is not what is wanted.

NOTE 2: Please  note  that  if  the  path  you  enter  contains  an image or  file 
extension that is registered in the registry, you should not also enter it when 
configuring  the  hyperlink  properties  as  this  would  be  duplicating  the 
information.

4.3 Navigation tools

4.3.1 Navigating around / Exploring the view

4.3.1.1 Introduction

There are several tools you can use to navigate around the map. These are 
basically zooms and panning.

4.3.1.2 Zooms and panning

You  can  activate  these  tools  by  clicking  on  the  "View”  menu and  then  on 
“Navigation".
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or by using the button bar which is quicker. Zoom in: Enlarges a particular area 
of the view.

Zoom out: Reduces a particular area of the view.

Previous zoom: Goes back to the previous zoom used.

Full extent: Full zoom of the total area included in all the layers of the view.

Panning: This allows you to change the view zoom by dragging the viewing 
field all over the view with the mouse. Click and hold down the left button of 
the mouse then move the mouse in the direction you require.

Zoom to selection: Full zoom of the total area of all the selected elements.
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Zoom to layer: To zoom to the layer, right click on the selected layer in the 
ToC, or click on the “Zoom to layer” option in the contextual menu.

4.3.1.3 Zoom manager

You  can access  the  “Zoom manager”  from the tool  bar  by  clicking  on  the 
following button:

or from the “View” menu, then “Navigation” and “Zoom manager”.

By clicking on the “Zoom manager” you can save a zoom so that you can go 
back to it at a later stage.

This tool can be used to name the current zoom of the view with the text bar 
which appears in the window.

Click on “Save” and the zoom currently in the view will automatically be added 
to the “Zoom manager” text box.

You can create and save as many zooms as you wish. Use the "Select” and 
“Delete” buttons to manage your working areas.
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4.3.2 Configuring the locator map

The locator is a general map which is displayed in the bottom left hand corner 
of the view's window. It is used to show the working area (main window zoom). 
Click on “View” in the menu bar and select “Configure locator map”.
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A window appears in which we can add layers (we can add the same types of 
layers as in the view) which will make up part of the locator map. This window 
can also be used to remove layers or edit the layers’ legends.

When you click on the “Add layer” button, the following window appears



gvSIG Desktop

This new function allows the layer loaded in the locator map to be reprojected. 
To  do this,  click  on the button  next  to  “Current  projection  when you have 
selected the layer you wish to load in the locator map.
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In the following window, select the reference system you wish the layer to have 
in the locator map and click on “Finish” for the changes to take effect.
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4.3.3 Centring the view on a point

This tool  allows you to locate a point in the view by its coordinates and to 
centre the view on this point.

You can also access the tool by going to the “View” menu then to “Centre view 
on a point”.

When you have accessed the tool, a dialogue box will appear in which you can 
input the required coordinates and select the point colour.
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When you click on the "Ok" button,  the view centres on this point  and the 
information window that corresponds to this point appears.

4.3.4 Locate by attribute

This tool allows you to zoom in on areas of a layer by specifying the value of a 
particular attribute. You can access this tool by clicking on the button

or by going to the “View” menu then to “Locate by attribute”.
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When the tool is selected, the following window appears

You will find all the layers loaded in the ToC in the “Layer” pull down menu. The 
fields associated with the chosen layer are included in the “Field” pull down 
menu.

The data included in the selected field appears in the "Value" pull down menu.

If you mark the “Open with the view” check box and decide to close the view, 
the “Locate by attribute” window will appear the next time you open the view.

When you have made the selection, click on the "Zoom" button and the chosen 
area will be shown in the view.
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4.4 Load data

4.4.1 Geographical data

4.4.1.1 Introduction

Firstly, open a “View” document in gvSIG.

You can access this  option  by going to the "View" menu and then to "Add 
layer" or by using the “Control + O” key combination

or by clicking on the "Add layer" button in the tool bar.



gvSIG Desktop

A window  appears  in  which  you  can  select  and  configure  the  layer's  data 
source by its type:

4.4.1.2 Vector

4.4.1.2.1 Adding a layer from a disk file

4.4.1.2.2 Introduction

Click on the "Add" button
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4.4.1.2.3 Selecting layers

The "Add” dialogue window allows you to move around the file system to select 
the layer to be loaded. Remember that only the files of the type selected will 
be shown. To indicate the type of file to be loaded, select a file from the “Files 
of type” pull down menu.



gvSIG Desktop

If several layers are loaded at the same time, the order in which the themes 
will be added to the view can be specified with the "Up" and "Down" buttons in 
the “Add layer" dialogue.

4.4.1.2.4 Adding a layer using the WFS protocol 

4.4.1.2.5 Introduction

The  Web  Feature  Service  (WFS)  is  one  of  the  OGC  standards 
(http://www.opengeospatial.org) which is included in the list of standards (of 
this type) that gvSIG supports.

WFS is a communication protocol via which gvSIG retrieves a vector layer in 
GML  format  from a  supporting  server.  gvSIG  retrieves  the  geometries  and 
attributes associated to each "Feature” and interprets the contents of the file.

4.4.1.2.6 Connecting to the server

Go to the “Add layer” and then select the WFS tab.
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1. The pull-down menu shows a list of WFS servers (you can add a different 
server if you don’t find the one you want).

2. Click on “Connect”. gvSIG connects to the server.

3. and 4. When the connection is made, a welcome message from the server 
appears, if this has been configured. If no welcome message appears, you can 
check whether you have successfully  connected to the server if  the “Next” 
button is enabled.

5. The WFS version number that the server you have connected to is using is 
shown at the bottom of the box.

N.B. You  can  select  the  “Refresh  cache”  option  which  will  search  for 
information from the server in the local host. This will only work if the same 
server was used on a previous occasion.

4.4.1.2.7 Accessing the service

Click on “Next” to start configuring the new WFS layer.

When you have accessed the service, a new group of tabs appears. The first 
tab (“Information”) shows all the information about the server and about the 
request  that  is  to  be  sent.  This  information  is  updated as  more  layers  are 
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selected.

4.4.1.2.8 Selecting 'Layers' 

The “Layers” tab can be used to select the layer you wish to load.  A two-
column table  appears  in  which  the layer name and the geometry type are 
shown. As the geometry type is obtained by clicking on the layer (it needs to 
be obtained from the server), this column is completely blank at the start.

The “Show layer names” option shows the name of the layer as it is recognised 

July 2011 Page 92 of 655



by the server and not by its description, which is what appears in the table by 
default.

4.4.1.2.9 Selecting 'Attributes'

The “Attributes” tab allows the fields (or attributes) of the selected layer to be 
selected. When the layer is loaded, only the fields that have been selected are 
retrieved.

To select the attributes, enable the check box which appears to their left.
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4.4.1.2.10 'Options' tab

The  "Options”  tab  shows  information  about  user  authentication  and  the 
connection. The “User” and “Password” fields are used in the WFS-T to be able 
to identify a user in the server so that writing operations can be carried out 
(not yet implemented).

The connection parameters are:

Number of features in the buffer, i.e. the maximum number of elements that 
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can be downloaded.

Timeout. This is the length of time beyond which the connection is rejected as 
it  is considered to be incorrect.  If  these parameters are very low, a correct 
request may not obtain a response.

The Spatial Reference System (SRS) is another important parameter. Although 
this cannot currently be changed, it is hoped that this will be possible in the 
future. In any case, gvSIG reprojects the loaded layer to the spatial system in 
the view.

4.4.1.2.11 Filter

You can use this tab to apply filters to your WFS layers. Click on the “Filters” 
tab in the window.
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The “Fields” text box shows the layer’s attributes which can be used as a filter. 
Click on the selected field to see its values.

When the layer is loaded for the first time, the values in the column cannot be 
selected. However, if you have a filter sentence for the layer you can apply it in 
the filter text area and the filtered layer will be loaded directly.

If you do not have a filter sentence, load the WFS layer into the ToC, then right 
click on the mouse and select the “WFS properties” option from the contextual 
menu.
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To create the filter for the WFS layer, double click on the field you wish to use 
as a filter and it will appear in the bottom text area. Then click on the operator 
you wish to apply and finally select the value in the “Values” text area by 
double clicking on it.
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When you have created the required filter, click on “Ok” and it will be applied 
to the WFS layer.

4.4.1.2.12 Adding the layer to the view

When all the parameters have been configured, click on “Ok”. The layer will be 
loaded into a gvSIG view.

4.4.1.2.13 Modifying the layer's properties

By  right  clicking  on  the  layer,  its  contextual  menu  appears.  If  the  “WFS 
Properties” option  is  selected,  an option  display opens (similar  to the “Add 
layer” display). This can be used to select new attributes and other layers and 
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change the layer’s properties.

4.4.1.2.14 Filtered by area

In gvSIG 1.9 a new 'Area' tab was added which allows the user to filter the 
requested WFS layer geometries according to a bounding box. The user enters 
the coordinates of the required display area so as to optimize access to the 
data layers and to save time when viewing them.
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Loading a WFS layer - The Area tab

4.4.1.2.15 Adding a layer using the ArcIMS vector protocol

4.4.1.2.16 Introduction to ArcIMS

In the proprietary software environment, ArcIMS (developed by Environmental 
Sciences  Research Systems,  ESRI)  is  probably  the  most  widespread/popular 
widely  used  (Internet)  cartographic  server  on  the  Internet  thanks  to  the 
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number of clients it supports (HTML, Java, ActiveX controls, ColdFusion...) and 
to its integration with other ESRI products. ArcIMS is currently one of the most 
important remote cartographic information providers. Although the protocol it 
uses does not comply with the Open Geospatial Consortium (because it was 
created long beforehand), the gvSIG team believes that offering support for 
ArcIMS is important.

4.4.1.2.17 Connecting to image services

The extension can access image services offered by an ArcIMS server.  This 
means that, just like a WMS server, gvSIG can request a series of layers from a 
remote  server  and  receive  a  view  rendered  by  the  server  containing  the 
requested layers in a specific coordinate system (reprojecting if necessary) and 
in specific  dimensions.  In  addition to displaying geographic  information,  the 
extension allows you to request information about the layers for a particular 
point via the gvSIG standard information button.

ArcIMS is slightly different in its philosophy from WMS. In WMS, the request is 
normally made by independent layers whilst in ArcIMS the request is global.

The steps required to request a layer from an ArcIMS server and to request 
information for a particular point are listed below.

4.4.1.2.18 Add layer using the arcIMS protocol 

Our  example  uses  the  ESRI  ArcIMS  server.  Its  URL  is 
http://www.geographynetwork.com. This is the address a web browser requires 
to access the HTML visual display unit.

Before  loading  a  layer  from  this  server,  the  datum  WGS84  in  geodesic 
coordinates  (code  4326)  has  to  be  set  up  previously  as  the  view’s  spatial 
system.

4.4.1.2.19 Connecting to the server

If the extension is loaded correctly, a new ArcIMS data source will appear in the 
“Add layer” dialogue box.

http://www.geographynetwork.com/
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Adding a new layer to the view

If the server has a standard configuration, simply indicate its address. gvSIG 
will try to find the servlet’s full address.1 If the servlet has a different path, you 
will have to write it into the dialogue box.

When  the  connection  has  successfully  been  made,  the  server  version,  its 
compilation number and a list of image and geometry services available are 
shown.

The service can be selected from the list or can be written in directly.

Finally, if the “Override service list” check box is enabled, gvSIG will delete any 
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catalogue that has already been downloaded and will request them again from 
the server.

List of services available

4.4.1.2.20 Accessing the service

The next step is to select the ImageServer type service required by double 
clicking or selecting it and clicking on "Next". The dialogue box changes and an 
interface  with  two  tabs  appears  (fig.  3).  The  first  tab  shows  the 
metainformation given by the server about the service’s geographic limits, the 
acronym of the language it has been written in, units of measurement, etc. It is 
a good idea to find out if a coordinate system has been defined in the service 
(using EPSG codes) as this can directly  influence the requests made to the 
server, as Figure 3 shows.

N.B. If no coordinate system has been defined in the service, the extension will  
assume that it is the same coordinate system as the one we have defined for 
the view.
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Figure 3: Metadata from the ArcIMS server

We can continue by clicking on "Next" or return to the previous dialogue by 
clicking on "Change service”.

4.4.1.2.21 Selecting layers

The last  dialogue box is the layer selection.  We can define a name for  the 
gvSIG layer or leave the default value (the service name) in this window. A box 
appears below with a list of the service layers in tree form. When the mouse is 
moved  over  the  layers,  information  about  these  layers  appears:  extension, 
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scale ranges, type of layer (raster or vector image) and if it is visible by default 
in the service (fig. 4).

Figure 4: Metadata from a service layer

We can view each layer’s ID via the “Show layer ID” check box. This check box 
is useful when there are layers whose descriptor is repeated. Therefore, the 
only way to distinguish between them is via an ID, which will always be unique. 
A combo box is also available to select the image format we wish to use to 
download the images.  We can choose JPG format if  our  service works  with 
raster images or one of the other remaining formats if we want the service to 
have a transparent background.

N.B. The transparency in 24-bit PNG images is not correctly displayed in gvSIG 
0.6. This type of files will be supported in gvSIG 1.0.

The box with the layers selected for the service appears below. If you wish, you 
can add just some of the service layers and also reorganise them. This makes 
the service view totally personalised.

N.B. The configuration cannot be accepted until a layer has been added.

N.B. Multiple selections of service layers can be made by using the Control and 
CAPS keys.
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4.4.1.2.22 Adding the layer to the view

When the “Ok” button in the dialogue box is pressed, a new layer appears in 
the view (fig. 5). If no layer has been added previously, the extension of the 
ArcIMS layer is shown, as per the standard gvSIG procedure.

Figure 5: ArcIMS layer added to the gvSIG view.

It must be remembered that when the layer extension is shown, the layers that 
make up the chosen configuration may not appear and a blank or transparent 
image appears instead. If this occurs, use the scale control dialogue box (V. 
Information about scale limits section).

July 2011 Page 106 of 655



4.4.1.2.23 Points to remember about spatial reference systems

An ArcIMS server does not define the spatial reference systems it supports as 
opposed to the WMS specification. This means that a priori we do not have a 
list  of  EPSG codes that  the map server can reproject.  In  short,  ArcIMS can 
reproject to any coordinate system and leaves the responsibility of how the 
projections are used to the client.

Therefore, if our gvSIG view is defined in ED50 UTM zone 30 (EPSG:23030) and 
we request a global coverage service (stored for example in the geographic 
coordinates WGS84, which correspond to code 4326) the server will not be able 
to reproject  the data correctly  because we are using global  coverage for  a 
projection of a specific area of the Earth.

However, the procedure can be carried out in reverse. If we have a view in 
geographic  coordinates  (and thus  global  coverage),  services  defined in  any 
coordinate  system  can  be  requested  because  the  server  will  be  able  to 
transform the coordinates correctly.

In short, requests to the ArcIMS server must be made in the view's coordinate 
system and they cannot be requested in another coordinated system.

Moreover,  as  we  mentioned  above,  if  an  ArcIMS  server  does  not  offer 
information  about  the  coordinate  system  its  data  is  in,  the  user  will  be 
responsible  for setting up the correct coordinate system in the gvSIG view. 
Thus,  if  a  user  with  a  view  in  UTM  adds  a  layer  which  is  in  geographic 
coordinates  (even though the server  does  not  show it),  the service  will  be 
added correctly but will take the view to the geographic coordinates domain (in 
sexagesimal degrees).

An additional effect is that if the view uses different units of measurement from 
the server, the scale will not be shown correctly.

4.4.1.2.24 Modifying the layer's properties

The layers requested from the server can be modified via a dialogue box, which 
can be accessed from the layer’s contextual menu (fig. 6) just like the WMS 
layers. This dialogue box is similar to the box used to load the layer, apart from 
the fact that the service cannot be changed.
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Figure 6: Properties of the ArcIMS layer

4.4.1.2.25 Information about scale limits 

The extension allows us to consult the layers' scale limits which make up the 
requested service via  a dialogue box which can be maintained in  the view 
during the session (fig. 7). This window shows the layers on the vertical axis 
and the different scale denominators on the horizontal axis via a logarithmic 
scale.  This  box  is  small  on  screen  but  can  be  enlarged  to  improve  the 
difference between the scales.

The vector layers, raster layers and the layers that can be seen on the current 
scale (marked with a vertical line) in a darker colour and the layers we cannot 
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see above or below the current scale are differentiated by different coloured 
bars (described in the window legend).

Figure 7: Scale limits status

4.4.1.2.26 Attribute information requests

Attribute information requests about the elements for a particular point is one 
of gvSIG’s standard tools. Its functionality is also supported by the extension.

The WMS specification allows information about several layers to be requested 
from the server in one single query. This is different in ArcIMS. We need to 
make one server request per layer required.

This means that no requests for unloaded layers or unseen layers that are not 
visible on the current scale or layers whose extension is outside the view will 
be made. Even if all these layers are filtered, the information request usually 
takes longer than is desirable because of this intrinsic feature of ArcIMS.

When  all  the  request  responses  have  been  recovered,  the  standard  gvSIG 
attribute information dialogue appears with each of the layers (LAYER) which 
return information as a tree. If we click on a layer, its name and ID appear on 
the right (fig. 8).

Under  this  node,  if  we are  talking  about  a  vector  layer,  all  the  records  or 
geometric elements the server has responded to appear, and give each one 
their corresponding attributes (FIELDS).

If it is a raster layer, such as an orthoimage or a digital terrain model, it returns 
the values for each of the bands (BAND) in the requested pixel colour, instead 
of records.
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Figure 8: Displaying attribute information

4.4.1.2.27 Connecting to geometry services

The  extension  allows  access  to  both  ArcIMS  image  services  and  geometry 
services (Feature Services). This means that a server can be connected to and 
geometric entities (points, lines and polygons) and their attributes obtained. 
This is not dissimilar to WFS service access.

However,  the variety of  existing geometry services  is  much lower than the 
variety in the image server. There are two main reasons for this. On one hand, 
providing the public with vector cartography implies security problems because 
many bodies  only  want  to  offer  the  general  public  views  and images.  The 
vector data becomes either an internal product or must be paid for. On the 
other hand, this type of services generate much more traffic on the network 
and in the case of basic information servers could become a problem.

4.4.1.2.28 Adding a geometry layer

Loading a  geometry layer is  practically  the same procedure  as loading the 
image  server  as  mentioned  above  (Accessing  the  service  section  and  the 
following sections). In this case, the number of layers to be selected must be 
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taken into account. If we wish to download all the layers offered by the service 
the response time will be very high.

The only difference between loading an image layer is that in this case we can 
choose whether we wish the layers to be downloaded as a group via a check 
box. This is useful for processing the vector layers as one layer when it needs 
to be moved and activated in the table of contents.

Unlike the image service, in which all the service’s layers appear as one unique 
layer in the gvSIG view, in this case each layer is downloaded separately and 
appears  in  the  view  grouped  under  the  name  defined  in  the  connection 
dialogue.

4.4.1.2.29 ArcIMS symbols

Cartography symbols are configured in the server in one AXL extension file for 
both geometry and image services. We can divide symbol definition into two 
parts.  On  one  hand,  we  can  talk  about  the  definition  of  the  symbols 
themselves, i.e. how a geometric element, such as a line or polygon, should be 
presented.  On  the  other  hand,  we can talk  about  the  distribution  of  these 
symbols  according  to  the cartographic  display scale  or  to  a  specific  theme 
attribute.

In  ArcIMS  terminology  symbols  are  different  from  legends  (SYMBOLS  and 
RENDERERS).

4.4.1.2.30 Symbols

There are various types of symbols: raster fill  symbols, gradient fill symbols, 
simple  line  symbol,  etc.  The extension  adapts  the  majority  of  the  symbols 
generated by ArcIMS. Table 1 shows the ArcIMS symbols and indicates whether 
they are supported by gvSIG.

Label Description Supported

CALLOUTMARKERSYMBOL Balloon-type label NO

CHARTSYMBOL Pie chart symbol NO

GRADIENTFILLSYMBOL Fill in with gradient NO

RASTERFILLSYMBOL Fill with raster pattern YES

RASTERMARKERSYMBOL Point symbol using pictogram YES

RASTERSHIELDSYMBOL Customised point symbol for US roads NO

SIMPLELINESYMBOL Simple line YES

SIMPLEMARKERSYMBOL Point YES

SIMPLEPOLYGONSYMBOL Polygon YES

SHIELDSYMBOL Point symbol for US roads NO

TEXTMARKERSYMBOL Static text symbol NO

TEXTSYMBOL Static text symbol YES

TRUETYPEMARKERSYMBOL Symbol using TrueType font character NO

Table 1: ArcXML symbol definition labels
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In general, the most common symbols have been successfully “transferred”. 
Some of the symbols cannot be obtained directly from gvSIG (at least in the 
current version), such as the raster fill symbol or they need to be “adjusted” 
such as the different types of lines. This means that a raster fill symbol is not a 
symbol that can be defined by the gvSIG user interface, but it can be defined 
by programming.

4.4.1.2.31 Legends

gvSIG supports the most common types of legends: unique value and range 
and value themes as well  as the scale-range control  over the whole  layer. 
ArcIMS  goes  much  further  in  its  configuration.  It  can  generate  much  more 
complicated legends in which symbols can be grouped together, scale-range 
controls can be established for labels and symbols and different labelling based 
on an attribute can be shown (as though it were a value theme for labelling).

This group of legends can generate very complex symbols for a layer in the 
end.  The current  implementation  status  of  the  gvSIG symbols  needs  to  be 
simplified to reach a compromise to recover the symbols that best represent 
the layer as a whole.

Label Description

GROUPRENDERER Legend which groups others together

SCALEDEPENDENTRENDERER Scale dependent legend

SIMPLELABELRENDERER Labelling layer legend

SIMPLERENDERER Unique value layer legend

VALUEMAPRENDERER Value and range themes

VALUEMAPLABELRENDERER Labelling themes

Table 2: ArcXML legend definition labels

When a GROUPRENDERER is found, the symbol ArcIMS draws first is always 
chosen. Thus, in the case of the typical motorway symbol for which a thick red 
line is drawn and a thinner yellow line is drawn over it, gvSIG will only show the 
red line with its specific thickness.

If  a  scale dependent legend is  discovered during a symbol  analysis,  this  is 
always chosen. If more than one is discovered, the one with the greatest detail 
is  chosen.  For  example,  in  ArcIMS  we  can  have  a  layer  with  simple  road 
symbols (only main roads are drawn) on a 1:250000 scale and based on this a 
different theme is shown with all types of roads (paths, tracks, roads, etc.). In 
this case, gvSIG will show this last theme as it is the most detailed.
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If a labelling legend is discovered during a symbol analysis, it will be saved in a 
different place and will  be assigned to the selected definitive legend. In the 
case  of  the  VALUEMAPLABELRENDERER  label,  only  the  legend  of  the  first 
processed value will be obtained as a label symbol. The rest will be rejected.

In  short,  it  is  obvious  that  the  failure  to  adapt  the  legends  for  gvSIG  is  a 
simplification process in which different legend and symbol definitions must be 
rejected to obtain a legend which is similar to the original as far as possible. It 
is to be expected that the gvSIG symbol definition will improve considerably so 
that it can support a larger group of cases in the future.

4.4.1.2.32 Working with the layer

Working with  the  layer  is  similar  to  any other  vector  layer,  as  long  as  we 
remember that access times may be relatively high. The layer attribute table 
can be consulted, in which case the records will be downloaded successively as 
we display them.

If we wish to change the table symbols to show a unique value or range theme 
we must wait as gvSIG requests the complete table for these operations. On 
the other hand, the downloading of attributes is only carried out once per layer 
and session and therefore, this wait only occurs in the first operation.

In general, if our ArcIMS server is in an Intranet, it  will  be relatively fast to 
handle,  but  if  we  wish  to  access  remote  services  we  may  be  faced  with 
considerable response times.

The main feature to bear in mind when working with an ArcIMS vector layer is 
that the geometries available at any given time are only the ones displayed. 
This is because we can connect to huge layers but only the visible geometries 
are downloaded. As far as gvSIG is concerned, the geometries shown on the 
screen  are  the  only  ones  available  and  thus,  if  we  export  the  view  to  a 
shapefile for example, are only a part of the layer.

Finally, we need to remember that to speed up the geometry downloads they 
are simplified to the viewing scale in use at any given time. This drastically 
reduces the amount of information downloaded as only the geometries that 
can actually be "drawn" are displayed in the view.

Loading a geometry  layer is  practically  the same procedure  as  loading the 
image  server  as  mentioned  above  (Accessing  the  service  section  and  the 
following sections). In this case, the number of layers to be selected must be 
taken into account. If we wish to download all the layers offered by the service 
the response time will be very high.

Unlike the image service, in which all the service’s layers appear as one unique 
layer in the gvSIG view, in this case each layer is downloaded separately and 
appear  in  the  view  grouped  under  the  name  defined  in  the  connection 
dialogue.

After a few seconds the layers appear individually but are grouped under a 
layer with the name we have defined for it.

The layer symbols are established at random. A pending feature is to recover 
the service symbols and configure them by default so that gvSIG can display 
the  cartography  as  similarly  as  possible  to  how  it  was  established  by  the 
service administrator.
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4.4.1.2.33 geoDB Extension (database manager)

4.4.1.2.34 Introduction

This extension allows users easy, standardised access to geographic databases 
from different  providers.  At  present,  gvSIG supports  the following  database 
management systems:

Data bases Read Write

PostgreSQL/PostGIS Yes Yes

MySQL Yes No

HSQLDB Yes No

Oracle (SDO Geometry) Yes Yes

gvSIG stores the different connections made during the various sessions. Thus, 
users do not need to input the parameters of every server they connect to. 
Likewise, if a project file is opened which has a database connection, the user 
will only be required to enter the password.

The extension has two user interfaces, one to manage the data sources and 
another to add the layers to the view.

4.4.1.2.35 The spatial connection database manager

Select the menu See – Spatial database connection manager (figure 1) to open 
the dialogue box which allows you to add, remove, connect and disconnect the 
connections  to  the  different  types  of  databases  containing  geographic 
information. If you have already used this manager in an earlier gvSIG session, 
the previous connections will appear (figure 2). If not, the dialogue box will be 
empty.
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Figure 1. Access to the geoDB connection manager

Figure 2. The connection manager

Click on Add to introduce the parameters of a new connection (figure 3). NB: 
From gvSIG version  1.1  onwards,  it  should  be  noted  that  the  name of  the 
database must be written correctly and that it is case sensitive. If you wish to 
open a  project  saved in  a  version prior  to  gvSIG 1.1  which  includes layers 
belonging to a database whose connections  have not taken this  factor  into 
consideration, the data must be recovered by reconnecting to the original data 
base.  You  can  either  connect  there  and  then  or  remain  offline.  Open 
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connections appear with a link and with “[C]” before their name (figure 4). If 
you wish to open a connection, select it and click on Connect. You will be asked 
to enter the password (figure 5) and the connection will then be made.

Figure 3. Adding a new connection
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Figure 4. The connection has been made

Figure 5. Password request

4.4.1.2.36 Adding a geoDB layer to the view

In the Project Manager, create a new view and open it using the New and Open 
buttons. Use the Add layer icon to add a layer to the view. Go to the GeoDB tab 
in the dialogue box to add a new layer of this type (figure 6). You must choose 
a connection (if you select one which is disconnected, you will then be asked to 
enter the password), select one or more tables and the attributes you wish to 
download from each layer and, optionally, set an alphanumeric restriction and 
an area of interest. You can give each layer a different name to that of the 
table. Click on Ok to view the table’s geometries in the view. This window also 
allows you to specify a new connection if the database is not registered in the 
data source catalogue.  Any alphanumeric  restriction  must  be introduced by 
means of a valid SQL expression which is attached as a WHERE clause to each 
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call to the database. Given that the table may take several seconds to load, a 
small icon appears next to the name of the table indicating that this process is 
underway. When the table has been loaded, the small blue icon disappears and 
the gvSIG view is automatically refreshed to allow the geometries to be viewed.

Figure 6. Adding a geoDB layer
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Figure 7. Views with geometries from a geographic database

Figure 8. Mini icon showing layers are loading

4.4.1.2.37 Exporting a gvsig layer to a spatial database

This function allows new tables to be created in the spatial database from any 
vectorial source in gvSIG. These tables can be created as follows:

1. Create a vectorial layer of any type, for instance by opening an SHP file 
using the Add layer button (figure 9). 

2. Select the layer by clicking on its name in the left-hand side of the screen 
(figure 10). 

3. In the Layer – Export to menu, select the type of database you wish to 
export the layer to. The example shows an Oracle database (figure 11). 

4. You will then be asked to introduce the name of the table which will be 
created in the database (Oracle) and whether or not you wish to include 
the newly-created layer in the current view. 

If all goes well, the new vectorial geoDB layer will appear in the view and you 
will be able to work with it in the usual way.
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Figure 9. Adding a vectorial layer
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Figure 10. Selecting the layer to export

Figure 11. Exporting to Oracle Spatial

Figure 12. Export progress bar

4.4.1.2.38 Oracle spatial

4.4.1.2.39 Introduction

These  notes  supplement  the  documentation  for  the  geoDB  extension  with 
regard to the driver for Oracle Spatial.

This driver allows access to any table from an installation of both Oracle Spatial 
and Oracle Locator (in both cases from version 9i onwards) which has a column 
that stores SDO-type geometries.
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4.4.1.2.40 Metadata

The  driver  only  lists  tables  which  have  their  geographic  metadata  in  the 
USER_SDO_GEOM_METADATA view.

Given that each table’s metadata is available, the interface makes use of that 
data  and  automatically  presents  the  column  (or  columns)  of  geometries. 
Likewise, ROWID, which is a unique descriptor for each row used internally by 
Oracle, is used and this ensures that identification is correct.

4.4.1.2.41 Data types

Two and three-dimensional data of the following types are supported:

1. Point and multipoint 
2. Line and multiline 
3. Polygon and multipolygon 
4. Collection 

At  present,  layers  in  LRS  format  (Linear  Referencing  System)  are  not 
supported.

4.4.1.2.42 Coordinate systems in Oracle

Oracle has its own system for cataloguing coordinate and reference systems. 
Miguel  Ángel  Manso,  on behalf  of  the Polytechnic  University  of  Madrid,  has 
provided a list of equivalent values for the Oracle system and the EPSG system 
and this is included in the driver as a DBF file.

Conversions from one coordinate system to another are carried out by gvSIG 
since its performance has proved to be superior.

4.4.1.2.43 Notes on reading geometries

The driver constantly performs geometric requests (in other words constantly 
calculates which geometries intersect with the current gvSIG view) and it  is 
therefore essential that the database has a spatial index linked to the column 
in question.

If this index does not exist, an error window appears (figure 1) and the table or 
view cannot be added to the gvSIG view.

In addition, the driver needs to set a unique identifier for the records of the 
table  or  view,  and this  is  not  possible  for  certain types of  views.  If  such a 
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problem occurs, it will be detected by the driver and an error message will also 
appear (figure 2).

As a result, the view cannot be loaded to gvSIG from the database.

Figure 1. Warning regarding the lack of a spatial index

Figure 2. Warning regarding the fact that a ROWID could not be obtained

4.4.1.2.44 Transferring a layer from gvSIG to Oracle

If you wish to export a layer to an Oracle database, you will also be asked if 
you wish to include the view’s current coordinate system in the table at the 
end of the process described in the manual. This may be useful in cases where 
we  do  not  wish  to  include  such  information  in  the  table  for  reasons  of 
compatibility with other applications or information systems.

To  work  with  two  Oracle  geometries  (the  most  common  case  is  an 
intersection), the two geometries must have the same coordinate system. Each 
geometry has an SRID field which can have the value NULL.

For instance, if we have a table with geometries in EPSG:4326 (Oracle code 
8307) and another with geometries in EPSG:4230 (Oracle code 8223), it will not 
be  possible  to  carry  out  SQL  instructions  to  perform  calculations  directly 
between the geometries of one table and another. However, if these tables’ 
geometries  do  not  have  a  coordinate  system  (i.e.  SRID  is  NULL),  then 
operations can be performed between the geometries of these tables, bearing 
in  mind  the  errors  involved  in  carrying  out  intersections  between  different 
coordinate systems.

When reading a table whose geometries have a coordinate system set at NULL, 
it  is  understood  that  the  user  will  make  sure  that  the  geometries  are 
appropriate for the current view, since no reprojection is possible (this may 
change  with  the  new gvSIG  extension  for  the  advanced  use  of  coordinate 
systems).

In short, not storing the coordinate system allows for a more flexible use of 
geometries.
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4.4.1.2.45 ArcSDE

4.4.1.2.46 Introduction

If  you  have  previously  used  the  connection  manager  in  a  previous  gvSIG 
session, the connections will have been preserved. Otherwise, it will be empty:

Click "add" and a window that allows you to enter new connection parameters 
will  show  up.  Fill  the  data  fields  and  click  "OK".  Note:  In  the  drop-down 
selections of “Driver” select the one that corresponds to "gvSIG SDE driver", as 
shown in the image.

Once the connection is validated, it brings back the "connection manager" with 
the  new  database  in  the  list.  If  in  the  connection  settings  window  the 
"connected"  box  is  left  checked,  the  connection  will  remain  open.  Open 
connections are marked "[C]" before its name.
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If you want to disconnect the connection click on "disconnect" at the bottom of 
the manager.  The connection will  stop at the time, but the parameters will 
remain recorded for future connections. If you want to open a connection that 
is already included in the list for having been previously used, you must select 
it and click "Connect". It will ask for the password again in a window like in the 
following figure represents and the connection will be open.

4.4.1.2.47 Access to the spatial DB connection manager

Choose the menu "View / Spatial BD connection manager" to open the dialogue 
that  lets  you add, remove,  connect  and disconnect connections  to different 
types of databases with geographic information:
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4.4.1.2.48 Adding an ArcSDE layer to the view

Once we have established the connection to the server, we can begin to query 
information from it.

For this we will open a view and press the button "Add layer".

Then select the GeoBD tab.

. In the dropdown list you can select your connection. The button to the right 
side of the box can take you directly to the connection settings window, in case 
you want to add a connection in some other time without having to go through 
the connection manager.

.  Once  the  connection  is  established  you  will  see  a  list  of  the  available 
information that can be added to gvSIG.

.  From this window you can query or create filters (SQL restrictions) before 
adding the information.

. Once you select the information you want, click "OK" and it will upload into 
the view.
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4.4.1.2.49 Adding an Event layer

4.4.1.2.50 Introduction

A new layer can be created from a table in gvSIG by using “Add event layer”.

There are two ways to do this: you can add a table to the project or you can 
work with a table associated with one of the layers in the view in which you are 
working at a particular time.

4.4.1.2.51 Adding an event layer from a table

Firstly,  the  table  needs  to  be  loaded.  To  do  so,  go  to  the  gvSIG  “Project 
manager” and select "Tables" in document types. Then click on "New".
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A search dialogue opens to add the table you require. Click on "Add".

A dialogue box appears in which you can choose two types of data sources: dbf 
and csv.
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When you have found the table you require, select it and click on “Open”.

gvSIG automatically returns to the "New table" window and adds the table you 
require to create the event layer in the text box.
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Click on “Ok” to finish the process.
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When  the  table  has  been  added,  a  view  must  be  active  to  create  its 
corresponding event layer and load it. If no view is active, you can return to the 
“Project manager” and add one or create a new blank one. When you have 
activated this view, go to the “Add event layer” by using the corresponding 
button in the tool bar:

A window with three pull-down menu bars appears.

We can select the table we need to add the new layer from the first pull-down 
menu bar.

Then, we can select the table fields which will become the X and Y values.

If you click on “Ok”, a new points layer will appear based on the coordinates 
contained in the initial table.
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4.4.1.2.52 Adding an event layer from a table associated with a 
layer in the view

If you wish to work with a table associated to the layers in the view, you will 
firstly have to activate the attribute table of this layer. To do so, click on the 
following button in the tool bar:

If you click on “Add event layer”

you will see that the table has been added.

4.4.1.2.53 Coordinate Reference Systems

4.4.1.2.54 Introduction

The jCRS extension intends to bring rigorous CRS handling capacity to gvSIG, 
as well as the incorporation of the standard CRS operations and repositories 
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like, in this version: EPSG, ESRI, IAU2000 and user-defined CRS.

These  added  functions  provide  a  solution  to  the  ED50-ETRS89  transition 
problem,  and  in  accordance  with  the  implementation  of  the  Royal  Decree 
1071/2007, two solutions are integrated that were achieved by the National 
Geographic Institute (IGN):

• Through  the  EPSG,  the  different  official  IGN  achievements  are 
incorporated following the seven-parameter transformation model. 

• Through Proj4, the official IGN grid based transformations with grid files 
in NTv2 format are incorporated. 

Further in this document, the user interface for this extension will be described, 
using the most common cases.

In the description of these cases, there might be an overlap in CRS selection 
methods and dialogs.  To avoid repetitions,  it  was considered convenient  to 
explain a dialog in  detail  the first  time that  it  appears  in  the manual,  and 
therefore users are advised to read the sections in the correct order.

4.4.1.2.55 Create, edit or delete custom Coordinate Reference 
Systems (CRS)

In this latest version of the jCRS extension, users can define a custom CRS. This 
functionality is available through the CRS selection dialog, see figure 14.

Figure 14: Selection of a user-defined CRS

When selecting User CRS as the type of CRS, you can choose from the following 
options:

1. Choose a custom CRS that was previously defined, by selecting 
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it from the table and click on OK. To facilitate the selection 
when there are many user-defined CRS, there are two search 
options to find common CRS: by code and by name. 

2. To find information on the selected CRS, you can click on the 
CRS info button, after which a window with the available 
information will appear. 

3. To edit the selected CRS, click on the Edit button. A dialog with 
different tabs will appear which is similar to the dialog in which 
you can define a new custom CRS. These dialogs will be 
described later on in this document. 

4. To delete the selected CRS, click on the Remove button. 
5. Create a new custom CRS, as described here below. 

To create a new custom CRS, click on the New button in the dialog shown in 
Figure 14, after which the dialog User defined CRS will open (see figure 15) to 
guide you through the process of creating a custom CRS.

This dialog includes three tabs:

• User CRS, where you can choose between three alternatives to create the 
CRS:

• From user definitions. With this option, the user will enter all the 
needed information to create the CRS. When this option is selected, 
the panels in the  Datum and  Coordinate system tabs will  appear 
empty so that the user can fill  them, although some information 
(ellipsoid, prime meridian, …) can be taken from other CRS that are 
included in EPSG. 

• From  an  existing  CRS.  This  option  permits  the  selection  of  an 
existing CRS from EPSG, by clicking on the button with three points, 
load the information in the corresponding panels under the Datum 
and  Coordinate  system tabs,  and  create  the  custom  CRS  by 
modifying this information. 

• From a WKT string. This option is similar to the previous one, but 
here the WKT string is used to load the information of an existing 
CRS  in  the  corresponding  panels  of  the  Datum and  Coordinate 
system tabs. 

• Datum, where you can enter the Datum information associated with the 
CRS. 

• Coordinate  system,  where  the  information  of  the  coordinate  system 
associated with the CRS is filled. 
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Figure 15: Create a new custom CRS

By clicking the button Next you can move from one tab to the next.

In figure 16, the panel of the  Datum tab is shown. In this tab, the following 
information must be filled:

• Information  about  the  CRS to  be  defined  that  will  be  used  in  search 
queries:

• Name. Alphanumeric string to indicate the name of the CRS. 
• Code. Integer number to be assigned to the CRS for indexing in the 

database,  this  must  be  a  unique  number  that  has  not  been 
previously assigned to another custom CRS. 

• Information about the datum associated with the CRS:
• Name of the datum. Alphanumeric string to indicate the name of 

the datum. This  can be selected from an existing EPSG CRS by 
clicking on the button with three points on the right of the text box. 

• Ellipsoid.  Information on the reference surface of  the CRS to  be 
defined. This can be selected from an existing EPSG CRS by clicking 
on the button with three points on the right of the text box for the 
ellipsoid name. The information to be filled is:

• Name of  the  Ellipsoid.  Alphanumeric  string  to  indicate  the 
name of the ellipsoid. 

• Shape  and  dimensions  of  the  ellipsoid.  You  can  choose 
between two options:

• a, inv_f, which refers to the semi-major axis and inverse 
flattening. To define the semi-major axis correctly it is 
necessary to enter the value and corresponding unit. 
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• a,  b,  which  refers  to  the  semi-major  and  semi-minor 
axis of the ellipsoid. This option should be chosen when 
the  reference  surface  is  a  sphere,  in  which  case  the 
values of  both semi-axes are equal  and the resulting 
value  of  the  inverse  flattening  is  infinite.  To  define 
correctly both semi-axes of the ellipsoid, the value and 
corresponding unit must be entered. 

• Meridian. Here, the name of the prime meridian that is used for the 
datum must be filled. You can select the prime meridian from an 
existing EPSG CRS by clicking on the button with three points on 
the  right  of  the  textbox  for  the  meridian  name.  The  following 
information must be filled:

• Name of  the meridian.  Alphanumeric  string  to indicate  the 
prime meridian. 

• Longitude.  Geographic longitude relative to Greenwich.  The 
value and corresponding unit must be filled. 

The default ellipsoid and meridian for user defined CRS are the GRS80 ellipsoid 
and Greenwich meridian.
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Figure 16: Definition of the datum for the CRS

When the datum parameters are defined, the Coordinate system information 
associated with the CRS must be filled in the next tab as shown in figure 17.
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Figure 17: Selection of the coordinate system for the CRS

The following Coordinate system information must be filled:

• Coordinate system: Geographic 2D or Projected. 
• In case of a projected coordinate system, the following must be filled:

• Name of the projection. Alphanumeric string to indicate the name 
of the projection. 

• Projection. One of the available options of the drop-down list must 
be chosen. 

• Projection parameters: Value and unit. The list of parameters will 
change according to the type of cartographic projection. 

To edit a custom CRS that was previously defined (see figure 14), select this 
CRS from the table and click on Edit.

Below in figure 18 the dialog  Definition  of  a new custom CRS is  displayed, 
where the tab User CRS is disabled as well as the CRS code in the Datum tab. 

July 2011 Page 138 of 655



The reason why you can not modify the CRS code is that this code is used for 
the  indexation  of  the  user  database.  The  other  values  for  the  datum are 
editable, as well as the values for the Coordinate system tab (see figure 19).

Figure 18: Editing of the datum values
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Figure 19: Editing of the coordinate system of the CRS

4.4.1.2.56 Select the CRS for a layer

The selection of the CRS for a layer can be done by adding the layer to a view, 
and clicking on the button labelled  Current projection in the  Add layer dialog 
(see figure 12).
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Figure 12: Add layer

Then the dialog  CRS and transformation will  open where you can select the 
CRS for the layer, and, if needed, a transformation to load the layer into the 
view (see figure 13).
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Figure 13: Selection of the CRS for a layer

Compared to the New CRS dialog that was described before, what is new here 
is that the table of used CRS includes a  Transformation column. This column 
facilitates the simultaneous selection of the CRS and the transformation for a 
layer, but only if these have been used before.

The selection of a transformation will be described hereafter.

4.4.1.2.57 Configure the CRS for a View

The CRS for the View must be defined through the dialog View properties which 
can be accessed by clicking on the Properties button in the Project manager of 
gvSIG (see figure 9).
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Figure 9: Project manager of gvSIG

After clicking on the  Current projection button of the  View properties dialog 
(see figure 10), the New CRS dialog will open (see figure 11) which has been 
described in the previous section.

IMPORTANT: Currently it is not possible to re-project an open view, so if you 
change the CRS while the view is open, the results may be erroneous.
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Figure 10: View properties dialog
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Figure 11: Selection of the CRS

4.4.1.2.58 Set the default CRS

This section describes how to set the default CRS for every new View that is 
created in gvSIG.

The default CRS is defined in the  Preferences window of gvSIG which can be 
accessed through the menu (Window->Preferences) or with the corresponding 
button in the toolbar  , see figure 1.
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Figure 1: View Preferences

When clicking on the  Change button, the  New CRS dialog is displayed which 
lets you select the default CRS, see figure 2.
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Figure 2: Select CRS. Recent CRS

In this dialog you can select CRS from five different repositories:

• Recent: This includes the CRS that have been used previously (Figure 2). 
The  list  of  recent  CRS  will  be  available  in  the  current  and  future 
executions of gvSIG and is not linked to a specific project. 

• EPSG:  This  lets  you browse and select CRS from the EPSG (European 
Petroleum Survey Group) database. 

• ESRI: This lets you browse and select CRS from the ESRI database 
• IAU2000:  This  lets  you  browse  and  select  CRS  from  the  IAU2000 

database. 
• User CRS: With this option you can create or select a user-defined CRS. 

When  creating  a  new  user-defined  CRS,  you  can  base  this  CRS  on 
existing CRS from the EPSG database or create it from scratch. 

Below, a brief description of each option is presented.
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Figure 3: EPSG repository

The  selection  of  CRS from the  EPSG database  can  be  done  through  three 
search criteria: through the EPSG code (for example 4230), through the name 
of the CRS (for example ETRS89), or by the area where the CRS is used (for 
example Spain). The two last cases are character string searches, resulting in 
those CRS where the name or area description includes the introduced string.

By clicking on the Info CRS button, you can access detailed information about 
the CRS that is selected in the table at the moment when you click the button, 
see figure 4 and 5:
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Figure 4: Information of the selected CRS

In the information that is shown for the selected CRS, it is important to note the 
Proj4 string (at the bottom). The jCRS library includes CRS operations through 
the Proj4 library (link), where the results will be correct if this string has been 
correctly constructed. This information could be useful for advanced users.

http://trac.osgeo.org/proj/
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Figure 5: Information of the selected CRS, including the proj4 string

This information sheet for selected CRS is available for all repositories included 
in the extension.

The selection of CRS from the IAU2000 and ESRI databases, (see figure 6 and 
7, respectively) can be done by searching on the CRS code or name of the CRS.
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Figure 6: IAU2000 repository

Figure 7: ESRI repository

The User CRS dialog allows for the management of the user database including 
select, edit or delete existing CRS, or create new CRS.
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The  selection  of  existing  user-defined  CRS  (see  figure  8)  can  be  done  by 
searching on the CRS code or the name of the CRS. Since there are normally 
only a few user-defined CRS, all user-defined CRS will appear in the table by 
default when the New CRS dialog is opened or when a search is performed 
without any code or search string.

The  process  of  creating,  editing  and  deleting  of  user-defined  CRS  will  be 
explained in a later section of this manual.

Figure 8: Repository of user-defined CRS

4.4.1.2.59 Transformations

In accordance with ISO 19111, there are two types of operations to relate two 
different CRS: conversion operations and transformation operations:

• Conversion of coordinates is used when the datum of the CRS of the layer 
coincides with the datum of the CRS in the view, in other words, both CRS 
correspond to the same geodetic reference system but are in different 
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coordinate systems. If you choose the CRS of the layer in this case you 
need to select the option No transformation. 

• Transformation is used when the datum of the CRS of the layer does not 
coincide with the datum of the CRS of the view. In this case there are two 
types of coordinate operations:

• The operation involves only a transformation when the coordinate 
system  of  the  CRS  of  the  layer  coincides  with  the  coordinate 
system of the view; in both CRS the positions are expressed in the 
same coordinate system but in a different datum. 

• The  operation  involves  a  transformation  and  a  coordinate 
conversion when both the datum and the coordinate system of the 
CRS of the layer and the CRS of the view are different. 

If a transformation is needed, you must choose the type of transformation for 
the layer in the CRS selection dialog (see Figure 20) and click the Next button 
to continue to the corresponding transformation dialog.

Figure 20: Select the type of transformation

The  transformation  dialog  depends  on  the  type  of  transformation  to  be 
performed:

• EPSG transformation. These are the official 7-parameter transformations 
as  defined  in  the  EPSG  repository.  The  dialog  for  this  type  of 
transformation  shows  a  table  where  all  the  applicable  EPSG 
transformations are listed, with the CRS that was chosen for the layer as 
source CRS, and the CRS of the View as destination CRS (see Figure 21). 
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Figure 21: Transformación EPSG

Keep  in  mind  that  the  transformation  operations  of  this  type  are  always 
between the base CRS (i.e. non-projected CRS), and therefore if the CRS of the 
view or  the CRS of  the layer is  projected,  the corresponding base CRS will 
appear in the fields Source CRS and Destination CRS. Keep also in mind that for 
this type of transformation, the CRS for the View and the CRS for the layer 
must  come  from  the  same  EPSG  repository.  If  they  come  from  different 
repositories, the table will appear empty.

• Manual  transformation.  With  this  option  you  can  define  a  Helmert 
transformation through the introduction of the 7 parameters (see Figure 
22). 
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Figure 22: Manual transformation

• Grid  based  transformation (see  Figure  23).  With  this  option  a 
transformation based on an NTv2 grid file is applied. For this, you must 
choose the NTv2 file  from a list  of  available  files  or  import  it  from a 
location to be specified. Since in the NTv2 file the translations have been 
calculated in a given base CRS, you must indicate here whether the NTv2 
was calculated in the base CRS of the View, or the base CRS of the layer. 

IMPORTANT: The grid file has a specific scope, which can be deduced from the 
file information that is displayed in the processing panel. Transformation is not 
applied beyond this scope, so the re-projection accuracy will be considerably 
lower,  since only the corresponding coordinate system conversion would be 
applied.
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Figure 23: Grid based transformation

• Recent transformations (see Figure 24). With this option, you can select a 
transformation  that  has  been  used  before.  The  list  of  recent 
transformations will be available in the current and future executions of 
gvSIG and is not linked to any specific project.

There are two ways to select a recent transformation. The first way is 
through the CRS selection panel for the layer. There is now an additional 
field in the table to indicate if the selected CRS has been used together 
with  a  transformation  in  any recent  execution  of  the  program.  If  you 
select the CRS and recent transformation, you can do two things:

• Accept the CRS and transformation. 
• Continue the process of selecting the transformation. This 

will be helpful to review the selected transformation, 
because in the next panels the information of the selected 
transformation will be loaded, so that you can still change 
it or select another transformation, in which case in the 
next CRS selection for the layer, a new recent 
transformation will be added with the chosen settings. To 
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access the information of the CRS and the transformation, 
just click on the Info CRS button (see Figure 25). 

Figure 24: Selection of the CRS for the layer and recent transformation
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Figure 25: Information of the CRS for the layer and the selected transformation

The second way to select a recent transformation is through the selection of 
CRS without transformation and then select Recent transformations as the type 
of transformation, after which a panel is displayed where you can choose from 
transformations that were previously defined (see Figure 26).
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Figure 26: Recent transformations

• Composite  transformation.  This  type of  transformation  is  new for  this 
version. The objective of composite transformations is to provide gvSIG 
users  with  the  possibility  to  represent  two CRS with  different  datums 
without  the  transformation  between  those  two  CRS,  but  with  a 
transformation of those two CRS into a third CRS.

The composite transformation can play an important role when you need 
to define two transformations, one that refers to the CRS of the layer and 
the other to the CRS that has been defined for the view.

With this mechanism, you can set the CRS for the layer and the CRS of 
the View through an intermediate CRS that connects the two CRS.

To do this, after selecting the CRS of the layer and setting the type of 
transformation to Compound transformation, you need to:

1. Define the transformation to be applied  to the CRS of  the layer 
(Figure 27) 

2. Define  the  transformation  to  be applied  to  the CRS of  the view 
(Figure 28). 
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Figure 27: Select the transformation for the CRS of the layer
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Figure 28: Select the transformation for the CRS of the view

4.4.1.3 Raster

4.4.1.3.1 Adding a layer from a disk file

4.4.1.3.2 Introduction

Click on the "Add" button



gvSIG Desktop

4.4.1.3.3 Selecting layers

The "Add” dialogue window allows you to move around the file system to select 
the layer to be loaded. Remember that only the files of the type selected will 
be shown. To indicate the type of file to be loaded, select a file from the “Files 
of type” pull down menu.
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If several layers are loaded at the same time, the order in which the themes 
will be added to the view can be specified with the "Up" and "Down" buttons in 
the “Add layer" dialogue.

4.4.1.3.4 Adding a layer using the WMS protocol 

4.4.1.3.5 Connecting to the service

Go to the "Add layer" window and then select the WMS tab.
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1. The pull-down menu shows a list of WMS servers (you can add a different 
server if you don’t find the one you want). 

2. Click on “Connect”. 
3. and  4.  When  the  connection  is  made,  a  welcome  message  from the 

server  appears,  if  this  has  been  configured.  If  no  welcome  message 
appears, you can check whether you have successfully connected to the 
server if the “Next” button is enabled. 

5. The WMS version number that the connection has been made to is shown 
at the bottom of the box. 
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4.4.1.3.6 Accessing the service

Click on “Next” to start configuring the new WMS layer.

When you have accessed the service, a new group of tabs appears.

The  first  tab  in  the  adding  a  WMS  layer  wizard  is  the  information  tab.  It 
summarises the current configuration of the WMS request (service information, 
formats, spatial systems, layers which make up the request, etc.). This tab is 
updated as the properties of its request are changed, added or deleted.

4.4.1.3.7 Selecting 'Layers'

The wizard’s “Layers” tab shows the WMS server’s table of contents.
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Select the layers you wish to add to your gvSIG view and click on “Add”. If you 
wish, you can choose a name for the layer in the “Layer name” field.

N.B.  Several  layers can be selected at the same time by holding down the 
“Control” key and left clicking on the mouse.

N.B. To obtain a layer description move the cursor over a layer and wait a few 
seconds. The information the server has about these layers is shown.
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4.4.1.3.8 Selecting 'Styles' for the WMS server layers

The “Styles” tab allows you to choose a display view for the selected layers. 
However, this is an optional property and the tab may be disabled because the 
server does not define styles for the selected layers.

4.4.1.3.9 Selecting values for a WMS layer's 'Dimensions'

The  “Dimensions”  tab  helps  to  configure  the  value  for  the  WMS  layer 
dimensions.  However,  the  dimensions  property  (like  the  styles  property)  is 
optional and may be disabled if the server does not specify dimensions for the 
selected layers.



gvSIG Desktop

No dimension is configured by default. To add a dimension, select one from the 
“Settings  editor”  area in  the list  of  dimensions.  The controls  in  the bottom 
right-hand  corner  of  the  tab  are  enabled.  Use  the  slider  control  to  move 
through the list of values the server has defined for the selected dimension (for 
example “TIME” refers to the dates the different images were taken). You can 
move back to the beginning, one step back, one step forward or move to the 
end of the list using the navigation buttons which are located below the slider 
control. If you know the position of the value you require, you can simply write 
it in the text field and it will move automatically to this value.

Click on “Add” so that you can write the selected value in the text field and 
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request it from the server.

gvSIG allows you to choose between:

Single value: Only one value is selected

Multiple value:  The values will  be added to the list  in the order they are 
selected in

Interval: An initial value and then an end value are selected

When the expression for your dimension is complete, click on “Set” and the 
expression will appear in the information panel.

N.B. Although each layer can define its own dimensions, only one choice of 
value is permitted (single, multiple or interval) for each variable (e.g. for the 
TIME variable a different image date value cannot be chosen in each layer).

N.B.  The server may come into conflict  with the layer combination and the 
variable value you have chosen. Some of the layers you have chosen may not 
support your selected value. If this occurs, a server error message will appear.

N.B.  You can personalise the expression in the text field.  The dialogue box 
controls are only designed to make it easier to edit dimension expressions. If 
you wish you can edit the text field at any time.

4.4.1.3.10 Selecting  the  format,  spatial  system  and/or 
transparency 

The “Formats” tab allows you to choose the image format the request will be 
made  with,  specify  if  you  wish  the  server  to  hand  in  the  image  with  a 
transparency  (to  superimpose  the  layer  onto  other  layers  the  gvSIG  view 
already contains) and also the spatial reference system (SRS) you require.
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4.4.1.3.11 Adding the layer to the view

As soon as the configuration is sufficient to place the request, the “Ok” button 
is enabled. If you click on this button, the new WMS layer will be added to the 
gvSIG view.
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4.4.1.3.12 Modifying the layer's properties

Once the layer has been added its properties can be modified. To do so, go to 
the Table of contents in your gvSIG view and right click on the WMS layer you 
wish to modify. The contextual menu of layer operations appears. Select “WMS 
Properties”. The “Config WMS layer” dialogue window appears. This is similar 
to  the  wizard  for  creating  the  WMS  layer  and  can  be  used  to  modify  its 
configurations.
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4.4.1.3.13 Adding a layer using the WCS protocol

4.4.1.3.14 Accessing the service

Click on “Next” to start configuring the new WCS layer.

When you have accessed the service, a new group of tabs appears.

The  first  tab  in  the  adding  a  WCS  layer  wizard  is  the  information  tab.  It 
summarises the current configuration of the WCS request (service information, 
formats, spatial systems, layers which make up the request, etc.). This tab is 
updated as the properties of its request are changed, added or deleted.
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4.4.1.3.15 Selecting 'Coverages' 

Select the coverage you wish to add to your gvSIG view. If you wish, you can 
choose a name for your layer in the “Coverage name” field.
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4.4.1.3.16 Selecting the 'Format'

You can choose the image format you wish to use to make the request and 
reference system (SRS) in the “Format” tab.
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N.B.  Tabs  such  as  “Time”  and  “Parameters”  are  disabled  in  this  case. 
Configuring these variables depends on the server chosen and the type of data 
it has access to.

4.4.1.3.17 Adding the layer to the view

As soon as the configuration is sufficient to place the request, the “Ok” button 
is enabled. If you click on this button, the new WCS layer will be added to the 
gvSIG view.
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4.4.1.3.18 Modifying the layer's properties

Once the layer has been added its properties can be modified. To do so, go to 
the Table of contents in your gvSIG view and right click on the WCS layer you 
wish to modify. The contextual menu of layer operations appears. Select “WCS 
Properties”.

The “Config WCS layer” dialogue window appears. This is similar to the wizard 
for creating the WMS layer and can be used to modify your configurations.

4.4.1.3.19 Adding orthophotos using the ECWP protocol

If you wish to add an orthophoto to gvSIG using the ECWP protocol, first open a 
view and click on the “Add layer” button.

Click on the “Add” button in the dialogue box. A file browser window appears.

Choose the “gvSIG Image Driver”  option from the “Files of  type” pull-down 
menu.
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Write the URL of the file you wish to load as follows in “File name”:

ecwp://server address/path of the file you wish to add.

For example:

ecwp://raster.alava.net/datos/ecw/Ortofoto_5000.ecw

ecwp://earthetc.com/images/geodetic/world/MOD09A1.interpol.cyl.retouched.to
po.bathymetry.ecw

When you have input the data, click on “Open”.

The orthophoto will be added to the layer list.

Select the new added layer and click on “Ok”.

The image will be added to the view.
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4.4.1.3.20 Adding a layer using the ArcIMS raster protocol

4.4.1.3.21 Introduction to ArcIMS

In the proprietary software environment, ArcIMS (developed by Environmental 
Sciences  Research Systems,  ESRI)  is  probably  the  most  widespread/popular 
widely  used  (Internet)  cartographic  server  on  the  Internet  thanks  to  the 
number of clients it supports (HTML, Java, ActiveX controls, ColdFusion...) and 
to its integration with other ESRI products. ArcIMS is currently one of the most 
important remote cartographic information providers. Although the protocol it 
uses does not comply with the Open Geospatial Consortium (because it was 
created long beforehand), the gvSIG team believes that offering support for 
ArcIMS is important.
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4.4.1.3.22 Connecting to image services

The extension can access image services offered by an ArcIMS server.  This 
means that, just like a WMS server, gvSIG can request a series of layers from a 
remote  server  and  receive  a  view  rendered  by  the  server  containing  the 
requested layers in a specific coordinate system (reprojecting if necessary) and 
in specific  dimensions.  In  addition to displaying geographic  information,  the 
extension allows you to request information about the layers for a particular 
point via the gvSIG standard information button.

ArcIMS is slightly different in its philosophy from WMS. In WMS, the request is 
normally made by independent layers whilst in ArcIMS the request is global.

The steps required to request a layer from an ArcIMS server and to request 
information for a particular point are listed below.

4.4.1.3.23 Add layer using the arcIMS protocol 

Our  example  uses  the  ESRI  ArcIMS  server.  Its  URL  is 
http://www.geographynetwork.com. This is the address a web browser requires 
to access the HTML visual display unit.

Before  loading  a  layer  from  this  server,  the  datum  WGS84  in  geodesic 
coordinates  (code  4326)  has  to  be  set  up  previously  as  the  view’s  spatial 
system.

4.4.1.3.24 Connecting to the server

If the extension is loaded correctly, a new ArcIMS data source will appear in the 
“Add layer” dialogue box.

http://www.geographynetwork.com/
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Adding a new layer to the view

If the server has a standard configuration, simply indicate its address. gvSIG 
will try to find the servlet’s full address.1 If the servlet has a different path, you 
will have to write it into the dialogue box.

When  the  connection  has  successfully  been  made,  the  server  version,  its 
compilation number and a list of image and geometry services available are 
shown.

The service can be selected from the list or can be written in directly.

Finally, if the “Override service list” check box is enabled, gvSIG will delete any 
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catalogue that has already been downloaded and will request them again from 
the server.

List of services available

4.4.1.3.25 Accessing the service

The next step is to select the ImageServer type service required by double 
clicking or selecting it and clicking on "Next". The dialogue box changes and an 
interface  with  two  tabs  appears  (fig.  3).  The  first  tab  shows  the 
metainformation given by the server about the service’s geographic limits, the 
acronym of the language it has been written in, units of measurement, etc. It is 
a good idea to find out if a coordinate system has been defined in the service 
(using EPSG codes) as this can directly  influence the requests made to the 
server, as Figure 3 shows.

N.B. If no coordinate system has been defined in the service, the extension will  
assume that it is the same coordinate system as the one we have defined for 
the view.
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Figure 3: Metadata from the ArcIMS server

We can continue by clicking on "Next" or return to the previous dialogue by 
clicking on "Change service”.

4.4.1.3.26 Selecting layers

The last  dialogue box is the layer selection.  We can define a name for  the 
gvSIG layer or leave the default value (the service name) in this window. A box 
appears below with a list of the service layers in tree form. When the mouse is 
moved  over  the  layers,  information  about  these  layers  appears:  extension, 
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scale ranges, type of layer (raster or vector image) and if it is visible by default 
in the service (fig. 4).

Figure 4: Metadata from a service layer

We can view each layer’s ID via the “Show layer ID” check box. This check box 
is useful when there are layers whose descriptor is repeated. Therefore, the 
only way to distinguish between them is via an ID, which will always be unique. 
A combo box is also available to select the image format we wish to use to 
download the images.  We can choose JPG format if  our  service works  with 
raster images or one of the other remaining formats if we want the service to 
have a transparent background.

N.B. The transparency in 24-bit PNG images is not correctly displayed in gvSIG 
0.6. This type of files will be supported in gvSIG 1.0.

The box with the layers selected for the service appears below. If you wish, you 
can add just some of the service layers and also reorganise them. This makes 
the service view totally personalised.

N.B. The configuration cannot be accepted until a layer has been added.

N.B. Multiple selections of service layers can be made by using the Control and 
CAPS keys.
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4.4.1.3.27 Adding the layer to the view

When the “Ok” button in the dialogue box is pressed, a new layer appears in 
the view (fig. 5). If no layer has been added previously, the extension of the 
ArcIMS layer is shown, as per the standard gvSIG procedure.

Figure 5: ArcIMS layer added to the gvSIG view.

It must be remembered that when the layer extension is shown, the layers that 
make up the chosen configuration may not appear and a blank or transparent 
image appears instead. If this occurs, use the scale control dialogue box (V. 
Information about scale limits section).
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4.4.1.3.28 Points to remember about spatial reference systems

An ArcIMS server does not define the spatial reference systems it supports as 
opposed to the WMS specification. This means that a priori we do not have a 
list  of  EPSG codes that  the map server can reproject.  In  short,  ArcIMS can 
reproject to any coordinate system and leaves the responsibility of how the 
projections are used to the client.

Therefore, if our gvSIG view is defined in ED50 UTM zone 30 (EPSG:23030) and 
we request a global coverage service (stored for example in the geographic 
coordinates WGS84, which correspond to code 4326) the server will not be able 
to reproject  the data correctly  because we are using global  coverage for  a 
projection of a specific area of the Earth.

However, the procedure can be carried out in reverse. If we have a view in 
geographic  coordinates  (and thus  global  coverage),  services  defined in  any 
coordinate  system  can  be  requested  because  the  server  will  be  able  to 
transform the coordinates correctly.

In short, requests to the ArcIMS server must be made in the view's coordinate 
system and they cannot be requested in another coordinated system.

Moreover,  as  we  mentioned  above,  if  an  ArcIMS  server  does  not  offer 
information  about  the  coordinate  system  its  data  is  in,  the  user  will  be 
responsible  for setting up the correct coordinate system in the gvSIG view. 
Thus,  if  a  user  with  a  view  in  UTM  adds  a  layer  which  is  in  geographic 
coordinates  (even though the server  does  not  show it),  the service  will  be 
added correctly but will take the view to the geographic coordinates domain (in 
sexagesimal degrees).

An additional effect is that if the view uses different units of measurement from 
the server, the scale will not be shown correctly.

4.4.1.3.29 Modifying the layer's properties

The layers requested from the server can be modified via a dialogue box, which 
can be accessed from the layer’s contextual menu (fig. 6) just like the WMS 
layers. This dialogue box is similar to the box used to load the layer, apart from 
the fact that the service cannot be changed.
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Figure 6: Properties of the ArcIMS layer

4.4.1.3.30 Information about scale limits 

The extension allows us to consult the layers' scale limits which make up the 
requested service via  a dialogue box which can be maintained in  the view 
during the session (fig. 7). This window shows the layers on the vertical axis 
and the different scale denominators on the horizontal axis via a logarithmic 
scale.  This  box  is  small  on  screen  but  can  be  enlarged  to  improve  the 
difference between the scales.

The vector layers, raster layers and the layers that can be seen on the current 
scale (marked with a vertical line) in a darker colour and the layers we cannot 
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see above or below the current scale are differentiated by different coloured 
bars (described in the window legend).

Figure 7: Scale limits status

4.4.1.3.31 Attribute information requests

Attribute information requests about the elements for a particular point is one 
of gvSIG’s standard tools. Its functionality is also supported by the extension.

The WMS specification allows information about several layers to be requested 
from the server in one single query. This is different in ArcIMS. We need to 
make one server request per layer required.

This means that no requests for unloaded layers or unseen layers that are not 
visible on the current scale or layers whose extension is outside the view will 
be made. Even if all these layers are filtered, the information request usually 
takes longer than is desirable because of this intrinsic feature of ArcIMS.

When  all  the  request  responses  have  been  recovered,  the  standard  gvSIG 
attribute information dialogue appears with each of the layers (LAYER) which 
return information as a tree. If we click on a layer, its name and ID appear on 
the right (fig. 8).

Under  this  node,  if  we are  talking  about  a  vector  layer,  all  the  records  or 
geometric elements the server has responded to appear, and give each one 
their corresponding attributes (FIELDS).

If it is a raster layer, such as an orthoimage or a digital terrain model, it returns 
the values for each of the bands (BAND) in the requested pixel colour, instead 
of records.
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Figure 8: Displaying attribute information

4.4.1.3.32 Connecting to geometry services

The  extension  allows  access  to  both  ArcIMS  image  services  and  geometry 
services (Feature Services). This means that a server can be connected to and 
geometric entities (points, lines and polygons) and their attributes obtained. 
This is not dissimilar to WFS service access.

However,  the variety of  existing geometry services  is  much lower than the 
variety in the image server. There are two main reasons for this. On one hand, 
providing the public with vector cartography implies security problems because 
many bodies  only  want  to  offer  the  general  public  views  and images.  The 
vector data becomes either an internal product or must be paid for. On the 
other hand, this type of services generate much more traffic on the network 
and in the case of basic information servers could become a problem.

4.4.1.3.33 Adding a geometry layer

Loading a  geometry layer is  practically  the same procedure  as loading the 
image  server  as  mentioned  above  (Accessing  the  service  section  and  the 
following sections). In this case, the number of layers to be selected must be 

July 2011 Page 188 of 655



taken into account. If we wish to download all the layers offered by the service 
the response time will be very high.

The only difference between loading an image layer is that in this case we can 
choose whether we wish the layers to be downloaded as a group via a check 
box. This is useful for processing the vector layers as one layer when it needs 
to be moved and activated in the table of contents.

Unlike the image service, in which all the service’s layers appear as one unique 
layer in the gvSIG view, in this case each layer is downloaded separately and 
appears  in  the  view  grouped  under  the  name  defined  in  the  connection 
dialogue.

4.4.1.3.34 ArcIMS symbols

Cartography symbols are configured in the server in one AXL extension file for 
both geometry and image services. We can divide symbol definition into two 
parts.  On  one  hand,  we  can  talk  about  the  definition  of  the  symbols 
themselves, i.e. how a geometric element, such as a line or polygon, should be 
presented.  On  the  other  hand,  we can talk  about  the  distribution  of  these 
symbols  according  to  the cartographic  display scale  or  to  a  specific  theme 
attribute.

In  ArcIMS  terminology  symbols  are  different  from  legends  (SYMBOLS  and 
RENDERERS).

4.4.1.3.35 Symbols

There are various types of symbols: raster fill  symbols, gradient fill symbols, 
simple  line  symbol,  etc.  The extension  adapts  the  majority  of  the  symbols 
generated by ArcIMS. Table 1 shows the ArcIMS symbols and indicates whether 
they are supported by gvSIG.

Label Description Supported

CALLOUTMARKERSYMBOL Balloon-type label NO

CHARTSYMBOL Pie chart symbol NO

GRADIENTFILLSYMBOL Fill in with gradient NO

RASTERFILLSYMBOL Fill with raster pattern YES

RASTERMARKERSYMBOL Point symbol using pictogram YES

RASTERSHIELDSYMBOL Customised point symbol for US roads NO

SIMPLELINESYMBOL Simple line YES

SIMPLEMARKERSYMBOL Point YES

SIMPLEPOLYGONSYMBOL Polygon YES

SHIELDSYMBOL Point symbol for US roads NO

TEXTMARKERSYMBOL Static text symbol NO

TEXTSYMBOL Static text symbol YES

TRUETYPEMARKERSYMBOL Symbol using TrueType font character NO

Table 1: ArcXML symbol definition labels
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In general, the most common symbols have been successfully “transferred”. 
Some of the symbols cannot be obtained directly from gvSIG (at least in the 
current version), such as the raster fill symbol or they need to be “adjusted” 
such as the different types of lines. This means that a raster fill symbol is not a 
symbol that can be defined by the gvSIG user interface, but it can be defined 
by programming.

4.4.1.3.36 Legends

gvSIG supports the most common types of legends: unique value and range 
and value themes as well  as the scale-range control  over the whole  layer. 
ArcIMS  goes  much  further  in  its  configuration.  It  can  generate  much  more 
complicated legends in which symbols can be grouped together, scale-range 
controls can be established for labels and symbols and different labelling based 
on an attribute can be shown (as though it were a value theme for labelling).

This group of legends can generate very complex symbols for a layer in the 
end.  The current  implementation  status  of  the  gvSIG symbols  needs  to  be 
simplified to reach a compromise to recover the symbols that best represent 
the layer as a whole.

Label Description

GROUPRENDERER Legend which groups others together

SCALEDEPENDENTRENDERER Scale dependent legend

SIMPLELABELRENDERER Labelling layer legend

SIMPLERENDERER Unique value layer legend

VALUEMAPRENDERER Value and range themes

VALUEMAPLABELRENDERER Labelling themes

Table 2: ArcXML legend definition labels

When a GROUPRENDERER is found, the symbol ArcIMS draws first is always 
chosen. Thus, in the case of the typical motorway symbol for which a thick red 
line is drawn and a thinner yellow line is drawn over it, gvSIG will only show the 
red line with its specific thickness.

If  a  scale dependent legend is  discovered during a symbol  analysis,  this  is 
always chosen. If more than one is discovered, the one with the greatest detail 
is  chosen.  For  example,  in  ArcIMS  we  can  have  a  layer  with  simple  road 
symbols (only main roads are drawn) on a 1:250000 scale and based on this a 
different theme is shown with all types of roads (paths, tracks, roads, etc.). In 
this case, gvSIG will show this last theme as it is the most detailed.
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If a labelling legend is discovered during a symbol analysis, it will be saved in a 
different place and will  be assigned to the selected definitive legend. In the 
case  of  the  VALUEMAPLABELRENDERER  label,  only  the  legend  of  the  first 
processed value will be obtained as a label symbol. The rest will be rejected.

In  short,  it  is  obvious  that  the  failure  to  adapt  the  legends  for  gvSIG  is  a 
simplification process in which different legend and symbol definitions must be 
rejected to obtain a legend which is similar to the original as far as possible. It 
is to be expected that the gvSIG symbol definition will improve considerably so 
that it can support a larger group of cases in the future.

4.4.1.3.37 Working with the layer

Working with  the  layer  is  similar  to  any other  vector  layer,  as  long  as  we 
remember that access times may be relatively high. The layer attribute table 
can be consulted, in which case the records will be downloaded successively as 
we display them.

If we wish to change the table symbols to show a unique value or range theme 
we must wait as gvSIG requests the complete table for these operations. On 
the other hand, the downloading of attributes is only carried out once per layer 
and session and therefore, this wait only occurs in the first operation.

In general, if our ArcIMS server is in an Intranet, it  will  be relatively fast to 
handle,  but  if  we  wish  to  access  remote  services  we  may  be  faced  with 
considerable response times.

The main feature to bear in mind when working with an ArcIMS vector layer is 
that the geometries available at any given time are only the ones displayed. 
This is because we can connect to huge layers but only the visible geometries 
are downloaded. As far as gvSIG is concerned, the geometries shown on the 
screen  are  the  only  ones  available  and  thus,  if  we  export  the  view  to  a 
shapefile for example, are only a part of the layer.

Finally, we need to remember that to speed up the geometry downloads they 
are simplified to the viewing scale in use at any given time. This drastically 
reduces the amount of information downloaded as only the geometries that 
can actually be "drawn" are displayed in the view.

Loading a geometry  layer is  practically  the same procedure  as  loading the 
image  server  as  mentioned  above  (Accessing  the  service  section  and  the 
following sections). In this case, the number of layers to be selected must be 
taken into account. If we wish to download all the layers offered by the service 
the response time will be very high.

Unlike the image service, in which all the service’s layers appear as one unique 
layer in the gvSIG view, in this case each layer is downloaded separately and 
appear  in  the  view  grouped  under  the  name  defined  in  the  connection 
dialogue.

After a few seconds the layers appear individually but are grouped under a 
layer with the name we have defined for it.

The layer symbols are established at random. A pending feature is to recover 
the service symbols and configure them by default so that gvSIG can display 
the  cartography  as  similarly  as  possible  to  how  it  was  established  by  the 
service administrator.
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4.4.1.3.38 Web Map Context

4.4.1.3.39 Introduction

Web  Map  Context  (WMC)  is  another  OGC  standard 
(http://www.opengeospatial.org) which can be added to the list of standards of 
this type supported by gvSIG.

It can reproduce a view made up of Web Map Services (WMS) layers on any GIS 
platform which supports WMC. If your project has a view which contains WMS 
layers, you can export these layers. The result is an XML file with a specific 
format and .cml extension which can be imported by another platform on which 
the view it describes can be reproduced.

4.4.1.3.40 Exporting a view to WMC

Web  Map  Context  (WMC)  is  another  OGC  standard 
(http://www.opengeospatial.org) which can be added to the list of standards of 
this type supported by gvSIG.

It can reproduce a view made up of Web Map Services (WMS) layers on any GIS 
platform which supports WMC.
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If your project has a view which contains WMS layers, you can export these 
layers. The result is an XML file with a specific format and .cml extension which 
can be imported by another platform on which the view it describes can be 
reproduced.

Exporting a view to WMC

Exports to WMC are currently limited to WMS type layers, although it is hoped 
that its functions will extend to all layers that comply with OGC standards in 
the future.

To obtain  a  WMC file,  open a  view in  gvSIG and add the WMS layers  you 
require.

Then go to the “View” menu and select “Export” and then “Web Map Context”.

The following dialogue will be shown.

N.B.: If you cannot find the "Web Map Context" option in the "Export" option, 
your project does not contain any WMS layers.

Basic mode only shows the compulsory properties which cannot be taken for 
granted by the application.
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View: This defines which view is going to be exported to the WMC. The view 
which is currently active is selected by default.

Title: This is the title of the view which will be shown when your .cml file is 
loaded at a later date. The current title of the view is used by default but this 
can be changed.

ID: This field is also compulsory and represents a file ID which must be unique.

File: You can search for the place you wish to save the .cml file in from the 
"Browse" button.

Version: Use this tool to specify the WMC version you wish to use.

The version 1.1.0 is selected by default as it is the most highly developed and 
the  most  recommended.  However,  several  applications  and  geoportals  are 
often limited to a specific version.

gvSIG  currently  supports  Web Map Context  in  its  versions  0.1.4,  1.0.0  and 
1.1.0.

Extent: This defines the extension of the map to be exported.

Defined by the view’s extent. This option only exports what we can currently 
see in the view.

Use full extent. This extension is better to use the full WMS layers depending 
on how their respective servers define them.

If you click on the “Advanced” button, the advanced configuration dialogue will 
drop down. This allows you to define more properties  to obtain a complete 
WMC.
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Abstract: This contains a summary of the view defined by WMC.

Keywords: This list of words allows you to classify and “metadata” the WMC.

URL description: If you have a web site which refers to this WMC, write its 
link here.

URL logo: If you have an image associated with this WMC, write its link here.

Map size (pixels): This defines the pixel size that the WMC-defined view will 
have. The current gvSIG view size is used by default but you can customise the 
size if you wish.

Contact info: Information that allows third parties to contact the WMC author.

4.4.1.3.41 Importing an WMC

Importing Web Map Context allows you to use gvSIG to open views with WMS 
layers which have been created with other platforms or with another gvSIG.

Use the "View” menu and select “Import” and then “Web Map Context”.
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The WMC file selection dialogue opens.

Choose the WMC file you wish to import. On the right, you can specify how you 
wish to view the layers.

New view: This adds a new view to the current project and loads the WMC as 
specified in the file.

Layers in the active (current) view: This option only appears if the active 
gvSIG window is a view. It allows you to quickly add the layers to the current 
view.

Layers in other view: This adds the layers defined by the WMC in the chosen 
view. In this option, a list of views appears to select the view that will contain 
the new layers.

Click on the “Open” button to import the file based on your preferences.
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4.4.2 Alphanumeric data

4.4.2.1 File

4.4.2.1.1 Introduction

Tables  are  documents  which  contain  alphanumeric  information.  Tables  are 
made up of rows or records (which represent each of the elements in the data 
base)  and  columns  or  fields  (which  define  the  different  attributes  of  each 
element).

Row or record: Used to represent the different elements in the table.

Column or field: The types of attributes which define each element.

Cell: A cell is the intersection of a record and a field. A cell is the minimum 
working element and may contain information.

Record  information:  This  provides  information  about  the  total  number  of 
elements (records) contained in the table.

All  the vector information layers have their  own “Table of  attributes”.  Each 
graphic element in a particular layer has its corresponding record in the “Table 
of attributes”.

To select elements in the table, left click on them. Use the “Control” and “Shift” 
(CAPS) keys to select more than one record.
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4.4.2.1.2 Adding a table

You can load a table in gvSIG in two ways:

• From the “Project manager” 
• From the “View” 

4.4.2.1.3 Adding a table from the 'Project manager' 

Select “Tables” as the document type from the “Project manager” and click on 
“New”. A dialogue box will open in which you can add the table.
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When you click on the “Add” button, a browser window will open.
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Specify the type of file you wish to load in gvSIG in “Files of Type”. When you 
have located the file that contains the table, select it so that it is added to the 
“File name” text box and click on “Open”. You will automatically be returned to 
the "Add table" dialogue. If you wish to add more than one table, click on "Add" 
again and repeat the process. When you have finished, click on “Ok”. The table 
will then be displayed. It will also appear in the “Project manager” text box.

4.4.2.1.4 Adding a table from a view

Click on the "See table of attributes" button from the display window of a view 
with at least one active layer, i.e. a layer that is selected in the ToC,

or go to the "Layer" menu and then select the "See table of attributes" option.

The table will automatically be added to the project.
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If you minimise the view, go back to the "Project manager" and select "Tables" 
as the document type, you will see that the table displayed in the view appears 
in the text box.

4.4.2.1.5 Table properties

You can access “Table properties” from the “Project manager” window.
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You can use this window to:

• Rename the table. 
• Edit the creation date. 
• Add an owner to the table. 
• Add comments. 

When you have input the changes, click on “Ok” and they will be saved.

4.4.2.1.6 Table tools

4.4.2.1.7 Introduction

When a table has been loaded, either from the “Project manager” or from the 
view, the tools associated with the table will appear in the tool bar.

A new menu, called “Table”, will also be activated in the tool bar. This can also 
be used to access the different tools.
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4.4.2.1.8 Stadistics

You can access this option by clicking on the following button

or by going to the “Table” menu and then to “Statistics”.

The “Statistics” tool allows you to obtain the most common statistical values.

N.B.: Remember that the tool will not be activated until you select a numerical 
field.

If  you  wish  to  obtain  field  statistics,  select  the  field  (left  click  on  the  field 
heading), then click on the “Statistics” tool.

You can only obtain statistics from a series of records, firstly, select the field 
the values are located in, then select the desired records,  and click on the 
“Statistics” tool.
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4.4.2.1.9 Filters

You can access this tool by clicking on the “Filter” button in the tool bar

or by going to the “Table” menu and then to “Filter”. The “Filter” tool works in 
much the same way as in the “Views” section.

gvSIG allows selections to be made using filters. Selection using filters allows 
you to define exactly  what you want to select,  including several  attributes, 
operators and calculations.

Requests can be made using logical operators, such as “equals” “more than” 
“different from”, etc.

If you press the “Filter” button in the tool bar, a dialogue window will appear to 
define your request.
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Fields:  Double click on the field you wish to add to your request from the 
“Fields” list in the layer.

Logical operators: These allow you to insert a logical expression into your 
query by clicking on them.

Values: This shows a list with the different values the selected field has. If you 
wish to add a value to the request, double click on it.

Request: This is the window which represents the request to be made. You 
can write here directly.

Selection buttons: These buttons make the request using:

• “New set” (deletes any previous selections). 
• “Add to set” (adds the elements selected by the query to the existing 

elements). 
• “Select from set” (makes the request from the selected elements). 

N.B.: In a gvSIG view, when you activate a layer by selecting it in the ToC, the 
filter tool will also be activated in the tool bar, even though no table has been 
loaded. This allows you to work with the table associated with the selected 
layer.  The "Table" menu will  also be added in the menu bar.  This  provides 
another way to access the filter tool when it drops down.

4.4.2.1.10 Select duplicates

4.4.2.1.11 Introduction

With the select duplicates tool  you can quickly locate duplicate geometries 
through the attribute table.
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4.4.2.1.12 Instruction for use

4.4.2.1.13 Duplicated records

The Locate Duplicates tool can be used to quickly locate duplicate geometries 
in a layer's attribute table.

To locate duplicate geometries in a layer, open the layer's attribute table and 
select  the  field  (by  clicking  on  its  header)  for  which  you  want  to  select 
duplicates.

Then click on the "Select Duplicates" button.

Select Duplicates button

Notice  that  the selected geometries  have duplicate attribute  values for  the 
specified field:
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4.4.2.1.14 Ascending order

You can access this tool by clicking on the following tool bar button

or by going to the “Table” menu and then to “Ascending order”.

The “Ascending order” tool allows you to order the table records.

• It orders the values from the lowest to the highest in a numerical field. 
• It  orders the records in alphabetical order,  starting from “A” in a text 

field. 

4.4.2.1.15 Descending order

You can access this tool by clicking on the following tool bar button

or  by  going  to  the  “Table”  menu  and  then  to  “Descending  order”.  The 
“Descending order” tool allows you to order the table records. It orders the 
values from the highest to the lowest in a numerical field. It orders the records 
in alphabetical order, starting from “Z” in a text field.

4.4.2.1.16 Join

The “Join” tool allows two tables to be joined via a common field. You can also 
access this tool by clicking on the following button

or by going to the “Table” menu and then to “Join”. To join the two tables, 
carry out the following steps: Firstly, specify the source table the join is to be 
made from.
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Then specify the field to be used for the join.

Then indicate the table you wish to join to the first one.

Finally, indicate the field in the second table which is common to the first one.
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If you open the data source table, you will see that the fields of the destination 
table have been joined. The name of the field added to the table is identified by 
the word “Join_(Field name)”

4.4.2.1.17 Moving selection to the top

This tool allows the records selected in the table to be moved to the top of the 
table. You can access this tool by clicking on the following button in the tool 
bar

or by going to the “Table” menu and then to “Move selection to top”.  The 
following table shows an example in which two records have been selected to 
move to the top of the table.

If you click on the button, the table will  change the position of the selected 
records.
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4.4.2.1.18 Character encoding in tables

4.4.2.1.19 Introduction

Although .dbf files should contain a byte to indicate character encoding, this 
information is usually not present. gvSIG provides the Shalom tool that sets the 
encoding and then reads the information in the table using that encoding. If the 
encoding is not set in this way then gvSIG will read the table data using the 
default encoding.

4.4.2.1.20 Setting table encoding 

It is possible to set the character encoding of a table by selecting Table > Set 
encoding to .dbf files from the menu bar. Choose the table for which the 
encoding needs to be set and then select the encoding type (charset). This 
encoding setting is recorded permanently in the table.

Now the table can be added to the gvSIG project. When gvSIG opens the table 
the character encoding is read and the characters in the table are correctly 
displayed.

Note:  The  correct  display  of  characters  depends  not  only  on  the  encoding 
setting, but also on the virtual machine that is installed (specifically Java 1.6, 
which supports more encodings than Java 1.5).

4.4.2.1.21 Changing the default character encoding

This option can be accessed by opening the  Window > Preferences menu 
and then selecting DBF default encoding.

gvSIG will use the selected encoding as the default when adding a .dbf file to a 
project,  and  will  also  use  it  when  exporting  a  table  that  uses  a  specific 
encoding.

The  export  of  a  table  might  not  be  correct  if  the  character  encoding  is 
incorrectly configured in the gvSIG preferences.

4.4.2.1.22 Adding a table from a CSV file

From version 0.5 onwards, gvSIG can read information contained in a plain text 
file, whose fields are separated by a semi-colon.
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To carry out this operation, go firstly to the “Project manager”. Select “Tables” 
and then click on “New”. A search dialogue box will open. Click on “Add” and 
the file browser will appear in a new window (select “csv string” in “Type of 
file” to show the csv files).

When the .csv file has been selected, click on “Open”.

If you click on “Ok”, the data of the table you have added will be shown.
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4.4.2.2 Adding a table from a JDBC data source

The contents of a data base table can be imported to gvSIG using data base 
managers (PostgreSQL,  MySQL,  GBMS-HSQLDB,  ODBC).  gvSIG processes the 
information obtained just like any other table.

Note:  Oracle  drivers  installation  is  required  for  access  to  Oracle  Spatial 
databases of the geoBD extension. Please follow the steps bellow: Go to Oracle 
Database 10g Release 2 (10.2.0.3) drivers.

Accept  the  license  terms.  In  the  next  page,  download  the  file  ojdbc14.jar 
(1,545,954 bytes) - classes for use with JDK 1.4 and 1.5. (Registration required)

Move this file to the next folder:

• Windows: 

Move the file to the:
bin\gvSIG\extensiones\com.iver.cit.gvsig\lib 

folder, that is in the directory where gvSIG is installed.

• Linux: 

Move the file to the:
bin/gvSIG/extensiones/com.iver.cit.gvsig/lib folder
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, that is in the directory where gvSIG is installed.

To load a table with the information obtained from a JDBC data origin you must:

Firstly, go to the "Project manager" and select "Tables". Then click on "New". 
Select  the  “Data  base”  tab  in  the  window  that  opens  (“New  table”)  and 
configure the data base server connection parameters:

If the information entered is correct, a new table will be created in gvSIG with 
the information contained in the original JDBC table.

4.5 Symbology

4.5.1 Introduction

It is a tool which allows thematic cartography to be carried out with relative 
ease.

You can choose the colour, mesh etc. which most appropriately symbolises or 
represents the data or variables of the elements to a layer.

To access the edit option of properties related to the symbology you must go to 
the “Properties” menu (click on the smaller button on the layer).
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Another window will open, place the cursor on the “'tables of symbols' tab".

4.5.2 Vector

4.5.2.1 Legend types

4.5.2.1.1 Introduction

In this tab you can define, in an advanced manner, the type of legend with 
which you want to represent the data of layer, from its fields [1].

[1]: It must be noted that you can not use the fields resulting from a join to 
make legend classifications, meaning that, to use these fields in a legend you 
will have to export the shp resulting from the join.

You can choose the following forms of representation:
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4.5.2.1.2 Quantities

Four types of legends can be found:

Point density

Defines a legend of a point density based on the value of a certain field.

Labelling field A drop-down menu opens where you can choose fields from 
the table (Double or Integer types) from which you can make a legend which 
represents the quantity of each value in the table. The properties of the points 
which represent the density of the values in the table can be changed.

• Point size: Use the arrow to change size of the point. 

Point value: This is the numeric value which will be given to each point that is 
drawn.

• Colour: Choose the colour of the point by clicking on the button located 
right of the colour. 

• Background colour: Choose the background colour. 
• Outline: Click on this button if you want to give an outline to the symbol. 

Intervals

This type of legend represents the elements of a layer using a range of colours. 
The gaps  or  graduated colours  are  mainly  used  to  represent  numeric  data 
which have progression or range of values, such as population, temperature, 
etc.

Classification field: A drop-down menu where you can chose the attributes of 
the layer for which you want to make the classification for. The field must be 
numerical as it is a gradual classification (by the rank of the value)

• Interval type: There are three types of intervals from which to choose. 
These are:

• Same intervals: Calculate same intervals from values which can be 
found in the chosen field to make the selection. 

• Natural  intervals:  The number of  intervals  are specified  and the 
sample of this number is divided into this number according to the 
Jenk method of optimisation of the natural localisation of intervals. 

Cuantil  intervals:  The  number  of  intervals  are  specified  and  the  sample  is 
divided into this number but gathering into groups values according to their 
order. Number of intervals: Should indicate the rank or interval number which 
defines their classification.

• Nº of intervals: Type in the nº of intervals to be represented. 
• Initial  and  final  Colour: Select  the  colours  that  will  be  used  to 

graduate. The initial colour for lower values and the final colour for the 
higher ones. 

• Calculating intervals: Once the above options have been defined, click 
on the “Calculate intervals” button to show the final result. The default 
symbols and labels that appear can be modified by clicking on them, just 
as in the previous cases. 

• Add: New ranks to the calculations can be added. 
• Remove all / Remove: Allows you to delete all (remove all) or some 

(remove) of the elements which make-up the legend. 
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Graduated symbols

Represents quantities through the size of a symbol showing relative values.

• Classification  field: Choose  the  numeric  field  for  which  the 
classification is to be made. 

• Interval types: The same that are in legend type Intervals 
• Symbol: Modify  the  symbol  size  with  a  minimum value  (From),  to  a 

maximum value (Until). You can also modify all the features of a specific 
symbol by clicking on the “Template” button, as well as its “background”. 

• Calculating intervals: Once the above options have been defined, click 
on the “Calculate intervals” button to show the final result. The default 
symbols and labels that appear can be modified by clicking on them, just 
as in the previous cases. 

• Add: New ranks to the calculations can be added. 
• Remove all / Remove: Allows you to delete all (remove all) or some 

(remove) of the elements which make-up the legend. 

Proportional symbols

Represents  quantities  through  the  size  of  the  symbol  which  shows  exact 
values.

• Classification  field: Choose  the  numeric  field  for  which  the 
classification is to be made. 

Normalisation  fields: Possibility  of  choosing  a  numerical  field  which 
normalises the results, maintaining the proportion of quantities.

• Symbol: Modify  the  symbol  size  with  a  minimum value  (From),  to  a 
maximum value (Until). You can also modify all the features of a specific 
symbol by clicking on the “Template” button, as well as its “background”. 

4.5.2.1.3 Categories 

Expressions

Shows layer elements according to a certain filtered expression.
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• ''New  filtered  expression:''  A  new  window  opens  where  you  can 
configure  expressions  (filters)  upon  which  a  certain  symbol  will  be 
applied. Each of these will be shown as a row in the main window of this 
type of legend. The syntax these filters use is SLD. 

• ''Modification  of  filtered  expression:''You  are  able  to  modify  an 
expression by selecting it. 

• ''Delete a filtered expression:''You are able to delete an expression by 
selecting it. 

• ''Up/Down buttons:'' Allows you to move the created expressions up or 
down so that they later have that order in ToC. 

Unique values

Each register can be represented with an exclusive symbol according to the 
value it adopts in a certain field in the attributes table. It is the most efficient 
method for spreading categorical data, such as municipalities, floor types, etc.
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You will find the following symbology configuration options:

• ''Classification field:''A drop-down menu opens where you can select 
the layer which contains the data to carry out the classification, in the 
attributes table field. 

• ''Add all/Add:'' Once the “classification field” is selected, all the different 
values are shown by assigning a symbol  (colour)  different  to each by 
clicking  on  the  “Add  All”  button.  These  symbols  can  be  modified  by 
clicking on them. By default the label (name that appears on the legend) 
is similar to the value that is adopted by this field. By clicking on “Add” 
you can add new values to the list. 

• ''Delete  all/Delete:''  Allows  you  to  delete  all  (delete  all)  or  some 
(delete) of the elements that make up the legend. 

• ''Symbol properties:''  If  you right  click  on any of  the “cells”  on the 
“Symbols” you can modify its properties specifically through the “Select 
symbol” and “Symbology level” buttons, as well as being able to change 
the label name in TOC. 
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4.5.2.1.4 Multiple attributes

Category quantities

Represents quantities for each category.

For this, it combines two fields (which must be of a numeric type), applying a 
combined legend made up of  colour  ramp (for  field_1)  and specific  gradual 
symbols (for field_2).

Meaning  that  this  type  of  legend  combines  a  a  representation  of  intervals 
based on the values of Field_1 with anothier representation of gradual symbols 
based on the values of field_2.

4.5.2.1.5 Pie legend

Introduction

Chart or diagram legends are intended to provide a visual representation of 
data in a table, thereby communicating a lot of information very easily.

In particular this extension allows two types of legends to be constructed:

• The first one is represented by circular diagrams known as  Pie Charts. 
The  pie  chart  shows  the  proportional  size  of  the  elements  of  a  data 
series, based on the sum of its parts, and with each sector representing 
the value of a particular field. It always shows only one data series and is 
useful when you want to emphasize a significant element. 

• The second type of  legend is  represented by diagrams known as  Bar 
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Charts or  Bar Graphs. A  bar graph, also known as a  column graph, is a 
diagram  containing  rectangular  bars  with  lengths  proportional  to  the 
values  they represent.  Bar  graphs  are  used to  compare  two or  more 
values. 

Display and selection of pie charts

The pie legend is located in the  Multiple attributes section of the legend 
tree, and can be used to represent several attributes at once. To access it, 
right-click  on  the  layer  name  to  open  the  Properties  and  then  select  the 
symbols tab.

The following options are available for configuring the pie charts:

Symbols. Pie legend

Fields: You can choose which of the layer's fields to represent, provided they 
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are numeric. With these fields you can:

• Add all fields. 
• Delete all fields. 
• Add the selected fields. 
• Delete the selected fields. 

To do this click on the buttons shown in the image above (Box 1).

Colour scheme: You can change the default colour scheme for the pies. To do 
this select the desired "Colour scheme" from the drop-down list, as shown in 
the image above (Box 2).

Change the colour: In addition it is possible to change the colour of pie slices 
once they have been added.

Once the default colour scheme has been chosen, the colour of a pie slice can 
be changed by double-clicking on its color.

The following dialog is displayed where you can select a colour sample or set it 
yourself (HSB, RGB).

Symbols. Color Selection

Background  symbol: You  can  change  the  symbol  of  the  background 
geometries  by  clicking  on  the  symbol  to  open  the  symbol  editor  (pictured 
above, Box 3).
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Symbols. Symbol Selector

Outline: You  can  display  an  outline  with  a  specified  colour  and  thickness 
around the pie slices. Tick the "Show" check box to draw outlines around the 
pie sectors.

Dimension: Tick the check box to display the pie in 3D. By default the pie is 
drawn in 2D.

Preview chart: Any changes made are reflected on the chart preview.

Chart size options

Click the 'Size' button located in the pie legend configuration screen.
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Pie Legend. Size button

Clicking this will open the following dialog:

Pie Legend. Configuring size

There are three options for setting the size of the diagrams:

• Fixed Size: All the pie charts will have the size indicated here. 
• Sum of field values: The size of the pie charts is obtained from the sum 

of all the records of the fields making up the chart. 
• Field  size: The  size  is  obtained  from the  selected  field  and  can  be 

normalized if so desired. 

In addition to setting the size of the pie, the units can also be specified.

Units: Select units (meters, pixels ...) and representation (in the world or print 
layout), depending on your requirements. If the units are set to "in the world" 
then  the  size  will  depend  on  the  View's  zoom level,  while  selecting  "print 
layout" results in a fixed size, both on the screen and when printed.

Active Limits: Limits can be specified if the size of the chosen field size is not 
set to the "Fixed Size" option.

Activating limits for the other options sets the minimum and maximum values 
of a particular measure (Sum of field values or Field size). Taking the limits into 
account, the intermediate field values are calculated in proportion to the values 
of the records of the field, or to the sum of the field values.

Draw pie charts for selected geometries only

This option is used to restrict the drawing of pie charts to selected geometries.

The geometries can be selected either before or after configuring the pie chart 
size and display options.

In order to represent pie charts for selected geometries, simply activate the 
check box Draw only selection in the pie legend configuration dialog.



gvSIG Desktop

Check to display pie charts for selected geometries only

The following image shows an example in which pie charts are only shown for 
selected geometries (shown in yellow).

Example showing pie charts for selected geometries

4.5.2.1.6 Bar legend

Display and selection of bar charts

The bar legend is located the Multiple Attributes section of the legend tree, 
and can be used to represent several attributes at once. To access it, right-click 
on the layer name to open the Properties, then select the Symbols tab.

The following options are available for configuring bar charts:
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Symbols. Legend bar

Fields: You can choose which of the layer's fields to represent, provided they 
are numeric. With these fields you can:

• Add all fields. 
• Delete all fields. 
• Add the selected fields. 
• Delete the selected fields. 

To do this click on the buttons shown in the image above (Box 1).

Colour scheme: You can change the default colour scheme for the bars. To do 
this, select the desired "Colour scheme" from the drop-down list, as shown in 
the image above (Box 2).

Change the colour: In addition it is possible to change the colour of bars once 
they have been added.

Once the default colour scheme has been chosen, the colour of a bar can be 
changed by double-clicking on its color tile.

You can use the following dialog to select a colour sample, or set it yourself 
(HSB, RGB).
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Symbols. Color Selection

Background  symbol: You  can  change  the  symbol  of  the  background 
geometries  by  clicking  on  the  symbol  to  open  the  symbol  editor  (pictured 
above, Box 3).
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Symbols. Symbol Selector

Outline: You  can  display  an  outline  with  a  specified  colour  and  thickness 
around the bars. Tick the "Show" check box to draw outlines around the bars.

Dimension: Tick the check box to display the bars in 3D. By default the bars 
are drawn in 2D.

Preview chart: Any changes made are reflected on the chart preview.

Chart size options

Click the 'Size' button located in the bar legend configuration screen.

Bar Legend. Size button

Clicking this will open the following dialog:
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Bar Legend. Configuring size

There are three options for setting the size of the diagrams:

• Fixed Size: The largest bar will drawn to this size, and the rest will be 
drawn proportionately. 

• Sum of field values: The size of the bars will be determined by the sum 
of all the records in the fields making up the chart. 

• Field  size: The  size  is  obtained  from the  selected  field  and  can  be 
normalized  if  so  desired.  For  example,  a  chart  could  be  drawn  to 
represent the number of votes for each political party by the size of the 
bar, while the overall size of the diagram could be determined by another 
field, such as number of habitants. In this example, the size of the graph 
would be larger for areas of greater population. 

In addition to setting the size of the bars, the units can also be specified.

Units: Select units (meters, pixels ...) and representation (in the world or print 
layout), depending on your requirements. If the units are set to "in the world" 
then  the  size  will  depend  on  the  View's  zoom level,  while  selecting  "print 
layout" results in a fixed size, both on the screen and when printed.

Active Limits: Limits can be specified if the size of the chosen field size is not 
set to the "Fixed Size" option.

Activating limits for the other options sets the minimum and maximum values 
of a particular measure (Sum of field values or Field size). Taking the limits into 
account, the intermediate field values are calculated in proportion to the values 
of the records of the field, or to the sum of the field values.
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Draw bar charts for selected geometries only

This option is used to restrict the drawing of bar charts to selected geometries.

The geometries can be selected either before or after configuring the bar chart 
size and display options.

In order to display bar charts for selected geometries, simply tick the check box 
“Draw only selection” in the pie legend configuration dialog.

Check to display bar charts for selected geometries only

The following image shows an example in which bar charts are only shown for 
selected geometries (shown in yellow).

Example showing bar charts for selected geometries

4.5.2.1.7 Unique symbol

This is the default gvSIG legend type.

Represents all the elements of a layer using the same symbols. It is useful for 
when  you  need  to  show  the  location  of  a  layer  more  than  its  any  other 
attribute.  The  representation  of  its  symbology  depends  on  the  type  of 
geometry, this is further explained in the symbols section.
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4.5.2.1.8 Saving and recovering legends

Save legend:

The legends that have been created can be saved so that you can use them on 
other occasions.

To save, click on the “Save legend” button.
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A window will open with the save options: save legend with gvSIV (.gvl) format 
or standard exchange .sld format (currently supports SDL 1.0.0).

Legend recovery:
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Legends that have been previously created can be recovered at any time. Click 
on the “Recover legend button” and select the legend you want to recover.

4.5.2.2 Modify symbols

4.5.2.2.1 Introduction

The  Symbols  tab  is  used  to  define  advanced  features  of  the  legend  being 
worked with.

When creating symbols for a legend it is important point to bear in mind the 
type of  layer the symbols  are being created for.  This  is  important  because 
there are two different types of  vector layers to consider when making the 
symbols:

• Single geometry layers: (point, line or polygon shp layers). In this case 
the Symbols tab allows you to create or edit symbology relevant to the 
geometry (lines, points or polygons), as shown below: 
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Single geometry layer

• Multigeometry vector layers, such as dxf, dwg, gml ... 

Multigeometry layer

In this case, there is a single Symbols tab where you can configure the symbol 
properties of the points, lines and polygons separately. Points are configured 
under the Marker tab, lines under the Line tab, and polygons under the Fill tab.
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Tabs corresponding to the symbols for multigeometry layers

With  this  clarified,  we can now look  at  symbol  properties  while  taking  the 
geometry type into account.

4.5.2.2.2 Symbol editor

Introduction

From the layer menu, in properties, you can access the Symbology section. It is 
possible to change or configure a new symbol clicking on  “Select symbol” 
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where you will find different configuration options.

Click on the “Select symbol” button and then on the “Properties” button. 
The window which opens will allow you to edit the properties of the symbol. 
This is the same window that will open if you click on “New”.

By default gvSIG symbolises the layers with 'unique symbols'.

As well as the basic options that can been seen at first glance, such as colour, 
breadth and the type of units in which the symbol is to be represented, you can 
also edit the properties of the element. Next a classification of the properties of 
an element is made according to its geometry type.

The  dialogue  boxes  that  open  have  common  sections  and  others  that  are 
specific to the type of geometry, we see them as follows:

Common characteristics:



gvSIG Desktop

When a symbol,  is  configured from its  Properties,  be it  a point,  a line or a 
polygon, it can be defined:

• Its colour and transparency. Allows the fill-in colour to be chosen. 

Under colour you find a scrolling bar, which allows you to play with the grade of 
the  transparency of  the  elements.  This  way,  you  can superimpose  polygon 
layers without interfering with its display.

• The breadth of the symbol. Allows you to define the breadth of the 
element. 

• Units: In this drop-down menu you can chose the type of unit which you 
want  the  symbol  to  be  represented in.  By  default  the unit  which  the 
symbol  will  be  represented  in  are  pixels,  although  you  can  chose 
between: Kilometers, meters, centimeters, milimeters, miles, yards, feet, 
inches, grades and pixels. 
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We can also specify if they are units “on the map” (the size would depend on 
where the zoom is set) or “on paper” (it will have a set size, both on screen 
and when it is printed).

• New: Access  the  properties  of  the  symbols  in  order  to  make  a  new 
symbol. 

• Save: Allows you to save the symbols you have created in gvSIG's library 
of symbols, with a .sym extension, in order to be able to use them as 
often as you need and also to configure different types of legends. 

• Restart: Click  on  this  button  if  you  wan  to  restart  the  editing  of  a 
symbol. 

Specific characteristics of each type of geometry:

Symbol type:

Mercator Lines Fill-in

Of character Simple line Simple fill-in

Simple mercator Mercator lines Image fill-in

Mercator image Line image Mercators fill-in

Of character Simple line Line fill-ins

Of character Simple line Gradient fill-ins

The mercators represent the layers of the points.

The lines represent the linear layers.

The fill-ins represent the polygon layers.

All three together represent the multi-geometric layers.

Marker or specific symbol

You  can  chose  between  different  Markers  that  are  shown  in  “Type  of 
Marker”.

Simple Marker:

In “Marker style”, select the marker (circle, square, cross...). You can modify 
its size, angle and colour as well as being able to move it around the ordinate 
and abscissa axis.
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Marker made up of simple markers: you can make up a marker from various 
other simple markers by  “overlapping” one over the other, this is done by 
clicking on “add layer”, where each layer is a simple marker. You can delete or 
change  the  order  of  the  layers  by  clicking  on  “Delete  layer” or  “Tidy 
layers”. In the following image there is an example of a symbol made up of 
various simple markers.
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You can make the symbols stand out by choosing the colour of the outline and 
giving it the same transparency as the fill-in of the symbols. To give the symbol 
an outline you must check the “Use outline” box. You can move the symbol 
around the ordinate and abscissa axis or leave it in the centre.

Character marker:

You can use the different alphanumeric character types to create a symbol, 
you can modify  its size,  angle and colour as well  as being able to move it 
around the ordinate and abscissa axis.
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Picture marker:

You can chose whichever image you want to represent the symbol. This image 
can be in different formats (jpg, png,bmp, svg..., you can even download an 
image from the internet, as long as the format is supported by gvSIG). To add it 
just select the path where the image is saved by clicking on “Examine”, next 
to "Image file".

Also, you have the option of selecting a different image, which is to represent 
the geometries, when they have been selected and are in view. Do this by 
entering the path of the image in "Selected image".

You can move the symbol around the ordinate and abscissa axis or leave it in 
the centre.
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Lines or linear symbols

You can choose between different Mercator that are shown in the “Mercator 
type”.

Simple line symbol:

You can choose the colour of the line, its breadth and its movement (offset), as 
well  as  having  the  option  to  modify  its  opaqueness  and,  of  course,  its 
measurement units.
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As well as that the layers of the points can make up one line with various lines 
“overlapping” using the same method than which in the layers of points.

In  the  “Line  properties” tab  you  can  generate  different  types  of  lines, 
continuous  lines  which  gvSIG  has  as  default,  or  discontinuous  lines, 
establishing the fill-in pattern you choose. For this a rule is made available from 
which you can design your own patterns.
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• Fill-in pattern: 

Click on the grey section which is on the rule and drag right, next click on the 
rule, in the rule section you want, and a black section will appear which you 
can eliminate if you  “click” on it again. This way you can successively add 
sections which can design your line.

If you want to delete the designed line click on “clean”.

• Boarder style: You can chose between round, rectangular or none for the 
boarder style. 

• Style of the union: You can chose between square, angles and rounded 
for the union of the lines. 

In the “Arrow decorations” tab you can turn a line into an arrow. To make 
this happen check the “Use decoration” box.



gvSIG Desktop

The options available to decorate the arrow are:

• The size of the arrow. 
• The sharpness of the arrow. 
• Nº of positions: Number of times you want the “point” of the arrow to be 

repeated along the line. 
• Choose Symbol: This button will take you the simple Mercator of a layer 

of points menu, here you can select the shape of the arrow “point” and 
configure it as if it were any other symbol. 

• Reverse: You have the option of reversing the first or all the arrows from 
the line. 

• Rotation:  You  can  chose  between  the  “point”  of  the  arrow  rotates 
according to the slope of the line or that it has a permanent inclination 
according to the page. 

Mercator line symbols:

You  can  use  different  font  types,  such  as  characters,  to  create  a  symbol, 
modifying its breadth and separation.
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Image line symbol:

You can chose the image you want to make up the line, this image can be in 
different formats (jpg, png, bmp, svg...). To add the image you only have to 
select the path to where the image is saved by clicking on “Examine”. You can 
set the breadth and scale the image in “X” and “Y”.
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4.5.2.2.3 Fills for polygon symbols

The following fill-in Types for polygonal geometry layers are available.

Simple fill-in:

You can choose the polygon fill-in colour and its opaqueness.

Click on the button where you can see the outline and the simple symbol of a 
line  properties  menu  will  open.  Here  you  can  configure  the  outline  of  the 
polygon as if it were a line.

You can give the outline the breadth and opaqueness you want.

Fill-in made up of simple mercators: You can make up a fill-in from various 
simples  by  “overlapping”  them,  it  is  the  same  method  as  that  which  is 
explained in the layers of points and lines.

Mercator fill-ins:

You can give the polygon a fill-in made up of different types of mercators, such 
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as punctual, linear, image... with their own characteristics.

The fill-in can be organised in an aleatory way or in a regular mesh way.

There is the option to make compositions with various layers.

Line fill-in:

Instead of filling the polygon in with specific  mercators you can do so with 
lines,  you  can  give  them the  same  properties  that  you  gave  a  line  layer, 
including the outlines.

As in all  sections, here you can also create a composition through different 
layers.

Image fill-in:

You can fill-in the polygon of images and set their inclinations by indicating the 
angle and you can also scale them.

The way to fill-in the polygon of images is by giving them the specific route to 
the image. These images can be framed, click on “Outline” and select the line 
you want.

Gradient fill-in:

The  possibility  of  gradually  filling-in  is  available,  you  can  select  different 
options to configure the gradual scale of the colour, these options are:

• Intervals: Nº of intervals you want the gradual changing of the colour to 
be structured by. 

• Percentage:  You  can  chose  to  set  the  percentage  of  gradual  change 
between 0 and 100%. 

• Style: Select the style that you want for the fill-in from the drop-down 
menu. 

• Angle: Angle of the fill-in colour. 
• Colour gradient: Select the colour scale you want. 
• Outline: Give the ploygon an outline, the process of this is the same as if 

it were a line. 
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4.5.2.2.4 Symbol levels

As you can see in the following image, a symbol has two buttons that configure 
it,  “Select Symbol” where you can define its properties, and  “Symbology 
Levels” which allows us to establish the exact order the different layers has 
created the symbol.
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It  is  important to establish an order when different geometries of the same 
layer intersect,  as can be the case in  the unique Value of  legends for  line 
layers, for example, where the order established could be of interest so that 
some symbols are above others.

“0” value corresponds to the symbol drawn at that bottom, “1” is drawn above 
that and so forth successively.
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4.5.2.2.5 Labels that show in ToC

You can give whatever name you want to the different legend values, to see 
them in the Table of Contents.
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In the previous image we saw a legend by a unique Symbol,  but  it  is  also 
possible to give each of the legend values a label name by Interval, unique 
Value, etc. (or modify it, from each of the text boxes), as well as being able to 
modify  the  order  with  which  theses  values  appear  in  ToC  (throught  the 
up/down arrows):

4.5.2.2.6 Library of Symbols

Upon installing gvSIC a folder called 'Symbols' is created in the user directory, 
here you can save different types of symbols (punctual, linear, polygonal...). In 
other words, it works as a library of symbols. Also, gvSIG includes, by default, a 
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set  of  symbols  from  each  type  of  geometry,  saving  them  in  the  above 
mentioned folder.

Once  a  symbol  is  created,  from the  “Symbology  select” menu,  click  on 
“Save”.

A window will open, allowing you to save the symbols on a specific route, inside 
the “Symbols” folder.
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Name the symbol and click on save. Make sure you have saved the symbol as a 
.sym file and that when you open another layer of the same type of geometry, 
the library of symbols which has been saved appears.
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4.5.3 Raster

4.5.3.1 Color tables or gradients

The  Colour table interface allows users to assign specific  RGB values to a 
range of pixel values in a single band image. It is important to note that the 
input image can only have one band because if there are multiple bands, each 
of  the  bands  will  have  colours  associated  with  it.  With  the  colour  table 
functionality, users can build new tables or gradients, or modify existing ones.

The  colour  table  dialog can be launched from the toolbar  by  selecting  the 
option "Raster layer" on the left drop-down button and "Colour table" on the 
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drop-down button on the right. Make sure that the name of the layer for which 
you want to build colour tables is set as the current layer in the text box. The 
"Colour table" option will only be available if a single band image is selected.

Colour table icon

To use this function, it is important to know the minimum and maximum values 
in the image. If  these values are unknown, they will  have to be calculated. 
Depending on the size of the image, this calculation process may take some 
time. When the Colour table dialog is launched for an image that does not have 
any colour tables associated with it,  all  components will  be inactive. To get 
started, we need to tick the check box labelled "Activate color table".

Description of components

The colour table dialog is divided into several parts:

1. The  central  part,  which  covers  most  of  the  dialog,  displays  the 
legend associated with the image in tabular or gradient form. (You 
can  switch  between table  and  gradient  view  by  clicking  on  the 
tabs.) 

4. In the lower part are the controls with settings for the tabular and 
gradient view. 

2. A preview window is located in the upper right corner of the dialog. 
Here we can preview the output results before they are applied to 
the image. 

3. The  library  in  the  lower  right  corner  lists  the  predefined  colour 
tables. From this list, you can choose a colour table to apply to the 
image. It is also possible to create a new colour table and add it to 
the library for future use. 
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Colour table dialog - Table tab

Tabular view

Every row in the table corresponds to a range of pixel values and its associated 
RGB colour.  The  column  Value shows  the  first  value  of  the  range and the 
column  To shows the  last  value  of  the  range.  These values  can be edited 
directly by double-clicking on the cell and typing a new value. The RGB column 
contains the RGB value to be assigned to the range of pixel values. The cells in 
this column are not editable, but if you want to change the colour you can go to 
the corresponding cell  in the  Colour column and click  on it.  A generic  java 
colour  selection  dialog  will  appear  where  you  can  modify  the  colour  by 
changing the RGB values or visually.
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Colour selection

The  Class column contains associated labels that will not have any effect on 
the calculation and are just meant to add descriptive names to the range of 
values. If there is any text in this column, it will be displayed in the map legend 
when  this  is  created.  The  last  column  labelled  Alpha shows  transparency 
values. When clicking on the values, a transparency selection dialog will open.

Apply transparency

To manage the rows of the table (add, delete or move) you can use the general 
table controls located below the table (see the table control description).

Gradient view

The  gradient  view  (which  can  be  accessed  by  clicking  the  gradient  tab) 
contains the same information as the tabular view but presented in a different 
way, and with the possibility to obtain results that are difficult to achieve with 
the tabular view. The colour bar represents the range of values from minimum 
on the left to maximum on the right. At the start, the end and on intermediate 
points on the colour bar are a number of break points with a fixed colour value.

Break point

These break points indicate the colour that will be assigned to the value that 
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falls on that point. A click on a break point will activate the text boxes below 
the  colour  bar.  These text  boxes  show the following  information  about  the 
selected break point:

• Colour: The colour of the break point (which can be modified by clicking 
on it) 

• Class: Label associated with the point. This is the same associated label 
as in the Class column of the tabular view. 

• Value: Pixel value at this break point. 

To add a break point, just click below the colour bar. After adding a break point 
you can modify its information. To remove a break point you can click on it and 
drag it away.

Colour table dialog - Gradient tab

The final result of the gradient will depend on whether the check box labelled 
as "Interpolated", located below the gradient tab, is ticked or not. This option is 
available  both in the tabular  view and the gradient  view. When ticked, the 
transition between one break point colour and the next colour will be gradual. If 
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it is not ticked, the transition will be abrupt. The point where one colour ends 
and the next colour begins is marked by a diamond-shaped symbol.

Cutoff point

This cutoff point can be moved to the right or the left by clicking and dragging 
it.

General controls

In the lower part of the dialog are the controls for the tabular and gradient 
view.

• The  text  boxes  labelled  "Minimum"  and  "Maximum"  indicate  the 
minimum and maximum values of the image. We can recalculate these 
values with the button labelled "Recalc Statistics". 

• The  check  box  labelled  "Activate  colour  table"  is  used  to  enable  or 
disable the use of colour tables for the current layer. 

• Ticking the check box labelled as "Interpolated" will result in a smoother 
transition between the colours of two ranges of pixel values. This means 
that instead of assigning a fixed colour to the whole range of pixel values, 
the RGB colour value of the intermediate pixel values will be the result of 
an interpolation of  the first  colour in the range, the last colour in the 
range and the relative position of the pixel value. If you disable this check 
box, the transition between colours will be abrupt. 

• The check box labelled "Limits adjust" is used to adjust the ranges to the 
maximum and minimum values of the image. If  this is turned off,  the 
colour table will be applied to the whole range of values which is 0 to 255 
by default. 

• Clicking the button "Middle distance" will result in break points that all 
hold the same distance between them (they will be equally spread over 
the colour bar). The first and last values of the range of pixel values will 
be modified accordingly in the tabular view. 

• When clicking the button "Save as Default", the current colour table will 
be  set  as  the  default  colour  table  for  this  image.  The  colour  table 
information will be saved as a metadata file (.rmf) with the image, and 
the next time that the image is loaded in a gvSIG view it will have this 
colour table associated with it by default. 

Library of colour tables

gvSIG provides a list of predefined colour tables to which you can add others 
that you have built yourself. Located at the lower right part of the Colour table 
dialog, the colour table libary allows users to scroll through and manage colour 
tables. The list of colour tables can be displayed in three ways: List, SmallIcon 
and LargeIcon. The type of display can be changed by right-clicking on the list,  
after which a drop-down menu appears where you can select the display mode.

List:
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Colour table library - List display mode

SmallIcon:

Colour table library - SmallIcon display mode

LargeIcon:
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Colour table library - LargeIcon display mode

Below the colour table library are buttons to add, export, import and delete 
colour tables

• When clicking on the button with the tooltip "New library", a dialog opens 
which  prompts  for  basic  information  of  the  colour  table:  the  name, 
minimum value, maximum value and the intervals. The default minimum 
and maximum values are 0 and 255.  In  principle  there is  no need to 
change these values because the colour table is automatically set to the 
value range of  the image to which it  is  applied.  The intervals  can be 
specified by two different methods. The first method is by defining an 
interval of values, after which the number of intervals is calculated for 
the whole range of values. The second method is to specify the number 
of  intervals,  after  which  the  size  of  the  intervals  is  calculated 
automatically. 

Create new colour table

• To remove colour tables press the button with the tooltip "Delete library". 
You will be prompted for confirmation before the selected colour table is 
deleted. 

• You can export a colour table in one of the supported formats. Currently, 
only .rmf y .ggr y .gpl of Gimp are supported. 

• You can import a colour table in one of the supported formats. Currently, 
only .rmf y .ggr y .gpl of Gimp are supported. 
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Legend in the view and map

The colour table built with this tool will  classify the image in ranges of data 
values. When accepting the colour table dialog settings, this classification is 
shown  in  the  TOC  just  below  the  layer  name.  For  each  colour,  the 
corresponding range of values and the associated label, if any, is shown as a 
legend.

Legend in the ToC according to the colour table of the image

The generated legend can be inserted when preparing a map.
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Map with view and legend inserted

4.6 Labelling

4.6.1 Introduction

Layer labels are an independent property of the legend that draws the layer 
geometry. For this reason, labels have been separated from the legend and are 
treated as entities in their own right. The entity containing the layer labels is a 
level (containing text) that is drawn above all the other layers in the legend. 
Note that labels only make sense in certain environments, e.g. vector layers, 
annotation.

Labelling can be accessed via the new 'Labelling' tab in the 'Layer properties' 
dialog box (to activate the 'Layer properties' right-click on the active layer in 
the Table of Contents (ToC) and select 'Properties' or else double-click on the 
layer name).

Enable labelling in the Layer properties box

There are two general types of labelling:

1- Static labelling (Using attributes from the layer's attribute table)

2- Advanced labelling (User defined)

To activate labelling the 'Enable labelling' option must be checked.
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4.6.2 Static labelling

Static labelling automatically creates labels by using values from an existing 
field in the layer's attribute table. It has been inherited from gvSIG 1.1 and has 
almost  the  same  functionality  that  existed  before  the  implementation  of 
Advanced Labelling in the current version of gvSIG.

Options for static labelling

These are the options that can be set:

Enable labelling. This enables labelling and displays the layer's labels in the 
view.

General. For  static  labelling  set  this  option  to  'Label  attributes  defined  in 
table'.

Field to be labelled. A  drop-down list  that lets  you choose a field in the 
layer's attribute table that contains values to display as labels.
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Text height field option. Select a field in the attribute table that contains the 
height of each label.

Fixed height option. Enter a fixed value for the size of the labels.

Rotation field. Select a field in the attribute table that denotes the rotation 
angle of the labels. This must be a numeric field.

Units. Choose the units used for the height values.

Font. Select the font to apply to the labels.

Fixed colour option. Choose a colour for the labels. You can also set the label 
transparency by using the slider.

Colour field option. Select a field in the attribute table that contains colours.

4.6.3 Advanced Labelling (user defined)

4.6.3.1 Introduction

User defined labelling provides the user with a great degree of control over the 
design and placement of labels. It has many more options and is much more 
powerful than static labelling.

The three different methods of user defined labelling are described below.

4.6.3.2 Label features in the same way

Choose this option to apply the same label style to all features in the layer, 
regardless of whether they have been selected or not.

The interface for this labelling option looks like this:
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Label all features in the same way

Note the following options, which are explained below:

• Properties 
• Visualization 
• Placement 

It is also possible to preview the labels that have been defined for the layer. 
These will be applied to the View if the Apply or Accept buttons are clicked.

4.6.3.3 Label only when the feature is selected

Apply the label setting only to those features that are selected in the View.

This labelling is dynamic, so that if the selection in the View is changed, the 
View is automatically updated with the labels for the new selection.

The interface for this labelling option is the same as that shown above (Label 

July 2011 Page 266 of 655



features in the same way).

4.6.3.4 Define classes of features and label each differently

With this option the user can create different label classes (through the 'Add' 
button), assign them a priority for display (using the 'Move up' / 'Move down' 
buttons to the right of the panel) and label each one separately.

Advanced labelling. Different classes and labelling

The  properties  for  each  class  can  be  accessed  by  double  clicking  on  the 
relevant class (This brings up a dialog box, which is the same as for the three 
existing advanced labelling methods).

In other words, the label classes can be configured separately, with different 
labelling properties and different filters applied to the layer geometry for each 
class. Keep in mind that the labelling expression uses SLD grammar, while 
the geometry filter is applied using SQL statements, as defined by GDBMS.
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Advanced labelling. Property Configuration

The dialog box below shows how SQL statements can be entered for each of 
the label classes. These statements act as filters that determine which of the 
layer's features the class is applied to.

Here is an example of how this SQL filter is used:

SQL statement for filtering features
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4.6.3.5 Common options

4.6.3.5.1 Introduction

Regardless of which  advanced labelling method is chosen, there are some 
options that are common to all three methods. These options provide a great 
degree of control over the configuration of the labels.

These options are accessible via the buttons on the labelling tab of the Layer 
properties dialog box and are described below.

4.6.3.5.2 Properties

The 'Properties' button provides access to a large number of label options.

Clicking this button opens the dialog box shown in the figure below:

Label class properties

The following properties can be set in this dialog box:

• Name

• Font type

• Font colour

• Text size (fixed size or adjusted to fit on text area)

• Label expression (one or more)
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This is where the actual label is specified. The possibilities are:

• Strings (enclosed in quotes) 
• Fields from the attribute table (enclosed in square brackets) 
• Mathematical expressions 
• Combinations of the above 

• Label all features / filter features with a SQL statement

The  SQL  filter  allows  the  user  to  apply  the  defined  label  to  certain 
features only.

• Background style

Select  a  style  (picture)  as  a  background  for  the  labels.  Clicking  the 
'Select' button opens the following dialog box:

Select a label background style

When gvSIG is installed, the installer automatically creates a directory 
called 'Styles' in the directory /user/gvSIG/. This is where all the label 
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styles are saved (by clicking the 'Save' button).

Once  a  label  style  has  been  selected,  it  is  possible  to  modify  its 
properties by clicking the  'Properties' button. This opens a dialog box 
(shown below) where the user can insert one or more text boxes in which 
to place the different label expressions that have been created. These 
text boxes can also be moved or deleted and it is also possible to upload 
a new image from disk.

Configure the label background style

Note: It is not possible to apply a background style if the label orientation is set 
to "Following the line" (see the Placement section below).

4.6.3.5.3 Placement

Clicking the Placement button opens the Placement properties dialog box 
where  the  following  properties  can  be  configured:  location,  orientation, 
duplicates,  etc.  The options  available  in  this  dialog box will  depend on the 
geometry of the layer in question (point, line or polygon):

Point layer
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Placement properties for a point layer

If the layer is a point layer, the following options can be configured:

• Point settings 

This options allows the user to place the labels on top of the points, or else to 
offset them around the points.

In  the  latter  case,  the  label  position  can  be  selected  from  pre-defined 
placement  configurations,  which  are  accessed  by  clicking  the  Change 
location button. This opens the  Placement priorities selector from where 
existing  placement  styles  can  be  selected.  It  is  also  possible  to  modify  a 
placement style by highlighting it and clicking the Properties button:
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Label priority placement around a point feature

By using the tools on the right and applying them to the location grid on the 
left it is possible to set the label position priority relative to the point:

1 = High precedence

2 = Normal precedence

3 = Low precedence

0 = Prohibited

• Duplicate labels 

Here it is possible to choose between 'Remove duplicate labels' (eliminate any 
duplicate  labels  and only  draw one label  per  feature),  'Place one label  per 
feature',  and  'Place  one  label  per  feature  part'  (in  the  case  of  multipoint 
features).

Line layer

For line layers the following options are available:
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Placement properties for a line layer

• Orientation 

The label can be oriented horizontally, parallel or perpendicular to the line, or 
can be set to follow the line.

• Position 

The label can be placed above, on or below the line.

• Location 

Place the label  at  the beginning,  middle  or  end of  the line,  or  at  the best 
position.

• Duplicate labels 

The options here are the same as for point layers (described above).

Polygon layer
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If the layer is a polygon layer, the Placement properties dialog box provides 
the following options:

Placement properties for a polygon layer

• Polygon settings 

Labels can be set to be always horizontal, or else to follow the orientation of 
the polygons (always straight).  There is also an option for  fitting the labels 
inside the polygons. This last option is used to ensure that labels are placed 
inside polygons even if they have islands, or are U-shaped.

• Duplicate labels 

These options are the same as for point and line layers.

Multigeometry layers

In  the  case  of  multigeometry  layers  (dwg,  dxf,  gml...)  the  Placement 
properties dialog box contains a tab for each of the three geometries (points, 
lines, polygons). These tabs are identical to those shown above.

4.6.3.5.4 Visualisation

Clicking  the  'Visualisation' button  opens  a  dialog  box  which  allows 
configuration of the range of scales at which labels will be shown.
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Scale range for a layer's labels

The user can choose to use the same scale range as the feature layer (set 
under the General tab of the layer properties dialog), or else can  specify a 
scale  range  at  which  the  labels  will  be  visible (this  scale  range  is 
independent of the range applied to the geometries of the layer).

In the example shown above, labels in the view are only displayed between the 
scales of 1:500000 and 1:1000000.

4.6.3.5.5 Allow label overlapping

Finally, there is a check box that controls whether labels may overlap or not.

If this box is checked then all labels are drawn, even if they overlap each other. 
If  this  box is  left  unchecked, only non-overlapping labels  are drawn and all 
overlapping labels are eliminated.

4.6.4 Single labelling

In addition to static labelling and user defined advanced labelling, there 
is a third type of labelling, namely Single Labelling, which can be accessed 
via the following icon on the toolbar:

Single labelling icon

This  type  of  labelling  supplements  the  existing  functionality  of  annotation 
layers.  In  fact,  single  labelling  allows  the  user  to  create  personalised 
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annotations that have not been possible till now.

The  result  is  an  annotation  layer,  of  type  shape,  plus  a  file  with  a  .gva 
extension.

This type of labelling acts only on the geometry that the user has selected in 
the gvSIG View.

As with advanced labelling, valid label expressions can take on a number of 
forms:

• Strings 
• Fields from the attribute table 
• Mathematical expressions 
• Combinations of the above 

The advantage of Single Labelling over static or user defined labelling, aside 
from the availability  of  the many annotation  layer  labelling  options,  is  that 
individual labels can be modified and/or moved after they have been created. 
This is because the labels are in a new, independent layer that can edited just 
like any other vector layer.

The steps for using this type of labelling are described below:

• Configure the annotation properties:

From  the  main  window  of  this  tool,  the  user  can  set  some  basic 
properties that will apply to the new annotation labels (default annotation 
properties can be defined in the Annotation properties section of the 
gvSIG Preferences).

• Font type 
• Font style 
• Font height 
• Font Colour 
• Font Rotation 

Properties of the annotation being created

• Configure the target annotation layer:
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As shown in the following dialog box, it is possible to open an existing 
annotation layer from the hard drive, create a new one in the specified 
location, or to select one that has already been loaded into the View:

Destination of the annotation layer

• Define a labelling expression:

Activate the source layer in the ToC, click the Set labelling expression 
button and then define an expression in the text box next to the layer 
name.

An example of this step is shown below:

Annotation labelling expression

• In the View click on the features that need to be labelled.

In this way, labels are inserted into the View as each of the features is 
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clicked. The labels are drawn according to the label properties set above.

Finally,  opening the Layer properties for the annotation layer reveals that a 
new 'Annotation' tab has been added to the dialog box.

Annotation tab in the Layer properties dialog box

In this tab it is possible to configure a number of annotation options:

• Measurement units (any of the measurement units supported by gvSIG 
may be selected) 

• Draw text only 
• Avoid overlapping 
• Remove overlapping annotation 

4.7 Selection tools

4.7.1 Selecting elements

SELECT ALL

This tool is enabled when one or more vector layers are active in the TOC. The 
tool selects all the geometries (features/elements) in the active vector layers.

•  "Select all" tool enabled if there are active vector layers in the current 
View. 

•  "Select all" tool disabled when there are no active vector layers in the 
current View. 

The tool is accessed via the menu:

• View -> Selection -> Select All 
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Menu location of Select All tool

July 2011 Page 280 of 655



Result of selection

 The tool is not available if the layer is being edited.

SELECT BY POLYLINE

This tool is enabled when there is at least one active vector layer in the TOC.

•  "Select by polyline" tool enabled if there are active vector layers in the 
current View. 

•  "Select by polyline" tool disabled if there are no active vector layers in 
the current View. 

This  tool  selects  those  geometries  of  the  active  layers  that  intersect  the 
polyline defined by the user.

The tool can be accessed in two ways:

• Via the menu: View -> Selection -> Select by polyline 
• Via the icon on the toolbar 
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Location of the Select by polyline tool

With the tool selected, move the mouse over the View and enter a series of 
clicks to define the polyline. Double-click to end the polyline.
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Selection using a polyline

 You  can  use  any  mouse  button  to  define  the  points  of  the  polyline, 
including the final point.

 If another polyline is created while holding down the Ctrl key then the 
geometries thus selected are added to those already selected. If, while doing 
this,  a  previously  selected  geometry  is  selected  again  then  it  will  be 
deselected.
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Result of the selection

SELECT BY CIRCLE

This tool is enabled when there are one or more active vector layers in the 
TOC.

This tool selects geometries (features) of the active layers that intersect the 
circular area defined by the user.

•  "Select by circle" tool enabled if there are active vector layers in the 
current View. 

•  "Select by circle" tool disabled if there are no active vector layers in 
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the current View. 

The tool can be accessed in two ways:

• Via the menu: View -> Selection -> Select by circle 
• Via the icon on the toolbar 

Location of the Select by circle tool

In the View click the mouse at the centre of  the circle  and then move the 
mouse outwards to define the size of the circle. Click once to finish drawing the 
circle.



gvSIG Desktop

Selection using a circle

 Another circle can be defined while holding down the Ctrl key to add new 
geometries to those already selected. Previously selected geometries selected 
again in this manner will be deselected.
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Result of the selection

SELECT BY BUFFER ZONE

This tool is enabled if there is at least one active vector layer in the TOC.

 "Select by buffer zone" tool enabled if there are active vector layers in the 
current View and these layers have plane coordinates.

 "Select by buffer zone" tool disabled if there are no active vector layers in 
the current View with plane coordinates.

This  tool  selects geometries of  the active layers that intersect buffer zones 
around selected geometries.

The tool can be accessed in two ways:

• Via the menu: View -> Selection -> Select by buffer zone 
• Via the icon on the toolbar 
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Location of the Select by buffer zone tool

• Tool requirements
• Vector layers must be active in the TOC 
• The  selection  does  not  apply  to  layers  with  geographical 

coordinates, only to layers with plane coordinates (e.g. UTM) 
• Geometries must be selected in at least one layer 

• Configuration panel 

When the tool is selected the following configuration panel is displayed:
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Configuration options

1. Width: width of the buffer zone. 
2. Unit: units of the buffer zone width. 
3. Polygon: which side of the polygon to generate the buffer zone: 
4. Outside: to the outside of the polygon. 
5. Inside: to the inside of the polygon. 
4. Line:  for  line  layers  the  buffer  zone  will  always  be  towards  the 

outside. 
5. Point: for point layers the buffer zone will  always be towards the 

outside. 
6. Multipoint:  for  multipoint  layers  the  buffer  zone  will  always  be 

towards the outside. 
7. Multi-layer selection: the selection will apply to all layers that meet 

the requirements. 
8. Add  buffer  zone  layers:  when  selected  this  option  adds  the 

generated buffer zone(s) to the View's TOC. 

The new layers are named as follows:

• influence_areas_layername_num 
• influence_areas -> prefix to identify this type of layer. 
• layername -> name of the layer for which the buffer zone is calculated. 
• num -> numerical suffix to identify each new buffer zone layer that is 

generated, automatically increased for each new zone generated from a 
single layer, starting from zero. 

Example

Let's look at a typical example using the "Select by buffer zone" tool and four 
layers:
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• A shape layer showing "Bird Special Protection Areas" of Castilla y León, 
obtained  from  the  Ministry  of  Environment,  symbolised  with  a  filled 
"unique symbol" and with a transparency setting (zepa41): 

http://www.mma.es/secciones/biodiversidad/banco_datos/info_disponible/zip/ze
pa41.zip/

• A shape layer  showing  "Sites  of  Community  Importance"  in  Castilla  y 
León,  obtained from the Ministry  of  Environment,  and using a  unique 
values symbology: 

http://www.mma.es/secciones/biodiversidad/banco_datos/info_disponible/zip/lic
41.zip/

• A shape layer shape showing the provinces of Castilla y León, using a 
unique values symbology. 

• A background WMS layer showing hydrographic information, topography, 
geology, road networks and administrative boundaries in Spain: 

WMS Server: http://www.idee.es/wms/PNOA/PNOA/

Layer: PNOA

Style: Default

Format: image/png with transparency and SRS=23030
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View showing the vector layers, with the Bird Protection Areas layer active

Now select the bird special protection area called "Tierra de Campiñas", which 
belongs to Valladolid, Ávila and Salamanca. Also select the Site of Community 
Importance called "Montes Torozos y Páramos de Torquemada – Astudillo" in 
Valladolid.
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View showing the vector layers, with the provinces layers active

July 2011 Page 292 of 655



Manual selection of one of the polygons
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Make the lic41 layer active

Finally, we want to find the areas of type "lic" and "zepa" close to (up to 15 km) 
the selected areas so that, for example, they can be taken into account in a 
future second phase involving work to protect birds.
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Set options for the buffer zone

The following settings have been applied:

• The zepa41 and lic41 vector layers have been made active. 
• Width is set at 15 kilometers. 
• The two selected layers  are polygon layers,  and for  this  example the 

buffer zone is set to be outside the polygons. 
• Indicate that the selection should be applied to each active layer (Multi-

layer selection). 
• Finally, add the generated buffer zones as new layers. 

The result is shown in the following screenshot. The buffer zones can be turned 
off so that the selected areas can be seen.
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Result of selection by buffer zone
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Result with buffer zones switched off

• Details of the process 

Click the "Show Details" button below the progress bar to show information on 
the steps that have been performed, including failures.

Sample output from the above process:
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Sample output

Selection is applied to each active layer that meets the requirements.

If  the  "Multi-layer  selection"  option  is  active,  then  for  each  buffer  zone 
selections are applied to those layers that also meet the requirements.

If the projection of the layer is not the same as that of the View, an internal 
reprojection is performed in order to compute the buffer zones. The projection 
is later restored.

A  shape  layer  is  created  (one  for  each  active  layer  that  meets  the 
requirements) for storing the buffer zones. The location of each new layer is 
shown in the line beginning "Creating temporary file".

If the "Add buffer zone layers" option is selected, then the temporary layers are 
created and added to  the TOC,  symbolised with  a unique symbol  and with 
transparency.
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If an active layer is not projected, then the applied selection is discarded.

If a failure occurs, the user is alerted and the selection process is terminated.

 If the process is cancelled, the previous selection state in the affected 
layers is restored.

4.7.2 Introduction

You can select one or several elements or items by making either a graphic 
request or an alphanumeric request.

The selected data are shown in the view in the colour you have configured (by 
default this is yellow).

You can access the different ways of selecting elements by going to the tool 
bar or by going to the “View” menu and then to “Selection” as long as the layer 
you wish to work with has already been activated in the ToC.
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4.7.3 Selecting by point

This is the basic selection method and consists of clicking on the element you 
wish to select.

4.7.4 Selecting by rectangle

This allows you to select the elements which are partly or wholly located inside 
a rectangle.

To define the rectangle, place the cursor point over the position you wish to 
start to draw the rectangle in, left click on the mouse and hold the button down 
until you have defined the area you wish to select.

4.7.5 Selecting by polygon

July 2011 Page 300 of 655



This allows you to select elements which are partly or wholly located inside a 
polygon.

To define this polygon, place the cursor in the part of the view you wish to draw 
the selection polygon in. Left click on the mouse in the view to add the polygon 
vertices.

When you have finished, double click on the mouse. All the elements which are 
located  inside  the  polygon  or  which  intersect  with  any  of  its  sides  will  be 
selected.

4.7.6 Selecting by layer

You can access this tool by going to the “View” menu then to “Selection” and 
“Selection by layer”. It allows you to select elements in the active layer based 
on the selection made in another layer.

The options available using this tool are:

• 1.New set: This creates a new selection set. 
• 2.Add to set: This creates a selection set based on the previous request 

and the current request. 
• 3.Select from set: This creates a selection set from what has already 

been  selected,  the  current  selection  request  is  extracted  from  the 
previous one. 

An example of how to use this tool consists of selecting the cities and towns of 
the Valencian Region whose municipal boundaries are affected by flood risks.

We start with a shape file  with the areas of the provinces in the Valencian 
Region which are subject to flood risks.

Then  the  layer  corresponding  to  all  the  cities  and  towns  in  the  Valencian 
Region is added. Pre-select the full flood risk layer.

We go to the “Selection by layer” tool. Use the “Intersect with” option in the 
first pull-down menu, “Select items from active layers that are:…”.

Use the “riesgo_inundación_25000_completo” option in the second pull-down 
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menu “Selected items of a layer”.

We can  now click  on  “New set”  and  the  layer  with  the  new selection  will 
appear.
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4.7.7 Selecting by attributes

You can access this tool using the following button:

gvSIG allows selections to be made using requests (filters). Selecting elements 
by attributes allows you to define exactly what you want to select, including 
several attributes, operators and calculations.

Requests can be made using logical operators, such as “equals” “more than” 
“different from”, etc.

If you press the “Filter” button in the tool bar, a dialogue window will appear to 
define your request.
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1.Fields: Double click on the field you wish to add to your request from the 
“Fields” list in the layer.

2.Logical operators: These allow you to insert a logical expression into your 
request by clicking on them.

3.Values: This shows a list with the different values the selected field has. If 
you wish to add a value to the request, double click on it.

4.Request: This is the window which represents the request to be made. You 
can write here directly.

5.Selection buttons: These buttons make the request using:

New set (deletes any previous selections).

Add  to  set (adds  the  elements  selected  by  the  request  to  the  existing 
elements).

Select from set (makes the request from the selected elements).
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4.7.8 Inverting the selection

When you have made your selection, you can click on the following button in 
the tool bar

or you can go to the “View” menu then to “Select” and “Invert selection”

and invert the previous selection as shown below.

4.7.9 Clearing selection

If you click on this button, the selected element set will once again become 
empty. You can also access this option by going to the “Layer” menu then to 
“Clear selection”.

4.8 NavTable

4.8.1 What is NavTable ?

NavTable is a gvSIG extension to  display in an agile way the alphanumeric 
elements of vectorial layers. It allows seeing the features of an element in a 
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vertical  table  besides editing,  navigating and quick filtering the values of  a 
layer.

NavTable is  released  under  a  GPL  v3  license.  It  has  been  created  by 
CartoLab, the Cartographic Laboratory from University of A Coruña. Feel free 
to send us comments, suggestions, bug reports, etc.

4.8.2 List of features

1. Display data from vectorial layers in vertical align 
2. Edit alphanumeric values (tested with ESRI Shapefile and PostGIS) 
3. Navigate between elements: next, previous, ... 
4. Allow to navigate only by selected elements 
5. Zoom to the elements: manual and automatic 
6. Allow zoom with fixed scale 
7. Select and unselect elements 
8. Alphanumeric editing of values 
9. Copy attributes from last register or from selected 
10.Create and drop elements 
11.Length and area of a element is calculated 
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12.Available in spanish, galician, english and french. 

4.8.3 Interface

To activate NavTable you must select a vector layer in the gvSIG ToC (Table of 
Contents) and click the button NavTable  .

NavTable interface has the following areas:

• Top: basic adjustments and filter checkboxes. 
• Central: view and edit data in each record. 
• Bottom: navigate bar, save button and others practical buttons. 

NavTable can be used for editing and display alpha-numeric tables, which have 
no associated geometry. For these cases, NavTable icon in the toolbar will be 
blue . The title of the NavTable window for tables without geometry has a '*' 
to distinguish it from normal tables.

4.8.4 Navigation

NavTable scrolls through the records and features in a friendly way. You will 
find the navigation bar at the bottom of NavTable's window.

With these buttons you can:

• Go to the first record 
• Go to the previous record 
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• Go to the next record 
• Go to the last record 
• Go to any record using the box located between the buttons described 

above. It shows the number of the records you're currently viewing. If you 
enter a new value here you will see the corresponding record. Next to the 
position  of  the  box  there  is  a  number  indicating  the  total  amount  of 
records in the table. 

If you are working in the central area of NavTable (click on any row) you can 
use the buttons “right”or “left”, “home” or “end” to change the record that you 
want to see.

4.8.4.1 Selecting elements

If you click on the checkbox "selected" the navigation buttons will work only for 
features that are previous selected. If a feature is selected, the bottom area of 
the NavTable Window will be highlighted in yellow. In between parentheses the 
number of selected records can be seen next to the whole number of records.

In this image you see an example explaining how this function works: record 8 
for a layer with 20 records is displayed where 7 records are selected.

If the checkbox "selected" is activated without any selected feature, all records 
will be shown empty and the box will not display any number  and .

The option "select" is another interesting tool you can find next to "selected" in 
the  Nav  Table  menu.  If  you  activate  the  checkbox  next  to  "select",  the 
attributes you are visualizing will be selected and highlighted in the view. In the 
case that other features were selected, this option will turn them unselected 
and will select only the register you are visualizing.

On top of the NavTable Window there is the button “Filter”  If you press it, a 
dialogue window will appear in which you can define exactly what you want to 
select  (attributes  and  calculations).  If  you  click  on  "clear  selection"   all 
selections will be turned off and no features will be selected.

4.8.4.2 Zoom to feature

If you click on the zoom button  the feature will be displayed in the center of 
the view, referring to the record you are working with at that time. The scale of 
the view will be changed to have a good visualization of the data. In case you 
are working with a point layer, a scale size will be chosen that allows to see 
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also the surroundings of the point.

With help of the button "always zoom" next to the checkbox "select", Navtable 
will zoom to each feature referring to the record you are visualizing. If you click 
on "fixed scale" as well, Navtable will zoom to the feature and display it in the 
center of the view, but the scale will always remain the same. It is possible to 
change the scale value introducing a new one in the "scale bar" of gvSIG. This 
is shown on the buttom right of the gvSIG view, next to where the coordinates 
are displayed.

Tip: The options "always zoom" or "fixed scale" together with "select" is a very 
interesting way of navigate through the features of a layer.

4.8.4.3 Quick filters

Navtable offers you a comfortable way to make quick filters. If you want to use 
this  functionality  you must  select  a  row in  Navtable  which  has  one of  this 
attribute types: number, string or boolean. If you click on the right button of 
your  mouse  a  new  menu  will  be  displayed  which  shows  you  the  different 
options to define filters.

If  the  selected field  is  of  type "string"  one of  the  following  options  will  be 
shown:

• is the same than [current text] 
• is different than [current text] 
• contains... (a new dialogue window will  be displayed introducing text 

that Navtable should find between all other records) 
• Filter (this option will call the "Filter" function of gvSIG as we have seen 

it before) 
• Clear Selection (if a feature is selected) 
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If you want to use the quick filter of Navtable on a numeric field you will have 
these possibilities:

• is the same than (==) [current value] 
• is different than (!=) [current value] 
• smaller than (<) [current value] 
• greater than (<) [current value] 
• filter 
• clear filter 
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Regarding boolean fields the filter options are the followings:

• equal to "TRUE" 
• equal to "FALSE" 
• filter 
• clear fliter 

If there are selected records the "clear filter" option can be activated to delete 
the current selection. Each time you use Navtable´s quick filter option a new 
selection will be made and the actual one will be cleared.

Notice: You should consider that NavTable will show you an empty record if you 
use a filter and you have to activate the checkbox "selected". Every feature 
has the condition you are looking for including the expression you have defined 
for the filter.

Warning: if there is a great amount of records inside the table, the processing 
of  the Navtable filter  operations  could take a long time (like in gvSIG filter 
itself). Please consider that there is a known bug in gvSIG when using filters 
with decimals in numerical fields and the "equal to" operator.

Filter for date fields have not yet been implemented in Navtable.

4.8.5 Editing

The main new functionality  in  Navtable is  that  you don't  need to start  the 
editing mode for a layer if you want to edit it. You should follow these steps to 
edit the table:

1. Make double click on the register you wish to work with (or click on the 
space bar). Now you are in editing modus and you will be able to modify 
this record. 

2. Modify the data by entering a new value 
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3. Click on the "save" button  . 

After that, the new value will be saved. It's important to consider these special 
cases if you want to save the edition:

• with boolean fields you can only use true or false (the expression is not 
case sensitive). If you enter another value, the original one will be saved. 

• If you try to save a value into a not appropriate field (for example from 
type „text“ into type „numerical“), the original value will be written. 

• If you want to save an empty text, the default value will be saved. But if 
the field is from type „string“, the record will  be saved with an empty 
value. 

With  Navtable  it  is  also  possible  to  use  options  for  advanced  editing.  For 
example you can copy and paste records. For that you should select the record 
you want to copy first and click then on the button "copy selected feature"  . 
The data will be modified when you click on the button "save".

Removing records

It is possible to delete the record you are visualizing with Navtable if you click 
on the button "delete feature"   . If this record has an associated geometry 
feature (graphical element), this one will be also deleted.

Adding records to alphanumerical tables

For tables which aren't associated to a layer, Navtable has this button   . If 
you click on it, after the last one of the table a new record will appear.

4.8.6 Displaying long names

As you know,  the dbf  format doesn't  allow field  names with  more  than 10 
characters.  This  limitation  could  be solved using alias  for  these fields.  This 
option is also available for layers stored in a geodatabase.

If you wish to use this functionality you will need to create a text file with the 
same name as the layer in which you want to use "alias" names. Save this text 
file in the folder "alias" that was created when installing Navtable.

When installing gvSIG, a folder with the name gvSIG will also be created:

On Windows it is usually installed here "C:Documents and Settingsuser"
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On GNU/Linux you will find it here: "/home/user/gvSIG"

When installing Navtable, a folder with the Name "Navtable" is saved to the 
"gvSIG" folders. At the Navtable folder you will find the "Alias" one, where you 
should save the text file mentioned above.

In this file you can define long names or alias for the field names.

Name_original_field=long_name

It's only necessary to describe a row for the fields you want to define an alias 
name for. The order of the lines isn't important, that means, you don't need to 
follow the same sequence like the field's names of the table.
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When  Navtable  is  opened,  the  according  "alias"  text  file  will  be  found 
automatically. If new names for the fields are available there, Navtable will use 
these ones instead of the original names.

Example: There is a dbf file with the following fields:

We  define  an  alias  text  file  with  the  same  name  as  the  shape  file: 
Afg_district.alias in this case. In this file we will write the following text:
prov_code=province code
distr_code=district code

This  file  Afg_district.alias will  be  saved  in  the  same  folder  as  the  file 
Afg_district.shp. Now we can open the table of this layer with Navtable and can 
see the following:
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Important for Windows:

Windows doesn't show the file extension by default. For this reason for a new 
alias text file  the name of the file  will  be probably  name_layer.alias.txt and 
Navtable will not be able to read this alias file.

In order to have a correct result for this functionality we recommend you to 
deactivate  the  option  hide  hidden  files  and  folders.  You  can  make  this  in 
Windows Explorer: Extras > File Options > View > Advanced Settings > Hidden 
Files and Folders

4.8.7 More information about NavTable

NavTable is hosted by the OSOR Forge  [1]. On this page you can find useful 
information about the project and also related documents, mailing lists, bug 
reporting system, etc.

In the section "Future Work" on the project website you will find some of the 
things we want to incorporate in NavTable in the near future.

[1] http://navtable.forge.osor.eu/

5 Editing tools

5.1 Introduction

There are two types of edition. Firstly, there is the graphic edition of elements 
which  creates,  modifies  and  deletes  graphic  elements  and  secondly,  the 
alphanumeric  edition  of  elements  which  creates,  modifies  and deletes  data 
associated with the elements.

http://navtable.forge.osor.eu/
http://localhost:9673/plone/projects/contrib/navtable/pub/ver0_6_0/userdoc/#id1
http://localhost:9673/plone/projects/contrib/navtable/pub/ver0_6_0/userdoc/#id2
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5.2 Graphic editing

5.2.1 Introduction

gvSIG's CAD extension can make complex drawings from basic elements, such 
as lines, circles or polygons.

Features can be duplicated or modified as you wish by using actions such as 
copying or rotating.

To carry out these tasks, we need to know what type of layer is being edited. 
Once we know the type of layer, we can see which tasks can be carried out.

When the “Start edition” option is selected, the edition tool bar buttons appear. 
Only the buttons which can be used in the layer being edited are active. Thus, 
for example, if a points layer is being edited, the selection, move and point 
insertion tools are enabled

whilst if, for example, the layer is a line layer, all the tools are enabled except 
the point insertion tool.

Another tool which appears when an editing session is started is the command 
console or message and command area, located at the bottom of the graphic 
area.  This  tool  allows  you  to  input  commands  via  the  computer  keyboard. 
These are then carried out in the graphic area.
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5.2.2 The graphic area

If you select the “Layer” menu option then go to “Start edition”, the application 
window shows the following areas.

Menu bar: Menus with which you can access the application’s functions. The 
contents  will  change  according  to  the  situation,  thus,  for  example,  the 
"Geometry" menu will only appear when a layer is being edited.

Tool bar: Bar which shows the drawing command icons.

Graphic area: This takes up the majority of the display and is where the layer 
which is being edited is shown.

Command console: This is where the editor’s PROMPT is located (active line 
of the console). This means that the programme is ready to receive commands. 
When a command is input, the corresponding process is run and the messages, 
information or parameter requests are shown.

Status  bar: This  shows  the  scale,  the  measuring  units,  the  absolute 
coordinates of the cursor position (X and Y) in these units and the projection.

5.2.3 Starting and finishing an editing session in gvSIG

5.2.3.1 Introduction

Firstly, enable the layer you wish to edit by selecting it in the ToC. Place the 
cursor over it  and right  click on the mouse. The contextual  menu appears. 
Select the “Start edition” option.
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N.B.: More than one layer can be edited and you can alternate what you do 
with them. However, whatever you do will only take effect on the active layer. 
To change the layer you are working on, select it in the ToC.

When you finish your editing session, go to the “Finish edition” option in the 
contextual menu.

N.B.: The application will create a projection of the object you are working on to 
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help you with the graphic editing. This will allow you to get a visual idea of the 
obtained result. The object projection will be shown in red.

The figure shows how a projection of the figure copied in a different colour is 
created  during  the  copying  process.  This  projection  allows  you  to  specify 
exactly where you want to place the new object in the graphic area.

5.2.4 Procedures to input commands

5.2.4.1 Introduction

There are three general mechanisms for the application to run user commands. 
The first mechanism is to select the command by clicking on the corresponding 
button in the tool bar. The second option is to activate the tool by selecting it in 
the  menu  bar  (normally  in  the  “Geometry”  tab)  and  the  third  and  last 
mechanism  is  by  inputting  commands  in  the  command  console  using  the 
keyboard.

5.2.4.2 Tool bar

The edition tool bar appears when a layer is being edited. The tool bar icons 
will be activated according to the type of layer being edited.

5.2.4.3 Menu bar

When an editing session starts, a new menu called “Geometry” appears in the 
bar from which we can access the different tools.
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5.2.4.4 Command console

The commands, options, messages or parameter requests the programme runs 
are shown in the area called "Command console".

The bottom line of the command console is called the "line command" and 
shows the action the application is running. The command console area size 
can be increased or decreased. To modify its size, place the mouse pointer on 
the separation bar between the command console and the graphic area, left 
click on the mouse and move the bar up or down until  it  is situated in the 
required position.

When you have finished, let go of the mouse button. You can also hide the 
command console by clicking on the down-facing triangle situated at the top 
right of the console. To show the command console, click on the upward-facing 
triangle.
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To input commands into the command console using the keyboard, write the 
name of the command or order and press “Enter”. Commands can be input in 
capital or small letters. When a command is input, a window or a set of options 
associated with this command appears.

For  example,  if  the “rectangle” command is  input,  a window will  appear in 
which the definition of a corner point is requested. When the point has been 
inserted, a second point or “C” is requested to indicate that the object will be a 
square.

5.2.5 Editing properties

5.2.5.1 Introduction

When a layer editing session has been started, if you right click on its name in 
the ToC, a contextual menu appears in which, among other things, you can 
access the “Edition properties” to configure them.
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5.2.5.2 Snapping

You can configure the “Snap tolerance” in the first editing page. “Snap” or 
“Snapping” is the process of moving an element until it coincides exactly with 
the coordinates of another element. If  the “Snap tolerance” is 4 pixels, two 
elements which are the same distance or closer than 4 pixels will be joined in a 
common coordinate.

You can do element snapping between layers by enabling the corresponding 
check boxes in the “Selected” column.

You can modify the values of the "Maximum features edition cache" column to 
accelerate  the  snappings  and  handlers  being  edited.  This  is  the  maximum 
number of geometries you wish to work with in the cache.

5.2.5.3 Configuring the grid

If you select “Grid” in the tree on the left, this will allow you to configure the 
grid’s properties.

The grid is a point pattern which extends over the whole of the graphic area.

It is useful in that it allows you to line up objects and calculate the distance 
between them.

You can enable the “Show grid” and “Adjust to grid” check boxes and edit the 
distance between the grid points.
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When the grid is shown, the graphic area will look like this.

5.2.5.4 Flatness

You can configure “Flatness” by selecting the corresponding option in the tree 
on the left.
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In gvSIG, a circle or any curved geometry is made up of straight sections. The 
flatness number you specify will define the maximum size of these sections.

5.2.6 Undoing / Redoing

5.2.6.1 The command stack 

The command stack is a tool which allows you to undo/redo several commands 
at once. It also provides information about the commands carried out, such as 
the name and time they were carried out.

The command stack can be activated in different ways.
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By clicking on the tool bar icon shown below.

By selecting the menu bar option "File" then going to "Command stack". The 
command stack saves all the commands given on the layer being edited since 
the last time it was saved.

You can select the commands you wish to undo in the slider control. You can 
move the slider control up or down until you have positioned it in the order in 
which you wish to continue working.

You must remember that you cannot undo one specific command, you have to 
undo all the commands given up to that point, i.e. we have to go to the last 
step we wish to keep and continue editing from this point. For example, let us 
suppose that we take eleven steps and when we reach the eleventh step, we 
realise that step number six is incorrect. We cannot simply go to step 6 and 
cancel it, we have to undo the eleventh, tenth, ninth steps, etc. until we get to 
the fifth one. The advantage of using the command stack is that we can undo 
all the changes at once without having to undo them one by one. In addition, 
we know which steps we are undoing.
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5.2.6.2 Undo/Redo

You  can  access  Undo/Redo  from  the  edition  tool  bar  by  clicking  on  the 
corresponding icon.

The button with the left facing arrow allows you to undo the last step. The 
button with the right facing arrow allows you to redo the last step you have 
undone.

5.2.7 Editing commands

5.2.7.1 Introduction

Editing commands are the set of orders used to edit or modify a drawing. More 
specifically, they cover all the processes and mechanisms required to modify 
and work with what has already been drawn.

gvSIG uses three different ways to run these commands.

• By clicking on the corresponding button from the tool bar. 
• From the menu bar. 
• By writing the command in the command console. 

5.2.7.2 Copying

This makes a copy of the objects you have selected. The elements copied will 
keep the same size and orientation as the originals. To access this tool, click on 
the “Copy” button in the tool bar

or go to the “Geometry” menu bar, then to "Modify" and "Copy".
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The copying process is basically the same as the move process but the source 
objects do not move from their initial positions. New objects are created in the 
new location  which  are  identical  to  the  originals  in  size,  shape and in  the 
distance between them.

To make a copy, when the objects to be copied have been designated, two 
points need to indicated, the base point and the move point.

As with the rest of the tools, a projection of these objects will be shown in the 
view to specify the view location the copied objects are to be inserted in.

When the copied objects are situated in their location, click on the view again 
to set their position.

To copy objects from the command console, write the command "copy" when 
you have selected the objects you wish to copy, input the first move point and 
then the second point.

For example, when the command and the first move point have been input 
(30,40), the projection of the figure being copied appears. Input the second 
move point, (60, 40 in the example), and the new identical element will appear 
in the defined location.

5.2.7.3 Symmetry

This tool allows you to make a drawing which is symmetrical to the selected 
one. You can access this tool by clicking on the “Symmetry” button in the tool 
bar
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or by going to the “Geometry” menu bar, then to “Modify” and “Symmetry”.

To obtain a symmetrical drawing in gvSIG, firstly select the element and then 
select the “Symmetry” option. Then, click on the display graphic area to insert 
the first symmetry axis point. gvSIG will then create a red projection of a figure 
which is symmetrical  to the selected figure.  You can then input the second 
point  the  symmetry  axis  will  pass  through  by clicking  on  the  graphic  area 
again.

If you wish to run the tool from the command line, firstly write the command 
“symmetry”.

Input the first point the symmetry axis will pass through and press “Enter”. The 
console will then ask you to input a second point this axis has to pass through.

Input the point and press “Enter” again.

The console will ask you if you wish to keep the source object, write “Y” if you 
wish to keep it and “N” if you do not.
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5.2.7.4 Rotating

You can use this tool to rotate the selected objects by taking a base point as 
the centre. You can activate this tool by clicking on the “Rotate” button in the 
edition tool bar

or by going to the "Geometry" menu bar, then to “Modify” and “Rotate”.

To rotate an element, first place the base point by clicking on the graphic area. 
Move the mouse, with the help of the projection that gvSIG uses to the effect, 
until the new position has been established.

Left click on the mouse in the view to define this point.

If you wish to rotate an element from the command console, select the object 
to be rotated, write the command “rotate” and input the first move point.

Then input how much you wish to rotate it in sexagesimal degrees.

The object will  be rotated clockwise if  you write a negative angle and anti-
clockwise if you write a positive angle.
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5.2.7.5 Moving Elements

This tool allows you to move the selected objects from one point to another in 
the view by indicating a move vector. You can use this tool by selecting it from 
the tool bar by clicking on the "Move" button

or by going to the “Geometry” menu bar, then to “Modify” and "Move".
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If you wish to move an element, select the object you wish to move and then 
activate the “Move” option. Click on the graphic area to define the move point.

gvSIG will create a red projection of the elements it is moving which can be 
used as a guide to position them in their new location.

When the element is located in the desired position, left click on the mouse 
again to define the new position.

To use the “move” command from the command console, write the command 
“move”. The console will show a message requesting a move point. Input the 
point.

Then input the second move point. Press “Enter” and the object will move to its 
new position.
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5.2.7.6 Selecting

5.2.7.6.1 Simple selection

To select one of the drawn objects in the layer we are editing, click on the 
"Select" button in the tool bar,

or go to the “Geometry” menu bar and then to “Select”.

Then click on the object you wish to select.

5.2.7.6.2 Complex selection 

You can access this button in the tool bar,

or by going to the “Geometry” menu bar then to “Complex selection”.

When the “Complex selection” tool has been selected, right click on the mouse 
in the graphic area. The following contextual menu will appear.

Click on the option you wish to use to select the elements.

If  you  use  the  “Inside  circle”  option  you  can  delimit  a  circle  so  that  the 
elements you wish to select remain inside this area.
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The selection result corresponds to the following image.

You  can also  write  the  “select”  and  “complex  selection”  commands  in  the 
command  console.  Command:  “select”  Write  the  command  “select”  in  the 
command console.

When a message appears in the command console requesting you to add the 
selection point, input the coordinates of the object you wish to select.

If there is an object in the defined coordinates, it will be selected.

Command: “complex selection” Write the command “complex selection” in the 
command console and when the selection options appear, write the desired 
option.

The options are shown with their names, and in square brackets ([]) the text 
you need to input in the command console to use the option.

If, for example, you wish to select the features that are in a polygon area, you 
need to write “complex selection” in the command console, press “Enter” and 
then select the “IP” option.

This allows us to indicate the coordinates of the vertices which will make up the 
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polygon (when the coordinates of each of the vertices are indicated a polygon 
is drawn in the drawing window) and when it is finished, the elements which 
are inside it are selected so you can work on them.

The following image shows how a selection option is input.

The following figure shows the definition of the selection polygon in the graphic 
area.

When the polygon is finished, the elements contained inside it will be selected 
so you can work on them.

Selection options 
• Outside rectangle [OR]: This allows you to delimit a rectangular area 

and select the elements which lie outside this area. 
• Inside polygon [IP]: This allows you to draw a polygon area and 

select the elements located inside this area. 
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• Intersects with/Contains polygon [CP]: This allows you to draw a 
polygon area and select all the elements located inside it or which 
intersect with its perimeter. 

• Outside polygon [OP]: This allows you to delimit a polygon area and 
select the elements which lie outside it. 

• Inside circle [IC]: This allows you to delimit a circle and select all the 
elements located inside this area. 

• Intersects with/Contains circle [CC]: This allows you to delimit a 
circle and select all the elements located inside it or which intersect 
with its perimeter. 

• Outside circle [OC]: This allows you to delimit a circle and select the 
elements which lie outside it. 

• Select all: This selects all the elements contained in the layer 
regardless of where they lie in it. 

5.2.7.7 Editing vertex

This tool allows you to go through the vertices of the selected objects easily 
and carry out other actions, such as adding a new vertex or deleting the vertex 
which is being edited.

To access this tool, click on the “Edit vertex” button in the tool bar.

You can also access the tool by going to the “Geometry” menu bar then to 
“Modify” and “Edit vertex”.

To edit the vertices of a figure, select the figure and click on the “Edit vertex” 
button in the tool bar.

A red pointer appears in one of the vertices of the figure you are editing.
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If you right click on the mouse, a menu will appear from which you can select 
the actions you wish to carry out.

If you click on the “Next” option, the cursor will move to the next vertex of the 
selected object.

You can also access this tool from the command console. To do so, write the 
command: EDIT VERTEX.

If, for example, you wish to go through the vertices of an element, write the 
command and input the parameter “S” (next).

To go to the previous vertex, write the parameter “A”.

To delete a vertex write the parameter “E” and press “Enter”.

To add (insert) a vertex, write the parameter “I” and press “Enter”.

The X and Y coordinates of the new vertex will then be requested (remember 
that these coordinates should belong to the polygon perimeter).
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Input the data in the console and press “Enter”.

A new vertex will be created in the figure.

5.2.7.8 Internal polygon

This tool allows you to create a polygonal feature inside an existing feature.

You can access this tool by going to the "Geometry" menu then to "Modify" and 
"Internal polygon”

or from the following tool bar button:

You  can  create  an  internal  polygon,  either  graphically  or  from  the  gvSIG 
command console.

If you wish to create the polygon graphically, the polygon element layer must 
be in editing mode and you must select the polygon on which you wish to use 
the selected tool.

Activate the "Internal polygon" tool and place the cursor where you wish to 
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insert the first vertex.

Then insert the vertices of the polygonal feature you wish to create. When you 
do not wish to insert any more vertices, right click on the mouse and select 
“End” from the contextual menu that appears.

The corresponding internal polygon is created.
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You can also use this  tool  from the command console.  To do so,  write  the 
command “internal polygon” in the command line.

Then input the X and Y coordinates of the points which will correspond to the 
vertices of the new polygonal feature. When you have finished, write “e” to 
close the new internal polygon you have created.

5.2.7.9 Scaling

This command can be used to modify the size of the selected objects. Select 
this tool by clicking on the “Scale” button in the tool bar

or by going to the "Geometry" menu bar then to "Modify" and “Scale”.
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There  are  two  ways  of  scaling,  either  by  indicating  a  scale  factor  or  by 
reference. Scaling by “Scale factor” To graphically scale elements using a scale 
factor, select the objects whose size you wish to modify, activate the scale tool 
and set the base point. The application will create an image which will give you 
a reference point about the size of the objects you are modifying.

As you get closer to the point you have set as the base point, the elements you 
are working with will get smaller, whilst the farther away you move, the bigger 
they will get.

When the objects are the desired size, click on the drawing window again. The 
same scale factor is applied for both the X and Y coordinates.

To  graphically  scale  using  the  "Reference"  option,  select  the  objects  and 
activate the “scale” command, then right click on the mouse inside the graphic 
area to show the tool’s contextual menu.

Select the “Reference” option. Indicate the points on the reference line and on 
the scale line as the messages in the command console are shown.
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You can also use the “scale” command in the command console. When you 
have selected the objects to be scaled, write the command “scale” and then 
input the base point as shown in the following figure.

To increase the  size of  the objects  you must  input  a  scale  factor  which  is 
greater than 1.

If you wish to reduce the size of the objects, the scale factor must be between 
0 and 1.

If no value is input, gvSIG will use the scale factor 2 by default.

Scaling by “Reference” If you wish to scale using the "Reference" option, select 
the elements you wish to scale, choose the base point, then input the letter "r" 
into the command console to indicate that scaling by reference will be used.

Specify the source point and the final point of the reference straight line and 
then input the source point and final point of the scale line.
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5.2.7.10 Explode

This tool is used to split a polyline into different segments.

To split a polyline, start editing the line layer and select the polyline:
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Polyline selection

Once the polyline has been selected, activate the  explode tool  to split  the 
polyine into segments. Verify that each of the segments can be selected as a 
line instead of as a poyline.

Explode button

5.2.7.11 Join geometries

The Join tool combines two or more geometries from the same polygon or line 
layer into a single multipolygon or multiline geometry. The tool can't be used 
with point layers as this would create a multipoint shape, which is already a 
shape-independent type.

In order to use the tool the layer must be in edit mode. Use the Edit Selection 
tool to select the geometries to be joined, making use of the Ctrl key to select 
multiple geometries.
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Selecting geometries to be joined

Once the geometries have been selected click the  Join  tool  to join  the 
geometries  into  a  single  record  in  the  table.  It  should  be  noted  that  the 
attributes of the geometry with the higher value 'Id' will be retained, i.e. the 
one that is drawn last.
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Example showing the result of the Join tool

5.2.7.12 Split geometries

This tool splits geometries from the same layer. To perform the division, first 
switch the layer to edit mode and then use the selection tool  to select the 
geometry to be split.

The "Split geometries"  tool can be found on the editing toolbar.

Once the geometry has been selected,
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Selecting the geometry

click on the Split geometries icon. In the command window at the bottom the 
following message appears: "Insert first point." To split the geometry, draw a 
line where it should be divided. This is done by inserting a series of points that 
define the line along which the division is performed.
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Splitting the geometry

Double-click to finish digitising the line and to perform the split. Then use the 
selection tool to verify that the geometry has been split into different parts.
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Result

The split operation results in the creation of separate records for each part in 
the attribute table, rather than the single record that existed prior to the split.

5.2.7.13 Matrix

The matrix command allows an item to be copied as many times as desired in 
a particular arrangement. The matrix can be of two types: rectangular matrix 
or polar matrix.

Right-click the layer you want to work with and select Start editing. Select an 
item, either a point, line or polygon, and then click on the Matrix tool. In the 
command  window  at  the  bottom of  the  screen  the  following  instruction  is 
displayed: Insert selection point. Clicking on the item opens the Matrix window.
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Matrix Window

Select the number of rows and columns by typing the values directly into the 
appropriate boxes.

The linear arrangement of the elements can be defined by typing the values 

manually, or by using the   and   icons to draw a direction vector or to 
define the extent of  the matrix,  respectively.  In the second case, there are 
icons for defining the extent for each axis.

The matrix can be rotated by manually entering a rotation value or by clicking 

the  icon and drawing the rotation angle in the View.

Using  the  values  defined  in  the  Matrix  Window shown in  the  image above 
would produce the following matrix:
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Final result showing the rectangular matrix

In the case of a polar matrix enter the source of the "system", the number of 
elements and whether the items should be rotated as they are copied.
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Final result showing the polar matrix

5.2.7.14 Copy & paste geometries

5.2.7.14.1 Introduction

Using the copy/paste tools you can copy and paste geometries from one layer 
to another. These layers may be in the same view, in different views, or even in 
two different instances of gvSIG.

5.2.7.14.2 Copy & paste geometries

Links  have  been  created  to  complimentary  tools  for  copying  and  pasting 
features between vector layers of the same type.

As  the  mechanism  used  to  implement  this  tool  makes  use  of  the  system 
clipboard, the source and destination layers can be either in the same view, in 
different views, or even in different instances of the application.

Copy items between layers with the editing session active.

This  tool  is  used to copy features selected in  a vector  layer to the system 
clipboard.

The tool can be accessed in three different ways:

Through a button on the toolbar:
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Through the Layer menu in the menu bar:

Through the context  menu that appears  when you right-click  on the active 
layer in the TOC:

This tool will be displayed and activated when the active layer is a vector layer 
with selected features.
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Paste features.

This  tool  is  used to  paste to  paste to  an editable  layer features  that  have 
previously been copied to the system clipboard.

The tool can be accessed in three different ways:

Through a button on the toolbar:

Through the Layer menu in the menu bar:

Through the context  menu that  appears when you right-click on the active 
layer in the TOC:

This tool will be displayed and activated when the active layer is a vector layer 
in edit mode and of the same type as the layer from which the features have 
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been  copied.  When  used  to  paste  geometries  from  the  clipboard  to  this 
editable layer, fields in the associated table will be filled if they have matching 
names and types.

5.2.8 Drawing commands (points, lines...)

5.2.8.1 Introduction

This section deals with gvSIG’s drawing commands. The rest of the commands 
can modify the elements but with the exception of the “copy” command, they 
cannot create new features and we thus require the actual drawing commands 
to do so.

gvSIG  includes  basic  drawing  elements,  such  as  lines,  circles  or  polygons, 
which can be used to obtain any complex drawings.

All the elements you wish to insert need one or several points to be specified 
so that they are correctly placed in the drawing.

Remember that the tools to insert new elements vary according to the type of 
layer being edited. Thus, for example, a point can only be inserted in a point-
type layer and is not supported by any other type of layer.

5.2.8.2 Point

You can activate this tool by clicking on the “Point” button in the tool bar.

You can also activate it by going to the “Geometry” menu bar then to “Insert” 
and “Point”.
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5.2.8.3 Inserting a coordinate point

A point can be referenced in two ways:

• Console mode. The point coordinates are input numerically. 
• Graphic mode. The point is indicated by using any of the pointer devices 

(normally a mouse). 

The coordinates can also be:

• Absolute: They define a point based on the coordinate source (0,0). 
• Relative: They define a point based on the last defined point. 

Inputting Cartesian coordinates.

Input  the X and Y values separated by a comma (X,Y).  The X value is  the 
positive or negative distance, in units along the horizontal axis, the Y value is 
the distance in units along the vertical axis.

The values used to designate the points can be whole,  decimal,  positive or 
negative.

The absolute coordinate values are based on the source (0,0), which is the 
place the X and Y axes intersect. For example, the point 25,7 designates a 
point located 25 units away from the source on the X axis and 7 units away on 
the Y axis.

The relative values of the coordinates are based on the last input point. Use 
the relative coordinates when you know the coordinates of a point based on 
the previous point.

To designate a relative point, place the (@) symbol in front of the coordinates.

For example, the @1,2 coordinates determines a point 1 unit away on the X 
axis and 2 units away on the Y axis from the previously designated point.

Inserting polar coordinates

To input polar coordinates, indicate a distance and an angle separated by the 
< symbol. For example, to designate a point 5 units away from the previous 
one with a 45 degree angle, write @5<45. The angles increase anti-clockwise 
and decrease clockwise. To move anti-clockwise, indicate a negative angle. For 
example, the 1<315 position is the same as the 1<-45 position.
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5.2.8.4 Multipoint

You can activate this tool by clicking on the “Multipoint” button in the tool bar

or by going to the “Geometry” menu bar then to “Insert” and “Multipoint”.

You can use the multipoint tool to create a drawing made up of a series of 
points which function as a single feature (i.e. we only need to select one of the 
points for the rest to also be selected). You need to bear in mind that this is not 
thus a points layer but a multipoint layer.

To insert a multipoint in the graphic area, select the tool and place the cursor 
over the part of the graphic area you wish to place the point. Left click on the 
mouse to insert the point. Repeat this step as many times as you wish. When 
you have finished adding points, right click on the mouse. A contextual menu 
will appear. Click on “End” to finish the new multipoint feature.
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You can create a multipoint feature from the command console. To do so, write 
the command “multipoint”. Input the coordinates of each point you wish to add 
in the console and press “Enter”. To finish the insertion of the new multipoint 
feature, write the command “E”.

5.2.8.5 Line

This command allows you to draw a line feature, which is actually a straight 
line segment. This feature is limited by its initial and final points. The final point 
may be the start of the next segment. When the first point has been inserted 
an elastic line appears on the display. You can use the mouse to determine 
where you wish the final point to go. As with the rest of the editing tools, there 
are three ways to access line creation. You can go to the edition tool bar and 
click on the “Line” button

or go to the “Geometry” menu bar then to “Insert” and “Line”.
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Place the cursor  inside  the graphic  area and insert  the line vertices  in  the 
desired points. gvSIG will create a projection from the last inserted point to the 
mouse pointer which you can use as a reference point to set the points in the 
drawing.  You  can  also  draw  a  line  from  the  command  console.  Write  the 
command “line”  and then input  the coordinates  to  define  the points  which 
delimit the segments which make up the line.

You can also insert the second and/or successive points by defining a distance 
and an angle. For example, to insert a point 1 unit away from the previous 
point at a 45º angle, write 1<45. The following image shows how a third point 
is inserted, after inserting the first and second points, one unit away from the 
previous point at a 180º angle.
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5.2.8.6 Arc

You can draw an arc by clicking on the “Arc” button in the tool bar

or by going to the “Geometry” menu bar then to “Insert” and “Arc”.

Three points are requested to draw an arc. The first and last points mark the 
initial and final points of the arc and the second one marks an intermediate 
point through which the hypothetic circle of which the arc is a part would pass. 
To insert an arc from the command console, write the command “arc”. The 
three points required to define the arc will be requested one after another.
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5.2.8.7 Polyline

This feature can be a set of arcs and/or segments combined by the user. You 
can draw a polyline by selecting the tool from the edition tool bar and clicking 
on the “Polyline” button

or by going to the “Geometry” menu bar then to “Insert” and “Polyline”.
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The polyline allows you to insert straight lines in the graphic area, but these 
differ from standard lines in that they allow you to insert an arc from the last 
vertex, to which it will always be located at a tangent, and end the polyline 
thus creating a polygon. Click on the graphic area in the place you wish the 
first point of the polyline to be located and insert the following points by left 
clicking on the mouse in the places you wish to locate them. If you wish to 
draw an arc, right click on the mouse and select the “Internal arc” option in the 
contextual menu.

When this option has been selected, gvSIG shows a projection of an arc from 
the last inserted vertex to the mouse pointer.

If you wish to insert more lines, go back to the contextual menu and select the 
“Internal line” option.

If you wish to close the figure so that a straight line is drawn from the last 
inserted point to the first point, select the “Close polyline” option.

To draw a polyline from the command console, write the command “polyline”. 
Input the coordinates of the source point. Then you can insert the second point 
or input one of the parameters to draw an arc “A”, or close the polyline “C”. 
When you have selected the arc option, you can draw more straight lines using 
the  parameter  “N”.  The  following  image  shows  how  the  polyline  draws  a 
straight line from the arc's last vertex to the source, thus creating a closed 
figure after inputting the parameter “C”.
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5.2.8.8 Polygon

This option allows you to draw regular polygons which will  be handled as a 
closed  polyline.  As  usual,  there  are  three  ways  of  activating  the  polygon 
command. You can select this tool by going to the tool bar and clicking on the 
"Polygon" button.

The second option way of activating the tool is by going to the “Geometry” 
menu bar then to “Insert” and “Polygon”.
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To graphically insert a polygon in the drawing, select the tool and then click 
inside the graphic area on the place you which to position the polygon’s central 
point.

The application will generate a projection of the object. Move the mouse using 
the polygon projection as a reference point until it is the size you require, and 
click on the graphic area once again.

You can tell gvSIG if you wish the polygon you are drawing to be defined as 
inscribed  or  circumscribed  in  the  circle.  By  default,  the  polygon  will  be 
inscribed in the circle. To modify this setting, define the central point of the 
polygon, right click on the mouse to open the contextual menu and select the 
desired option.

gvSIG also allows you to modify the number of sides you wish the polygon you 
are editing to have. To do so, select the polygon object and input the number 
of sides in the command console.
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The third  way to select  this  tool  is  from the command console.  To draw a 
polygon from the command console, write the command “polygon”, specify the 
number of sides you wish the polygon to have, whether it should be drawn as 
inscribed  or  circumscribed  (“I”  or  “C”  respectively),  and  finally  insert  the 
radius, which must be delimited by indicating its length in the units in which 
the view is defined.

5.2.8.9 Rectangle

This  allows  you  to  draw  a  rectangle  by  indicating  its  diagonally  opposite 
vertices. Click on the “Rectangle” button in the tool bar.

You can also select the tool  by going to the “Geometry” menu bar then to 
“Insert” and “Rectangle”.
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To graphically draw a rectangle in the layer you are editing, select the tool and 
place  the  first  vertex  in  the  required  position  in  the  graphic  area.  The 
application will show a projection of the rectangle you are drawing. Move the 
mouse, choose the position for the vertex diagonally opposite the one you have 
already inserted and left click on the mouse to define it.

To work with the command console write the command “rectangle” and then 
input the coordinates for the first vertex and the diagonally opposite vertex.
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5.2.8.10 Square

A square is simply a rectangle with equal sides. To prevent possible mistakes 
when drawing the square, the application allows you to create a square based 
on a rectangle and makes it have equal sides. To draw a square, first select 
“Rectangle” and insert the first vertex, then right click on the mouse and click 
on the “Square” option (“Corner”) in the contextual menu.
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The following figure shows an example of the creation of a square from the 
command console. After the first point of the rectangle has been input, gvSIG is 
told to make the figure become a square by inputting the letter “C”. You can 
then insert the opposite corner.

If you make a mistake in inputting the coordinates the application will still draw 
a  square  by  calculating  the  size  of  the  vertical  line  (Y  axis),  using  the 
coordinate specified for the X axis.

5.2.8.11 Circle

This command draws a circle inside the graphic area. You can select this tool 
by clicking on the “Circle” button in the tool bar

or  by  going  to  the  “Geometry”  menu bar  then to  “Insert”  and “Circle”,  as 
shown in the figure below.
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There are two ways of defining a circle. The first option is to define the central 
point and the radius. Select the “Circle” tool and click on the graphic area in 
the place you wish to locate the centre of the circle you are drawing. Then 
move  the  mouse  to  increase  the  radius  of  the  circle  until  it  reaches  the 
required  size.  gvSIG  will,  as  always,  create  a  projection  of  the  circle  as  a 
reference point to show the position of the circle in the drawing. The second 
way of drawing a circle in gvSIG is to define it by using three points. To access 
this option to define a circle, first select the tool and then go to the contextual 
menu by right clicking on the mouse in the graphic area.

There is only one circle that goes through three given points. When you use 
this option an elastic circle appears. It is defined by these two points and the 
cursor until we define the third point, as shown in the figure below.

You  can  also  draw  a  circle  from  the  command  console  using  any  of  the 
methods described above for graphic drawing. Write the command “circle” in 
the command console and press “Enter”. Insert the coordinates of the central 
point and then the coordinates of the point that will mark the desired radius or 
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length (use the status  bar to check whether you are working in  metres  or 
another measuring unit).

To insert a circle from the command console by defining three points, write 
“3p” when the “circle” command has been activated. When you use this option 
an elastic circle appears. It is defined by these two points and the cursor until 
we define the third point, as with the case of the graphic drawing of the circle. 
The figure below shows how to create a three-point circle.
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5.2.8.12 Ellipse

An ellipse is defined by an axis and the length of the second axis to the centre 
of the ellipse. There are, as always, three ways of selecting the ellipse drawing 
tool. To graphically draw an ellipse you can click on the “Ellipse” button in the 
edition tool bar.

The second option is by going to the “Geometry” menu bar then to “Insert” and 
“Ellipse”.

To  graphically  draw  an  ellipse,  indicate  the  initial  and  final  points  of  the 
ellipse’s axis by left clicking on the mouse in the corresponding places. When 
the initial point has been input an elastic line will be shown which can be used 
as a reference point to mark the final point of the axis. When it has been set 
the  ellipse  projection  will  be  shown  until  the  third  point  which  marks  the 
distance to the other axis is defined.
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To draw an ellipse from the command console, write the command "ellipse". 
When gvSIG requests the initial  point  of  the ellipse axis,  indicate the point 
coordinates.  It  will  then  request  the  final  point  of  the  axis  and  finally  the 
distance to the other axis.

5.2.8.13 Autopolygon

This tool is useful for drawing polygons adjacent to existing ones, thus avoiding 
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having to digitise all the vertices along the common boundary between the 
polygons.

Therefore it it only necessary to digitise the new sides of the polygon; the tool 
will automatically generate the common boundaries.

Apart from saving digitising or drawing time, this tool also eliminates overlaps 
and gaps between two polygons sharing a common boundary.

To use the tool first start editing the layer you wish to work with, and then 

activate the Autocomplete polygons icon .

Example of use of the tool

The new polygon can now be drawn without having to digitise the nodes of 
common boundaries, as shown in the figure below.

July 2011 Page 372 of 655



Example of use of the tool

Once all sides have been drawn, double-click the mouse or press "E" (end) to 
terminate the polygon. The figure below shows how the new polygon has been 
clipped to the common boundaries of the existing polygons.
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Example of use of the tool

5.2.9 Creating a new layer

5.2.9.1 Introduction

gvSIG can create a new layer in the following formats: shp, dxf and postgis.

The tool can be accessed from the “View / New Layer” menu.
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5.2.9.2 Creating a new SHP file

Select the “New SHP” option opens the wizard which will help you create the 
new layer.

The first window of the wizard allows you to choose the name you wish the new 
.shp file to appear with in the ToC, in addition to the geometry type associated 
with it.
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The second window of the wizard allows you to add all the fields you wish to 
the  attribute  table  associated  with  the  layer  and  to  define  some  of  the 
properties of these fields.

To add fields to the table, click on “Add field”. One field is added every time 
you click on this button.

If you wish to delete any of the fields created, simply select the field and click 
on the “Delete Field” button. You can edit the rest of the properties from the 
attribute table in which the fields are defined.

Field name: Place the cursor over the field name (“New field” by default) and 
write the new name. The maximum number of characters allowed for the field 
name is 10.

Field type: Place the cursor over any of the files in the “Type” field. A pull-
down menu appears in which the type of field you wish to create can be 
selected. 

• BOOLEAN: Boolean type data admits “true” or “false” values. 
• DATE: This allows you to create a field which includes dates. The 

maximum number of characters allowed is 8. 
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• INTEGER and DOUBLE are two number type fields. The former is 
for whole numbers and the latter for decimal values. 

• STRING: This is an alphanumeric field type. The maximum number 
of characters allowed is 254. 

Field length: This allows you to set the maximum number of characters for 
the field created (at present, this only applies to String-type fields).

Once  the  structure  of  the  table  associated  with  the  shape  file  has  been 
determined, click on “Next”.

You can save the file in the new window and choose the Reference System for 
the view the new layer is going to be inserted into by clicking on the button to 
the right of “Current Projection”.
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If other layers have been inserted in the view, this button will be disabled since 
the view already has a selected reference system.

To save the new layer, indicate the file path to save the file in the text box.
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You can also open the search dialogue box to select the file  path the new 
shape file will be saved in. To do so, click on the button to the right of the text 
box. Write the name for the new layer (remember that this name will appear in 
the source file of the shape file and that it may be different to the name which 
appears in the ToC) and click on the “Save” button.

When you have finished creating a new SHP file, it will be added to the ToC.

In  addition,  the  editing  tools  will  be  activated  to  allow  you  to  create  the 
elements of the new layer.

5.2.9.3 Creating a new dxf file

The procedure to create a new DXF file is similar to that used to create a new 
SHP file, as described in the previous section. This tool can be accessed from 
the “View/New layer/New dxf” menu.

If this tool is selected, the wizard will open a window allowing you to select a 
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path for the file which is going to create a reference system for the view.

5.2.9.4 Creating a new PostGIS file

If you wish to create a new PostGIS file, go to the menu “View/New layer/New 
PostGIS”.
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The initial steps to create a new PostGIS file are similar to those followed in the 
section on creating a new Shape file.

The difference lies in the way the new layer is saved, as this is entered into a 
PostGIS data base.

Fill in the fields which apply to your connection and click on “Finish”.
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5.3 Alphanumeric editing

5.3.1 Introduction 

A table is part of a data base. It is made up of rows or records and columns or 
fields which contain the alphanumeric information needed to characterise the 
elements  (polygons,  lines  or  points)  which  make  up  the  theme  maps, 
cartography in general  and graphs. The rows represent elements or objects 
and the columns represent the variables or  attributes  associated with each 
element.

In general  terms, there are two types of  tables;  “internal” tables which are 
typical of an information layer and are found in the same file and “external” 
tables which can be added to a gvSIG project.  Each element (point,  line or 
polygon) of a layer only has one record in that layer’s table of attributes.
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5.3.2 Editing session for an 'internal' table. 

Open a “View” and add the layer you wish to work with.

Remember that to start an alphanumeric editing process in gvSIG, you must 
put the layer you are working with in editing mode. In order to do this, select 
the layer in the ToC, go to the “Layer” menu and select “Start edition”. Select 
the “See table of attributes” button

or go to the “Layer” menu and select “See table of attributes”.

The table associated with the layer will be automatically added to the project.

If you go to the “Project Manager” and select the “Tables” type of document, 
you can check that  the table  shown in  the view is  included as  a  separate 
document in the project.

To finish the table editing session, go to the “Layer” menu and select “Finish 
edition”. When the session finishes a message appears asking if you would like 
to save the changes. Click on “Yes” to save all the changes made in the table.

5.3.3 Editing session for an 'external' table.

1. Go to the gvSIG’s  “Project  Manager”,  and select  the “Tables” type of 
document. 

2. Click on “New”. 
3. Click on “Add” and open the table you wish to edit. 
4. When you click on “Open” the table is displayed automatically on the 

screen. 
5. Go to the “Table” menu and select “Start edition”. 
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5.3.4 Managing fields

This tool allows you to add, delete or rename fields. To access this tool, go to 
the “Table” menu and select “Manage fields”.

(An error occurs when you try to change the structure of a table hosted in a 
postgresql data base above version 7.4. To modify the structure, use a suitable 
data base manager).
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When the menu option is selected, a window appears in which the fields of the 
selected table and the buttons to create a new field or delete or rename an 
existing field are included.

If  you  click  on  “New  field”,  a  new  window  appears  in  which  some  of  the 
properties of the new field to be added to the table can be configured.
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Field name: Enter the name of the new field. Type: If you click on the arrow 
on the right, a pull-down menu appears in which the type of field data (string, 
double...) can be configured.

Length: Indicate the required length of the field. (The max. length of a string 
field is 254 charecters).

Precision: Indicates the number of decimals a numerical field must have (only 
for numerical type fields).

Default value: Indicates the default value for the field when no specific value 
is defined in the table.

If  you  wish  to  use  the  delete  tool  (“Delete  field”)  and  the  renaming  tool 
(“Rename  field”),  simply  select  the  field  to  be  modified  and  click  on  the 
corresponding button.

5.3.5 Editing a layer's table of attributes 

5.3.5.1 Adding a record

To add a new record to a table associated with a layer, a graphic element must 
be inserted. When an element is added to the associated table a new blank 
record appears.
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Enter the data for the new entity and press “Enter”.

N.B.: Remember that if you wish to delete the selection, you can go to the tool 
bar and click on “Clear selection” or you can use the menu bar by clicking on 
the “Layer” menu and then on “Clear selection”.

N.B.: You can create a new layer with the elements selected in the table if you 
wish. To do so, close the table, go to the menu bar and click on the “Layer” 
option and then on “Export to ...”. Then select the format you wish to create 
the new layer with.

5.3.5.2 Modifying a record

To modify the data of a layer element saved in the table, select the element 
whose data you wish to modify. The record that corresponds to the selected 
graphic element is highlighted in yellow in the table of attributes.

Left click on the cell in which the record to be modified is located. The record 
changes and a cursor appears to indicate that the data can be input.

5.3.5.3 Removing a record

To remove a record from the table, you must first select the record.
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Go to the “Table” menu and select “Remove row”.

The  selected  record  is  deleted  from  the  table  and  the  associated  graphic 
element disappears from the view.
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5.3.6 Field Calculator

5.3.6.1 Introduction

gvSIG’s field calculator allows you to perform different types of calculations on 
the fields of a table (for example calculate areas, perimeters, convert the data 
in a field from degrees to radians, etc).

5.3.6.2 Accessing gvSIG's field calculator

To access the field calculator, you must first start an editing session in gvSIG. If 
you wish to activate the edition of a layer loaded in a view, go to the layer’s 
contextual menu and select “Start edition”.

If you wish to edit a recently-loaded table, go to the “Table” menu and select 
“Start edition”.
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If you decide to use the field calculator on a “New layer” (for example New shp) 
which you are going to create (remember that to access this option you must 
go  to  the  “View”  menu  and  select  the  “New  layer”  option),  the  layer  will 
automatically appear in editing mode when inserted in the view.

Once you have started an editing session, activate the table of attributes on 
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which the operations are going to be performed and select one of the fields (by 
clicking on the field heading). The following button will then be activated in the 
tool bar:

This will allow you to access the field calculator.

NB.  The first  time you open the field  calculator  in  a  new gvSIG  session,  a 
warning  window  appears  to  inform  you  that  the  calculator  is  “Loading 
operators”.  Once this process has finished, the window which allows you to 
perform operations with the various fields appears.

5.3.6.3 Introduction example

“Field calculator”  Let us look at a simple example to explain how the field 
calculator works.

In order to work out the area of a series of plots in a layer we have created:

First, open a gvSIG view and load an orthophoto which will be used as a base to 
determine the location of the plots. Next, select the tool in order to create a 
new shp file (View/New layer/SHP).

Select a “Polygon” type layer, click on the “Next” option and then create a 
“Double” type field called “Area”, leaving the default value at 20.

Draw four plots on the orthophoto using the “Insert polyline” tool selected from 
the tool bar. The image below shows that a record for each of the plots has 
been created in the table.
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Select the field from the table and activate the field calculator.
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The following information appears in the “General” tab:

“Field”.  This  contains  the  various  different  fields  which  comprise  the  table 
being worked on.

“Type” of field selected. Access to different commands depends on the type of 
field.

“Commands” which can be used in the calculations.

The “Information” section shows that:

If  the  “area”  command  has  been  selected  in  the  “General”  tab,  a  brief 
description will be displayed in the information window.
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If the “area” command has been selected in the “General” tab, the information 
window returns a message with information on the field type (remember that 
when designing the “area” shape, a Double type numeric field was created in 
which the area will be calculated).

The  “Expression"  area  displays  the  name  of  the  column  on  which  the 
calculation is being performed and a text box for the calculation sentence to be 
used.

In  this  case,  the sentence included  in  the  expression section  is  simple (no 
parameters  are  required  as  they  are  in  other  expressions  which  shall  be 
explained later on).

To sum up and conclude this example, once the “area” command has been 
selected, click on “Ok” and the field created in the table will automatically be 
filled with the area values of each of the polygons drawn.
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5.3.6.4 Description of the 'Field Calculator'

The field calculator window has three different sections.

5.3.6.4.1 Information

The Information section provides information about the type of field and the 
commands selected in the “General” tab.

The following information can be found in this section:

• “Operator" = This indicates the command selected and the expression 
which allows it to be executed. 
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Example: In this case the command we wish to use is “log”, which allows us to 
calculate the logarithm of a field with a numerical value.

The  “log  (Parameter)” operator  indicates  that,  for  example,  in  order  to 
obtain the logarithm of a field which contains the area data of a plot shp, the 
word  “Parameter” must  be  replaced  by  the  field  we  wish  to  obtain  the 
logarithm of. As a result, the expression will be as follows: log([AREA])

• "Parameter" = This can be one of three different field types which must 
be entered in the expression box in order to perform the calculation.

• Numerical value: a String, Double or integer type field must be 
entered. 

• String value: A String type field must be entered. 
• Date value: A date type field must be entered. 

NB. If a table field is selected in the “Field” section of the field calculator, the 
information window indicates what type of data it is.

NB. In order to input parameters into the “Expression” text box, either double 
click on the name of the field from the list of fields in the General tab or type in 
the  name of  the  field,  in  which  case the String  expressions  input  must  be 
placed in inverted commas.
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• "Return" = This indicates the type of data obtained as a result of the 
calculations. 

Numerical Value = The result must be String, Double or integer type field data.

NB. If a String field type has been selected, it should be noted that this field 
type uses string values. If we add two String fields to another String field, the 
final result is a string and not the result of the operation (for example: 2+2 = 
22, not 4).

Boolean Value = A Boolean value returns a true/false answer to a question. If 
the result of the question is in a numerical field, it would therefore be either 
“1/0”  depending on whether the reply  was true or  false.  Let us look at  an 
example:

We wish to know if there are records in a field which are the same as those in 
another field. The command which allows us to find this out “==”

If we type the following sentence: [integer] == [double] (double and integer 
being  the  names  of  two  fields,  each  with  numerical  values),  the  response 
according to the type of target field (Boolean or String) can be seen in the 
image below:

• Date Value: The result must be in a Date type field. 

NB. If a new layer is created in a gvSIG view (View menu / New layer), the 
wizard  for  this  action  allows  you  to  specify  the  “Type  of  field”  on  which 
calculations are going to be performed.
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If you are working with a layer and wish to know the field type, simply start a 
layer editing session, go to the “Table” menu and select “Manage fields”.
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This opens a window called the “Field manager”, which allows the fields of a 
table to be created, renamed or deleted. It can also be used to confirm the field 
type.
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5.3.6.4.2 General / Advanced Tabs

• General: This provides information about:
• "Fields": The text box shows all the fields of the table being worked 

on. 
• "Type":  Access  to  commands  depends  on  which  check  box  is 

activated. 
• "Commands": These are the operators which allow expressions to 

be constructed to perform the calculations required. 
• Advanced: A search box may be opened to look for an expression saved 

in a file. 
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Once the file  has been selected, click on the “Evaluate” button to find out 
whether the expression is correct or not.

NB. The expressions must be written in Python programming language.

5.3.6.4.3 'Expression' Section

The name of the field the results of the calculations of the expressions entered 
in the text box appear in is next to the “Column” text.

NB. The expressions are only calculated on the records selected in the table (if 
no records have been selected, the calculation is performed on all the records 
in the selected field).

5.3.6.5 Introductory example: 'Field Calculator'

“Field calculator”  Let us look at a simple example to explain how the field 
calculator works.

In order to work out the area of a series of plots in a layer we have created:

First, open a gvSIG view and load an orthophoto which will be used as a base to 
determine the location of the plots. Next, select the tool in order to create a 
new shp file (View/New layer/SHP).

Select a “Polygon” type layer, click on the “Next” option and then create a 
“Double” type field called “Area”, leaving the default value at 20.
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Draw four plots on the orthophoto using the “Insert polyline” tool selected from 
the tool bar. The image below shows that a record for each of the plots has 
been created in the table.
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Select the field from the table and activate the field calculator.
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The following information appears in the “General” tab:

“Field”.  This  contains  the  various  different  fields  which  comprise  the  table 
being worked on.

“Type” of field selected. Access to different commands depends on the type of 
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field.

“Commands” which can be used in the calculations.

The “Information” section shows that:

If  the  “area”  command  has  been  selected  in  the  “General”  tab,  a  brief 
description will be displayed in the information window.

If the “area” command has been selected in the “General” tab, the information 
window returns a message with information on the field type (remember that 
when designing the “area” shape, a Double type numeric field was created in 
which the area will be calculated).

The  “Expression"  area  displays  the  name  of  the  column  on  which  the 
calculation is being performed and a text box for the calculation sentence to be 
used.

In  this  case,  the  sentence included in  the expression  section  is  simple  (no 
parameters  are  required  as  they  are  in  other  expressions  which  shall  be 
explained later on).

To sum up and conclude this example, once the “area” command has been 
selected, click on “Ok” and the field created in the table will automatically be 
filled with the area values of each of the polygons drawn.
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5.3.6.6 Add consecutive numbers

5.3.6.6.1 Introduction

This functionality makes it easy to populate a field in a table with consecutive 
numbers by means of a mathematical function (REC) in the field calculator.

5.3.6.6.2 Enter row numbers in a field

This new functionality has been introduced to facilitate the task of filling a field 
in a table with consecutive numbers by means of a mathematical function in 
the field calculator.

This  function  is  typically  used for  the "ID" field of  a layer's  geometries.  To 
access it you need to activate edit mode for the layer and then open the table. 
Select the field (of type Integer) to which you want to add consecutive numbers 
and click on the field calculator.

Calculator button

Select the numeric type option and then double-click the "rec" command, as 
shown in the figure below.
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Rec function (consecutive numbering)

Once the process is complete the selected field in the table will be filled with 
consecutive numbers, starting with the number "0".  Finish editing and save 
changes if desired.

5.3.7 Import fields from one table to another

The  "Import fields" tool is used to import fields from one table to another. 
Both tables must have a common field.

In order to access the tool from the Table / Import fields menu, first open the 
table into which the fields are to be imported.
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Menu path to the tool

Clicking on "Import fields" opens the following dialog:
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Tool dialog

Follow these steps to perform the import:

• First specify the table on which to do the import. The drop-down list only 
shows the table that is active. 

• Then enter the field on which to make the join. This is a field that both 
tables have in common. 

• Next indicate the table to be imported. 
• Finally indicate the common field in this second table that will be used to 

perform the import. 

Click the "Next" button and from the dialog shown below select the fields to 
import.
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Final step of the tool

Click  on the  "Finish"  button  and check  that  the  imported  fields  have been 
added to the end of the active table.

5.3.8 Add geometric information to a layer

In  gvSIG,  the  Add geometric  info tool  is  available  when there are visible 
vector layers in the active View.

Icons

Icon Description

Add geometric info tool enabled if there are visible vector layers in the 
current view.

Add geometric info tool disabled if there are no visible vector layers in 
the current view.

With this  tool  you can select  which  geometric  properties  to calculate for  a 
visible vector layer in the current view, and then save these properties in the 
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layer itself. The information can be saved in either new or existing fields in the 
layer's attribute table.

Once the above condition is met (i.e. a visible vector layer in the active View), 
the tool is available:

Via the menu: Layer → Add geometric info

Selecting the Add geometric info tool from the menu

Selecting the tool displays a dialog where the attributes to be added can be 
selected:

Add geometric information

1. Drop-down list for selecting vector layers. Lists the layers in the order 
that they appear in the TOC of the active view. The following information is 
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shown:

• Postion of the layer in the TOC: displays various icons such as the layer 
grouping icon . The last icon always indicates a vector layer. 

• Name of the layer. 
• Type  of  geometry  of  the  layer:  five  types  of  layer  geometries  are 

supported: point, line, polygon, multipoint, and multi (which may contain 
any of the above). 

2. Layer information writable. Indicates whether changes can be saved to 
the selected layer:

Icons

Icon Mode

Yes, changes can be saved. In this case the attributes to be added can be 
selected.

No, changes can't be saved. The tool will not list any attributes.

3. List of geometric attributes. List of attributes of the geometry of the 
layer. These depend on the type of layer:

• Point layer:
• X coordinate 
• Y coordinate 
• Z coordinate 

• Line layer:
• Length of the line 

• Polygon layer:
• Perimeter of the polygon 
• Area of the polygon 

• Multipoint Layer:
• Number of points that make up the geometry 

• Multi geometry layers: any of the above. 

The geometric attribute will be associated with one type of geometry, which is 
identified by the icon on the left:

Icons

Icon Geometry type

The attribute is characteristic of point geometries.

The attribute is characteristic of multipoint geometries.
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The attribute is characteristic of line geometries.

The attribute is characteristic of polygon geometries.

4. Selection buttons. Allow attributes to be added to, or removed from, the 
list of geometry attributes to be calculated and saved for the vector layer.

Icons

Icon Option

Add all the geometric attributes to the list.

Add the selected geometric attributes to the list.

Remove the selected geometric attributes from the list.

Remove all the geometric attributes from the list.

5. List of added geometric attributes. List of layer geometry attributes to 
be calculated and added.

Clicking on any of the attributes in this list enables the controls that allow the 
field to be renamed.

6. New field. This checkbox indicates whether the attribute is added as a new 
field, or as an update to an existing field in the vector layer.

 By default, every attribute is added as a new field.

7. Field name. New fields can have any name. Otherwise, select a field to 
update.

 The length of the field names is limited.

 It is possible that the layer's alphanumeric encoding does not support some 
characters of the current language.

8. Save field settings. If  the checkbox field is changed, or if another field 
name is specified, the changes can be saved by pressing this button.
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Add geometric information

9.  Reset. Resets  the  dialog  by  reloading  the  current  View's  visible  vector 
layers, and by removing any selected attributes and their settings.

Once all the attributes have been selected, click the Ok button to start the 
process and display a progress bar.

Clicking the Cancel button, on the other hand, will terminate the tool.

Progress of the Add geometric information process
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1. Progress bar: percentage of process completed. 
2. Show/Hide Details: show or hide the steps that have been completed. 
3. Cancel: Stops the process. 

In  the  event  of  a  serious  problem,  the  process  is  terminated and an error 
message is displayed:

Error message

If the process completes successfully, the Accept button is enabled and the tool 
can be closed.

It  is  possible  to  view the  steps  that  were  performed by  clicking  the  Show 
Details button in the dialog:

List of steps performed in adding geometric information

 Do not use the gvSIG interface while the process is in progress as this can  
produce inconsistent data states, and even errors.

 It should be noted that gvSIG currently adds the areas and perimeters of  
islands to that of the surrounding geometry.

EXAMPLE

Following the steps described in paragraph 5:

• A gvSIG project containing a view with a vector layer is loaded. 
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• The Add geometric information tool is loaded. 
• The  layer  contains  polygons  so  Area  and  Perimeter  attributes  are 

available. 
• These  two  attributes  are  added  as  new  fields  with  default  names 

(Because of  the shape encoding support the process removes accents 
and any occurrences of characters such as ç, Ç, ñ, Ñ). 

• Click the OK button. 
• Start and end the process successfully. Attributes are added as new fields 

in the selected vector layer. 
• Click the Accept button to close the progress dialog. 
• Open the layer's attribute table and move the horizontal scroll bar to the 

right to view the newly added attributes. 

Example showing the calculated geometric information
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6 Analysis and data processing

6.1 Vector

6.1.1 Geoprocessing tools

6.1.1.1 Introduction

The gvSIG geoprocessing extension allows you to apply a series of standard 
processes to the vector information layers loaded in the layer tree in a gvSIG 
view (ToC), thus creating new vector information layers which will provide new 
information for the source layers.

The following geoprocesses have been implemented in the first version of the 
geoprocessing extension:

• Buffer. 
• Clip. 
• Dissolve (by adjacents and alphanumerical criteria). 
• Merge 
• Intersection. 
• Join. 
• Spatial Join. 
• Convex Hull (minimum convex polygon). 
• Difference. 

The output layer can take one of the output formats supported by gvSIG (it can 
only be saved in shp format at the moment).

When  some  geoprocessing  tools  are  applied  (for  example,  Clip)  a  window 
appears in which a spatial index can be created for the input layer. This is an 
internal process which is only carried out once per layer and per new project 
and speeds up the spatial intersection processes.

To  create  a  spatial  index  for  the  input  layer  which  can  be  used  by  the 
geoprocesses, click on “Yes”.

6.1.1.2 Accessing the geoprocesses

You can run the geoprocesses available in gvSIG with the geoprocessing wizard 
by clicking on the following tool bar button:

The  “Geoprocess  toolbox”  will  appear  and  you  can  use  it  to  select  the 
geoprocess you require. To access the different geoprocesses, pull down the 
tree in the window shown below (double click with the left button of the mouse 
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on the "Geoprocesses" folder and the rest of the folders will appear).

When you have found the geoprocess you wish to use,  click  on the “Open 
geoprocess” button.
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6.1.1.3 Buffer

6.1.1.3.1 Introduction

This  geoprocess  generates  “areas  of  influence”  around  the  vector  element 
geometries (points, lines and polygons) of an “input layer”, thus creating a new 
polygon vector layer.

Several equidistant concentric radial rings can be generated around the input 
geometries. Moreover,  in the case of  polygon input geometries, the area of 
influence can be outside the polygon, inside the polygon or both inside and 
outside it. Some examples of the creation of areas of influence include:

• Which urban areas lack schools in a 1000m radius. 
• Which wells do not comply with regulations on observing the minimum 

distance between two consecutive wells. 
• River bed flood zones to monitor flood risks. 

6.1.1.3.2 Creating an area of influence or buffer

When you click on the “Geoprocessing wizard” button, the following dialogue 
appears:
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If you select “Buffer” and click on the “Open geoprocess” button, the window 
associated with this process is shown:
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The form is divided into the following parts:

Selecting the elements whose buffer is to be computed. This is a pull-
down list  in  which  you can select  the vector  layer  the calculation  is  to  be 
applied to. If you wish, you can enable the “Use selected features only” check 
box so that the process only computes the buffer of the elements currently 
selected in the specified layer.

Inputting the features of the buffer to be computed. You can choose to 
input the buffer defined by distance (in the first text box) or to input a field in 
the input layer, from which the buffer radius value to be applied will be taken. 
This second option allows you to apply different buffer radii to different vector 
elements (whilst the first option applies the same radius to all the elements in 
the input  layer).  When the buffer  of  all  the input  layer elements  has been 
generated, the “Dissolve features” option allows you to merge the elements 
whose geometries touch each other in a second iteration.

The  “Rectangle  end  cap"  option  allows  you  to  generate  buffers  with 
perpendicular edges (not rounded). Selecting the number of concentric buffers 
and  their  situation  regarding  the  original  geometry.  The  gvSIG  “Buffer” 
geoprocess allows you to generate several equidistant areas of influence of the 
original geometry (for example, if the buffer distance to be applied is 200m and 
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you choose to generate two concentric radial rings, the buffer distance of the 
second ring will  be between 200-400m. Currently,  you can only  generate a 
maximum of three concentric radial buffer rings for efficiency reasons. If the 
vector layer we are working on is a polygon layer, the “Create Buffer…” option 
will be enabled, thus allowing the user to generate buffers outside, inside and 
both inside and outside the original polygon.

Introducing  the  result  layer  characteristics. Currently,  the  result  of 
running a geoprocess can only be saved as an shp file. Thus, gvSIG allows you 
to select an existing shp file to overwrite it or to specify a new one. As new 
formats are supported to save the result of the geoprocesses, wizards will be 
provided to indicate the characteristics of these formats.

When you have input all the necessary information to compute the buffer, and 
clicked on the “Ok” button, a check routine is carried out to ensure that the 
information input is correct: whether the radius distance is numerical, whether 
the attribute from which the buffer radii are taken are numerical, whether a 
result file has been input, etc. If the check routine is not correct, a dialogue box 
appears so that the input data can be corrected.

If  the input  information that  you have entered is  correct,  a window with  a 
progress bar appears, in which the buffer processing rate is shown.

The process can be cancelled at any time by clicking on the “Cancel” button. 
As a consequence, the result file and any other intermediate product generated 
as a result of  running the process are deleted. Whilst the buffer computing 
process is  underway,  other tasks can be carried out,  such as changing the 
zoom or adding new layers to the layer tree in the gvSIG view. Other tasks can 
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be carried out because all the geoprocessing extension geoprocesses are run in 
the background. When the process has finished, the new result layer is added 
to the layer tree in the active view. It is made up of buffer polygons with a 
specified radius based on the source layer.

Finally, the “Dissolve elements” option can be useful in specific situations (such 
as when the aim of computing the buffer polygons is to determine the total 
surface area affected by a phenomenon: quarantine areas, etc.), because when 
the generated polygons are merged the surface area covered by the buffer will 
be a real surface area, i.e. the sum of two buffers will not have any overlays.
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The above image shows non-merged overlay polygons. The total area covered 
by the phenomenon does not coincide with the sum of the individual areas.
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However, this second image shows merged overlay polygons. The total area 
covered  by  the  phenomenon  is  real.  When  the  buffer  computing  process 
includes the merger of  overlay areas (dissolve) we cannot  predict  its  exact 
duration (we do not know how many polygons will touch each other a priori). 
This is why the gvSIG geoprocessing extension does not show us a progress bar 
as such, it shows us a bar which periodically reaches the end and then goes 
back  to  the  beginning.  This  type  of  process  is  called  an  “indeterminate” 
process.
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6.1.1.4 Lateral buffer

Lateral Buffer

Select  "lateral  buffer"  from  the  proximity  geoprocesses  and  click  "Open 
Geoprocess" to show the form related to this geoprocess:

Lateral buffer

The form is divided into the following parts:

1. Selection of elements for which buffers will be calculated. From the 
drop-down  list  select  the  vector  layer  on  which  to  apply  the 
calculation.  Optionally,  select  the  "Use  selected  features  only" 
checkbox  to  restrict  the  calculation  of  buffers  to  the  currently 
selected items in the specified layer. 

2. Definition of the characteristics of the buffers to be calculated. You 
can either enter the buffer distance (in the first text entry box) or 
specify a field in the input layer which contains the buffer distances 
to apply.  This  second option allows you to apply different buffer 
sizes for different vector elements (whereas the first option applies 
the same buffer size to all elements of the input layer). 
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3. Selecting the number of radial buffers and the type of lateral buffer. 
gvSIG's "lateral buffer" geoprocess allows you to generate various 
buffers equidistant from the original geometry (for example, if the 
buffer  distance is  set  at  200  metres  and two radial  buffers  are 
specified,  the  second  buffer  covers  the  distance  of  200  to  400 
metres from the geometry. Currently, for reasons of efficiency, the 
number of concentric radial buffers that can be generated is limited 
to three. Select lateral gives you the option to create the buffer to 
the  right  or  the  left  side  of  the  geometry,  as  defined  by  the 
direction the geometry was digitised. 

4. Details of the result layer. The outputs from this geoprocess can 
only be saved as shp files. For this reason, gvSIG provides options 
for selecting an existing shp file to overwrite,  or for specifying a 
new shp file and path. 

Once all the information necessary to calculate the buffer has been entered 
and the "OK" button is clicked, the input information is checked to verify if it is 
correct.

If the input information is correct, a dialog with a progress bar indicating the 
progress of the calculation of the lateral buffers is displayed.

6.1.1.5 Intersection

6.1.1.5.1 Introduction

This  geoprocess operates on two layers,  the “input  layer” and the “overlay 
layer”, whose geometries must be polygons.



gvSIG Desktop

It  calculates  the  intersection  with  the  different  geometries  in  the  “overlay 
layer” for each geometry in the “input layer”, thus creating a new element for 
each intersection. This element will  take all the alphanumerical attributes in 
the geometries that created it (input and overlay). This is why (it models space 
areas which comply with the condition of belonging to the two polygons that 
created it) this geoprocess is known as “Spatial AND" operator.

An example of how this geoprocess can be applied:

Given a land use layer (e.g. Corine2000), and a national geological map layer, 
you can obtain a polygon layer with homogeneous information on land use and 
geological material.
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6.1.1.5.2 Running the 'Intersection' geoprocess

After selecting the "Intersection" geoprocess, the following dialogue appears:

Select the input layer and the overlay layer. You must also specify a file in 
which to save the results. Finally, click on "Ok" and the geoprocess will be run.

In  this  case,  we  will  use  a  very  simple  example  to  better  understand  the 
function of the geoprocess. The previous figure shows two overlaying polygons. 
The  result  of  launching  the  “Intersection”  geoprocess  with  these  layers  as 
parameters is as follows:
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6.1.1.6 Clipping

6.1.1.6.1 Introduction

This geoprocess allows you to limit the working area of a vector layer (points, 
lines or polygons), and to extract an area of interest from it.

July 2011 Page 430 of 655



To do so, you need an “input layer” (the layer you will use to extract an area) 
and a  “clipping  layer”  so that  the union of  the geometries  included  in  the 
"clipping layer" defines the working area.

The geoprocess checks all the vector elements in the “input layer” and will 
calculate the intersections for the vector elements contained in the working 
area defined by the “clipping layer”, so that in the "result layer" only the vector 
elements  of  our  working  area  will  appear.  The  geometry  portion  that  lies 
outside the working area will be clipped. The alphanumeric schema of the input 
layer remains intact.

Examples of use:

Setting up a local GIS would allow you to include national or regional maps and 
then to delimit the city or town as the working area.

6.1.1.6.2 Running the 'Clipping' geoprocess

When the "Clip" geoprocess has been selected, the following dialogue appears.
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This dialogue allows you to select which layer you wish to clip, and gives you 
the chance to only clip the elements which are selected in the layer.

It  allows  you  to  select  which  layer  will  be  used  as  the  clipping  layer  and 
whether you wish to use the union of all the polygons in the clipping layer as 
the clipping polygon or just the selected elements.

Finally,  as  in  the  case  of  the  other  geoprocesses  in  gvSIG's  geoprocessing 
extension, you can define how the result layer will be saved (at present you 
can only save it as a shp file).
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As a result of running the geoprocess, you will have a new layer in which only 
the geometries which came under the union of the clipping geometries have 
been kept.

6.1.1.7 Dissolve

6.1.1.7.1 Dissolve

This  geoprocess only acts on one “input layer” whose geometry must be a 
polygon  type.  The  process  analyses  each  polygon  in  the  "input  layer"  and 
merges the polygons that have an identical value for a specific field into one 
polygon. Moreover, it allows you to involve spatial criteria in the decision to 
merge several polygons. This allows you to establish that for two polygons to 
be merged, they must be adjacent to each other in addition to having the same 
value in the specified attribute.
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Example: We have a polygon layer which represents the municipalities of a 
particular autonomous region and we need a polygon layer with the provinces 
which make up this region. We can generate a province layer by launching the 
“Dissolve” geoprocess and specifying that the polygons that have the same 
value for the "PROV" field in which a unique code for the province is specified 
are merged.

6.1.1.7.2 Running the 'Dissolve' geoprocess

Using the previous example, we start by taking a "local layer" which we wish to 
convert into a "provincial layer".
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When  the  "Dissolve"  geoprocess  has  been  selected,  the  following  window 
appears:
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Firstly, select the layer you wish to dissolve (you can only work with a selection 
of elements in this layer).

You then need to specify the attribute of this layer which is going to be used as 
the criterion to merge the adjacent polygons. In our example, we must choose 
the “PROV” attribute.
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The  polygons  to  be  merged  must  have  the  same  value  for  the  dissolving 
attribute and in addition, you can choose whether they are adjacent to each 
other  (spatial  criteria).  If  you  wish  to  choose  this  option,  enable  the  "Only 
dissolve adjacents" check box. The gvSIG geoprocessing module allows you to 
keep a summary of the input layer polygon attributes once they have been 
merged.  To do so,  the “Summary function”  concept  is  introduced.  As  each 
polygon  of  the  “Dissolve”  geoprocess  result  layer  is  the  product  of  joining 
several input layer polygons, a summary function on the numerical attributes 
of the merged polygons can be applied.

If you click on the button with the "<-" icon, a dialogue will be shown in which 
you can choose one of several summary functions for a selected attribute.

The  summary  functions  supported  are  maximum,  minimum,  average  and 
summatory.  A  field  will  be  included  in  the  result  layer  for  each  summary 
function selected for the numerical attributes you have selected a summary 
function for.

When  you  have  specified  the  field  you  wish  to  merge  and  the  numerical 
attributes you wish to obtain a summary value for in the result layer, you are 
ready to run the geoprocess.



gvSIG Desktop

6.1.1.8 Split lines

Trim Lines

The functionality provided by this geoprocess is to cut a line into sections of 
equal size. To access this geoprocess click on the geoprocesses that transform 
data  and  choose  "Split  lines".  Click  on  "Open  geoprocess"  to  display  the 
following window:
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Enter the following data:

• Input cover: The Layer to be cut into into sections of equal size. You can 
also activate the "Use selected features only" check box to restrict the 
line cutting to selected lines only. 

• Distance section: Enter the length of the new lines. 
• Output  cover:  Enter  the  name  and  path  of  the  layer  for  saving  the 

changes. You can check that everything is correct by creating a field and 
then  calculating  the  lengths  of  the  new  lines  by  means  of  the  field 
calculator.  Note  that  the  last  line  section  will  not  necessarily  be  the 
specified length, but will have a length less than or equal to the desired 
length. 

6.1.1.9 Merge

6.1.1.9.1 Introduction

This geoprocess acts on one or several layers, generating a new layer which 
joins  all  the  geometries  in  the  “input  layer”.  The  "result  layer"  of  this 
geoprocess will keep the attributes of the "input layer" specified by the user. 
For the rest of the layers which have not been selected, the attributes whose 
name and type of data coincide with any of the attributes in the selected layer 
will be kept.
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Example:

When a cartographic series arrives which is separated into sheets and you wish 
to join the content of the different sheets in one layer. This is the case of the 
Magna series of sheets, published by the Spanish Technological and Geomining 
Institute (ITGME).

6.1.1.9.2 Running the 'Merge' geoprocess

If you select the “Merge” geoprocess, the following dialogue appears:
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The geoprocess allows any of the layers loaded in the layer tree in the gvSIG 
active view as an input layer. To run the process, first select the layers you 
wish to merge in the "Input layers" text box. Then, click on the "Select” button. 
A new window will open in which you can give the new layer file a name or 
choose a target file.
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Click on the "Save" button when you have finished and gvSIG will return you to 
the  geoprocess  window.  Click  on  the  "Ok"  button.  This  will  start  the 
geoprocess.

A new layer will be created at the end of the process which will be added to the 
view.
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However, in the example of the sheets in a cartographic series, it would be 
awkward to load all the pages in the series one by one. Thus, there is an extra 
option  to  select  a  directory  and  to  add  all  the  layer  files  (with  extensions 
supported by gvSIG) contained in this directory to the geoprocess input layer 
list. The only layer files currently supported are shp format files. If you click on 
the “Folder with files...” button and select a directory, a list of the layer files 
contained in it are shown and can be selected as part of the geoprocess input 
layers.

Until you select at least one layer to merge with one of the two possible lists 
(the  layer  list  in  the  gvSIG  layer  tree  and  the  layer  list  contained  in  the 
specified directory), no layer will be shown in the pull-down list. This list allows 
you to select which layer is going to define the attributes of the result layer’s 
attributes. When you select the layers to merge in one of the two lists, the 
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layer whose attributes we wish the result layer to have and when you have 
specified  the  file  you  wish  to  save  the  result  layer  in,  you  can  run  the 
geoprocess. An initial requirement is that all the geoprocess input layers have 
the same type of geometries.

The result will be a new layer with all the input layer geometries.

6.1.1.10 Convex hull

6.1.1.10.1 Introduction

This geoprocess calculates the “Convex hull”, or the smallest convex polygon 
which surrounds all the vector elements in an “input layer”.

It  only  works  with  an “input  layer”  whose geometry  type can be any type 
(point,  line  or  polygon).  There  are  different  types  of  applications  for  this 
geoprocess:  Determining  the  coverage  area  for  a  specific  geographical 
phenomenon.

Calculating the diameter of the area covered by a series of geometries, etc.

July 2011 Page 444 of 655



6.1.1.10.2 Creating a convex hull

If you select the “Convex hull” geoprocess, the following dialogue appears:

After  selecting  the  layer  whose  “Convex  Hull”  you  wish  to  calculate  and 
specifying an shp result file, you can run the geoprocess and generate a new 
result layer.
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The following image shows the convex hull  created which surrounds all  the 
points in the input layer.

6.1.1.11 Difference

The “Difference” geoprocess works with two layers, the “input layer” and the 
“overlay layer”. It is known as “Spatial NOT” and allows you to obtain the areas 
in a layer which are not present in the other layer. The geometries in both the 
“input layer” and the “overlay layer" must be polygons. The alphanumerical 
schema of the “input layer” will remain intact in the "result layer", as in the end 
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it gives more information about it.

This geoprocess is very useful in numerous situations. For example, it can be 
used  to  complement  the  "Clip"  geoprocess.  If  “Clip”  allows  you  to  exclude 
everything  that  does  not  belong  to  a  geographical  area  under  study, 
"Difference" allows you to do exactly the opposite; exclude a specific area from 
our working layer.

A useful example:

Transferring territorial jurisdiction between different governing bodies. Thus, if 
the national government transfers certain jurisdiction to a regional authority, it 
can decide to exclude the geographical area of the transfer in question from its 
data bases.

6.1.1.11.1 Running the 'Difference' geoprocess

Running the “Difference” geoprocessClick on the “Open Geoprocess” button to 
access  the  dialogue  window  which  allows  you  to  run  the  "Difference" 
geoprocess.
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You  can  enable  the  “selected  features”  check  boxes  at  this  point  of  the 
geoprocess for the input layer and the overlay layer. If you click on the “Ok” 
button, the geoprocess will be run.
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In the following image, the “Difference” geometry appears in black between a 
flood zone and one of the selected cities or towns. In this case, the new layer 
resulting  from  the  calculation  of  the  difference  will  take  the  schema 
(alphanumerical attributes) of the geoprocess input layer.
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6.1.1.12 Union

6.1.1.12.1 Introduction

This geoprocess is similar to the “Intersection” and "Difference" geoprocesses 
in that it operates on two polygon layers to obtain their intersections (this is 
why these three geoprocesses are known as “overlay geoprocesses”).

The "Union" geoprocess is known as "Spatial OR", because the result layer is 
made  up  of  the  geometries  which  appear  in  the  two  layers  (intersections 
between the polygons), plus the geometries which only appear in one of the 
two associated layers.

This means that the geoprocess carries out three analyses:

the first time it calculates the intersection of both layers, the second time it 
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calculates differences between the first layer and the second, and the third 
time it calculates the differences between the second layer and the first.

This geoprocess may be of interest if you wish to generate new layers which 
show the occurrence of two phenomena so that the occurrence of one of the 
two or of both is highlighted.

6.1.1.12.2 Running the 'Union' geoprocess

If you select the “Union” option, the following dialogue appears:

When you have selected the input layer, the clip layer and an output layer, 
click on "Ok".
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The result layer will have all the intersections and differences between the two 
layers.  If  you  click  on  the  “Information”  button  and  then  on  the  different 
polygons in the result layer, you will  see that the intersections have all  the 
attributes,  whilst  the  differences  only  have the  attributes  of  the  layer  that 
created them.

6.1.1.13 Spatial join

6.1.1.13.1 Introduction

This geoprocess allows you to transfer the attributes of one layer to another 
based  on  a  common  element.  In  contrast  to  the  join  sql  operator  in  the 
relational data bases, in this case, the common element is not that a field of 
the two tables takes the same value, but that the related elements in the two 
layers meet some spatial criteria.

July 2011 Page 452 of 655



The “Spatial join” geoprocess allows you to follow two types of spatial criteria 
to establish the spatial link:

Nearest neighbour (1->1 relationship). This assigns the attributes of the 
nearest element in the related layer to an element in the source layer.

If the nearest element intersects (or in the case of polygons is “Contained in”) 
with the source element, the algorithm will take the first element analysed in 
the possible intersections.

Contained in (1->M relationship). This  relates an element in the source 
layer with several elements in the destination layer (in particular, with those 
that intersect).

In this case, the source layer will not inherit the related layer’s attributes, but 
the operation will be very similar to the "Dissolve" geoprocess.

The user can choose one or several summary functions (average, minimum, 
maximum, summatory) to be applied on the numerical attributes of the related 
layer for the M elements related to an element in the source layer.

6.1.1.13.2 Running a 'Spatial Join'

When  you  have  selected  the  "Spatial  join"  option,  the  following  window 
appears:
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This  window  is  practically  the  same  as  the  windows  in  the  overlay 
geoprocesses (Union, Difference, Intersection) with one difference.

It allows you to choose whether you want to run a 1-1 relationship (using the 
nearest  neighbour  spatial  criterion)  or  run  a  1-N  relationship  (using  the 
“Intersect” or “Contained in” spatial criterion).

The choice can be made by enabling or disabling the "Use nearest geometry" 
check box. If  when you have selected the source layer and the layer to be 
related, the geoprocess is launched and you have not enabled the "Use nearest 
geometry" check box, a window appears in which you can select the summary 
functions  you wish to apply for  each numerical  attribute of  the layer to be 
related:
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The summary functions are the same as in the “Dissolve” geoprocess:

Thus, the attributes transferred to the source layer will  be the result of the 
summary functions selected for each numerical field. If you run the geoprocess 
and  the  “Use  nearest  geometry”  option  is  enabled,  this  window  does  not 
appear.
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6.1.1.14 2D Translation

6.1.1.14.1 Introduction

This  geoprocess allows a translation transformation to be applied to all  the 
points, lines and polygons of the geometries in the input layer. The geoprocess 
can be applied to all types of vector layers (shp, dgn, dxf…). To do so, the 
movement on X and Y must be specified.

This geoprocess is extremely useful when combining cartographies which come 
from different  sources,  a process which is referred to as conflation.  Bear in 
mind that although translations can be carried out on all types of vector layers 
(shp, dgn, dxf, dwg…), the resulting output layer will always be a shape file. In 
other words, the input layer can be a shp, dxf or dgn file, but when translation 
is applied to these layers, the result will  be one or various different output 
layers which are always shape files.

When a translation is carried out in which the input layer is a vector layer which 
is  not  a shape file,  the result  of  the translation will  be three layers in  SHP 
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format (one line layer, one point layer and one polygon layer).

If, for example, the input layer to which the translation is applied contains only 
points and lines, the polygon .shp file will be created but it will be empty.

NB. At the end of this section there is a table giving details of the relationship 
between the type of input file and the resulting output layer.

6.1.1.14.2 Translating a vector layer

Firstly, load a vector layer in gvSIG and then click on the geoprocessing wizard 
in the tool bar.

Select the option “2D Translation” from the “Data Conversion” folder. Click on 
the “Open Geoprocess” button and the geoprocess data input window opens. 
For the input layer, select the vector layer (dgn, dxf, dwg, shp…) you wish to 
translate and introduce the values corresponding to X and Y. Select an output 
layer and click on “Ok”.

The following image shows the result of applying the translation process.
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Relationship between the type of layer before and after translation.

Input cover Output cover/s

Point Shp file Point Shp file

Multipoint Shp file Multipoint Shp file

Line Shp file Line Shp file

Polygon Shp file Polygon Shp file

Dxf (points, lines, polygons) Point Shp file

Line Shp file

Polygon Shp file

Dgn (points, lines, polygons) Point Shp file

Line Shp file

Polygon Shp file
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Dwg (points, lines, polygons) Point Shp file

Line Shp file

Polygon Shp file

6.1.1.15 Reprojection

6.1.1.15.1 Introduction

This geoprocess allows you to change the geodesic projection of  the vector 
elements in the input layer. In order to do so, the user must specify the new 
projection to be applied.

This process is extremely useful when standardising cartographies in the same 
project if these are in different projections.

6.1.1.15.2 Reprojection of a layer

Click on the geoprocessing wizard in the tool bar and select the “Reproject” 
option from the “Data conversion” folder.

Click on “Open geoprocess”. The wizard will  open to guide you through the 
reprojection process.

In “Input layer”, select the layer you wish to reproject from the layers loaded in 
the ToC.

To select  the  new projection  for  the  layer,  click  on the button next  to  the 
destination projection and select the new reference system.
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6.1.2 Exporting layers

6.1.2.1 Introduction

The “Export to...” tool allows you to save the elements selected in a layer in a 
different format.  If  no elements have been selected the whole layer will  be 
exported. At the time of going to press the export formats supported by gvSIG 
were shape, dxf, and postgis and gml.

6.1.2.2 Exporting a shape

Select the “Layer” option from the menu bar then go to “Export to…/shp”.
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If you have selected elements in the layer to be exported, gvSIG will tell you 
how many elements are going to be exported and will  ask for confirmation 
before carrying out the operation.

If you continue with the operation, a dialogue box will appear in which you will  
be asked to select the file the new shape is to be saved in.

When you have accepted, a new message will appear asking whether you wish 
to insert the new layer into the view.

If you click on “Yes”, the layer will be added to the active view.

6.1.2.3 Exporting to dxf

Select the “Layer” option from the menu bar then go to “Export to…/dxf”.
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Follow the same process used for exporting to shape.

6.1.2.4 Exporting to postgis and Oracle Spatial

Select the “Layer” option from the menu bar then go to “Export to…/postgis”.

If you have selected any elements, a window will appear telling you how many 
elements are going to be exported (as in exporting to shp and dxf).

If you have selected any elements, a window will appear telling you how many 
elements are going to be exported (as in exporting to shp and dxf).

Remember that if the table already exists in the data base, the information it 
contains will be deleted.

Write the name of the table and click on “Ok”. A new window appears in which 
you will have to input the parameters of the data base connection.
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he parameters are:

Name: Name of the connection.

Computer: IP address of the computer the data base is hosted in

Port: Port on which the computer is listening to the postgreSQL service.

User: User name recognised by the administrator to make the connection

Password: User password required to validate the connection. db: The data 
base the new table is to be created in.

Driver: Driver  required  for  the  data  base.  (At  the  time of  going  to  press, 
drivers  for  postGIS  and  mySQL  were  available).  When  you  have  input  the 
connection parameters, click on “Ok”.

6.1.2.5 Exporting to gml

Select the “Layer” option from the menu bar then go to “Export to…/gml”.

Follow the same process used for exporting to shp or dxf.

6.1.2.6 Exporting to kml

From the menu bar, select  Layer > Export to... > Keyhole Markup Language 
(KML).
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Layer menu, Export to KML

From here on the steps are exactly  the same as for  the Exporting to GML 
option.

6.1.2.7 Annotation layer

6.1.2.7.1 Introduction

This gvSIG tool makes advanced labelling easy.

The process creates a new layer which represents annotations.

The main features of this new layer can be summarised as follows:

• The new layer is only composed of the annotations created. 
• The table associated with this new layer only contains the fields which 

refer  to  the  text  of  the  annotations  (Text,  Font,  Colour,  Height  and 
Rotation). 

• The layer created is always in .shp format, irrespective of the format of 
the original layer. 
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6.1.2.7.2 Creating an annotation layer

To create an annotation layer,  first  select the layer from the ToC (Table of 
Contents).

In the menu bar, select the “Layer” option, then select “Export to” and finally 
select the “Annotation” option.

This option opens the wizard which will guide you through the steps required to 
create the annotation layer.

In the wizard’s first window, select the data which gvSIG requires to carry out 
the operation from the pull-down tab:

Duplicate control: Select either “None” or “Centred” to choose the position in 
which you wish the annotations to be inserted.

Centred: A label  is  created for  each value and this  will  be inserted in the 
centre of all the labels which are the same.

None: A label is inserted for each value, even if these are repeated.

Select the field to be labelled: Choose the field which contains the text you 
wish the labels to show.

If you do not wish to modify the format of the annotations created by gvSIG 
and prefer a standard format, click on “Finish”. If you wish to customise the 
format, click on “Next”.

The wizard’s second window allows you to select the fields of attributes of a a 
table (if there are any) which contain the values which allow you to customise 
the labelling.
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The following parameters can be customised.

Slope – the slope the annotation will have in the view.

Colour – annotation text colour.

Height – annotation text height.

Units –  units  in  which  the  value  assigned  to  the  “Height”  field  are  to  be 
measured.

The options currently available are map units or pixels.

Font – annotation text font.

Set the values to be used for customising the required parameter (by pulling 
down the list).

Leave the default value in the fields you do not wish to customise.

Click on “Finish” when you have input these changes.

July 2011 Page 466 of 655



6.1.2.7.3 Editing an annotation layer

An annotation  layer can be edited like any other  layer.  To start  an editing 
session in gvSIG, select the layer in the Table of Contents and then select the 
option “Start edition”.

When you start an editing session, an option appears in the menu bar called 
“Modify  annotation”.  This  will  allow  you  to  individually  customise  the 
annotation you wish to change.

When you click on this button, the appearance of the cursor will change. You 
may graphically select the annotation by clicking on the point associated with 
the text and then access a set of properties shown in the following image.

6.1.2.7.4 Annotation layer properties

If we select the “Properties” option from the annotation layer contextual menu, 
the following box appears:
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The “Layer properties”  box has two tabs.  The “General”  tab allows  you to 
access the general properties of the layer and the “Annotations” tab allows you 
to select: whether you wish the annotation text to be shown in pixels or metres 
in the view.

Whether you want only the text to appear (select the “Draw text only” option) 
or if you prefer the text to be accompanied by a location point (deselect the 
“Draw text only” option).

However,  remember  that  this  point  is  useful,  for  example,  to  move  the 
annotation or to access the “Modify annotation” window.

If you wish to avoid overlays, activate the “Avoid overlays” option.

If you wish to eliminate overlaying annotations, activate the “Clear overlaying 
annotations” option.
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6.1.2.7.5 Adding an annotation layer to the view

To add an annotation layer, click on the “Add layer” button in the tool bar

and select the “Annotation” tab.

In the box you can select the annotation layer you wish to load, in addition to 
the units in which the annotations are displayed (pixels or metres) and the 
projection of the layer.

6.1.2.7.6 Example of how to create an annotation layer

The following image shows how an annotation layer is created out of a polygon 
layer called “muni10000.shp” which contains all  the towns in the Valencian 
Region.

In the first window of the wizard, insert the type of duplicate control you wish 
to use and select the field which contains the text to be shown.

This is the field in a layer’s table of attributes which contains the name of the 
town.
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If you do not wish to customise the presentation, click on “Finish” and indicate 
where you wish the new annotation layer to be saved.

The following image shows the result (the rest of the fields in the wizard are 
left  with  their  default  values  and  this  one  is  zoomed  in)  of  creating  the 
“annotation layer”.

The annotation layer which has been created is the one in red called “Towns” 
in the Table of Contents.

6.1.2.8 Export to a raster layer

This tool allows you to extract portions of a raster layer using a selection in the 
view or by inputting the coordinates that define the portion to be extracted.

It allows the user to change the spatial resolution of the clipping or of the whole 
image, choose the bands to be extracted or generate a new raster layer for 
each of the original bands.

To access this option, go to the ToC and select the raster layer you wish to 
select a portion of.

Then go to the Layer/Export to menu and select the “Raster” option.
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The following window appears:

Image clipping

There are two ways of selecting an area to be clipped from the original raster 
layer:

You can use the text boxes in the window to input the data which correspond 
to:

• Real coordinates: If the source image is georeferenced. 
• Pixel coordinates: If the source image is not georeferenced. 

You can also make your selection directly from the view by clipping the whole 
image or selecting a part of it.

This button allows you to obtain a clipping from the whole image.

This button allows you to obtain a clipping from a selected area in the view. 
Place the cursor over the image, then click and drag. Check that the text boxes 
are automatically completed.

If you wish to save the raster layer clipping you have created, click on “Save” 
and select the location you wish to save this file in. The image will be saved in 
TIF format.

Changing spatial resolution

The controls that allow you to specify the clipping’s (or whole image) spatial 
resolution are located in the Clip table, with the additional options panel pulled 
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down  (to  pull  this  panel  down  click  on  the  button).  You  can  define  the 
resolution by specifying the Cell size or the Width and Height of the raster layer 
to be generated in pixels as well as choosing the interpolation method using 
the resolution change. At the moment, only the “Nearest neighbour” option is 
operational.

Band selection

The original raster layer’s band list appears at the bottom of the Clip table. You 
can use this list to choose the bands the output raster layer will have if you 
enable or disable the check boxes in the Bands column. If you check the Create 
one layer per band option, a new layer will be generated for each of the bands 
checked in the list. The new layers will be added to the ToC.

Saving and Adding a raster layer clipping to the current view.

When you have established all the parameters which define the raster layer 
clipping you have made,  click  on “Save”.  This  opens a dialogue box which 
allows you to search for a directory to save the clipping in. If you wish to add 
the layer to the view, go to the “Add layer” button in the tool bar once you 
have saved the clipping.

Example of a raster layer clipping

This example shows how a clipping is taken from an orthophoto.

First, select the area by defining a rectangle in the gvSIG view.

When you have finished, the coordinates will automatically be input into the 
text boxes based on the selection.  You can fine tune these selected values 
from the view by inputting the new value directly into the text boxes containing 
the data.

Then pull  down the box. As the resulting image is to be resampled, not as 
much resolution is required. Therefore, go to the “Spatial resolution” section 
and select “Width x Height”. This enables the text boxes so that you can input 
the output raster layer resolution.

When one value is input the other one is automatically completed when you 
press Enter or when you exit the field, as the proportions between the width 
and height must be maintained.

The cell size for the chosen output resolution is also calculated. If “Cell size” 
had been chosen, you would have had to specify the size in metres for each 
pixel and thus the width and height for the chosen cell size would have been 
calculated.
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You now need to select the bands you want the output layer to have. In this 
case, select them all as this is a three-band orthophoto and we want to include 
them all.

Finally,  for  our example,  the “Create a layer per band” option needs to be 
enabled to do just this.

Each new layer will have the same data type as the original image. If you click 
on “Save” a dialogue box opens to indicate the directory and image name.

To retrieve the layers you have created, go to the Add layer” button and then 
to the directory they were saved in.

6.1.2.9 Creating a layer with derived geometries

"New layer with derived geometries" tool.

This tool allows users to generate geometries derived from points or lines in a 
vector layer, and to store them as a new shape layer.

Table

Icon Description

Derived geometries tool enabled if the TOC contains at least one visible 
point or line vector layer that is not in edit mode.

Derived geometries tool disabled if the TOC does not contain any visible 
point or line vector layers that are not in edit mode.

The tool can be accessed from:

Via the menu: Layer / Derivative geometries



gvSIG Desktop

Menu path to the tool

Layer selection dialog and process

Upon choosing the tool a dialog for selecting layers is displayed:
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Selecting layers and process

1. Source Layer: drop-down list of point or line vector layers in the current 
View that are not in edit mode. Select a layer to be the source layer. 

2. Name of the output layer: layer name that will appear in the TOC. 
3. Path of the output layer: full path for creating the new shapefile. 
4. Type of output layer: geometry type of the new layer. This depends on 

the type of process chosen (See options below). 
5. Type of process: select the type of geometry generation process. This 

depends on the geometry of the source layer. This process is applied to 
the source and destination layer pair until the tool is closed. 

6. Cancel: Close the tool. 
7. OK:  Opens  a  control  panel  and displays  data for  the  selected source 

layer. This control panel will be associated with source and output layers 
until it is cancelled. 

Table

Source layer geometry 
type

Type of 
process

Target layer geometry 
type

Points Points to line Lines

Points Points to polygon Polygons

Lines Close polylines Polygons

Process Control Panel

The control panel is associated with the layer and is shown every time the layer 
is activated in the TOC, as long as the layer is visible and not in edit mode.

The dialog has a semi-modal behavior in order to allow the user to continue 
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working with gvSIG by using the minimize, maximize, resize and hide buttons 
(use the X, not the Cancel button, to hide the dialog).

Process control panel

1. Name of  the  source  layer:  Layer  from  the  TOC  that  contains  the 
source geometries. 

2. Name of the output layer: Name of the new derived geometry layer 
that will appear in the TOC. 

3. Table of features: Table showing the attributes of all the source layer's 
features.  Source  layer  geometries  selected  in  the  View  will  also  be 
selected in this table. 

4. Add all: Adds all the features of the source layer to the table of selected 
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features. 
5. Remove all: Removes all features from the table of selected features. 
6. Enable  snapping  tool:  Enables  snapping  tool  on  the  source  layer, 

without putting it into edit mode (only available in the Castilla y León 
extension for gvSIG 1.1.2). 

7. Add selected features: Adds only the selected features to the table. 
8. Remove selected features: Removes only the selected features from 

the table. 
9. Table of  selected features:  Table  showing  the  attributes  of  all  the 

features selected from the source layer. It has 2 extra columns:
• Order: Order to be used when generating the new geometry from 

the  selected  features  in  a  point  source  layer,  or  when  closing 
polylines  in  the  case  of  a  line  source  layer.  The  order  can  be 
changed with buttons 10 and 11. 

• ID: Fixed ID number of the geometry in the vector layer. 
10.Move up: Moves the selected geometries up one position. 
11.Move down: Moves the selected geometries down one position. 
12.Create:  Start  the process  of  generating the derived geometries.  If  it 

doesn't already exist, a new layer is created, and the new geometries are 
added to this  layer.  The process is  done in  a thread, the progress  of 
which is indicated by a progress bar. 

Progress bar

The results of the completed process can be viewed by clicking on the "View 
Details" button. There are three types of data that are of interest here:

• Number of geometries to create: depends on the geometry selected:
• If they are of type point: one line or polygon is created. 
• If they are of type line: one polygon is created for each line. 

• Number of geometries that could not be created: the subprocess 
failed, for example because a polygon couldn't be derived from simple 
lines that consist of only two points. 

• Number  of  geometries  created  successfully:  the  new geometries 
created. 

 This information is recorded in the gvSIG log.

 The control panel is hidden during the process but becomes visible again 
when the progress dialog is closed.
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13.Cancel: Closes the control panel and de-registers the associated tools, 
thereby terminating the tool for the specified source layer. 

14.Expand / Collapse: Changes the position of the splitter, so as to display 
only  the  table  of  features,  only  the  table  of  selected  features  and 
associated  management  controls,  or  both  halves  of  the  control  panel 
interface. 

Control Panel Behaviour

The control panel is linked to the source layer from the time it is created until it 
is cancelled by clicking the cancel button.

Table

Action
GUI 

Element
Description

Maximize Resizes the dialog so that it fills all available space.

Minimize Minimizes the control panel to a restore button.

Collapse Control panel is hidden but remains linked to both 
the source and output layers. Further operations 
between these layers can be performed once the 
panel is restored.

Resize  The size of the control panel can be increased or 
reduced by selecting and dragging the edge of the 
panel.

Expand / 
Collapse 
splitter 
interface

These controls are used to display only the table of 
source layer features, or only the table of selected 
features and associated management controls, or 
both halves of the control panel interface.

Cancel Closes the tool so that is no longer available for 
operations between the source and output layers.

 When the control panel is hidden it can be restored it by clicking on the 
source layer in the TOC.

 If the View is closed when control panels are visible, the panels will be 
hidden and then restored when the View is reopened.

 Geometries derived from points do not retain any attribute values but do 
maintain the columns. Those derived from lines, keep all attributes.
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 Removing the new layer associated with control panel will result in the tool 
being ended and a warning being displayed to the user.

Examples

This example will show how to generate a line layer showing the path followed 
from home to work, and back again. The example uses the following four shape 
layers:

• Land-use: layer showing parcel boundaries of the town. 
• Rivers: layer showing rivers in the town. 
• Lakes: layer showing lakes in the town. 
• GPS Waypoints: shape layer containing points recorded by a GPS on the 

drive to and from work. This layer will be used as the source layer in the 
example. 

Once all four layers have been loaded the  "Derived Geometries" tool can be 
selected and the following values entered:

• Source layer:
• Layer: GPS Waypoints 

• Output Layer:
• Name: Route: Work to Home 
• Path: .../RouteWorkToHome.shp 
• Type: Lines 

• Options:
• Mode of operation: points to line 

When "OK" is clicked the new process control panel appears. If a file with the 
same name as the new output  layer already exists  then the user is  asked 
whether to continue or not. If yes, then the file will be overwritten.

Warning of an existing layer

Minimizing the control panel will reveal the View:
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View showing the layers

The geometries can be selected from the top table in the control panel.

We select the first seven geometry points (1st route: work to home).
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Selected geometries

Click "Create" to generate the first path:
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Resulting route generated by the "Points to line" process

Modify the symbology so that the route stands out as a thick line.

To generate the route back, activate the control panel and select the remaining 
points from the source layer so that the line can be generated:
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Selected geometries
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Resulting new route

Finally suppose we are interested in the polygon formed by the closure of the 
routes.

Cancel  the tool  and then reopen it  but this  time use the new layer as the 
source:

• Source layer:
• Layer: Path: GPS Waypoints 

• Output Layer:
• Name: Close routes 
• Path: .../CloseRoutes.shp 
• Type: Polylines 

• Options:
• Mode of operation: close polylines 
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Process "close polylines"

Select all the geometries (the two polylines) and generate the polygons.



gvSIG Desktop

Selected geometries

Since the layer "Route: Work to Home" does not contain data due to the points 
to line process,  we assign a distinguishing identifier  to each by editing the 
layer.

Now apply some changes to the symbolology:

• Layer "Close routes": select a unique values symbology to distinguish the 
two polygons, and choose fill patterns that allow the lower layers to be 
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seen. 
• Layer "GPS Waypoints": Use a symbol of a car for the points and place 

the layer above the other layers. 

Results of the polygons generated by the "Close polylines" process

6.2 Raster

6.2.1 Layer functionalities

6.2.1.1 Filters

6.2.1.1.1 Description

Filtering is a process by which we can enhance images. gvSIG can filter images 
through a variety of filtering methods. In the upper left part of the Filter dialog, 
the filters are grouped by type (1). By double-clicking one of the filters or by 
clicking on the "Add Filter" button on the bottom left, the filter will be added to 
the list of filters in the lower left part of the Filter dialog. All filters in the filter 
list will be applied in the preview. If you want to remove a filter from the list, 
you can either double-click on the filter or click on the "Delete filter" button. 
The filters in the list will be applied to the image in the order that they appear. 
Keep in mind that the order in which the filters are applied will affect the result, 
and changing the order of the filters may change the output.
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In the middle of the dialog window are the controls of the selected filter (2). 
When changing the controls of one of the filters from the filter list, the results 
will  be directly shown in the preview window. Below the middle part of the 
dialog you can change the name of the output layer that will  be generated 
when clicking "Apply" or "Close".

On the right side of the dialog you can preview the outcome of the filters (3). 
(See documentation on "Preview tool"). In the lower right part you can select 
whether you want to display the filters  over the selected layer or save the 
filtered image as a new layer (4).

The  button  "Apply"  will  apply  the  changes  according  to  the  entered 
parameters, keeping the Filter dialog open. The "Close" button will apply the 
changes and close the Filter dialog. The "Cancel" button will  close the Filter 
dialog without applying any filters.

All filters in the filter list can be activated or de-activated through the "Active" 
checkbox. This checkbox is usually located in the upper part of the filter control 
panel.

Configuration panel for the image filters
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Generate a new layer or apply to current layer

The number of applied filters will affect the time that it will take to draw the 
layer. If you choose to apply the filters to the current layer, the drawing and re-
drawing of the layer may slow down while the filters are applied. If the filter 
results are saved as a new layer, the filtering process has to be done only once 
so that the next time the layer is drawn, it will  not be slowed down by the 
filtering. Therefore, it is generally recommended to save the output to a new 
layer if possible. There are cases though in which it is not recommended to 
generate a new layer. For example, if you have a large orthophoto and you 
only want to change the brightness a little, it could take more time to save the 
output as a new layer. If the brightness filter is applied over the current view, 
the area on which the filter is applied is much smaller which makes the drawing 
faster. It is up to the user to decide whether it is better to create a new layer or 
display the filters on the view of the current layer.

6.2.1.1.2 Enhancements

The  brightness  filter  changes  the  brightness  value  of  the  layer.  You  can 
increase or decrease the brightness by moving the position of the sliding bar or 
by entering the value directly in the text box and press enter.

Brightness filter

The contrast filter changes the contrast value of the layer. You can increase or 
decrease the contrast by moving the position of the sliding bar or by entering 
the value directly in the text box and press enter.
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Contrast filter

6.2.1.1.3 Spatial filters

With  this  type  of  filter,  graphical  transformations  like  smoothing,  edge 
detection, sharpening etc. are applied to the image.

The following filter types can be applied:

MEDIAN FILTER

The median filter applies a kernel of a certain size, which is determined by the 
user through the sliding bar labeled Window side.

The median filter  is  normally  used to smoothen and to  reduce noise in  an 
image, by moving a kernel  of  N x N number of  pixels  over the image and 
evaluating  each  central  pixel,  replacing  its  value  with  the  median  of  its 
neighboring pixels. Compared to the Mean filter, the advantage of the Median 
filter is that the final pixel value is a value that actually occurs in the image and 
not an average.
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Median filter

MEAN FILTER

The mean filter applies a kernel of a certain size, which is determined by the 
user through the sliding bar labeled Window side.

The filter replaces the value of the central pixel with the mean value of the 
surrounding  pixels.  Each value  of  the  kernel  would  be one and the divider 
would be the total number of elements in the kernel (i.e. a kernel of 3 x 3 
would replace the value of the central pixel by the average value of the nine 
pixels covered by the kernel).

Mean filter
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LOW PASS FILTER (smoothing filter)

The low pass filter applies a kernel of a certain size, which is determined by the 
user through the sliding bar labeled Window side.

Using a low pass filter tends to retain the low frequency information within an 
image while reducing the high frequency information.

Low pass filter

SHARPENING FILTER

By moving the slider to change the sharpness (values from 1-100), the contrast 
of  an image can be changed.  The results  can be evaluated in  the preview 
window. With a higher contrast, details in the image can be accentuated but 
the noise will also increase.
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Sharpening filter

GAUSS FILTER

The Gauss filter applies a kernel of a certain size, which is determined by the 
user through the sliding bar labeled Window side.

The maximum value appears in the central pixel and gradually decreases for 
pixels that are further away from the central pixel.

Gauss filter

CUSTOM FILTER

This is a kernel of 5 x 5 or 3 x 3, for which the values can be introduced by the 
user. After multiplying the pixel values with the kernel values, the result will be 
divided by the number specified in the Divisor textbox.
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Custom filter

MODE FILTER

The mode filter applies a kernel of a certain size, which is determined by the 
user through the sliding bar labeled Window side.

This  filter  takes  the  value  that  occurs  most  in  the  surrounding  pixels  and 
assigns it to the central pixel.

Moda filter
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6.2.1.1.4 Colour adjustment

Adjustment of RGB values

It is possible to change the balance between Red, Green and Blue in an image 
if needed. To do this, move the sliding bar to increase or decrease the values 
or enter the value directly in the text box next to the sliding bar. Ticking the 
"Brightness" check box ensures that the brightness level of the pixels will be 
maintained while the RGB values are changed.

RGB balance filter

Adjustment of CMY values

It is possible to change the balance of Cyan, Magenta and Yellow in an image if  
needed. To do this, move the sliding bar to increase or decrease the values or 
enter the value directly in the text box next to the sliding bar.  Ticking the 
"Brightness" check box ensures that the brightness level of the pixels will be 
maintained while the CMY values are changed.

CMY balance filter
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Adjustment of HBS values

It is possible to change the balance of Hue, Brightness and Saturation in an 
image if needed. To do this, move the sliding bar to increase or decrease the 
values or enter the value directly in the text box next to the sliding bar.

HBS balance filter

6.2.1.1.5 Edge detection

These filters attempt, through the use of kernels, to detect edges in the image 
and change the image so that these edges are enhanced, while the rest of the 
image is grayed out.
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Filter dialog. Edge detection

There are four edge detection filters, all with the same interface and options, in 
which the user chooses a  threshold in the range 0-255, and the possibility 
compare the results by ticking the compare check box:

Sobel filter example

SOBEL

The  Sobel filter  detects  the  horizontal  and  vertical  edges  separately  on  a 
grayscale image. Colour images are converted to RGB gradations. The result is 
a transparent image with black lines and some remains of colour.
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ROBERTS

The  Roberts filter  is  suitable  for  detecting  diagonal  edges.  It  offers  good 
performance  in  terms  of  location.  The  major  drawback  of  this  filter  is  its 
extreme sensitivity to noise and therefore has poor detection qualities.

PREWITT

The Prewit filter detects edges in all directions as it consists of 8 kernels that 
are applied over the image pixel by pixel.

FREI-CHEN

The  Frei-Chen filter processes the neighbouring pixels as a function of their 
distance from the pixel that is being evaluated. The result is that edges in all 
directions are detected.

6.2.1.1.6 Masks

Transparent area

With this functionality it is possible to set the transparency level of a Region of 
Interest (ROI). The region of interest must have been defined previously. If the 
layer does not have a region of interest, the following message will appear: "A 
Region of Interest (ROI) must be defined for this layer to apply this filter. Please 
go to the dialog  Area of  Interest and select at  least  one ROI."  If  there are 
already  one  or  more  ROI  associated  with  the  layer,  the  message  will  not 
appear. Instead, a list of ROI will be shown, from which you can select one or 
more  by  ticking  the  corresponding  check  box.  Then,  adjust  the  level  of 
transparency with the slide bar or by entering the value directly in the text box 
next to the slider. Ticking the check box labeled as "Inverse" will result in the 
opposite effect; all of the image except for the ROI will be set to the specified 
transparency level.
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Transparent area filter

Mask

With this functionality it is possible to cut out a Region of Interest (ROI) that 
has been previously defined for the layer by assigning a fixed user-specified 
value to the rest of the image outside the ROI. If the layer does not have a 
region of  interest,  the following message will  appear:  "A Region of  Interest 
(ROI) must be defined for this layer to apply this filter. Please go to the dialog 
Area of Interest and select at least one ROI." If there are already one or more 
ROI associated with the layer, the message will not appear. Instead, a list of 
ROI  will  be  shown,  from which  you  can select  one  or  more  by  ticking  the 
corresponding check box. Then, select the value to be assigned to the pixels 
outside the ROI by typing a number in the "value" text box. The default value is 
-99,999. Ticking the check box labeled as "Inverse" will result in the opposite 
effect; the ROI will be assigned the specified value while the rest of the image 
values are maintained.

Mask filter
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6.2.1.2 Histogram

6.2.1.2.1 Description

To launch the histogram dialog window, use the drop-down toolbar selecting 
the "Raster Layer" button on the left and "Histogram" in the drop-down button 
on the right. Make sure that the text box that displays the current layer is set 
to the name of the raster layer for which you want to see the histogram.

Histogram icon

The Histogram dialog shows a histogram of the statistical distribution of pixel 
values in the current view. This information is often useful when you are trying 
to color balance an image. In the middle of the dialog you will see the graph on 
which you can right-click to show a context menu with general options for this 
kind of graphics.

Histogram dialog window

In the upper part of the dialog (1) are the controls to configure the histogram:

1. Type of histogram
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There are three types: "Normal", "Accumulated" and "Logarithmic".

• Normal: This is the normal histogram in which for every pixel value on 
the X axis the number of pixels is shown on the Y axis. 

• Accumulated: Shows the accumulated number of pixels for every pixel 
value. The graph is therefore ascending. 

• Logarithmic: Displays the histogram on a logarithmic Y axis, which may 
be useful for images that contain substantial areas of a constant value. 

2. Data source

With this option you can select the data source for the histogram:

Current view (R,G,B):

With this  option,  the pixel  values that  are displayed in  the current  view of 
gvSIG will be used for the histogram. Therefore, the band selector shows only 
the R, G, and B values which are the visual bands. Every band will appear in its 
corresponding colour in the graph (red for R, green for G and blue for B). This is 
the default option when the histogram dialog is opened.

Complete histogram:

With this option, the histogram for the whole raster layer is calculated. Because 
of the amount of time that it would take to calculate the histogram for large 
images, the histogram is only calculated once and saved with a .rmf extension 
in the directory in which the image is stored. After the first time, the histogram 
for the same layer can be displayed much faster. (Keep in mind that if you 
delete the .rmf file that is stored with the image, you will lose its histogram 
information.)

3. Band selection

Apart from identifying to which band each histogram corresponds through its 
colour (in case of the current view Data Source) you can also identify the band 
by hovering the mouse over a point in the graph. The tooltip displays the band 
name and the value of the point.

4. Context menu and manipulation of the graph (2)

Zoom operations

We can zoom in and out of the graph using the mouse.

• To zoom in on a part of the graph, draw a rectangle over it by pressing 
and dragging the mouse. 

• To return to the original graph, click on the left mouse button on any 
point in the graph and drag to the left, then release the mouse button. 

You can also zoom in and out using the context menu.

Context menu

When you right-click on any part of the graph, the context menu is shown with 
the following options:



gvSIG Desktop

Histogram options. Context menu

• Properties: This will open the properties dialog of the graph, where you 
can configure characteristics such as the background colour, title,  font 
etc. 
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Histogram properties

• Save As: to save the graph as an image. 
• Print: this opens the printer dialog from where you can print the graph. 
• Zoom In: to zoom in on one or both of the axes. 
• Zoom Out: to zoom out on one or both of the axes 
• Auto Range: to adjust the zoom automatically to the window size, for one 

axis or for both. 

5. Statistics (4)

The controls that appear under the graph allow the user to restrict the range of 
values (X axis of the histogram) on which the histogram is based. The default 
setting is the complete range so that, for example in a Byte data type image, 
the statistics are calculated for all the pixel values from 0 to 255. You can enter 
the values directly in the text boxes or use the + and – controls next to the text 
boxes. You can also slide the triangles over the sliding bar to select the range 
of values.

Sliding bar with pixel ranges

In this table, the statistics that correspond to the selected range of pixel values 
are shown in the text boxes. Each row of the table corresponds to one raster 
band as displayed in the histogram. The columns that are shown are:

• Minimum pixel value for the selected interval. 
• Maximum pixel value for the selected interval. 
• The mean (average) of all the pixel values for the selected interval in the 

histogram. 
• Median pixel value for this interval. 
• The number of pixels included in the selected interval. 

6. Export the table (3)

You can export the table through the option "Save as DBF". The data contained 
in this table are the values of the current histogram. After creating the DBF 
table, it can be used as any other table in gvSIG.
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Resulting DBF table

6.2.1.2.2 Preferences

The Raster section of the Preferences dialog contains the option "Number of 
classes" where you can set the number of intervals in which the histogram is 
divided when the data type of the image is not Byte. For Byte images, this 
value is 256. In the preferences dialog, the default value of this option is 64 but 
you can choose any of the options (32, 64, 128, and 256). The intervals are the 
parts in which the range of values is divided. For example, if we have a DTM 
with values between 0 and 1 and there are 64 intervals, each interval will have 
a range of 1/64.

July 2011 Page 504 of 655



The number of  classes does not  only  refer  to histograms but  also to other 
functionalities that require a division in intervals of value ranges.

Raster Preferences

6.2.1.3 Radiometric enhancement

The maps that are obtained through digital processing of satellite imagery are 
useful not only for thematic mapping, but also as a backdrop on which map 
features  can  be  overlaid.  If  the  visible  bands  are  displayed  in  a  colour 
composition through the colouring of each band with the corresponding colour 
gun, it is important that the bands are sufficiently enhanced so that the colours 
appear more natural. The final display colour depends not only on the direct 
result  of  the  chosen  colour  composition  but  also  on  the  radiometric  post-
processing.  The satellite  image map will  be more useful  as backdrop if  the 
bands are enhanced and displayed in colours that match the natural colours as 
the  human  eye  perceives  them.  gvSIG  provides  the  enhancement  tools  to 
adjust the colours for each band.

In the following sections the different parts of the dialog are described:

Histograms

The central part shows two graphs (1). The graph on the left is the histogram of 
the input image. The graph on the right shows the histogram of the output 
image. The graphs that are presented with a yellow line can be modified with 
the mouse. When you change the input histogram, the output histogram will be 
changed accordingly and you can preview the result.
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In the upper corners of the input histogram are the maximum and minimum 
values  of  the  raster  displayed.  In  the  lower  corners,  the  maximum  and 
minimum values that are being included in the enhancement are displayed. 
The percentage of values that are being left out of the histogram appears in 
parentheses.  These  values  can  be  modified  by  grabbing  and  dragging  the 
dotted vertical lines on the side of the graph. Dragging the left line will modify 
the minimum value,  while dragging the right  line will  modify  the maximum 
value.  (This  way,  by leaving out  the  values that  are  not  used in  the input 
image, you can  stretch the output values over the whole range of available 
values, so that the visual quality is improved.)

Radiometric Enhancement dialog

6.2.1.3.1 Controls

In the lower part of the dialog (2) you will find some controls with the following 
options:

Type of function:
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The enhancements will  replace each input value with an output  value.  This 
process is done by creating a look-up table which provides the correspondence 
between a  range  of  input  data  and  a  range  of  output  data.  To  apply  this 
correspondence, a fuction is used. The used function and its parameters are 
chosen by the user.

Linear enhancement

• Linear:  Linear  enhancements  apply  the  correspondence  between  the 
input  data  and  output  data  in  a  linear  way.  In  the  simplest  case,  a 
straight  line  will  correlate  each  value  in  the  input  interval  with  the 
corresponding value in the output interval in a complete equidistant way. 
For example, if you have an output range between 0 and 255 and the 
input values are between 0 and 1, the input value 0.5 would result in an 
output value of 127.5. This is the default algorithm when you first open 
the radiometric enhancement dialog. Variations of this algorithm can be 
achieved by introducing break points in the yellow line, by clicking on the 
line at the point where you want to break it. You can remove break points 
by  right-clicking  on  them.  Existing  break  points  can  be  moved  by 
dragging them. The effect is that the linear filter is divided in parts with 
different inclination, so that different parts will  follow a different linear 
function as defined by the inclination of the corresponding line part. 

Linear radiometric enhancement

• Level  slice (piecewise linear):  This  is  a type of  linear enhancement.  It 
divides the function stepwise in equidistant parts. The effect is that the 
input  values between two points  on the same horizontal  level  will  be 
assigned the same output values, so that the resulting image will have 
colour intervals without  transitions.  (This  may be useful  to highlight  a 
specific range of gray levels in an image, for example to enhance certain 
features.) You can modify the number of intervals by changing the value 
in the text box labeled "Levels". The default value is 6 levels. 
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Piecewise linear enhancement

Non-linear enhancement

The  non-linear  enhancements  have  the  same  approach  as  the  linear 
enhancements in the sense that each input  value is  replaced by an output 
value. The difference lays in the function that is assigned to produce the output 
values, which is non-linear. The available non-linear functions are logarithmic, 
exponential and square root. With each function you can modify the curve to 
smooth or accentuate the enhancement result.
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Exponential radiometric enhancement

Band

With this option you can specify the raster band to which the enhancements 
are applied. For a correct balance of the image, it is recommended to enhance 
each band separately.

Drawing type

With the option drawing type, different types of  histograms can be chosen. 
Filled will draw a filled histogram while Line will only show the contours of the 
histogram. The colour of the line or fill pattern depends on the selected band. 
The bands Red, Green, Blue and Gray are displayed in red, green, blue and 
gray respectively.

Type of histogram

• Standard: Standard display of the histogram. For each possible value on 
the X axis, the number of pixels that are assigned this value in the output 
image are shown on the Y axis. 

• Cumulative: For each possible pixel value on the X axis, the number of 
pixels that are assigned this value in the output image are shown on the 
Y axis. Furthermore, the number of pixels with the same or lower value 
are added to the result. 

• Logarithmic: This shows the logarithmic value of the histogram in each 
position, resulting in a more balanced histogram without dominating peak 
values. 

• Cumulative  Logarithmic:  This  shows  a  cumulative  histogram  in 
logarithmic values. 

RGB Check box

When check box labelled as  RGB is  ticked, it  is  assumed that the image is 
displayed as RGB with Byte data type and values between 0 and 255. If the 
checkbox is not ticked, it is assumed that the range of values are Byte data 
type values between -127 and 128, which will produce significant differences in 
the display and in the minimum and maximum values that are shown in the 
bottom of the input graph.

Display enhancement results

In the lower right part of the dialog (3), you can indicate how you want to see 
the enhancement results; in the current view or saved as a new layer.

Preview

The preview window (4) shows the real-time results of each enhancement that 
is applied to the image.

6.2.1.4 Save View as image

The tool for exporting the view as an image can be accessed from the drop-
down toolbar by selecting "Export to raster" on the left button and "Save view 
to georeferenced raster" on the right button. Make sure that the name of the 
raster layer that you want to export is set as the current layer in the text box.

Export to raster. Save view to georeferenced raster
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A message will appear to inform that you can use the selection tool to set the 
area in the view to export.

You can begin to select a area on the view

Now, you can select two points in the view to define the rectangle of the area 
to be exported, by clicking the first point and dragging the mouse towards the 
second point, then release.

Selection of a rectangle to define the output image

Then, the Save view to georeferenced raster dialog will appear. If the selected 
area is too small, the dialog will not appear and a bigger rectangle must be 
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selected.

Save view to georeferenced raster dialog

The upper part  of  the  Save view to georeferenced raster dialog shows the 
coordinates of the two points that define the selected area in the view. You can 
edit the coordinates to change the selected area.

In the option box in the central part of the dialog you can choose from three 
selection methods:

• Scale. Selecting this option will  enable the Scale textbox and the pull-
down box "Spatial resolution" which refers to the resolution in points per 
pixel (ppp) of the exported image. When entering a value in the Scale 
textbox and clicking enter, the values "Mts/pixel" and the size (Width and 
Height) will be recalculated for the output image. 

• Mts/pixel (Meters per pixel): When selecting this option, the "Mts/Pixel" 
textbox is enabled. When you enter a value in the Mts/Pixel textbox and 
press enter, the values for "Scale" and size ("Width" and "Height") will be 
recalculated automatically for the output image. 

• Size: When selecting this option, the text boxes to enter the "Width" and 
"Height" will be enabled. When you enter one of these values, the other 
will be calculated automatically to preserve the right proportions of the 
image. The other data ("Mtx/Pixel" and "Scale") will also be recalculated 
automatically. By default, the Width and Height values are displayed in 
Pixels, but you can select the units (Pixels, Cms, Mms, Mts, or Inches) in 
which you want to see these values. 

NOTE: To  save  time  and  memory  the  maximum size  of  output  images  is 
limited to 20000 x 20000 pixels. If the intended output image is larger and you 
click on "Apply", gvSIG will  display a message that the parameters must be 
changed before trying again.
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Clicking the "Selection" button will open a file browser dialog where you can 
specify the output file. Depending on the type of file, the corresponding driver 
will be loaded (you will notice that the button on the right of the "Selection" 
button will change). For example, an output file .jp2 will open the properties 
dialog for Jpeg2000. The formats in which you can save are .TIF, .IMG, .BMP, 
.PGM, .PPM, .MPL, .RST, .JP2, .JPG, and .PNG. Furthermore but only on Linux 
kernel 2.4 you can also select ECW.

File browser dialog to save the output image

When you select the output file, the Properties button will be enabled.

For example, for geoTiff the dialog will look like this:
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Properties geoTiff

• Photometric: [MINISBLACK | MINISWHITE | RGB | CMYK | YCBCR | CIELAB | 
ICCLAB  |  ITULAB].  This  assigns  the  photometric  interpretation.  The 
default is RGB, as the input image consists of 3 bands of the Byte data 
type. 

• Interleave: [BAND | PIXEL]. By default, tiff files are interleaved by band. 
Some applications only support interleaved by pixel, in which case you 
can change this option. 

• Compression: [LZW | PACKBITS | DEFLATE | NONE] This refers to the data 
compression. The default option is NONE. 

When the output image is selected and the properties set, you can click on 
"Apply". A progress bar will appear. Depending on the size of the output file, 
this  process  may  take  while.  Processing  times  may  vary  between  a  few 
seconds or  several  days,  so it  is  important  to check the size of  the output 
image in pixels before clicking "Apply". When finished, a screen with statistics 
will  appear  that  indicates  the  path  of  the  output  image,  the  disk  size,  the 
duration  of  the  process  and  whether  it  was  compressed.  To  check  the 
georeferencing of the output image, you can add it to the view as a new layer 
with transparency.

6.2.1.5 Clipping layers

(The clipping tool can be accessed from the raster toolbar by selecting "export 
to raster" from the left drop-down button and "Clipping" from the drop-down 
button on the right. Make sure that the raster layer that you want to clip is set 
as the current layer in the text box.)

With the clipping tool, you can create new layers from an existing one. The 
options are:

• Extract  an  area  from  the  input  image  to  be  saved  as  a  new  layer 
(cropping) 

• Modify the resolution through various interpolation methods 
• Modify the order or the number of bands 
• Separate the bands into multiple files 

Selection of the clipping area

In the "Coordinates" tab of the clipping dialog, there are text boxes to enter 
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coordinates. In the upper part are the values in pixel coordinates and in the 
lower  part  the  real  coordinates.  For  each  item,  the  two  upper  text  boxes 
correspond to the coordinates of the upper left corner, while the lower two text 
boxes  correspond  to  the  lower  right  corner.  When  changing  the  pixel 
coordinates,  the  real  coordinates  are  re-calculated  automatically  and  vice 
versa.

There are 3 selection methods that will fill the coordinates automatically. These 
methods can be activated by clicking the buttons on the bottom of the clipping 
dialog. From right to left, the buttons are:

• "Select from the view". This is the most commonly used tool to clip a 
layer. After clicking this button you can draw a rectangle over the view to 
select the portion of the input layer to be saved as a new layer. 

• "Full Extent of the raster layer" When clicking this button, the coordinates 
of the upper left and lower right corner of the input image are filled in the 
text boxes. 

• "Fit to the maximum extent of the ROIs of the layer". When clicking this 
button, the extent of the area covered by the ROIs associated with the 
layer is calculated, and the coordinates are filled in the text boxes. 
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Clipping dialog. Coordinates tab

Modifying the resolution

In  the  "Spatial  resolution"  tab  of  the  Clipping  dialog,  you  can  modify  the 
resolution of an output image through various interpolation methods. There are 
two option boxes located on the upper part of this tab:

• Cell  size:  Ticking  this  option  will  activate  the  text  box  labeled  "Cell", 
where you can introduce the new cell size value. By default, the text box 
shows the cell size of the input image. 

• Width x Height: Ticking this option will  activate the text boxes labeled 
"Width"  and "Height"  where  you can introduce  the desired width  and 
height of the output image. When changing the width, the height will be 
re-calculated  automatically  and  vice  versa  to  maintain  the  correct 
proportions of the selected area. 

When modifying the resolution it is necessary to resample and re-assign the 
pixel values for the output image through an interpolation method. There are 
four  interpolation  methods  available:  Nearest  neighbour,  Bilinear,  inverse 
distance  and  B-Spline.  The  nearest  neighbor  is  the  fastest  interpolation 
method, but the results in pixilation of the image and a lower visual quality. 
The other interpolation methods produce a smoother result.

The button labeled "Restore" returns the initial values of the input image.
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Clipping dialog. Spatial resolution tab

Band selection

The "Bands selection" tab of the Clipping dialog displays a table that lists the 
bands of  the input image. When processed, the output image will  have the 
bands in the order as shown in this list. By default, the output image will have 
the same order of bands as the input image. The order of the bands can be 
modified through the "Up" and "Down" buttons. The selected row will go up or 
down one position in the list. The bands can also be omitted from the resulting 
image by un-checking the corresponding row.
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Clipping dialog. Bands selection tab

Selecting Options

The "Options" tab of the Clipping dialog presents various options that can be 
set by the user:

• Name  of  the  output  layer:  you  can  modify  the  default  name  in  the 
textbox labeled "Layer names". This is the name that will appear in the 
TOC and the name of the file that will be saved to disk. In case of several 
output  layers (i.e.  when each band is  saved as a separate layer),  the 
name will  be the same for  each layer but  with a number  at  the end 
(_XXX).  For  example,  if  the  layer  is  called  NewLayer  and there  are 3 
output  layers,  the  respective  layer  names  will  be  NewLayer_1.tif, 
NewLayer_2.tif and NewLayer_3.tif. 

• If the check box labeled as "Create a layer for each band" is ticked, a new 
layer will be created for each band in the input image. 

• If the check box labeled as "Save on disk automatically" is ticked, a text 
box labeled "Directory" will be activated where you can indicate the file 
path for the output files. If un-checked, the generated output layers are 
temporary. 
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Clipping dialog. Options tab

6.2.1.6 Zoom to raster resolution

You can zoom to raster resolution by right-clicking on the layer in the TOC. In 
the context menu that appears, click "Zoom to raster resolution".

This will  activate a crosshair cursor in the gvSIG view which allows users to 
perform an action by clicking somewhere in the view. The action in this case is 
that with every mouse-click, the view will be centered on the point where you 
clicked. In addition, the view will zoom so that one screen pixel is the same size 
as a pixel in the current raster layer.

6.2.1.7 Automatic vectorization

The "automatic vectorization" function can be launched from the raster toolbar 
by selecting "Raster process" on the left drop-down button and "Vectorization" 
on the drop-down button on the right. Make sure that the name of the raster 
layer that you want to vectorize is displayed as current layer in the text box.

July 2011 Page 518 of 655



Vectorization icon

With automatic vectorization, you can generate a vector layer from a raster 
image using preprocessing to highlight the features of interest.

When launching the Vectorization dialog, the first step is to select the area of 
the  image that  you want  to  vectorize.  Keep in  mind that  the  vectorization 
process may take a long time, so it  is  recommended to minimize the area 
(number of pixels) for vectorization. The selection of the area for vectorization 
can be done in several ways. You can type the coordinates directly; either in 
pixel coordinates or in the map coordinates. The area can also be selected from 
the view by clicking the button "Select from the view", after which you can 
draw an approximate rectangle to define the area. Another selection option is 
by Region Of Interest (ROI).  You can define a ROI here or use a previously 
defined ROI  to set the area for  vectorization.  In the section "ROI  selection" 
appears a list of available ROI and a checkbox next to each of these to select 
one or more ROI that you want to use. There are two options to vectorize the 
ROI:  to  vectorize  the  entire  area  inside  the  rectangle  (bounding  box)  that 
covers all the selected ROI, or vectorize only the areas inside the ROI while 
considering the values outside the ROI as NoData values, excluding them from 
the calculations.

Finally  you can select  the  scale  of  the  image to  preprocess.  This  is  useful 
because a higher resolution of the preprocessed image will result in a higher 
precision for the resulting vector layer. You can define this with the drop-down 
text box labelled "Output Scale". By default, the resolution will be the same as 
the input image.

When moving on to the next step of the wizard, the process of cutting the 
image for preprocessing is started. A progress bar appears with the warning 
that this operation could take a few minutes. The resulting image cut is saved 
in the temporary folder of gvSIG.
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Vectorization. Selection of the area to vectorize

There are two methods to preprocess a raster image to vectorize. The first is by 
creating a  limited  number  of  grayscale  levels  from the original  image.  The 
image will be converted to grayscale using one single band or a combination of 
bands  (use  the  drop-down  button  labelled  "Bands").  For  the  conversion  to 
grayscale, a posterization process is used to reduce the number of different 
values. (By default, the image is reduced into 2 levels only: black and white.) 
For this process you can control the threshold on which the values are passing 
from black to white and vice versa. This can be done by moving the "Treshold" 
slider while you can see a preview of the result. (The Treshold slider is only 
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available  when  there  are  2  levels;  when  there  are  intermediate  grayscale 
levels, the slider is disabled.) In addition to the posterization threshold, you can 
apply a mode filter or a noise filter to smoothen the result.

Vectorization. Conversion to grayscale

The second preprocessing method is useful to vectorize contour lines and can 
be applied to data types other than byte.  With this method you can define 
intervals  between  each  contour  line  to  be  vectorized.  You  can  specify  the 
number of intervals in which you want to divide the raster, or indicate the size 
of each interval. The cuts that have been selected will be shown on a graph 
that represents the histogram of the image. On this graph, you can modify the 
distance between cuts, or add or remove some of them using the mouse. It is 
also possible to modify the distance between cuts in numeric format using the 
table on the right of the histogram. Each entry in the table represents a cut 
with the corresponding value.  This  type of  preprocessing is  used for  digital 
elevation models (for example .adf or .asc images).

When moving on to the last step of the vectorization wizard, the preprocessed 
image is  generated  with  the  specified  values,  and  saved in  the  temporary 
directory of gvSIG.
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Vectorization. Define intervals for vectorization in case of Digital Elevation 
Models

The last step is to select the method for generation of vectors. There are two 
methods: contour and potrace, that can be selected from the drop-down button 
after which a panel appears with settings that are specific for the method. The 
first method is the simplest and does not have any options. This method will 
trace  the  vectors  in  straight  sections  going  through  the  pixel  centers.  This 
generates  a  network  of  vectors  based on  very  small  straight  sections.  The 
potrace method uses the potrace library for vectorization. The available options 
for this method are those that the potrace library provides and they are used to 
define the precision of the tracing of the curves: number of points for each 
curve, threshold, optimization, etc.
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Vectorization. Options for vector generation

When clicking on "Apply" or "Accept", the process of vectorization will  start 
after which you will be prompted whether to display the generated layer in the 
TOC.

6.2.1.8 Analysis view

The  "Analysis  view"  can  be  launched  from  the  raster  toolbar  by  selecting 
"Raster layer" from the left drop-down button and "Analysis View" on the drop-
down button on the right. Make sure that the name of the raster layer that you 
want to analyze is displayed as current layer in the text box.

Analysis View icon

With this  functionality  you  can  zoom in  on  the  current  raster  layer  with  3 
different zoom levels:

1. On the left of the view, the layer is added to the locator map of gvSIG. 
This provides a general view of the layer, and you can zoom into the 
locator map by clicking and dragging, thus drawing a red rectangle. The 
area inside the red rectangle will be displayed in the view. 

2. The view itself is the second zoom level which functions independently, 
and the zoom variations that are performed on the view will be applied to 
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the locator map as well so that it keeps being centered on the correct 
area. 

3. When  launching  the  Analysis  view,  a  small  floating  window  labelled 
"Cursor Zoom" appears in the upper right corner of gvSIG. This window 
has the highest zoom level. The zoom level is fixed and always centered 
on the mouse point. By moving the mouse over the gvSIG view, you will 
see the contents change. 

You can change the relation between the zoom level of this floating window 
and the gvSIG view. This is done by right-clicking on the floating window and 
selecting  one  of  the  values  that  are  shown  in  the  drop-down  menu  that 
appears. The available options are x4, x8, x16, and x32. This means that the 
pixels  in  the floating window will  be 4,  8,  16,  or  32 times bigger  than the 
original.

The floating window also shows the RGB values of the pixel on which the cursor 
is currently located. The text colour of the RGB values as well as the colour of 
the  central  cross  (red  by  default)  can  be  changed by  right-clicking  on  the 
floating window and choosing the option from the drop-down menu.

Keep in mind that, to see the effects in the floating window while moving the 
mouse over the view, the view must be active. If it is not active, just click on 
the  view.  When the  cursor  is  outside  the  view,  the  content  of  the  floating 
window appears black.
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Screenshot with the different elements of Analysis View

There can only be one Analysis view open at any time in gvSIG. Therefore, the 
button "Analysis View" is re-labelled as "Close Analysis View" when the Analysis 
view is already open, so that it can be closed before re-opening.

6.2.2 Geographic Transformations

6.2.2.1 Geolocation

The Geolocation tool provides the ability to change the related transformation 
that is applied to a raster in its display. A raster could have coordinates that 
place it in a geographical position. This geographic location is only a change of 
position, scale and rotation of the image relative to an original position. These 
changes in position, scale and rotation are those that can be changed with this 
tool. This can be done numerically and by visual approximation.

This tool  does not provide capabilities to deal with complex projections and 
georeferencing involving the need for resampling.

To launch the geolocation dialogue of the layer, the drop-down toolbar is used 
by  selecting  "Geographical  Transformations"  on  the  left  button  and 
"Geolocation" on the dropdown button on the right. Make sure that the text 
shows the name of the layer to which we like to assign the transformation.

Geolocation Tool

Upon  activating  the  geolocation  tool  on  a  raster  layer,  a  small  dialog  will 
appear floating on the view with a series of text entries and a button bar. Also 
the raster layer that has been selected acquires the capacity to be moved, 
rotated or moved by clicking and dragging it to the right place on the view.
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Transformation on the view

• Translation: When the geolocation tool is active you can move the mouse 
over the image on the screen and the cursor changes to a hand. This 
indicates that we can move by clicking and dragging on the raster view. 

• Scaling: When the geolocation tool is active you can move the mouse 
over the edges of the image on screen and the mouse cursor will change. 
Depending on the chosen edge the cursor will take one form or another. 
If placed in the top or bottom borders the cursor will become a vertical 
arrow. This indicates that we can click and drag to scale the image from 
one side only. The scaling at all times keep the proportions of the raster. 
If  we move the  cursor  around the side edges the pointer  becomes a 
horizontal  arrow now allowing us to scale laterally.  In the case of  the 
corners the cursor appears as an oblique arrow. 

• Rotation: When the geolocation tool is active, we can move the mouse 
over the outer corners of the image and the cursor will change. This will 
appear as a circular arrow. This indicates that we can begin to rotate the 
raster from the selected corner. 

• Shear:  When the geolocation tool  is active you can move your mouse 
over the outer side edges of the image and the mouse cursor will change. 
This will appear as an arrow with a symbol X or Y depending on whether 
the  mouse  is  in  the  horizontal  or  vertical  edges  respectively.  This 
indicates that we can begin to warp the raster in the direction of the X or 
the Y. 
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Vista Panel Image Geolocation

Transformation by introducing coordinates

From the geolocation floating box we can modify  the transformation of  the 
image on the view. The text entries marked as X, Y, Pix X, Pix Y, Rot X, Rot Y 
contain the current position in upper left X coordinate, upper left Y coordinate, 
pixel size in X, pixel size in Y, rotation in X and rotation in Y respectively. If we 
change these values from the keyboard these will be updated on the image by 
pressing the "Enter" key while the cursor is inside the text box or when it loses 
focus.

Controls of the geolocation box

Centering the raster layer in the view: With this button we center the raster in 
the current view regardless of zoom it has selected. The coordinates will  be 
automatically calculated.

• Initialize  the raster transformation:  Resets all  the transformations that 
have been applied to the cells back to the default. 

• Go  to  the  first  processing:  Assign  the  first  transformation  that  was 
applied. 

• Go to the previous transformation: Assign the previous transformation to 
the current that was applied. 

• Go  to  the  next  transformation:  Assigns  the  following  to  the  current 
transformation. 

• Upload  georeferencing  from  tfw  file:  If  we  have  a  tfw  file  with 
georeferencing  coordinates,  these  can  be  loaded  with  this  option.  A 
dialog to select the file you want will show up. The extension of the file 
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must be tfw or wld. 
• Save current transformation as the default for the raster: Applying this 

option saves the currently active transformation in the file .rmf attached 
to raster. Next time the raster is loaded will be with that transformation. 

6.2.2.2 Georeferencing

6.2.2.2.1 Description

Direct traslation from Google traslator

To launch the georeferencing dialog it is used the dropdown toolbar selecting 
the "Geographic Transformations" button on the left and "Georeferencing" from 
the dropdown button on the right.

Georeferencing Tool

Initially we must decide what type of georeferencing to implement, "reference 
maps" or "without reference maps".

6.2.2.2.2 Georeferencing with "Mapping Reference"

Start Dialogue georeferencing

To implement this type of georeferencing is imperative that we have previously 
charged in a view mapping that we will  provide a geographic  reference for 
taking  control  points.  In  case  of  not  having  it  will  close  the  options  dialog 
georeferencing and proceed to prepare for the hearing. Once we have the view 
with  reference  maps  georeferencing  tool  launched  will  see  that  the  option 
"reference maps" is checked by default. Below is a dropdown menu which lists 
the views that gvSIG has at that time. If you have several it must select a view 
which is our base mapping for decision-points.
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Dialog Georeferencing

In the panel marked "a georeferenced file" pops up a dialog for selecting the 
file for which you want to create checkpoints and later georeferencing.

The panel labeled "Output File" we must put the path and file name destination 
if the georeferencing is done with resampling. This option can vary from box 
options once we are inside the application, so it is not essential to a correct 
value at the moment, but if must be done before the end of the process.

The panel "georeferencing algorithm" select how we will get the output result. 
There  are  two  possibilities,  "affine  transformation"  and  "polynomial 
transformation".

The affine transformation applied to raster an affine transformation only to the 
calculations performed with the control points taken. The affine transformation 
applied will be allocated "on the fly" for the display and the output image is the 
same  as  the  input.  The  result  of  this  transformation  is  therefore  a 
georeferencing file. Keep in mind that this type of transformation is limited and 
the user will be responsible for selecting the most convenient transformation in 
each case.

The polynomial transformation involves a resampling of the input image taking 
into account the reference control points and obtaining an output image with 
deformations necessary to adapt to the new location. If you select this option 
we will be forced to decide the degree of transformation that we apply and the 
type  of  interpolation  that  we  want  to  apply  for  calculating  new  pixels. 
Depending on whether you choose one degree or another need a minimum 
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number of control points for them. This number of points required is given by 
the formula (order + 1) * (order + 2) / 2, ie for a polynomial of degree one will 
be needed at least three points,  to grade two will  need six points for third 
grade ten points ... The interpolation method affects the way we calculate the 
information that we have not. When an image georeferenced output image has 
deformations with respect to the original there are areas where no information 
is available. These can not be empty with what must be calculated from the 
areas  where  we  know.  These  calculations  can  be  performed  by  various 
methods, the simplest of these is "Nearest neighbor" which will be unknown 
pixel  information  closest  known  pixel.  Other  methods  such  as  "bilinear"  or 
"bicubic" make calculations using the known group of pixels surrounding the 
unknown.  These other  methods  give  a  more  relaxed but  it  is  slower  in  its 
implementation. This option can vary from box options once we're inside the 
application.

The panel "Pixel  Pitch" is the pixel  size information of  the output image. In 
principle  this  will  be  calculated  from the  input  image  but  can  be  changed 
manually.  This  option  can  vary  from  box  options  once  we  are  inside  the 
application, so it is not essential to a correct value at this time.

The views

Executing the application are two views. The left contains the base mapping 
that  we  carry  in  the  gvSIG  view  of  the  right  and  the  image  we  want  to 
georeference. Both have a control bar on the right for view actions. Also in the 
upper  left  corner  are  the  coordinates  of  the  mouse  cursor.  In  reference 
mapping  coordinates  are  those  of  the  real  world.  In  the  image  to  be 
georeferenced coordinates in pixel coordinate on the upper left.

Cursor Zoom

In the central part appears a cursor with a central window. The window cursor 
is active when the view can be resized and moved. The contents of this window 
will be on display in the zoom windows. Ca da vista has its associated zoom 
window at the bottom. Par resize window cursor select the view you want by 
clicking on it then bring the mouse to the edges of the window until the pointer 
changes to horizontal or vertical arrows. Now we click and drag to force the 
resizing. To move the cursor window select the view you want by clicking on it 
then bring the mouse to the corners of the window until the pointer changes by 
crossed arrows. We must now drag and drop to force displacement.

View Controls

There  are  six  controls  to  handle  the  zoom level  and  position  of  the  view 
mapping
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 Increase the level of zoom: the zoom level increases by multiplying by 2 
the current level.

 Decrease zoom level: it decreases the zoom level by dividing by 2 the 
current level.

 Zoom area selection: Activates a tool on the hearing in order to make a 
rectangle the area we want to see enlarged.

 Full Zoom: Put a zoom level so that you can view the entire mapping.

 Zoom Previous: Sets the zoom level that you previously selected.

 Displacement: clicking and dragging on the scroll view mapping.

Zoom controls

Each view has an associated georeferencing zoom window centered over the 
cursor. When we move the cursor on the sale of view varies the position where 
the zoom and focus when we change the window size changes the zoom level. 
In the upper left corner of the window coordinates of the mouse cursor as in 
the overview.

Zoom box associated with the views

Checkpoints

A  control  point  is  an  entity  that  provides  a  correspondence  between  a 
geographic coordinate and pixel coordinate. Control points are represented in 
raster  geographic  view as  Blue-and  red  circles  respectively.  To  add  a  new 
control point is selecting "New" in the table control. This makes a new entry in 
the table appears. A control point is associated with a table entry. By selecting 
"New" automatically creates a point at coordinates 0, 0 for both views and will  
activate the tool "move point". Now clicking on the view point where we will 
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move puncture. We assign the coordinate point numerically by writing directly 
on  the  input  value  in  the  table  (X  for  the  geographic  coordinates  X,  Y 
geographic coordinate for Y, X 'for X and Y pixel coordinate' for the pixel Y 
coordinate). The points can also be moved by clicking and dragging on them. 
This may be done both in hearings and in the zooms.

The process of georeferencing. Sights and points of control

Options

The panel labeled "Output File" we must put the path and file name destination 
if the georeferencing is done with resampling.

The panel georeferencing algorithm "select how we will get the output result. 
There  are  two  possibilities,  "affine  transformation"  and  "polynomial 
transformation".

The affine transformation applied to raster an affine transformation only to the 
calculations performed with the control points taken. The affine transformation 
applied will be allocated on the fly for the display and the output image is the 
same  as  the  input.  The  result  of  this  transformation  is  therefore  a 
georeferencing file. Keep in mind that this type of transformation is limited and 
the user will be responsible for selecting the most convenient transformation in 
each case.
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The polynomial transformation involves a resampling of the input image taking 
into account the reference control points and obtaining an output image with 
deformations necessary to adapt to the new location. If you select this option 
we will be forced to decide the degree of transformation that we apply and the 
type  of  interpolation  that  we  want  to  apply  for  calculating  new  pixels. 
Depending on whether you choose one degree or another need a minimum 
number of control points for them. This number of points required is given by 
the formula (order + 1) * (order + 2) / 2, ie for a polynomial of degree one will 
be needed at least three points,  to grade two will  need six points for  third 
grade ten points ... The interpolation method affects the way we calculate the 
information that we have not. When an image georeferenced output image has 
deformations with respect to the original there are areas where no information 
is available. These can not be empty with what must be calculated from the 
areas  where  we  know.  These  calculations  can  be  performed  by  various 
methods, the simplest of these is "Nearest neighbor" which will be unknown 
pixel  information  closest  known  pixel.  Other  methods  such  as  "bilinear"  or 
"bicubic" make calculations using the known group of pixels surrounding the 
unknown.  These other  methods  give  a  more  relaxed but  it  is  slower  in  its 
implementation.

The panel "Pixel  Pitch" is the pixel size information of the output image. In 
principle  this  will  be  calculated  from the  input  image  but  can  be  changed 
manually.

The panel labeled "Options" contains settings of a different nature. Since we 
can change the background color  of  view,  the text  color  of  the views.  The 
"show the number of graphically checkpoint" will be displayed or hidden by the 
control point a point that indicates the corresponding point number. "Add the 
CSV file errors" will be generated when this type of text files with all the control 
points  we can ignore  the  file  or  add  the  calculated  errors.  The "Focus  the 
selected point view" makes automatically every time we select a point on the 
table the view is focused on this. The effect is much as if the tool center point 
was always active. The "error threshold for the warning," assigns the value at 
which the error appears in red on the table.
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Options for georeferencing

Points Table
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The points table is below the sights and initially will be empty. Each table entry 
corresponds to a checkpoint. It appears all the information related to a point. 
This table can see it folded its default state or maximized. In its maximized 
state are folded more information. On the left side of the row there is a check 
to activate and deactivate the current row. This means that this point will not 
be displayed graphically or be taken into account for calculation errors and will 
be prosecuted to do a test. The information can be found in the points table on 
each point:

• Number of point 
• Real coordinate X 
• Real coordinate y 
• Coordinate pixel X 
• Coordinate pixel Y 
• Error in X 
• Error in Y 
• Total RMS error for that point 

The quality of the geometric correction can be estimated based on the mean 
square  error  RMS  error  and  the  contribution  of  each  point.  When  the 
contribution  to  RMS  of  a  point  is  high,  this  may  indicate  that  the 
correspondence of points was poorly selected and the point is not well suited to 
model transformation between image and map or other information used as 
reference. The points with high contribution that exceeds a certain threshold 
can be deleted or deactivated, and calculate the RMS. However, when we are 
fully confident of the location of a point, and to find you, the RMS is triggered, it 
may  be  possible  that  the  geometric  model  does  not  resolve  the  local 
arrangements,  for  which  they may need a better  model,  which means,  put 
some more points, right on the problem area.

There is also a global RMS error in an external text field for all points.

Control Panel points
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Controls

 Tool center point: When you press the focus control to the view point that 
is selected.

 Georeferencing operation completes. Before you ask if we carry on the 
gvSIG view the results of the last trial. You'll also want confirmation of 
application output.

 Launching the options dialog.

 Make a test with the control points currently entered. If there are not 
enough for the specified algorithm will warn. The result is that applying the 
transformation and loading the transformed image on the view with the 
reference maps.

 Save the control points in the metadata file attachment with the raster.

 Retrieves the control points that are in the metadata file attached to 
raster.

 Ends the test of processing the raster. Eliminate the test image loaded in 
the view with the mapping.

 When the button "Select point" we are active, clicking on the view 
assigning the selected point on the table at that time to the position.

Sequence capture control points

There  may  be  ways  to  capture  control  points  with  the  tools  available.  An 
example would be the following sequence of actions:
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• Click "New" in the table of control points. This will create a new row is 
selected in the table. In addition the tool "Move Point" is selected. 

• Click with your mouse pointer over the view to locate the point raster. 
• Click  with  your  mouse  pointer  over  the  view with  reference  maps  to 

locate the point. 
• Push the button "Refocused selected view point" to place the checkpoint 

in the center and appears in the zoom window. 
• With the tool of choice for area Zoom "or" increase the level of zoom "or" 

Decrease the zoom level "we can set the desired zoom level until  the 
controls of" Zoom "we have an optimal resolution level approximate. 

• Click and drag the control  point in the zoom window to place it  more 
precisely. The accuracy depend on how correct is selected previous zoom 
level. 

• Use the zoom tools to return the view to a wider zoom level and to allow 
a new control point. 

• To return to one point and reset the Selection Click on the row of the 
table, click "Center views the selected point,  adjust the zoom level  to 
zoom tools  and we'll  move the  view by clicking and dragging on the 
window zoom for greater accuracy. 

6.2.2.2.3 Georeferencing with resampling

Two  types  of  processing  for  raster.  If  selected  in  the  options  the  affine 
transformation  the  image  obtained  is  not  wide  and  applies  an  affine 
transformation  on  the  view.  This  transformation  is  a  scaling,  displacement, 
rotation  and  deformation  in  the  direction  of  axis  X  and  /  or  Y  axis  The 
transformation  with  resampling  involves  generating  a  new image  from the 
original on which areas can appear empty. These areas are due to the fact that 
the resulting image should be rectangular but the area covered by the data 
processing may not have applied this same way.

Results georeferenced image with resampling
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Once the process of  georeferencing the raster generated and loaded in the 
view we can apply a transparency per pixel to eliminate the empty areas.

Image georeferenced, with application of transparency

6.2.2.2.4 Georeferencing without "Mapping Reference"

The georeferencing without reference maps is useful when you do not have 
imagery that guide us to assign the control points. We will have to allocate the 
actual coordinates directly by typing its value. In this case it is useful in view of 
the left so it  will  allow more space for the raster and the points table. The 
operation is very similar to the two views just that when you select the point on 
the reference maps have to type the entry of the table directly.

The operation of other controls is the same as with reference maps.

Modifying georeferencing upon loading
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When you load a file that is not georeferenced, gvSIG can prompt you to enter 
the  coordinates  manually.  For  this  the  option  has  to  be  activated  in 
preferences, which is disabled by default. The option that needs to be activated 
is "Pedir las coordenadas al cargar un raster que no tiene georreferenciación".

Raster Preferences. Pedir las coordenadas al cargar un raster que no tiene 
georreferenciación

In this case we will see a dialog with the message: "Name of layer. The layer 
has no georeferencing. Do you want to enter them manually?". If you answered 
"No", the load is carried out with the coordinates (0, 0) in the top left corner 
(width in pixels,  height in pixels) in the lower right corner.  If  the answer is 
"Yes", then a dialog to enter the coordinates of the raster will show. In this one 
must be careful to enter valid data to avoid erroneous results. The dialog has 
two  tabs  from  which  we  can  enter  the  coordinates  in  the  form  of  affine 
transformation or the upper-left and bottom-right corners. In the first mode will 
need the X and Y coordinates of the upper right corner of the original raster, 
the pixel size in X, the pixel size on Y, X rotation and the rotation Y.
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Loading raster without georeference. Transformation

In the second mode we only introduce the coordinates of the corners in the 
order indicated by the graphs.
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Loading raster without georeference. Corners

6.2.2.3 Image reprojection

For  the  reprojection  of  raster  layers,  gvSIG  uses  the  GDAL  library.  The 
reprojection process can be launched in two different ways: By activating the 
reprojection icon from the raster toolbar for images that have already been 
loaded to the view, or by reprojecting the layer before it is loaded to the view if 
this is needed.

The  GDAL  library  does  not  support  ecw,  mrsid  or  jpeg2000  images  and 
therefore images in these formats cannot be reprojected.

To launch the reprojection dialog from the raster toolbar, select "Geographic 
transformations"  on the left  drop-down button and "Reproject  layer" on the 
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drop-down button  on the right.  Make sure  that  the  layer that  you want  to 
reproject is set as the current layer in the text box.

Image reprojection icon on the raster toolbar

When launching  the  reprojection  function  from the  raster  toolbar,  a  dialog 
opens which shows the projection information of the input image as "source 
projection". The source projection cannot be changed as it is assumed that the 
input layer has been loaded into the view with the correct projection. Under 
"target projection" the projection of the output image can be set by the user 
through the standard gvSIG dialog for CRS and transformations. It should be 
noted that not all transformations are supported; the projection options depend 
on the GDAL reprojection library.

The output layer can be saved on disk or opened in memory as temporary file. 
When the first option (which is the default) is selected, the user is prompted for 
a file name and path. Then, the reprojection process starts and when this is 
finished, it will ask whether you want to add the new layer to the TOC.
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Reprojection dialog

NB: When  reprojecting  an  image,  the  used  transformation  is  "EPSG 
Transformation";  with  raster  layers  the  other  transformations  (manual, 
composed or grid) can not be used.

Images can also be reprojected before loading them to the view. To do this, 
you  will  need  to  have  the  option  "Ask  for  projection  when  the  raster 
loaded has different projection from view", located in the raster options 
section  of  the  Preferences  dialog,  selected.  If  this  option  is  selected and a 
raster with a different projection than the view is loaded, a dialog is opened 
with projection options. The default option is to load the layer while ignoring 
the  projection,  but  you  can  reproject  the  layer  by  selecting  the  option 
"Reproject raster to the view projection". Then, the same Reprojection dialog is 
shown, but in this case the "target projection" is fixed to the projection of the 
view,  and  the  "source  projection"  can  be  changed,  as  in  some  cases  the 
projection  of  an  image  may  not  have  been  set  correctly  or  the  needed 
projection information maybe missing.

After accepting the settings, the reprojection process will start and the layer 
will be added to the TOC.
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Reprojection options when loading an image to the view

6.3 Alphanumeric

6.3.1 Exporting to dbf and xls

Exporting Tables to DBF and Excel

The  application  allows  tables  (whether  layer  attribute  tables  or  separate 
alphanumeric tables ) to be exported in two formats:

• 1.Excel: Export data to a new Microsoft Excel file. The data appears on 
the  second row  of  the  first  sheet.  The  first  row  contains  the  column 
names. 

• 2.DBF: Export data to a dBase file. 

Follow these steps to export a table:

A. Select the table:

To export a table it must first be opened. The export operations are activated 
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once the table is opened.

To export a subset of the records use the selection tools to select the records 
to be exported. The records can be selected either from the attribute table or 
by selecting the corresponding geometries in the View.

B. Select the export option

To do this select the menu option:

For Excel: Table/Export/Excel.

For Dbase: Table/Export/DBF.

Export to Excel
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Export to DBF

C. Enter the file name

Locate the directory where you want to create the file and type a name for the 
file.  If  the  file  already  exists  the  application  will  ask  for  confirmation  to 
overwrite it.

6.3.2 Joining tables

The tool for joining tables has been improved and now reflects the relationship 
between the tables  once they have been joined.  The operation  of  the  tool 
remains the same in that both tables must contain a common field that will 
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be used to join them together.

Dialog for joining tables

It is possible to add a  prefix to the source table fields so that they can be 
easily identified in the joined table, e.g. Table1_FIELD1, Table1_FIELD2, etc. In 
a  similar  manner  a  prefix can  also  be  added  to  the  target  table  fields: 
Table2_FIELD1, Table2_FIELD2, etc.

The resulting joined table is given a title made up of the tables participating in 
the join, e.g. Table1 X Table2 X, or vice versa.

Result of the table join

The join between the tables can be removed by selecting 'Remove joins' from 
the Table menu.

• Note: A layer can't be edited once a join has been established on it and 
the "Start Editing" option on the layer's context menu will be disabled. To 
start an editing session go to the Table menu and remove the existing 
joins. 

6.3.3 Join

The “Join” tool allows two tables to be joined via a common field. You can also 
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access this tool by clicking on the following button

or by going to the “Table” menu and then to “Join”. To join the two tables, 
carry out the following steps: Firstly, specify the source table the join is to be 
made from.

Then specify the field to be used for the join.

Then indicate the table you wish to join to the first one.
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Finally, indicate the field in the second table which is common to the first one.

If you open the data source table, you will see that the fields of the destination 
table have been joined. The name of the field added to the table is identified by 
the word “Join_(Field name)”

6.3.4 Statistics

You can access this option by clicking on the following button

or by going to the “Table” menu and then to “Statistics”.

The “Statistics” tool allows you to obtain the most common statistical values.

N.B.: Remember that the tool will not be activated until you select a numerical 
field.

If  you  wish  to  obtain  field  statistics,  select  the  field  (left  click  on  the  field 
heading), then click on the “Statistics” tool.

You can only obtain statistics from a series of records, firstly, select the field 
the values are located in, then select the desired records,  and click on the 
“Statistics” tool.
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7 Maps

7.1 Preparing a page

You can use this tool to define the working area, i.e. the size and properties of 
the page to be used for the map layout. You can access this tool by clicking on 
the “Configure page” button in the tool bar or from the menu bar by selecting 
the “Map” option and then “Prepare page”.

When you have selected the tool a new window will appear:
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Page size: The pull-down menu allows you to define the source and size of the 
paper to be used to print the map. You can select a standard size or define 
your own.

Measuring  units: You  can  select  the  units  of  measurement  for  the  page 
Height and Width. Orientation: This defines whether the paper will be printed 
horizontally or vertically.

Margins: This  allows  you  to  define  the  page’s  four  margins.  The  ruler  is 
adjusted to fit in with the page margins.

Resolution of the result: You can choose between high,  low and normal 
resolution.  When you have finished configuring the page, click on the “Ok” 
button.

7.2 Templates

Saving templates gvSIG allows the configuration of a map to be saved as a 
template.

This can then be used at a later date with different data sources.
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The element distribution and properties from a map can be saved.

If you click on the “File” menu then on “Save as template”
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a dialogue box appears so you can save your .gvt file which can be recovered 
at a later date and will allow you to reconstruct the map configuration.

7.3 Tools for navigating in a map

You can use these tools to move around and zoom in and out of the maps 
page.

You can access the tool from the tool bar or by going to the “Map” menu and 
then to “Navigation”.

Zoom in: This allows you to zoom into the page.
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Zoom out: This allows you to zoom out of the page.

Panning (Frame): This allows you to move the map page.

Full extent: This carries out a full zoom of the page.

Scale 1:1 zoom: This carries out a “real” size zoom of the configured page.

Zoom in: This zooms into the centre of the page.

Zoom out: This zooms away from the centre of the page.

7.4 Graphic elements

7.4.1 Operations with graphics

gvSIG can be used to carry out a whole range of operations to prepare the 
layout of your map.

You can access these tools by going to the "Map" menu then to “Graphics” or 
by going to the tool bar.

The “Graphics” menu can be used for the following:

• Properties 
• Align 
• Group / Ungroup 
• Simplify the legend 
• Bring to front and send to back 
• Size and position 
• Graphic line (to create frames) 
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7.4.2 Inserting elements in a map

7.4.2.1 Introduction

gvSIG can be used to add the following cartographic elements to a map:

• Views 
• Images 
• Scale bars 
• Legends 
• Graphic objects 
• North 
• Texts 
• Boxes 

Many  of  these  cartographic  elements  are  closely  linked  to  the  “View” 
document, so that when changes are made in the view, they are shown in the 
map  (changes  in  zooms,  panning,  legend  modifications,  layer  organisation, 
etc.). You can access the different options from the tool bar or by going to the 
“Map” menu and then to “Insert”.
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7.4.2.2 Legend

The legend represents the visible layers of the ToC in the selected view. If a 
legend is inserted, it is added in the same order as it appears in the ToC.

In the view frame, select the view the legend is associated with. The order in 
which the legends in the ToC will be added appears in the panel on the right.
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7.4.2.3 Scale range

This tool allows you to insert a scale (associated with the view) in the map.

The scale bar dialogue box is shown below:

View frame: Select the view, if there is more than one, the inserted scale is 
related to.

Bar: Select  the  type  of  scale  you  wish  to  insert  (numeric  or  graphic).  By 
clicking on the pull-down menu, you can see the different options with which 
the scale to be inserted in the map can be shown.
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Intervals: Select the number of intervals, what each one represents and the 
number of divisions to the left of the 0 that you require in the interval.

Scale: You can use this section to make the numeric scale appear above the 
bar.

Units: This defines the graphic scale units of measurement (metres, Km., etc.).

Labels: You  can  use  this  box  to  select  the  label  colour,  font  and location 
(numeric scale, units…).

7.4.2.4 North symbol

If  you click on the “Insert  “North”  button in  the tool  bar,  you can insert  a 
“North” symbol in the map. Place the mouse pointer on one of the vertexes of 
the rectangle which define the space to be occupied by the symbol, left click, 
then  drag  the  pointer  to  the  opposite  vertexes  and  drop.  A  dialogue  box 
appears in which you can choose between several default North symbols.
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You can add new symbols by copying them in the folder:

bin/gvSIG/extensiones/com.iver.cit.gvsig/northimages

of the folder you have installed gvSIG in.

The acceptable format for North symbols is SVG (Scalable Vector Graphics). To 
add a new North symbol you will need to use an external application (such as 
Inkscape http://www.inkscape.org). Moreover, in order to ensure that the new 
North symbol will be correctly processed by gvSIG, it is better to base it on one 
of the default symbols suggested by gvSIG.

7.4.2.5 Box

gvSIG has a tool which allows you to insert a box in the map.

If you wish to insert a box, select the following button from the tool bar:

Left click on the map area you wish to insert the object in and drag it to create 
a frame which will define the future box size.

When you drop it, a window will automatically appear for you to define some of 
the box properties.

7.4.2.6 Image

You can use this tool to insert an image in the map.

You can access this tool by clicking on the “Insert image” button or by going to 
the “Map” menu bar, then to “Insert” and then to “Image”. If you activate this 
tool and create the frame to insert the image on the map (similar to “Insert 
view”), the following dialogue box will appear:

http://www.inkscape.org/
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If you click on the “Browse” button, you can select the file path of the image to 
be inserted. You can insert an image in any of the following formats: jpeg, jpg, 
gif, png and bmp.

From gvSIG version 0.4 onwards, you can add vector files in SVG format to the 
map.

7.4.2.7 Views

7.4.2.7.1 Insert a view

You can insert a view in the map by clicking on the “Insert View” button in the 
tool bar.

Place the mouse pointer on one of the vertexes of the rectangle which define 
the view area, left click and drag the pointer to the opposite vertex and drop. A 
dialogue box appears in which you can define the view-type element properties 
you have just inserted.
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View: You can use the text box to select the view you wish to insert, if there is 
more than one.

Active  link: If  this  check  box  is  enabled,  any  changes  made  in  the  view 
(changing colour, adding a layer…) will be shown in the map. Remember that 
scale  changes  will  not  be  affected  by  this  check  box,  because  these 
modifications are regulated by the scale pull-down menu which appears below.

Scale: Select one of the following three scale types: Automatic: If this option is 
chosen, any scale change made in the view will automatically be shown on the 
map.

Keep visualisation scale: In this case, although you change the view frame 
in the map, the layer associated with the view will not resize itself and will keep 
the same size it has in the view.

User-defined: This option allows you to define a specific scale.

Quality: This defines the visualisation, as either presentation or draft quality.

Degrees: This allows you to specify a degree of  rotation when the view is 
inserted in the map. This option also appears in the rest of the elements that 
can be inserted: images, scales, legends and texts.

7.4.2.7.2 Exploring the view of the map

There are several tools you can use to navigate around the view.

Zoom in: Enlarges a particular area of the view.

Zoom out: Reduces a particular area of the view.

Full extent: Full zoom of the total area included in all the layers of the view.
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Panning: This allows you to change the view zoom by dragging the viewing 
field all over the view with the mouse. Click and hold down the left button of 
the mouse then move the mouse in the direction you require.

7.4.2.8 Texts

Texts, which can also be inserted by clicking on the corresponding button in 
the tool bar or by selecting “Maps” then “Insert” and then “Text”, are defined 
in the following dialogue box.

You can write the text you wish to appear in the map in the text box.

Align: This can be used to select the alignment type (left,  centred or right 
respectively).
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Font: This can be used to select the font type. You can also set the font size by 
activating the corresponding check box and specifying the required size in the 
text box.

Degrees: This defines the text slope, from the horizontal axis.

Frame: This allows you to define a border around the text you are using.

Text field title: You can also define a title for the corresponding border.

7.4.2.9 Graphics

7.4.2.9.1 Insert graphic elements

You can insert the following types of graphic elements:

• Points 
• Rectangles 
• Circles 
• Lines 
• Polylines 
• Polygons 

All these elements can be inserted by going to “Insert” in the “Map” menu or 
by clicking on the corresponding button in the tool bar.

If you wish to insert a graphic element, left click on the map in the place you 
wish the graphic element to be inserted in.

7.4.2.9.2 Editing graphic elements in a map

When you have inserted a graphic element, you can edit its vertexes. You can 
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access this tool by going to the "Map" menu, then to "Edit" and then to “Edit 
vertexes” or from the following tool bar button.

If you wish to edit a vertex in a graphic element, select the element from the 
map and go to the tool.

7.4.3 Map-inserted element properties

When the elements have been inserted in a map, you can access its properties.

Select  the  element.  Right  click  to  show  its  contextual  menu  and  select 
"Properties".

7.4.4 Aligning

You can access this tool by going to the “Map” menu, then to “Graphics” and to 
“Align”.

This tool can be used to modify the alignment, distribution and size of the map 
elements selected.
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In the layout: If this button is enabled, the tools in the "Align" menu will use 
the map limits as a reference. If it is disabled, the selection will be used as the 
reference.

Alignment: The tools in this section allow you to align the selected graphics 
(place a series  of  objects  on the same axis)  according to  your  needs (left, 
horizontally centred, right, top, vertically centred and bottom).

Distribution: This allows you to space out objects at equal distances over a 
specific  area.  Match size:  This  allows  you  to  modify  the  size  of  a  selected 
object, using another object as a reference. The adjustments are made based 
on the largest object in the selection.

The object sizes can be made to coincide in width, height or both.

Space: This allows the selected elements to be “spatially distributed”.

If, for example, you decide to spatially distribute two selected elements in the 
map (using the active "In the layout" button), the objects will be moved to the 
same distance from the map’s left and right-hand margins when you click on 
the first option.

If  we  click  on  the  second  button,  the  images  will  be  moved  to  the  same 
distance from the top and bottom margins.

7.4.5 Grouping / Ungrouping

You can access this tool from the tool bar by clicking on the buttons

or  by  going  to  the  “Map”  menu,  then  to  “Graphics”  and  to  “Group”  or 
“Ungroup”.

7.4.6 Viewing order

You can access this tool by going to the “Map” menu then to “Graphics” and 
then to “Bring to front” or “Send to back” respectively or from the tool bar by 
clicking on the following buttons:

You can use this option to change the viewing order of the selected elements in 
the map by bringing them to the front or sending them to the back.
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7.4.7 Graphic line

This tool draws a frame around a selected element or elements.

You can access this tool from the tool bar by clicking on the following button

or by going to the “Map” menu and then to “Graphics” and "Graphic line".

The available options are shown in the following dialogue box:

The  different  options  include  a  check  box  which  allows  you  to  group  the 
graphic line and the object you have inserted in the map so that they make one 
single element and not two separate ones.

If you click on the “Configure” button, another dialogue box appears which can 
be used to define the properties of the graphic line or frame to be inserted.

Select the properties and click on the “Ok” button if you wish to use the new 
configuration or "Cancel" if you wish to maintain the default values.
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7.4.8 Size and position

You can access this tool by going to the tool bar and clicking on the following 
button

or by going to the “Map” menu then to “Graphics” and to “Size/Position”.

This tool opens a dialogue box which allows you to specify the size and position 
of the selected element.

You can edit the different text fields and modify and specify the object’s size 
and position.
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7.4.9 Undoing / Redoing

These tools allow you to undo actions you have taken on the map or redo the 
actions you have previously undone.

You can access these tools  by clicking on the “Undo” (left-facing arrow) or 
“Redo” (right-facing arrow) buttons

or by going to the menu bar and selecting the “Map” option.

You  can  also  undo  several  actions  by  using  the  command stack.  This  tool 
allows you to view the actions you have carried out on the map and decide 
which point you wish to continue working from.

The advantage of this tool is that you can undo or redo several actions at the 
same time. However,  you cannot undo a specific  action,  i.e.  if  you take six 
actions, you cannot undo just the fourth one. The sixth and the fifth action will 
also be undone.

You can also access this tool by clicking on the command stack button in the 
tool bar

or by going to the “Map” menu bar and then to “Command stack”.

7.4.10 Deleting a selection

You can delete any of the elements selected in the “Map” by clicking on the 
“Delete selection” button in the tool bar.

7.5 Tools for exporting to postScript and pdf

You can use these tools to export a layout to a postScript and/or pdf file by 
going to the "File" menu and then selecting "Export to ps" or "Export to pdf" 
respectively
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or by clicking on the following buttons in the tool bar:

 
This opens a dialogue box in which you are asked to specify a file to save the 
resulting  postscript  file  (with  the  .ps  extension)  or  pdf  file  (with  the  .pdf 
extension). When you have selected where you wish to save the document, 
click on “Save”.

7.6 Printing

This  option  opens the printing dialogue box from which you can select the 
printing options (selecting printer, quality, etc.).

N.B.: The specifications which are not enabled depend on the type of printer 
installed.
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7.7 Quick print

Wizard to print the active View using a template

Adds  the  ability  to  print  a  View  using  a  wizard,  which  can  change  basic 
parameters (title, page size, etc). This option is accessible through the menu 
View/Quick Print.
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Print Config

You can set:

• The format: A0, A1, A2, A3, A4. 
• Number of copies. 
• Orientation, horizontal or vertical. 
• The title. 
• The scale at which to display the View. 
• Show a grid and specify its range. 
• Show the legend. 
• Display a custom or a default logo. 

The result looks something like this:
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Final result

You can print directly from the wizard, or first preview the result (as shown in 
the screenshot) and then print from this preview. It is also possible to modify 
any element in  the preview (the width of  the map, layers  displayed in  the 
legend, etc.) in the same way as amending any Map document in gvSIG.

8 Preferences window

8.1 Introduction preference window

The preference window allows you to customise gvSIG.  You can access the 
preference window by going to the "Window" menu then to "Preferences"
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or by clicking on the “Preferences” button in the tool bar.

When you have accessed the tool, a new window appears in which you can 
configure your preferences.

Select  the  property  you  wish  to  access  from the  tree  on  the  left  and  the 
preferences you can configure will appear in the space on the right.

8.2 The annotation preferences 

The annotation preferences allow you to define the default characteristics you 
wish the annotation layers to have.
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You can predefine the default characteristics you wish the annotation layers to 
have.

Text You can select the default text to be written in the annotation layer if the 
record of the field you have chosen to label is blank. You can choose not to 
write anything in the record if you wish so that it remains blank.

Font  type You  can  select  the  default  font  type  in  which  you  wish  the 
annotation layer’s text to be written.

Text style You can select the default text style you wish the annotation layer 
to have.

Text height You can select the default text height you wish to be used in the 
annotation layers.

Text  rotation You  can  use  the  text  rotation  option  to  select  the  default 
orientation that the text in the annotation layers will have. For example, if you 
want the text to be shown horizontally, input “0 degrees”. If you want the text 
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to  be  shown  vertically,  input  90º.  Remember  that  gvSIG  uses  sexagesimal 
graduation and this turns anti-clockwise.

Text colour You can select the default text colour you wish the text in the 
annotation layers to be shown in.

8.3 Editing preferences

8.3.1 Introduction

This allows a series of default colours used in a gvSIG editing session to be 
chosen. A detailed explanation is provided below:

8.3.2 Colour of the selection

This allows you to set the default colour for the selected geometry of a layer 
which is being edited.
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8.3.3 Colour of the reference axis

This allows you to set the colour of the reference axis which will  guide you 
through any editing operations, for instance operations such as “symmetry”, 
“rotate” etc…
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8.3.4 Colour of the selected geometry

This allows you to set the default colour of the selection frame used to select 
the required geometry.
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8.3.5 Colour of the selection handler

This allows you to set the default colour for the “Handlers”, in other words the 
vertexes which make up the selected object.  In this case, the colour of the 
outline can be selected, as can the colour of the inside of the handler.

July 2011 Page 578 of 655



8.4 General preferences

8.4.1 Introduction

This tool establishes whether gvSIG needs to remember the project windows’ 
position and size.
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If you pull down the tree (click on “+”), the properties you can configure in 
“General” will appear.

8.4.2 Extension directory

This tool defines the directory for the extensions that gvSIG must use.
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8.4.3 Appearance

You can use this tool to modify gvSIG’s appearance. Pull down the box with the 
available options and select the required option.

N.B.: You will have to restart gvSIG for this change to take effect.

8.4.4 Folders

You can use this option to create a shortcut to the folders your projects (.gvp), 
data (raster and vector) or templates (.gvt) are saved in.

8.4.5 Display configuration 

You can specify the points per inch for your display in the “Resolution” text 
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box.

gvSIG allows you to calculate the exact resolution of your display as follows:

Place a ruler on the screen to measure the straight line drawn in the “Test 
measurement” box.

Write the measurement obtained in the text box underneath (the value 5.61 
has been inserted in this example) and the units in which this measurement 
was taken (“Centimetres” in our case).

Click on the “Calculate resolution” button.

gvSIG automatically provides a points per inch value for the resolution of your 
display.

This appears in the corresponding text box (the result in our case is 95ppi).
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8.4.6 Web browser

This  allows  a  default  web  browser  (for  the  Linux  operating  system)  to  be 
specified for any search carried out from gvSIG to any of the hyperlinks found 
in the application.

The first option contains the pull-down menu in which the different supported 
browsers are located.

The second option can be used to specify which browser you want to open the 
different URLs included in the application such as the URLs in the “Help” menu 
(Example: firefox %www.gvsig.gva.es).

8.4.7 Activate/Deactivate Extensions

This allows you to configure the extensions that gvSIG uses while running. Pull 
down the extension tree and select the required extension.
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A  description  of  the  selected  extension  is  displayed.  You  can  activate  or 
deactivate the extension and modify its order of priority in the list.

N.B.: If you activate an extension, you will have to restart gvSIG to use it.
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8.4.8 Translator Manager

8.4.8.1 Introduction

gvSIG  has  support  for  showing  the  application's  text  based  on  a  language 
selection, that by default it is usually the same as for the operating system but 
that the user may change through the language preferences panel.

Translations to new languages have been added to every new released version 
of gvSIG, especially thanks to the support of the community and the translators 
involved.

However, to add a ne language, make corrections or finish the translation of 
one of the languages available, it has been necessary to wait to the release of 
the new version of gvSIG.

However, to add a new language, make corrections or finish the translation of 
one of the languages available, it has been necessary to wait to the release of 
the new version of gvSIG.

The  translation  manager  extension  will  allow  gvSIG  users  to  append 
translations to new languages and updates to the existing ones over a version 
already installed with the application, without having to reinstall it. This way, 
there  will  be  the  possibility  to  publish  translations  to  new languages  from 
within gvSIG, without having to wait for the following gvSIG version.

Furthermore, the extension will let any gvSIG user to update or translate to a 
new language the application chains and will allow checking the result over the 
application itself without having to resort to a programmer.

Upon  installing  the  translation  manager  extension,  the  language  selection 
panel will be replaced by a new preference panel in which besides being able 
to select the application language, there will be a series of buttons to perform 
the language translation.

With the new translation manager, the extension adds the option to distinguish 
the translations, not only by language but by country and other variants as 
well.  This  is  due to the fact  that  for  some languages there are differences 
between countries (e.g. English from United Kingdom vs. United States) and 
even  variants  within  the  same  country  (e.g.  Norwegian  Nynorsk  alongside 
Riksmål).

The following figure shows the translation manager panel with the language 
preference panel:



gvSIG Desktop

Language Preference Panel

The panel shows upon selecting the option Idioma (1), from within the General 
section of the gvSIG preferences. A table with the list of available translations 
to languages will  show in the upper part inside the panel. The columns that 
show in the table are:

• Idioma (2):  name of the language in its own language to facilitate its 
identification. 

• País (3): language country 
• Variante (4): language variant. 
• Activar (5):  selected language in  which the application  chains  will  be 

shown. 

In  the  lower  part  of  the  table  there  are  a  number  of  buttons  that  allow 
managing the application translations. The task of those buttons, in general will 
be applied to the language selected in the table (6), selecting over the row of 
the table of the language that will be used.

The function of those buttons is as follow:
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• Instalar (7): install or update a language translation. 
• Desinstalar (8): uninstall a language translation. 
• Actualizar (9): export the translation to a language to update it. 
• Traducir (10): export to translate to a new language. 

8.4.8.2 Changing the application language

To change the language of the application we go to the Activar column of the 
table and select the radio button of the row of the language we would like to 
visualize the application.

Changing the active language

In order to commit the change, we must click in the  Accept button from the 
preferences window. The selected language will be installed next time gvSIG is 
started.

8.4.8.3 The import/export file

A compressed file with ZIP format will be used to install or export translations.

This  file  should  always  have,  at  least  a  file  locales.csv with  the  list  of 
translations that are contained in the ZIP file, as well as a .properties file with 
the  labels  and  the  translations  for  each of  the  languages  contained in  the 
locales.csv file.

Note: the files must obligatorily be on the root of the ZIP file and not 
inside any folder.
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For example, a file with the translations to the German and English languages 
should have the following files:

Import or export translations file.

The locales.csv file serves to show the list of available translations in the ZIP 
file,  indicating  for  each one  of  them those  that  are  used  as  translation  or 
updating reference, and those that are not.

The locales.csv file is in text format, with every language indicated in a line and 
the values separated by comma with the following format:

FILE_NAME,LANGUAGE_CODE,COUNTRY_CODE,VARIANT_CODE,REFERENCE 
(whether it is a reference language or not)

• File name: Properties that contain the translation to the language. 
• Language Code: Two characters language ID according to the ISO 639 

standard. 
• Country  Code:  Two  character  country  ID  according  to  the  ISO  3166 

standard. Optional. 
• Variant code: Variant ID. Optional. 
• Reference: True in case it is a language used as reference, false if not. 

Upon importing a file, those with a true value will be ignored. Optional. 

Optional fields are allowed to remain empty, but all fields must be separated by 
commas. If we would like to edit this file we could use any regular text editor or 
spreadsheet, as long as we keep the CSV comma delimited format.

The content of the locales.csv file in the initial example would be:

text.properties,es,,,true
text_en.properties,en,,,false

8.4.8.4 To install or update a language translation

To install the translation of a language or update one already existing, we need 
to have a compressed ZIP file  saved in the file  system. The ZIP file  should 
include a properties file with the translated texts to that language.

To  install  a  language translation,  we will  select  Instalar from the  language 
preferences. A file browser will  open and we will  look for the .zip file to be 
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installed in our file system.

Selecting the .zip file to import.

Once the .zip file to be imported is selected, we will click in the Importar button 
and the file will be loaded by the application. Next gvSIG will let us know if the 
import was successful.

Import confirmation

If it is a language already installed in the application, the new translation will 
substitute the previous one. If on the other hand it is a new language, it will be 
installed  and  the  new  language  will  show  up  in  the  table  of  available 
languages.

8.4.8.5 Uninstall a language translation

If we would like to uninstall a translation to a language we will select from the 
table the row corresponding to the language and click the Desinstalar button.

Language uninstall confirmation
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The application will ask for confirmation to uninstall the selected language. We 
can cancel, if we do not want to uninstall the language or accept, after which 
the corresponding text file will be erased and removed from the list.

8.4.8.6 Exporting a language translation to update it

If we want to complete or fix the translation of one of the available languages 
in gvSIG, we can use the export to update option.

For that we will select the row of the language we would like to update from 
the table and then click on the Actualizar button.

Selection of the reference language

We will be asked to select a reference language. Specially if we are going to 
complete  a  language  translation,  we  will  need  another  language  that  is 
complete from which we will translate the pending chains.
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Saving exported file

Next there will be a dialog that will allow us to save the ZIP file with the export  
to a location within the file system of our computer. By default it will named in 
English with the .zip extension.

Once it is saved, we can unzip the zip file and to proceed to edit the language 
translation we would like to complete. The files with the text chains that are 
exported always have the following format:

text_[CODIGO-IDIOMA]_[CODIGO_PAIS]_[CODIGO-
VARIANTE].properties

• CODIGO-IDIOMA: 2-letter ID for the language according to the ISO 639 
standard. 

• CODIGO_PAIS:  2-letter  ID  for  the  country  according  to  the  ISO  3166 
standard. 

• CODIGO-VARIANTE: variant ID. 

The  variant  and  country  codes  are  optional.  In  the  case  of  the  Spanish 
language it will not have language code either since it is by default the base 
language in gvSIG.

Once the editing of the language translation to be completed is finished, we 
can create a new ZIP file with the content of the files extracted from the export 
zip file. It is important to include all the files since in the locales.csv file there is 
information that allows gvSIG to identify what language we are updating and 
which one is its properties file.

After that we could use the install or update a language options to install the 
changes as it is explained in the previous section.

8.4.8.7 Exporting to translate to a new language

If we want to translate the gvSIG interface to a new language we could ask the 
application to export a file with all the identifiers of the text chains to translate.

For that we first select a reference language, choosing the row corresponding 
to the selected language from the table. Like in the language updating option, 
besides the selected reference language we need to include the Spanish and 
English languages as well.

Next there will be a dialog that will allow us to select the new language we 
would like to translate to. Those languages appear in their native language to 
facilitate identification.
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Select new language to translate

Once the language is selected, there will be a dialog asking where we would 
like to save the generated ZIP file.

Saving the generated ZIP file
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The  above  mentioned  ZIP  file  has  the  same  content  as  in  the  language 
updating case. The difference is in the .properties file of the language we are 
going to translate to, that in this case contains all the identifiers but empty.

In the previous figures, for example we are going to translate to the Danish 
language. Therefore, we need to edit the text_da.properties file. The contents 
of it should be something like:

searchButton=
enter_layer_name=
inside_circle=
ascending_order_tooltip=
time=
wfsLoad=
shp=
infocrs=
A2=
lowerCoordinates=
results=
discard_changes=
...

By opening the .properties file of one of the reference languages we could see 
the text  that  corresponds to each of  the labels  and thus proceed with the 
translation.

Once the translation is finished, we can recreate again the ZIP file with all the 
content and proceed to load the new language through the Instalar un idioma 
option. If we want to visualize the text in that language we would need to mark 
it as the active language and restart gvSIG.

8.4.9 Preferences. Create backup of the gvp

8.4.9.1 Create backup copy of project file

Backup project automatically before saving

This extension can be found under the application's general preferences and 
allows  the  user  to  automatically  backup  a  gvSIG  project  file  (.gvp)  before 
replacing it. The backup is created in the same directory as the original project, 
with the same name, and with a .bak extension. To enable automatic backup, 
select the third checkbox in the General section of the Application Preferences:
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Menu

Vía the menu: Window → Preferences → General

Preferences menu
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8.5 Raster

8.5.1 Nodata values

8.5.1.1 Description

The NoData value refers to information that is not taken into account during 
the data processing. This NoData information is defined as one specific value 
depending on the data type of the raster layer. These NoData values can be set 
as  transparent  in  gvSIG,  because if  these values do not  represent  relevant 
information, you may not want to display them. The value is associated with 
the raster layer (i.e. each image can have a different NoData value) and can be 
defined in the metadata or assigned by the user.

Raster properties. NoData value

To find  out  if  the  layer contains  NoData values,  you can open the  "Raster 
properties" dialog and select the "General" tab where the NoData information 
is shown.

A layer can have an associated NoData value defined in its metadata. In this 
case, the text "Layer" is displayed in the drop-down text box in the NoData 
section. This means that the NoData value associated with the layer is being 
used. The text box labelled as "Value" shows the numeric value. In case the 
layer does not have a NoData value associated with it, the text "Deactivate" is 
shown in the drop-down text box while the "Value" text box is inactive and the 
value in this text box is irrelevant. If you want to define a new NoData value for 
the layer, either because the current NoData value is incorrect or because the 
NoData  value  is  not  defined,  you  can  select  the  option  "Custom".  When 
selecting this option, the "Value" textbox will show the default NoData value as 
set in the "Preferences" dialog. You can modify this default value if needed.

By clicking "Apply" or "Accept" the new value is assigned to the layer. Keep in 
mind that the NoData values defined in this way are only temporary; when the 
layer is opened again this value will have been lost. To associate the new value 
with  the  layer  you  can  click  the  button  "Save  as  default",  after  which  a 
message appears  to  confirm this  action:  "The default  NoData  value  will  be 
changed. Would you like to continue?"

8.5.1.2 Preferences

The "Raster" section of the "Preferences" dialog contains options for "NoData" 
values. Here, you can specify whether you want to display the NoData values in 
the layers that are loaded into gvSIG.

The option "Set NoData value to transparent" does exactly what it announces; 
for any raster layer that is loaded into gvSIG and has associated NoData values 
(as defined in its metadata or assigned by the user), the NoData values will not 
be displayed.  For  efficiency in  displaying images,  this  option  is  disabled by 
default.
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Another available option is to change the default NoData value. When in the 
"Layer Properties" dialog the "Custom" option is selected, the NoData value 
that  will  appear  is  the  default  NoData  value as  set  in  this  text  box in  the 
"Preferences" dialog.

Raster preferences. Set default NoData value

8.6 Network, firewall, proxy

gvSIG allows you to check the status of a network connection.
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Firewall/Proxy

If you use a proxy connection, you can configure your connection parameters 
so that gvSIG can use them.

8.7 Map preferences

This section of the preference window can be used to customize how you wish 
to work with your map documents.

You can define both the horizontal and vertical grid spacing values and decide 
whether the grid should be displayed, enabled or disabled and whether the 
ruler should be enabled or disabled simply by clicking on the required check 
boxes. When you have selected your preferences, click on “Ok”.
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8.8 View preferences

8.8.1 General view preferences

You can configure the values that gvSIG will use for zooming in or out of a view 
and changing the selection colour which by default is "Yellow".

You can also use this window to define map and measuring units for gvSIG.

You  can use  this  window to  change the  view projection  by clicking  on the 
"Change"  button.  A  dialog  box  appears  from  which  you  can  choose  the 
reference system.
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8.8.2 Selection of layer loading order

Selecting the loading order of layers.

The ability to choose the loading position of a new layer has been added. For 
example, you can specify that new raster layers should be loaded just below 
the vector layers, or be loaded below all the layers. Similarly, you can decide 
on  the  position  of  new vector  layers  and  other  layer  types.  This  option  is 
accessible in the gvSIG Preferences, as shown in the following screenshot:

Preferences menu

The choice in this dialog does not affect a specific gvSIG project but is applied 
to all  projects.  At present it  is  not possible  to choose a different  order per 
project.

9 Add-ons manager

9.1 Introduction

This tool allows you to add a number of add-ons to gvSIG such as languages, 
plugins, symbol sets or application aids.

Note

Some of this functionality is only available from Version 2.0 of the application 
onwards. In version 1.11 only installation of plugins is available.

Plugins can be added from disk (files of type .gvspkg and .gvspks) or from a 
repository over the Internet.

9.2 Standard installation

From the Tools / Add-ons manager menu select Standard Installation.
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Add-ins Manager

With this option you can view the add-ons installed by default and reinstall 
them.

This option is only available for official add-ons.

Note: This feature is only available from Version 2.0 of the application onwards.

9.3 Installation from file

From the  menu  Tools  /  Complement  Manager select  'Installation  from file', 
choose the .gvspkg or .gvspks file you want and click 'Next'.
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Add-ons Manager: installer selection

With this option you can install add-ons that have been previously packed in 
.gvspkg or .gvspks files.

After  selecting  and  accepting  the  file  in  question,  appropriate  add-ons  are 
added to the list of plugins by default, either in the official add-ons tab (those 
that have been through the  gvSIG process of formalizing) or in the unofficial 
tab.

More information on how to package add-ons.

9.4 Installation from URL

From the  Tools / Add-ons Manager menu select 'Installation from URL', enter 
the URL and click 'Next'.

By default the official repository of packages for the current version of gvSIG is 
shown.

http://www.gvsig.org/web/projects/gvsig-desktop/docs/devel/como-contribuir-en-gvsig/proyectos-oficiales-en-gvsig
http://www.gvsig.org/web/projects/gvsig-desktop/docs/devel/gvsig-devel-guide/2.0.0/trabajar-con-un-proyecto/proyectos-con-plugins-para-gvsig/create-install-package/generacion-desde-plugin-instalacion
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Add-ons Manager: installer selection

Select  the  add-on  to  install  from  the  Official (those  that  have  passed  the 
process of formalizing gvSIG) or the Unofficial tab and click 'Next':
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Add-ons Manager: add-on selection

After installation, you should see the following window:
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Installation Complete

If you go back to the Add-Ins menu you will notice that the add-on has been 
properly installed.
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Add-on installed

10 Sextante

10.1 Introduction

10.1.1 Introduction

This text is targeted at those using geospatial algorithms from the SEXTANTE 
library through the available GUI on this new version of gvSIG, the SEXTANTE 
toolbar. It is located at the right of the three main icons of the gvSIG toolbar.

Particular information about SEXTANTE algorithms is not found in this text. The 
user should refer to the context help system instead.

10.1.2 Basic elements of the SEXTANTE toolbar

There are five basic elements in the SEXTANTE toolbar, which are used to run 
SEXTANTE algorithms for diferent purposes. Choosing one tool or another will 
depend on the  kind  of  analysis  that  is  to  be  performed and the  particular 
characteristics of each user an project.

The SEXTANTE elements are available in a toolbar like the one show next.
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SEXTANTE toolbar

• The SEXTANTE toolbox.  The main element of  the SEXTANTE GUI,  it  is 
used to execute a single algorithm or run a batch process based on that 
algorithm. 
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SEXTANTE toolbox

• The SEXTANTE graphical modeler. Several algorithms can be combined 
graphically  using  the  modeler  to  define  a  workflow,  creating  a  single 
process that involves several sub-processes. 
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SEXTANTE graphical modeler

• The  SEXTANTE  command-line  interface.  Advanced  users  can  use  this 
interface  to  create  small  scripts  and  call  SEXTANTE  algorithms  from 
them. 
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SEXTANTE command-line

• The SEXTANTE history manager. All actions performed using any of the 
aforementioned elements are stored in a history file  and can be later 
easily reproduced using the history manager. 

SEXTANTE history manager

• The  SEXTANTE  results  tool.  Allows  users  to  search  for  the  generated 
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results during the recent work. 

SEXTANTE results

Along the following chapters we will review each one of this elements in detail.

10.2 The Sextante toolbox

10.2.1 Introduction

The Toolbox is the main element of the SEXTANTE GUI, and the one that you 
are more  likely  to  use  in  your  daily  work.  It  shows the list  of  all  available 
algorithms grouped in different blocks, and is the access point to run them 
whether as a single process or as a batch process involving several executions 
of a same algorithm on different sets of inputs.
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SEXTANTE toolbox

Depending on the data available in the gvSIG View, you will be able to execute 
an  algorithm  or  not.  When  there  is  enough  data  for  the  algorithm  to  be 
executed (i.e. the algorithm requires raster layers and you have raster layer 
already loaded into the View), its name is shown in black, otherwise, it is show 
in grey.

In the lower part of the toolbox you can find a text box and a search button. To 
reduce the number of algorithms shown in the toolbox and make it easier to 
find the one you need, you can enter any word or phrase on the text box and 
click on the search button. SEXTANTE will search the help files associated to 
each algorithm and show only those algorithms that include the word or phrase 
in  their  corresponding help files.  To  show all  the algorithms again,  make a 
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search with an empty string.

To execute an algorithm, just double-click on its name in the toolbox.

10.2.2 The algorithm dialog

10.2.2.1 Introduction

Once you double-click on the name of the algorithm that you want to execute, 
a dialog similar to the next one is shown (in this case, the dialog corresponds to 
the Anisotropic cost algorithm).

SEXTANTE dialog

This  dialog is  used to  set  the input  values  that  the  algorithm needs  to  be 
executed.  There  is  a  main  tab  named  Parameters  where  input  values  and 
configuration parameters are set. This tab has a different content depending on 
the requirements of the algorithm to be executed, and is created automatically 
based on those requirements. On the left side, the name of the parameter is 
shown. On the right side the value of the parameter can be set.

Those algorithms that generate raster layers as output have an additional tab 
named Raster output. This tab is used to set the characteristics of those output 
raster layers, specifying its extent and its cell size. On the lower part of the 
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window there is a help button. Click on it to see the context help related to the 
current algorithm, where you will find detailed description of each parameter 
and each output generated by the algorithm.

10.2.2.2 The parameters tab

Although the number and type of parameters depends on the characteristics of 
the algorithm, the structure is similar for all of them. The parameters found on 
the parameters tab can be of one of the following types.

• A raster layer, to select from a list of all the ones available in the View. 
• A vector layer, to select from a list of all the ones available in the View. 
• A table, to select from a list of all the ones available in the View. 

SEXTANTE raster dialog

• A method, to choose from a selection list of possible options. 
• A numerical value, to be introduced in a text box. 
• A text string, to be introduced in a text box. 
• A field, to choose from the attributes table of a vector layer or a single 

table selected in another parameter. 
• A band, to select  from the ones of  a raster layer selected in another 

parameter. In both this and the previous type of parameter, the list of 
possible choices depends on the value selected in the parent parameter. 

• A list of elements (whether raster layers, vector ones or tables), to select 
from the list of the ones available in gvSIG View. To make the selection, 
click on the small button on the left side of the corresponding row to see 
a dialog like the following one. 
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SEXTANTE multiple selection

• A file or folder 
• A point, to be introduced as a pair of coordinates in two text boxes (X and 

Y coordinates) 
• A small table to be edited by the user. These are used to defined lookup 

tables or convolution kernels, among other parameters. 

Click on the button on the right side to see the table and edit its values.
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SEXTANTE filter table

Depending on the algorithm, the number of rows can be modified or not, using 
the buttons on the right side of the window.

10.2.2.3 The raster output tab

The Raster output tab is found in those algorithms that generate raster layers. 
Unlike  in  most  GIS,  when  combining  several  raster  layers  as  input  for  an 
algorithm, they do not have to have the same extent an cellsize in order to 
process  them  together.  That  is,  layers  don't  have  necessarily  to  match" 
between  them.  Instead,  the  characteristics  of  the  output  raster  layer  are 
defined and SEXTANTE performs the corresponding resampling and cropping 
needed to generate layer with those characteristics.

It is responsibility of the user to enter adequate values and be aware of the 
limitations  of  this  mechanism,  so  as  to  generate  cartographically  correct 
results. (i.e. you can select a small cell size for the resulting raster layers, but if 
the input layers you are using have a bad resolution the results will  not be 
geographically sound).

The following options are available in the raster output tab:
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SEXTANTE raster output tab

• Fit  to input  layers.  By default,  the characteristics  of  the output  raster 
layers are set based on the input ones. The minimum extent needed to 
cover all the input layers is used. 

• User defined. The coordinates of the boundaries of the extent and the 
cellsize are both defined manually,  entering the desired values in  the 
corresponding text boxes. 

• Use extent from view..  This option will  let you use predefined extents 
from one of the views currently opened. 

• Use extent from layer. The extent of a layer can be used as well to define 
the output characteristics, even if the layer is not used as input to the 
algorithm. If the selected layer is a vector one, the cellsize will have to be 
entered manually, since vector layers do not have an associated cellsize. 

If an option other than the automatic fitting is selected, SEXTANTE will check 
that the values are correct and the resulting layers will not be too large (due to, 
for instance, a wrong cell size). If the output layers seems to large, SEXTANTE 
will show the next message dialog to ensure that the user really want those 
layer to be created.
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SEXTANTE size warning

Not all algorithms have the first option available, since not all algorithms that 
generate raster layers take some other raster layer as input. The interpolation 
algorithms,  for  instance,  take  a  vector  layer  and  create  a  raster  one.  The 
extent and cellsize of the latter has to be manually defined, since it cannot be 
set based solely on the input vector layer.

10.2.3 Data objects generated by Sextante algorithms

Data objects generated by SEXTANTE can be of any of the following types:

• A raster layer 
• A vector layer 
• A table 
• A graphical result (chart, graph, etc.) 
• A textonly HTML formatted result 

Layers  and tables  can  be saved to  a  file,  and the  parameters  window will 
contain a text box corresponding to each one of these outputs, where you can 
type the desired file path. If you do not enter any file path, a temporal file 
name and folder will be used.

The  supported  formats  for  the  SEXTANTE  cartographic  output  files  are  as 
follows.

• shp 
• dxf 
• tif 
• asc 

To select a format, just select the corresponding file extension. If the extension 
of the file path you entered does not match any of the supported ones, the 
default extension (the first one in the list of supported ones) will be appended 
to the file path and the file format corresponding to that extension will be used 
to save the layer or table.

Graphics and texts are kept in memory and shown at the end of the algorithm 
execution  in  a  new  dialog.  This  dialog  will  keep  the  results  produced  by 
SEXTANTE during the current session, and can be shown at any time using the 
Results button. You can save graphical results as images in png format, and 
texts as HTML files. Rightclick on the name of the result in the tree on the left 
hand of the window and select Save as....
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SEXTANTE statistics results

SEXTANTE graphic result

10.2.4 Context help

Each SEXTANTE algorithm has its own context help file, which provides detailed 
information  about  the  meaning  of  each  input  parameter  and  each  output 
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object,  and gives hints about its usage. To access the context help system, 
click on the button that you will find in the algorithm dialog, or right click on its 
name on the toolbox and then select See help.

SEXTANTE help icon

The context help system contains not only information about each algorithm, 
but also description of each one of the elements of the SEXTANTE GUI like the 
text you are reading now. You will find it at the top of the tree on the left hand 
side of the help window. Just select an item to see its associated help file on 
the right canvas.

SEXTANTE help window
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Help files associated to each algorithm are stored as XML files, and can be 
edited using the help authoring tools included with SEXTANTE. Right click on 
the name of the algorithm in the context help window and select Edit help to 
get to the following window.

On the left hand side you can select any of the elements to be documented 
(input parameter and outputs, along with other fixed field such as a general 
description of the algorithm). Then use the right hand side boxes to enter to 
text associated to that element or add images.

10.3 The Sextante graphical modeler

10.3.1 Introduction

The graphical modeler allows to create complex models using a simple and 
easytouse interface. When working with a GIS, most analysis operations are not 
isolated, but part of a chain of operations instead. Using the graphical modeler, 
that chain of processes can be wrapped into a single process, so it is easier and 
more convenient  to execute than single  process later  on a different  set on 
inputs. No matter how many steps and different algorithms it involves, a model 
is  executed as a single algorithm, thus saving time and effort,  specially for 
larger models.

The modeler has a working canvas where the structure of the model and the 
workflow it represents are shown. On the left part of the window, a panel with 
two tabs can be used to add new elements to the model.
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SEXTANTE modeler window

Creating a model is a two-step process.

• Definition  of  necessary  inputs.  These  inputs  will  be  added  to  the 
parameters window, so the user can set their values when executing the 
model.  The  model  itself  is  a  SEXTANTE algorithm,  so  the  parameters 
window is generated automatically as it happens with all the algorithms 
included in the library. 

• Definition  of  the  workflow.  Using  the  input  data  of  the  model,  the 
workflow is defined adding algorithms and selecting how they use those 
inputs  or  the  outputs  generated  by  other  algorithms  already  in  the 
model. 

10.3.2 Definition of inputs

The first step to create a model is to define the inputs it needs. The following 
elements are found in the Inputs tabs on the left side of the modeler window:

• Band 
• Raster layer 
• Vector layer 
• String 
• Table field 
• Coordinate (Point) 
• Table 
• Fixed table 
• Multiple input 
• Selection 
• Numerical value 
• Boolean value 
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Double-clicking on any of them, a dialog is shown to define its characteristics. 
Depending  on  the  parameter  itself,  the  dialog  will  contain  just  one  basic 
element (the description, which is what the user will see when executing the 
model) or more of them. For instance, when adding a numerical value, as can 
be seen in  the next  figure,  apart  from the description  of  the parameter  is 
needed to set a default value, the type of numerical value and a range of valid 
values.

SEXTANTE modeler window for adding values

For each added input, a new element is added to the modeler canvas.

SEXTANTE modeler elements
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10.3.3 Definition of the workflow

Once the inputs have been defined, it is time to define the algorithms to apply 
on them. Algorithms can be found in the Processes tab, grouped much in the 
same way as they are in the toolbox.

SEXTANTE modeler

To add a process, double-click on its name. An execution dialog will appear, 
with a content similar to the one found execution panel that SEXTANTE shows 
when executing the algorithm from the toolbox.
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SEXTANTE modeler process

Some differences exist, however, the main one being the absence of a raster 
ouput tab, even if the selected algorithm generates raster layers as output.

Instead of the textbox that was used to set the filepath for output layers and 
tables, a checkbox and a text box are found. If  the layer generated by the 
algorithm is just a temporary result that will be used as the input of another 
algorithm and should not be kept as a final result, the check box should be left 
unchecked. Checking it means that the result is a final one, and you have to 
supply also a valid description for the output, which will be the one the user will 
see when executing the model.

Selecting the value of each parameter is also a bit different, since there are 
important differences between the context of the modeler and the toolbox one. 
Let's see how to introduce the values for each type of parameter.

• Layers (raster and vector) and tables. They are selected from a list, but in 
this case the possible values are not the layers or tables currently loaded 
in the GIS, but the list of model input or the corresponding type, or other 
layers or tables generated by algorithms already added to the model. 

• Numerical  values.  Literal  values  can  be  introduced  directly  on  the 
textbox.  This  textbox  is  a  list  that  can be used to  select  any of  the 
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numerical value input of the model. In this case, the parameter will take 
the value introduced by the user when executing the model. 

• String. Like in the case of numerical values, literal strings can be typed, 
or an input string can be selected 

• Points. Coordinates cannot be directly introduced. Use the list to select 
one of the coordinate inputs of the model 

• Bands.  The number of  bands of  the parent  layer cannot  be known at 
designtime,  so  it  is  not  possible  to  show  the  list  of  available  bands. 
Instead, a list with band numbers from 1 to 250, as well  as the band 
parameters of the model, is shown. At runtime, SEXTANTE will check if 
the parent raster layer selected by the user has enough bands and the 
given band has therefore a valid value, and if not it will generate an error 
message. 

• Table field. Like in the previous case, the elds of the parent table or layer 
cannot be known at designtime, since they depend of the selection of the 
user  each  time  the  model  is  executed.  To  set  the  value  for  this 
parameter, type the name of a field directly in the textbox, or use the list 
to select a table field input already added to the model. The validity of 
the selected field will be checked by SEXTANTE at runtime 

• Selection. The list contains in this case not only the available option from 
the algorithm, but also the selection inputs already added to the current 
model 

Once all the parameter have been assigned valid values, click on OK and the 
algorithm will be added to the canvas. It will be linked to all the other elements 
in the canvas, whether algorithms or inputs, which provide objects that are 
used as inputs for that algorithm.

SEXTANTE model
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10.3.4 Editing the model

Once the model has been designed, it can be executed clicking on the Run 
button.  The  execution  window  will  have  a  parameters  tab  automatically 
created based on the requirements of the model (the inputs added to it), just 
like it happens when a simple algorithm is executed. If any of the algorithms of 
the model generates raster layers, the Raster output tab will be added to the 
window.

Elements can be dragged to a different position within the canvas, to change 
the way the module structure is displayed and make it more clear and intuitive. 
Links between elements are update automatically.

To change the parameters of any of the algorithms of a model, doubleclick on it 
to access its parameters window.

To delete an element, right-click on it and select Delete. Only those elements 
that do not have any other one depending on them can be deleted. If you try to 
delete  an  element  that  cannot  be  deleted,  SEXTANTE  will  show a  warning 
message.

10.3.5 Saving and loading models

Models can be saved to be executed or edited at a later time. Use the Save 
button to save the current  model  and the Open model  to open any model 
previously saved. Model are saved in an XML file with the .model extension.

Models saved on the models folder will appear in the toolbox algorithm tree in 
a group named Models.
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SEXTANTE models on the tree

When the toolbox is invoked, SEXTANTE searches the models folder for files 
with .model extension and loads the models they contain. Since a model is 
itself a SEXTANTE algorithm, it can be added to the toolbox just like any other 
algorithm.

The  models  folder  can  be  set  from  the  SEXTANTE  toolbox,  clicking  the 
configuration  button  at  the  right  lower  corner  of  the  window,  and  then 
introducing the path to the folder in the corresponding field.
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SEXTANTE modeler configuration

Models loaded from the models folder appear not only in the toolbox, but also 
in the algorithms tree in the Processes tab of the modeler window. That means 
that you can incorporate a model as a part of a bigger model, just as you add 
any other algorithm.

10.4 The Sextante batch processing interface

10.4.1 Introduction

SEXTANTE algorithms (including models) can be executed as a batch process. 
That is, they can be executed using not a single set of inputs, but several of 
them, executing the algorithm as many times as needed. This is useful when 
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processing  large  amounts  of  data,  since  it  is  not  necessary  to  launch  the 
algorithm many times from the toolbox.

SEXTANTE executing batch

10.4.2 The parameters table

Executing a batch process is similar to performing a single execution of  an 
algorithm. Parameter values have to be defined, but in this case we need not 
just a single value for each parameter, but a set of them instead, one for each 
time the algorithm has to be executed.

Values are introduced using a table like the one shown next.
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SEXTANTE batch processing

Each line of this table represents a single execution of the algorithm, and each 
cell contains the value of one of the parameters. It is similar to the parameters 
tab that you see when executing an algorithm from the toolbox, but with a 
different arrangement.

By default, the table contains just two rows. You can add or remove rows using 
the buttons on the right hand side of the window.

Once the size of the table has been set, it has to be filled with the desired 
values.

10.4.3 Filling the parameters table

Whatever the type of parameter it represents, every cell has a text string as its 
associated value. Doubleclicking on a cell,  this string can be edited, directly 
typing  the  desired  value.  For  most  of  the  parameters,  however,  it  is  more 
convenient to use the button on the right hand side of the cell. Clicking on it, a 
dialog is shown to select the value of the parameter. The content of this dialog 
depends on the kind of parameter, and it features elements that make it easier 
to introduce the desired value. For example, for a selection parameter the list 
of all possible values is shown and the value can be chosen from them.
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SEXTANTE batch method

For all parameter cells, if the introduced value is correct, it will  be shown in 
black. If the value is wrong (for instance, a numerical value out of the valid 
range or an option that does not exists for a selection parameter), the text will 
be shown in red.

SEXTANTE batch wrong value

The most important different between executing an algorithm from the toolbox 
and executing it as part of a batch process is that input data objects are taken 
directly from files, and not from the set of layers already opened in the GIS. For 
this reason, any algorithm can be executed as a batch process even if no data 
objects at all are opened and the algorithm cannot be called from the toolbox.

Filenames  for  input  data  objects  are  introduced  directly  typing  or,  more 
conveniently, clicking on the button on the right hand of the cell, which shows 
a typical file chooser dialog. Multiple files can be selected at once. If the input 
parameter represents a single data object and several files are selected, each 
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one of them will  be put in a separate row, adding new ones if needed. If it 
represents a multiple input, all the selected files will be added to a single cell, 
separated by commas.

If  multiple  bands  are  required,  a  more  complex  dialog  is  shown,  which 
incorporates a table for selecting both layer files and bands. Click on the cells 
on the left side to select the file which contains the raster layer. Then click on 
the left side to select the bands you want to use from that layer. To know the 
number  of  bands  in  a  layer  it  would  be  necessary  to  open  it.  However, 
SEXTANTE does not open the layer, and shows instead a list of bands from 1 to 
250 to select from. If  you select a band that does not exist in the selected 
layer, an error message will be shown at execution time.

SEXTANTE batch band dialog

Output data objects are always saved to a file and, unlike when executing an 
algorithm from the toolbox, saving to a temporary one is not permitted. You 
can type the name directly or use the file chooser dialog that appears when 
clicking  on  the  accompanying  button.  This  dialog  differs  slightly  from  the 
standard one, incorporating some additional fields for autocompletion.
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SEXTANTE batch save dialog

If the default value (Do not autofill)  is  selected, SEXTANTE will  just put the 
selected filename in the selected cell from the parameters table. If any of the 
other  options  is  selected,  all  the  cells  below  the  selected  one  will  be 
automatically lled based on a defined criteria. This way, it is much easier to ll 
the table, and the batch process can be defined with less effort.

Automatic  filling  can  be  done  simply  adding  correlative  numbers  to  the 
selected filepath, or appending the value of another field at the same row. This 
is particularly useful for naming output data object according to input ones. 
Cells can be selected just clicking and dragging. Selected cells can be copied 
and pasted in a different place of the parameters table, making it easy to ll it 
with repeated values.

10.4.4 Setting raster output characteristics

Just like when executing a single algorithm, when running a batch process that 
generates raster layers you must define the extent and cell size of the raster 
layers to be created. The corresponding Raster Output tab is similar to the one 
found when running a single algorithm, but only contains two options: t to input 
layers and user-defined.

The  selection  will  be  applied  to  all  the  single  executions  contained  in  the 
current batch process. If you want to use different raster output configurations, 
then you must define different batch processes.
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SEXTANTE batch raster output dialog

10.4.5 Executing the batch process

To  execute  the  batch  process  once  you  have  introduced  all  the  necessary 
values, just click on OK. SEXTANTE will  show the progress of each executed 
algorithm, and at the end will show a dialog with information about the values 
used and the problems encountered during the execution of the whole process.

10.4.6 Batch processing with layers in the current project

It is possible to execute the batch processing from a set of layers from the 
current view, clicking on the correct option in the toolbox tree, similar as it was 
the usual batch processing.
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10.5 The Sextante command-line interface

10.5.1 Introduction

The  command-line  interface  allows  advanced  users  to  increase  their 
productivity and perform complex operations that cannot be performed using 
any  of  the  other  elements  of  the  SEXTANTE  GUI.  Models  involving  several 
algorithms can be defined using the command-line interface,  and additional 
operations such as loops and conditional  sentences can be added to create 
more flexible and powerful workflows.

10.5.2 The interface

10.5.2.1 Introduction

Invoking the command-line interface will make the following dialog appear.

SEXTANTE command-line

The SEXTANTE command-line interface is based on BeanShell. BeanShell is a 
Java source interpreter with object scripting language features, that meaning 
that it dynamically executes standard Java syntax and extends it with common 
scripting conveniences such as loose types, commands, and method closures 
like those in Perl and JavaScript.

A detailed description of BeanShell and its usage can be found at the BeanShell 
website. Refer to it if you want to learn more about generic BeanShell features. 
This  chapter  covers  only  those  particular  elements  which  are  related  to 
SEXTANTE geoalgorithms.

By using the extension mechanisms of BeanShell, SEXTANTE adds several new 
commands to it, so you can run geoalgorithms or get information about the 
geospatial data you are using, among other things.

Java users can create small scripts and programs combining standard elements 
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of Java with SEXTANTE commands. However, those who are not familiar with 
Java can also use the command-line interface to execute single processes or 
small sets of them, simply calling the corresponding methods.

A detailed description of all SEXTANTE commands is given next.

10.5.2.2 Getting information about data

Algorithms need data to run. Layers and tables are identified using the name 
they  have  in  the  table  of  contents  of  the  GIS  (and  which  usually  can  be 
modified using GIS tool). To call a geoalgorithm you have to pass it an identifier 
which represents the data to use for an input.

The data() command prints a list of all data objects available to be used, along 
with the particular name of each one (i.e. the one you have to use to refer to 
it). Calling it you will get something like this:

RASTER LAYERS
­­­­­­­­­­­­­­­­­
mdt25.asc

VECTOR LAYERS
­­­­­­­­­­­­­­­­­
Curvas de nivel

TABLES
­­­­­­­­­­­­­­­­­

Be aware that gvSIG allows you to have several layers with the same name. 
SEXTANTE will just take the first one which matches the specified identifier, so 
you should make sure you rename your data object so each one of them has a 
unique name.

To get more information about a particular data object, use the describe(name 
of data object) command. Here are a few examples of the result you will get 
when using it to get more information about a vector layer, a raster layer and a 
table.

>describe points 
Type: Vector layer ­ Point
Number of entities: 300
Table fields: | ID | X | Y | SAND | SILT | CLAY | SOILTYPE | 
EXTRAPOLAT |

>describe dem25
Type: Raster layer
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X min: 262846.525725 
X max: 277871.525725 
Y min: 4454025.0 
Y max: 4464275.0 
Cellsize X: 25.0 
Cellsize Y: 0.0 
Rows: 410 
Cols: 601 

>describe spatialCorrelation 
Type: TableNumber of records: 156 
Table fields: | Distance | I_Moran | c_Geary | Semivariance | 

10.5.3 Getting information about algorithms

Once you know which data you have, it is time to know which algorithms are 
available and how to use them.

When  you  execute  an  algorithm  using  the  toolbox,  you  use  a  parameters 
window  with  several  fields,  each  one  of  them  corresponding  to  a  single 
parameter. When you use the command line interface, you must know which 
parameters are needed, so as to pass the right values to use to the method 
that  runs  that  algorithm.  Of  course  you  do  not  have  to  memorize  the 
requirements of all the algorithms, since SEXTANTE has a method to describe 
an algorithm in detail.  But before we see that method, let's have a look at 
another one, the algs() method. It has no parameters, and it just prints a list of 
all the available algorithms. Here is a little part of that list as you will see it in 
your command-line shell.

bsh % algs();
acccost­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­: Accumulated 
cost(isotropic)
acccostanisotropic­­­­­­­­­­­­­­­­­­­­: Accumulated cost 
(anisotropic)
acccostcombined­­­­­­­­­­­­­­­­­­­­­­­: Accumulated cost 
(combined)
accflow­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­: Flow accumulation
acv­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­: Anisotropic coefficient of 
variation
addeventtheme­­­­­­­­­­­­­­­­­­­­­­­­­: Points layer from table
aggregate­­­­­­­­­­­­­­­­­­­­­­­­­­­­­: Aggregate
aggregationindex­­­­­­­­­­­­­­­­­­­­­­: Aggregation index
ahp­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­: Analytical Hierarchy 
Process (AHP)
aspect­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­: Aspect
buffer­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­­: Buffer

On the right you find the name of the algorithm in the current language, which 
is the same name that identifies the algorithm in the toolbox. However, this 
name is  not  constant,  since  it  depends  on  the  current  language,  and  thus 
cannot be used to call the algorithm. Instead, a command-line is needed. On 
the left side of the list you will find the command-line name of each algorithm. 
This is the one you have to use to make a reference to the algorithm you want 
to use.
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Now, let's see how to get a list of the parameters that an algorithms require 
and  the  outputs  that  it  will  generate.  To  do  it,  you  can  use  the 
describealg(name of the algorithm) method. Use the command-line name of 
the algorithm, not the full descriptive name.

For example, if we want to calculate a ow accumulation layer from a DEM, we 
will  need to execute the corresponding module,  which, according to the list 
show  using  the  ags()  method,is  identified  as  accflow.  The  following  is  a 
description of its inputs and outputs.

>describealg("accflow")
Usage: accflow(DEM[Raster Layer]
              WEIGHTS[Optional Raster Layer]
              METHOD[Selection]
              CONVERGENCE[Numerical Value]
              FLOWACC [output raster layer])

10.5.4 Running an algorithm

Now you know how to describe data and algorithms, so you have everything 
you need to run any algorithm. There is only one single command to execute 
algorithms: runalg. Its syntax is as follows:

> runalgname_of_the_algorithm, param1, param2, ..., paramN)

The list of parameters to add depends on the algorithm you want to run, and is 
exactly the list that the describealg method gives you, in the same order as 
shown.

Depending on the type of parameter,  values are introduced differently.  The 
next one is aquick review of how to introduce values for each type of input 
parameter

• [Raster Layer], [Vector Layer]o [Table]. Simply introduce the name that 
identies the data object to use. If the input is optional and you do not 
want to use any data object, write #". 

• [Numerical  value].  Directly  type  the  value  to  use  or  the  name  of  a 
variable containing that value. 

• [Selection]. Type the number that identies the desired option, as shown 
by the options command 

• [String].  Directly  type  the  string  to  use  or  the  name  of  a  variable 
containing it. 

• [Boolean]. Type whether true" or false" (including quotes) 
• [Multiple selection - tipo datos]. Type the list of objects to use, separated 

by commas and enclosed between quotes. 
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For example, for the maxvaluegrid algorithm:

Usage: runalg("maxvaluegrid",
      INPUT[Multiple Input ­ Raster Layer]
      NODATA[Boolean],
      RESULT[Output raster layer])

The next line shows a valid usage example:

> runalg("maxvaluegrid", "lyr1, lyr2, lyr3", "false", "#")

Of course, lyr1, lyr2 and lyr3 must be valid layers already loaded into gvSIG.

When  the  multiple  input  is  comprised  of  raster  bands,  each  element  is 
represented by  a  pair  of  values  (layer,  band).  For  example,  for  the  cluster 
algorithm:

Usage: runalg ("cluster",
      INPUT[Multiple Input ­ Band]
      NUMCLASS[Numerical Value]) ***************

The next line shows a valid usage example:

> runalg("cluster, "lyr1, 1, lyr1, 2, lyr2, 2", 5, "#", "#")

The algorithm will use three bands, two of them from lyr1 (the first and the 
second ones of that layer) and one from lyr2 (its second band).

• [Table  Field  from  XXX  ].  Write  the  name  of  the  field  to  use.  This 
parameter is case sensitive. 

• [Fixed Table ]. Type the list of all table values separated by commas and 
enclosed between quotes. Values start on the upper row and go from left 
to right. Here is an example: 

runalg("kernelfilter", mdt25.asc, "­1, ­1, ­1, ­1, 9, ­1, ­1, ­1, 
­1", "#")

• [Point ]. Write the pair of coordinates separated by commas and enclosed 
between quotes. For instance "220345, 4453616" 

Input parameters such as strings or numerical values have default values. To 
use them, type "#" in the corresponding parameter entry instead of a value 
expression.

For output data objects, type the filepath to be used to save it, just as it is done 
from the toolbox. If you want to save the result to a temporary file, type "#".

10.5.5 Adjusting output raster characterisitics

Just like when you execute a geoalgorithm from the toolbox, when it generates 
new raster layers you have to define the extent and cellsize of those layers.

By default, those characteristics are defined based on the input layers. You can 
toggle this behaviour using the autoextent command.

> autoextent("true"/"false)

If  you want to define the output  raster  characteristics  manually  or  using a 
supporting  layer,  you  have  to  use  the  extent  command,  which  has  three 
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different variants.

Usage: extent(raster layer[string])
       extent(vector layer[string], cellsize[double])
       extent(x min[double], y min[double],
              x max[double], y max[double],
              cell size[double])
Type "autoextent" to use automatic extent fitting when possible

When  this  command  is  used,  the  autoextent  functionality  is  automatically 
deactivated.

10.6 The Sextante history manager

10.6.1 Introduction

Every time you execute a SEXTANTE algorithm, information about the process 
is stored in the SEXTANTE history manager. Along with the parameters used, 
the date and time of the execution are also saved.

This  way,  it  is  easy  to  track  the  and  control  all  the  work  that  has  been 
developed using SEXTANTE, and easily reproduce it.

The SEXTANTE history manager is a set of registries grouped according to their 
date  of  execution,  making  it  easier  to  find  information  about  an  algorithm 
executed at any particular moment.
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SEXTANTE history manager

Process  information  is  kept  as  a  command-line  expression,  even  if  the 
algorithm was launched from the toolbox. This makes it also useful for those 
learning  how  to  use  the  command-line  interface,  since  they  can  call  an 
algorithm using the toolbox and then check the history manager to see how 
that same algorithm could be called from the command-line.

Apart from browsing the entries in the registry, processes can be reexecuted, 
simply double-clicking on the corresponding entry.

10.7 GRASS implementation process from Sextante

10.7.1 Introduction

This  document describes  how to configure  SEXTANTE to incorporate GRASS 
applications into its interface and thus broaden its own set of algorithms.

Once you  have configured  the  system,  you will  be  able  to  execute  GRASS 
algorithms just like any other SEXTANTE algorithm.

To do this, you will enter SEXTANTE toolbox using the toolbar icon.

ToolBar

Open the settings dialog and select the GRASS menu.
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Access to settings

• Linux: 

If the operating system is Linux, you only need type the path to the GRASS 
installation folder, required by SEXTANTE to execute GRASS commands.

Usually: /usr/lib/grass64.

At the following options, tick "Create temporary mapset".
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Setting dialog

• Windows 

If it is configured on Windows XP, it will be necessary to set the path to the 
GRASS installation folder and the Shell interpreter path.

GRASS usually installed at:

C:\Archivos de programa\GRASS­64

C:\Archivos de programa\GRASS­64\msys\bin\sh.exe

Once you have set the previous paths, click on Install GRASS button.
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Setting dialog of Windows

It will appear a message if the installation has had success.

Info window

After it, GRASS algorithms will be shown in the toolbox and identified with a 
GRASS icon. They will appear in a new branch named "GRASS" which contains 
two groups: raster and vector.
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GRASS Algorithms

11 Scripting extension

11.1 Introduction

gvSiG has an extension which allows you to create your own scripts in different 
programming languages, such as Jython, javascript, beanShell or groovy.

Jython is an implementation of the high-level, object-oriented language Python 
written  in  Java,  and integrated with the Java platform.  It  allows  you to  run 
Python on any Java platform.

BeanShell is  an  object-oriented  Java  source  code  interpreter  with  script 
utilities.  It  executes  standard  Java  expressions  and  statements  as  well  as 
scripting commands and syntax.

Groovy is a powerful  language for the Java virtual machine which compiles 
Java byte code and implements several high-level utilities for Java developers. 
A scripting extension tutorial is available in www.gvsig.org.

11.2 Jython console

gvSIG includes a command console for Jython language which can be accessed 
by going to the "File" menu bar, then to "Scripting" and “Jython console".

http://gvsig.org/
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12 Glossary

ADL Gazetter Protocol: Standard defining how the communication between 
ADL gazetteer clients and servers must be.

ADL GCS (ADL Gazetteer Content Standard): Although it is not an official 
standard it is the de facto set of rules used to defined the relationship between 
a toponym and its coordinates. It can supply other attributes such as the region 
where the toponym is settled, or the nature of this datum.

ANZLIC (Australian and New Zealand Land Information Council): Is the 
organization in charge of the development of the SDI in these two countries.

Band:  Frequency interval  from the electromagnetic  spectrum. For  example, 
the first band of the TM sensor is defined in the range of 0.45-.052 mm.

Database: Set of data structured in order to enable the storage, consultation 
and upgrading in a computer system. The relational  database is a concrete 
case  in  which  the  information  is  organized  in  relations  (often  known  as 
“tables”).  Relations  are  a  set  of  tuples  (“records”)  and  a  tuple  integrates 
information about an element in a set of fields (one field for each attribute of 
the element);  if  two tables share a field containing values within the same 
domain then it is possible to apply a union operation. The union links the tuples 
according on the values in the linking field.

BMP: Acronym for Bit Map Picture; is a basic image format. It is simple and 
pretty  normalized;  it  is  a  excellent  format  for  sharing  data  and  fast  when 
analyzing and processing images. However, since it is not compressed it does 
not improve the transmission and disk accessing times. BMP is often used win 
RGB 24 bits.

CAD:  Acronym  for  Computer  Assistant  Design.  It  is  an  automatic  system 
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oriented to design, draw and graphical visualization.

Cartography: Set of operations and processes that take part in the creation, 
edition and analysis of maps.

catalogue, Service of: Allows the publication and searching of information 
(metadata) describing data (cartography), services, applications and any other 
kind of resources. The catalogue services are necessary to supply search and 
invocation  capabilities  over  registered  resources  within  an  SDI.  A  Open 
Geospatial  Consortium  spec  establishes  how  a  Catalogue  Service  must  be 
standard and interoperable.

CatMDEdit:  Is  a  computer  application  for  creating  and  editing  geographic 
metadata  based  upon  the  “OSI19115.  Geographic  Information  –  Metadata” 
norm.  Among  its  features,  it  is  an  open-source  project,  multiplatform 
(Windows / UNIX) and multilingual (Spanish and English) as well.

CEN (European  Committee  of  Standarization):  Official  organization  for 
normalization of the European Union. Replaces country specific techniques by 
common  rules  for  the  whole  Union  in  collaboration  with  international 
organizations and its members in Europe (CENELEC for electronics and ETSI for 
telecommunications).

CEN TC 287 (Technical Committee of Geographic Information): Set of 
standards for manipulating geographical information (approximately 20).

Clearinghouse:  A  distributed  service  for  metadata  about  geospatial  data 
locating. Allows to search in one or several nodes or servers that have been 
registered in the Clearinghouse of the Internet. It is the term used by FGDC, 
equivalent to the OGC’s Catalogue Service.

CNIDR  z39.50  Server  (clearinghouse  for  Networked  Information 
Discovery and Retrieval): z39.50 server, also known as zDist.

Compression: Technique for reducing the amount of bits needed for storing or 
transmitting information.  There are lossless or destructive compressions (for 
instance, GIF and JPG for the digital images respectively).

Coordinate:  Value  defining  the  position  in  a  reference  system.  The 
coordinates can be lineal  (Cartesian) or  polar  (spherical),  depending on the 
reference system.

Cota en ingles es Height que se autodefine CSDGM (Content Standard 
for Digital Geospatial Metadata: Determines the metadata that exists in a 
geographical position and how to access to them. It does explain neither how 
to organize the data in a computer nor which software to use.

Datum: Geometric reference system used to numerically express the geodesic 
position of  a point  over the terrain.  Each datum is defined according of  an 
ellipsoid and a point where the ellipsoid and the Earth are tangent. In Spain for 
example, the datum uses the Hayford (or International 1924) ellipsoid and the 
tangency point is Postdam (Germany).

DublinCore:  Set  of  metadata  elements  created  to  make  the  electronic 
resource discovery easier. ebRIM (ebXML Registry Information Model): Specifies 
a  set  of  services  that  make  the  communication  between companies  easier 
using ebXML.

ebRS (ebXML Registry: Services and Protocols): Defines the services that 
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the ebXML Registry and other related protocols offer.

ebXML  (electronic  Business  XML):  Is  a  Standard  that  defines  an  XML-
document format for sharing information between companies.

Element of a metadata: Discrete metadata unit. Entity of a metadat**: Set of 
elements describing the same aspect of the data.

Ellipsoid: Simplified description of the Earth shape: the ellipsoids are defined 
by equatorial and polar radiuses.

EPSG: European Petroleum Survey Group.

Scale: Constant relation between a distance in a map and the corresponding 
real distance.

FGDC (Federal Geographic Data Committee):  Organization  in  charge of 
developing the National Spatial Data Infrastructure (NSDI) of the United States 
of America.

Geodesy: The science that studies the shape of the Earch in the gravitational 
field.

Geoid:  Is  the  level  surface,  equipotential  in  the  gravitational  field,  which 
adopts an irregular three-dimensional spheroid. Due to the dependency on the 
mass  distribution  inside  the  Earth,  it  is  impossible  to  represent  it 
mathematically.  The mathematical  shape used to  do it  is  the ellipsoid  that 
approximately  fits  better  the Earth shape.  The geoid  is  coincident  with  the 
mean ocean surface when they are quiet, virtually extended for the continents 
land.

Georreference: The art of assigning geographic coordinates to an object or 
structure. This concept applied to a digital image involves a set of geometric 
operations that allow assigning to each image pixel a pair of coordinates (x, y) 
in a projection system.

GIF:  Graphic  Interchange  Format.  Developed  by  CompuServe  to  provide  a 
standard  and  platform-independent  format.  The  GIF  format  is  limited  to  a 
maximum of 256 colours. It  is a reasonable limitation since most of the PC 
screens  support  256  colours  at  most.  In  general,  GIF  is  recommended  for 
simple images. When the background has textures they are not useful because 
the computer tries to find the closest colour, and some distortions may appear 
in this process and the result is an inaccurate displaying for the image.

GPS: Acronym for global positioning system. It refers to the system by means 
of which it is possible to approximately calculate a position in the Earth using a 
signal  received  from  several  satellites  (called  the  GPS  constellation) 
simultaneously.
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Grid: Is a net composed by two or more series of arcs in which the member of 
each series intersects with the members of the other series in an algorithmic 
way.

gvSIG:  A  Geographical  Information  handling  tool.  Features  a  user-friendly 
interface, an agile access to the most common vector and raster formats. It can 
integrate local and remote (the Internet) data through connections following 
some protocols specified by the Open Geospatial Consortium.

Spindle: Part of a sphere limited by two meridians or maximum circles. In the 
UTM  projection  each  spindle  is  defined  by  two  meridians  separated  by  a 
distance of  6 degrees (for a total  circle  round of  360 degrees) and by two 
parallels of 80 degrees latitude North and South.

SDI: An SDI (Spatial Data Infrastructure) is a computer system integrated by a 
set of resources (catalogues, servers, programs, data, applications, web pages, 
and  so  on),  for  manage  Geographic  Information  (maps,  satellite  images, 
toponymes,  etc.),  available  from  the  Internet,  that  follow  a  set  of 
interoperational capacity conditions (rules, specifications, protocols, interfaces, 
etc) that allow an user to use them using a simple browser and combine then 
for his/her needs.

IDEE: Acronym for Infraestructura de Datos Espaciales de España, or Spanish 
Spatial Data Infrastructure. The goal of the IDEE is to integrate through Internet 
the geographic data, metadata, services and information produced in Spain. 
So, any potential can identify, select, and access to these resources from the 
IDEE’s  site  where  any node and other  site  of  other  geographic  information 
producers of local, regional or even national wide areas available in Spain.

Digital  Image:  Graphical  representation  of  an  object  which  is,  in  fact,  a 
regular  matrix  that  is  a  collection  of  a  reflectance  values.  The  reflectance 
values  are  usually  measured  by  sensors  of  a  specific  range  of  light 
wavelengths; examples of these sensors are those aerial-transported such are 
aircrafts or satellites or those integrated in a scanner used to digitalize printed 
documents.

Nomenclator Service: Offers the possibility of locating a geographic place by 
its name. It is defined as a service that receives an input that is the name of 
the place (toponym), with the common possibilities: exact match, starting with, 
contains, etc. and returns the location,  by means of the coordinates, of the 
place. Additionally, the query by name also handles other criteria such as the 
spatial extension where to look up, or the type of the place (river, mountain, 
towns …). If one or more occurrences are found, the service supplies a list of 
the places found with any additional  attribute describing it for the user can 
choose  the  desired  one.  There  is  an  Open  Geospatial  Consortium  spec 
describing  how  a  Nomenclator  Service  must  be  to  be  standard  and 
interoperable.
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Attribution-ShareAlike 3.0 Unported

 

CREATIVE COMMONS CORPORATION IS NOT A LAW FIRM AND DOES NOT PROVIDE 
LEGAL SERVICES. DISTRIBUTION OF THIS LICENSE DOES NOT CREATE AN 
ATTORNEY-CLIENT RELATIONSHIP. CREATIVE COMMONS PROVIDES THIS 
INFORMATION ON AN "AS-IS" BASIS. CREATIVE COMMONS MAKES NO WARRANTIES 
REGARDING THE INFORMATION PROVIDED, AND DISCLAIMS LIABILITY FOR 
DAMAGES RESULTING FROM ITS USE. 

13 License

THE  WORK  (AS  DEFINED  BELOW)  IS  PROVIDED  UNDER  THE  TERMS  OF  THIS  CREATIVE 
COMMONS PUBLIC LICENSE ("CCPL" OR "LICENSE"). THE WORK IS PROTECTED BY COPYRIGHT 
AND/OR OTHER APPLICABLE LAW.  ANY  USE  OF  THE  WORK OTHER THAN AS  AUTHORIZED 
UNDER THIS LICENSE OR COPYRIGHT LAW IS PROHIBITED.

BY EXERCISING ANY RIGHTS TO THE WORK PROVIDED HERE, YOU ACCEPT AND AGREE TO BE 
BOUND BY THE TERMS OF THIS LICENSE. TO THE EXTENT THIS LICENSE MAY BE CONSIDERED 
TO  BE  A  CONTRACT,  THE  LICENSOR  GRANTS  YOU  THE  RIGHTS  CONTAINED  HERE  IN 
CONSIDERATION OF YOUR ACCEPTANCE OF SUCH TERMS AND CONDITIONS.

1. Definitions

a. "Adaptation" means a work based upon the Work, or upon the Work and other pre-
existing works, such as a translation, adaptation, derivative work, arrangement of music 
or  other alterations of  a literary or  artistic  work, or phonogram or performance and 
includes cinematographic  adaptations  or  any other  form in which the Work may be 
recast,  transformed,  or adapted including in any form recognizably derived from the 
original,  except  that  a  work  that  constitutes  a  Collection  will  not  be  considered an 
Adaptation for the purpose of this License. For the avoidance of doubt, where the Work 
is a musical work, performance or phonogram, the synchronization of the Work in timed-
relation with a moving image ("synching")  will  be considered an Adaptation  for  the 
purpose of this License. 

b. "Collection" means a collection of literary or artistic works, such as encyclopedias and 
anthologies,  or  performances,  phonograms  or  broadcasts,  or  other  works  or  subject 
matter other than works listed in Section 1(f) below, which, by reason of the selection 
and arrangement of their contents, constitute intellectual creations, in which the Work is 
included in its entirety in unmodified form along with one or more other contributions, 
each constituting separate and independent works in themselves, which together are 
assembled  into  a  collective  whole.  A  work  that  constitutes  a  Collection  will  not  be 
considered an Adaptation (as defined below) for the purposes of this License. 
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c. "Creative  Commons  Compatible  License" means  a  license  that  is  listed  at 
http://creativecommons.org/compatiblelicenses  that  has  been  approved  by  Creative 
Commons  as  being  essentially  equivalent  to  this  License,  including,  at  a  minimum, 
because that  license:  (i)  contains  terms that  have the  same purpose,  meaning and 
effect as the License Elements of this License; and, (ii) explicitly permits the relicensing 
of  adaptations  of  works  made  available  under  that  license  under  this  License  or  a 
Creative Commons jurisdiction license with the same License Elements as this License. 

d. "Distribute" means to make available to the public the original and copies of the Work 
or Adaptation, as appropriate, through sale or other transfer of ownership. 

e. "License Elements" means the following high-level license attributes as selected by 
Licensor and indicated in the title of this License: Attribution, ShareAlike. 

f. "Licensor" means the individual, individuals, entity or entities that offer(s) the Work 
under the terms of this License. 

g. "Original  Author" means,  in  the  case  of  a  literary  or  artistic  work,  the  individual, 
individuals, entity or entities who created the Work or if no individual or entity can be 
identified, the publisher; and in addition (i) in the case of a performance the actors, 
singers, musicians, dancers, and other persons who act, sing, deliver, declaim, play in, 
interpret or otherwise perform literary or artistic works or expressions of folklore; (ii) in 
the case of a phonogram the producer being the person or legal entity who first fixes 
the sounds of a performance or other sounds; and, (iii) in the case of broadcasts, the 
organization that transmits the broadcast. 

h. "Work" means the literary and/or artistic work offered under the terms of this License 
including without limitation any production in the literary, scientific and artistic domain, 
whatever may be the mode or form of its expression including digital form, such as a 
book, pamphlet and other writing; a lecture, address, sermon or other work of the same 
nature; a dramatic or dramatico-musical work; a choreographic work or entertainment in 
dumb show; a musical composition with or without words; a cinematographic work to 
which are assimilated works expressed by a process analogous to cinematography; a 
work  of  drawing,  painting,  architecture,  sculpture,  engraving  or  lithography;  a 
photographic work to which are assimilated works expressed by a process analogous to 
photography;  a  work  of  applied  art;  an  illustration,  map,  plan,  sketch  or  three-
dimensional  work  relative  to  geography,  topography,  architecture  or  science;  a 
performance;  a  broadcast;  a  phonogram;  a  compilation  of  data  to  the  extent  it  is 
protected as a copyrightable work; or a work performed by a variety or circus performer 
to the extent it is not otherwise considered a literary or artistic work. 

i. "You" means an individual or entity exercising rights under this License who has not 
previously  violated  the  terms of  this  License with  respect  to  the  Work,  or  who has 
received express permission from the Licensor  to  exercise rights  under  this  License 
despite a previous violation. 

j. "Publicly  Perform" means  to  perform  public  recitations  of  the  Work  and  to 
communicate to the public those public recitations, by any means or process, including 
by wire or wireless means or public digital performances; to make available to the public 
Works in such a way that members of the public may access these Works from a place 
and at a place individually chosen by them; to perform the Work to the public by any 
means or process and the communication  to the public  of  the performances of  the 
Work, including by public digital performance; to broadcast and rebroadcast the Work 
by any means including signs, sounds or images. 

k. "Reproduce" means  to  make  copies  of  the  Work  by  any  means  including  without 
limitation  by  sound  or  visual  recordings  and  the  right  of  fixation  and  reproducing 
fixations of the Work, including storage of a protected performance or phonogram in 
digital form or other electronic medium. 

2. Fair Dealing Rights. Nothing in this License is intended to reduce, limit, or restrict any 
uses free from copyright or rights arising from limitations or exceptions that are provided for in 
connection with the copyright protection under copyright law or other applicable laws.

3. License Grant. Subject to the terms and conditions of this License, Licensor hereby grants 
You  a  worldwide,  royalty-free,  non-exclusive,  perpetual  (for  the  duration  of  the  applicable 
copyright) license to exercise the rights in the Work as stated below:

a. to Reproduce the Work, to incorporate the Work into one or more Collections, and to 
Reproduce the Work as incorporated in the Collections; 
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b. to create and Reproduce Adaptations provided that any such Adaptation, including any 
translation  in  any  medium,  takes  reasonable  steps  to  clearly  label,  demarcate  or 
otherwise  identify  that  changes  were  made  to  the  original  Work.  For  example,  a 
translation could be marked "The original work was translated from English to Spanish," 
or a modification could indicate "The original work has been modified."; 

c. to Distribute and Publicly Perform the Work including as incorporated in Collections; 
and, 

d. to Distribute and Publicly Perform Adaptations. 
e. For the avoidance of doubt:

i. Non-waivable Compulsory License Schemes. In those jurisdictions in which 
the  right  to  collect  royalties  through  any  statutory  or  compulsory  licensing 
scheme cannot be waived, the Licensor reserves the exclusive right to collect 
such royalties for any exercise by You of the rights granted under this License; 

ii. Waivable Compulsory License Schemes. In those jurisdictions in which the 
right to collect royalties through any statutory or compulsory licensing scheme 
can be waived, the Licensor waives the exclusive right to collect such royalties 
for any exercise by You of the rights granted under this License; and, 

iii.Voluntary License Schemes. The Licensor waives the right to collect royalties, 
whether individually or, in the event that the Licensor is a member of a collecting 
society that administers voluntary licensing schemes, via that society, from any 
exercise by You of the rights granted under this License. 

The above rights may be exercised in all media and formats whether now known or hereafter 
devised.  The above rights  include the  right  to  make such modifications  as  are  technically 
necessary to exercise the rights in other media and formats. Subject to Section 8(f), all rights 
not expressly granted by Licensor are hereby reserved.

4. Restrictions. The license granted in Section 3 above is expressly made subject to and 
limited by the following restrictions:

a. You may Distribute or Publicly Perform the Work only under the terms of this License. 
You must include a copy of, or the Uniform Resource Identifier (URI) for, this License 
with every copy of the Work You Distribute or Publicly Perform. You may not offer or 
impose any terms on the Work that restrict the terms of this License or the ability of the 
recipient of the Work to exercise the rights granted to that recipient under the terms of 
the License. You may not sublicense the Work. You must keep intact all notices that 
refer to this License and to the disclaimer of warranties with every copy of the Work You 
Distribute or Publicly Perform. When You Distribute or Publicly Perform the Work, You 
may not  impose any effective technological  measures on the Work that  restrict  the 
ability of a recipient of the Work from You to exercise the rights granted to that recipient 
under the terms of the License. This Section 4(a) applies to the Work as incorporated in 
a Collection, but this does not require the Collection apart from the Work itself to be 
made subject to the terms of this License. If You create a Collection, upon notice from 
any Licensor You must, to the extent practicable, remove from the Collection any credit 
as required by Section 4(c), as requested. If You create an Adaptation, upon notice from 
any Licensor You must, to the extent practicable, remove from the Adaptation any credit 
as required by Section 4(c), as requested. 

b. You may Distribute or Publicly Perform an Adaptation only under the terms of: (i) this 
License;  (ii)  a  later  version of  this  License with the  same License Elements  as  this 
License;  (iii)  a  Creative  Commons  jurisdiction  license  (either  this  or  a  later  license 
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version)  that  contains  the  same License Elements  as  this  License (e.g.,  Attribution-
ShareAlike 3.0 US)); (iv) a Creative Commons Compatible License. If you license the 
Adaptation under one of the licenses mentioned in (iv), you must comply with the terms 
of that license. If you license the Adaptation under the terms of any of the licenses 
mentioned in (i), (ii) or (iii) (the "Applicable License"), you must comply with the terms 
of the Applicable License generally and the following provisions: (I) You must include a 
copy of, or the URI for, the Applicable License with every copy of each Adaptation You 
Distribute  or  Publicly  Perform;  (II)  You  may  not  offer  or  impose  any  terms  on  the 
Adaptation that restrict the terms of the Applicable License or the ability of the recipient 
of the Adaptation to exercise the rights granted to that recipient under the terms of the 
Applicable License; (III) You must keep intact all  notices that refer to the Applicable 
License and to the disclaimer of warranties with every copy of the Work as included in 
the Adaptation You Distribute or Publicly Perform; (IV) when You Distribute or Publicly 
Perform the Adaptation, You may not impose any effective technological measures on 
the Adaptation that  restrict  the  ability of  a recipient of  the Adaptation from You to 
exercise the rights granted to that recipient under the terms of the Applicable License. 
This Section 4(b) applies to the Adaptation as incorporated in a Collection, but this does 
not require the Collection apart from the Adaptation itself to be made subject to the 
terms of the Applicable License. 

c. If You Distribute, or Publicly Perform the Work or any Adaptations or Collections, You 
must,  unless  a  request  has  been  made  pursuant  to  Section  4(a),  keep  intact  all 
copyright notices for the Work and provide, reasonable to the medium or means You are 
utilizing: (i) the name of the Original Author (or pseudonym, if applicable) if supplied, 
and/or if the Original Author and/or Licensor designate another party or parties (e.g., a 
sponsor  institute,  publishing  entity,  journal)  for  attribution  ("Attribution  Parties")  in 
Licensor's copyright notice, terms of service or by other reasonable means, the name of 
such party or parties; (ii) the title of the Work if supplied; (iii) to the extent reasonably 
practicable,  the  URI,  if  any,  that  Licensor  specifies  to  be  associated with the  Work, 
unless such URI does not refer to the copyright notice or licensing information for the 
Work; and (iv) ,  consistent with Ssection 3(b), in the case of an Adaptation, a credit 
identifying the use of the Work in the Adaptation (e.g., "French translation of the Work 
by Original Author," or "Screenplay based on original Work by Original Author"). The 
credit required by this Section 4(c) may be implemented in any reasonable manner; 
provided, however, that in the case of a Adaptation or Collection, at a minimum such 
credit will appear, if a credit for all contributing authors of the Adaptation or Collection 
appears, then as part of these credits and in a manner at least as prominent as the 
credits for the other contributing authors. For the avoidance of doubt, You may only use 
the credit required by this Section for the purpose of attribution in the manner set out 
above  and,  by  exercising  Your  rights  under  this  License,  You  may  not  implicitly  or 
explicitly  assert  or  imply  any  connection  with,  sponsorship  or  endorsement  by  the 
Original Author, Licensor and/or Attribution Parties, as appropriate, of You or Your use of 
the Work, without the separate, express prior written permission of the Original Author, 
Licensor and/or Attribution Parties. 

d. Except as otherwise agreed in writing by the Licensor or as may be otherwise permitted 
by applicable law, if You Reproduce, Distribute or Publicly Perform the Work either by 
itself or as part of any Adaptations or Collections, You must not distort, mutilate, modify 
or take other derogatory action in relation to the Work which would be prejudicial to the 
Original Author's honor or reputation. Licensor agrees that in those jurisdictions (e.g. 
Japan), in which any exercise of the right granted in Section 3(b) of this License (the 
right to make Adaptations) would be deemed to be a distortion, mutilation, modification 
or other derogatory action prejudicial to the Original Author's honor and reputation, the 
Licensor  will  waive  or  not  assert,  as  appropriate,  this  Section,  to  the  fullest  extent 
permitted by the applicable national law, to enable You to reasonably exercise Your 
right under Section 3(b) of this License (right to make Adaptations) but not otherwise. 

5. Representations, Warranties and Disclaimer

UNLESS OTHERWISE MUTUALLY AGREED TO BY THE PARTIES IN WRITING, LICENSOR OFFERS 
THE  WORK  AS-IS  AND  MAKES  NO  REPRESENTATIONS  OR  WARRANTIES  OF  ANY  KIND 
CONCERNING  THE  WORK,  EXPRESS,  IMPLIED,  STATUTORY  OR  OTHERWISE,  INCLUDING, 
WITHOUT LIMITATION, WARRANTIES OF TITLE, MERCHANTIBILITY, FITNESS FOR A PARTICULAR 
PURPOSE, NONINFRINGEMENT, OR THE ABSENCE OF LATENT OR OTHER DEFECTS, ACCURACY, 
OR  THE  PRESENCE  OF  ABSENCE  OF  ERRORS,  WHETHER  OR  NOT  DISCOVERABLE.  SOME 
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JURISDICTIONS  DO  NOT  ALLOW  THE  EXCLUSION  OF  IMPLIED  WARRANTIES,  SO  SUCH 
EXCLUSION MAY NOT APPLY TO YOU.

6. Limitation on Liability. EXCEPT TO THE EXTENT REQUIRED BY APPLICABLE LAW, IN NO 
EVENT  WILL  LICENSOR  BE  LIABLE  TO  YOU  ON  ANY  LEGAL  THEORY  FOR  ANY  SPECIAL, 
INCIDENTAL,  CONSEQUENTIAL,  PUNITIVE  OR  EXEMPLARY  DAMAGES  ARISING  OUT  OF  THIS 
LICENSE  OR  THE  USE  OF  THE  WORK,  EVEN  IF  LICENSOR  HAS  BEEN  ADVISED  OF  THE 
POSSIBILITY OF SUCH DAMAGES.

7. Termination

a. This License and the rights granted hereunder will terminate automatically upon any 
breach by You of the terms of this License. Individuals or entities who have received 
Adaptations or Collections from You under this License, however, will  not have their 
licenses terminated provided such individuals or entities remain in full compliance with 
those licenses. Sections 1, 2, 5, 6, 7, and 8 will survive any termination of this License. 

b. Subject to the above terms and conditions, the license granted here is perpetual (for the 
duration of the applicable copyright in the Work). Notwithstanding the above, Licensor 
reserves  the  right  to  release  the  Work  under  different  license  terms  or  to  stop 
distributing the Work at any time; provided, however that any such election will  not 
serve to withdraw this License (or any other license that has been, or is required to be, 
granted under the terms of this License), and this License will continue in full force and 
effect unless terminated as stated above. 

8. Miscellaneous

a. Each time You Distribute or Publicly Perform the Work or a Collection, the Licensor offers 
to the recipient a license to the Work on the same terms and conditions as the license 
granted to You under this License. 

b. Each  time  You  Distribute  or  Publicly  Perform an  Adaptation,  Licensor  offers  to  the 
recipient a license to the original Work on the same terms and conditions as the license 
granted to You under this License. 

c. If any provision of this License is invalid or unenforceable under applicable law, it shall 
not affect the validity or enforceability of the remainder of the terms of this License, and 
without further action by the parties to this agreement, such provision shall be reformed 
to the minimum extent necessary to make such provision valid and enforceable. 

d. No term or provision of this License shall be deemed waived and no breach consented 
to unless such waiver or  consent  shall  be in writing and signed by the party  to be 
charged with such waiver or consent. 

e. This License constitutes the entire agreement between the parties with respect to the 
Work licensed here. There are no understandings, agreements or representations with 
respect to the Work not specified here. Licensor shall not be bound by any additional 
provisions that may appear in any communication from You. This License may not be 
modified without the mutual written agreement of the Licensor and You. 

f. The  rights  granted  under,  and  the  subject  matter  referenced,  in  this  License  were 
drafted utilizing the terminology of the Berne Convention for the Protection of Literary 
and Artistic Works (as amended on September 28, 1979), the Rome Convention of 1961, 
the WIPO Copyright Treaty of 1996, the WIPO Performances and Phonograms Treaty of 
1996 and the Universal Copyright Convention (as revised on July 24, 1971). These rights 
and subject matter take effect in the relevant jurisdiction in which the License terms are 
sought to be enforced according to the corresponding provisions of the implementation 
of those treaty provisions in the applicable national law. If the standard suite of rights 
granted under applicable copyright law includes additional rights not granted under this 
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License, such additional rights are deemed to be included in the License; this License is 
not intended to restrict the license of any rights under applicable law. 

13.1.1 Creative Commons Notice

Creative Commons is not a party to this License, and makes no warranty 
whatsoever in connection with the Work. Creative Commons will not be liable to You 
or any party on any legal theory for any damages whatsoever, including without 
limitation any general, special, incidental or consequential damages arising in 
connection to this license. Notwithstanding the foregoing two (2) sentences, if 
Creative Commons has expressly identified itself as the Licensor hereunder, it shall 
have all rights and obligations of Licensor.

Except for the limited purpose of indicating to the public that the Work is licensed 
under the CCPL, Creative Commons does not authorize the use by either party of 
the trademark "Creative Commons" or any related trademark or logo of Creative 
Commons without the prior written consent of Creative Commons. Any permitted 
use will be in compliance with Creative Commons' then-current trademark usage 
guidelines, as may be published on its website or otherwise made available upon 
request from time to time. For the avoidance of doubt, this trademark restriction 
does not form part of the License.

Creative Commons may be contacted at http://creativecommons.org/.

http://creativecommons.org/
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